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What is Azure VMware Solution?
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Azure VMware Solution provides you with private clouds that contain VMware vSphere clusters built from
dedicated bare-metal Azure infrastructure. The minimum initial deployment is three hosts, but additional hosts
can be added one at a time, up to a maximum of 16 hosts per cluster. All provisioned private clouds have
VMware vCenter Server, VMware vSAN, VMware vSphere, and VMware NSX-T Data Center. As a result, you can
migrate workloads from your on-premises environments, deploy new virtual machines (VMs), and consume
Azure services from your private clouds. In addition, Azure VMware Solution management tools (vCenter Server
and NSX Manager) are available at least 99.9% of the time. For more information, see Azure VMware Solution
SLA.

Azure VMware Solution is a VMware validated solution with ongoing validation and testing of enhancements
and upgrades. Microsoft manages and maintains the private cloud infrastructure and software. It allows you to
focus on developing and running workloads in your private clouds to deliver business value.

The diagram shows the adjacency between private clouds and VNets in Azure, Azure services, and on-premises
environments. Network access from private clouds to Azure services or VNets provides SLA-driven integration
of Azure service endpoints. ExpressRoute Global Reach connects your on-premises environment to your Azure
VMware Solution private cloud.
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Hosts, clusters, and private clouds

Azure VMware Solution clusters are based on hyper-converged, bare-metal infrastructure. The following table
shows the RAM, CPU, and disk capacities of the host.

VSAN CACHE VSAN CAPACITY REGIONAL
HOST TYPE CPU (GHZ) RAM (GB) TIER (TB, RAW) TIER (TB, RAW) AVAILABILITY
AV36 dual Intel 18 576 3.2 (NVMe) 15.20 (SSD) All product
core 2.3 GHz regions

(SkyLake)


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/introduction.md
https://azure.microsoft.com/support/legal/sla/azure-vmware/v1_1/

VSAN CACHE VSAN CAPACITY REGIONAL
HOST TYPE CPU (GHZ) RAM (GB) TIER (TB, RAW) TIER (TB, RAW) AVAILABILITY
AV36P dual Intel 18 768 1.5 (Intel Optane 19.20 (NVMe) Selected regions
core 2.6 GHz / Cache) *)
3.9 GHz turbo
(Cascade Lake)
AV52 dual Intel 26 1536 1.5 (Intel Optane 38.40 (NVMe) Selected regions

core 2.7 GHz / Cache) *
4.0 GHz turbo
(Cascade Lake)

An Azure VMware cluster requires a minimum number of three hosts. You can only use host of the same type in
a single cluster. You can use multiple clusters with different host types in a single Azure VMware Private Cloud.
Hosts used to build or scale clusters come from an isolated pool of hosts. Those hosts have passed hardware
tests and have had all data securely deleted before being added to a cluster.

(*) details available via the Azure pricing calculator.

You can deploy new or scale existing private clouds through the Azure portal or Azure CLI.

Networking

Azure VMware Solution offers a private cloud environment accessible from on-premises and Azure-based
resources. Services such as Azure ExpressRoute, VPN connections, or Azure Virtual WAN deliver the connectivity.
However, these services require specific network address ranges and firewall ports for enabling the services.

When deploying a private cloud, private networks for management, provisioning, and vMotion get created.
You'll use these private networks to access vCenter and NSX-T Manager and virtual machine vMotion or
deployment.

ExpressRoute Global Reach is used to connect private clouds to on-premises environments. It connects circuits
directly at the Microsoft Enterprise Edge (MSEE) level. The connection requires a virtual network (vNet) with an
ExpressRoute circuit to on-premises in your subscription. The reason is that vNet gateways (ExpressRoute
Gateways) can't transit traffic, which means you can attach two circuits to the same gateway, but it won't send
the traffic from one circuit to the other.

Each Azure VMware Solution environment is its own ExpressRoute region (its own virtual MSEE device), which
lets you connect Global Reach to the 'local' peering location. It allows you to connect multiple Azure VMware
Solution instances in one region to the same peering location.

NOTE

For locations where ExpressRoute Global Reach isn't enabled, for example, because of local regulations, you have to build a

routing solution using Azure laaS VMs. For some examples, see AzureCAT-AVS/networking.

Virtual machines deployed on the private cloud are accessible to the internet through the Azure Virtual WAN
public IP functionality. For new private clouds, internet access is disabled by default.

For more information, see Networking concepts.

Access and security

Azure VMware Solution private clouds use vSphere role-based access control for enhanced security. You can
integrate vSphere SSO LDAP capabilities with Azure Active Directory. For more information, see the Access and


https://docs.microsoft.com/en-us/azure/expressroute/expressroute-global-reach
https://github.com/Azure/AzureCAT-AVS/tree/main/networking

Identity concepts.

vSAN data-at-rest encryption, by default, is enabled and is used to provide vSAN datastore security. For more

information, see Storage concepts.

VMware software versions

The VMware solution software versions used in new deployments of Azure VMware Solution private cloud
clusters are:

SOFTWARE VERSION
vCenter Server 7.0 U3c
ESXi 7.0 U3c
vSAN 7.0 U3c
vSAN on-disk format 10

HCX 433
NSX-T Data Center 3.1.2

NOTE: NSX-T Data Center is the only supported version of
NSX Data Center.

The currently running software version is applied to new clusters added to an existing private cloud. For more
information, see the VMware software version requirements for HCX and Understanding vSAN on-disk format

versions and compatibility.

Host and software lifecycle maintenance

Regular upgrades of the Azure VMware Solution private cloud and VMware software ensure the latest security,
stability, and feature sets are running in your private clouds. For more information, see Host maintenance and
lifecycle management.

Monitoring your private cloud

Once you've deployed Azure VMware Solution into your subscription, Azure Monitor logs are generated

automatically.
In your private cloud, you can:

e Collect logs on each of your VMs.

e Download and install the MMA agent on Linux and Windows VMs.
e Enable the Azure diagnostics extension.

e Create and run new queries.

e Run the same queries you usually run on your VMs.

Monitoring patterns inside the Azure VMware Solution are similar to Azure VMs within the laaS platform. For
more information and how-tos, see Monitoring Azure VMs with Azure Monitor.

Customer communication

You can find service issues, planned maintenance, health advisories, security advisories notifications published


https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/rn/VMware-NSX-T-Data-Center-312-Release-Notes.html
https://docs.vmware.com/en/VMware-HCX/4.3/hcx-user-guide/GUID-54E5293B-8707-4D29-BFE8-EE63539CC49B.html
https://kb.vmware.com/s/article/2148493
https://docs.microsoft.com/en-us/azure/azure-monitor/overview
https://docs.microsoft.com/en-us/azure/azure-monitor/agents/log-analytics-agent
https://docs.microsoft.com/en-us/azure/azure-monitor/agents/diagnostics-extension-overview
https://docs.microsoft.com/en-us/azure/azure-monitor/logs/data-platform-logs
file:///C:/localrun/t/1pp1/gn1d/azure/azure-monitor/vm/monitor-vm-azure.html

through Service Health in the Azure portal. You can take timely actions when you set up activity log alerts for
these notifications. You can take timely actions when you set up activity log alerts for these notifications. For

more information, see Create service health alerts using the Azure portal.

Home > Service Health

5 Service Health | Health advisories 2) = &

Subscription Region Service
I/O Search (Ctrl+/) I « P 9
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“® Service issues

" Azure Disaster Recovery Drill for East...  95X9-LT8 Network Infrastructure East US 2 EUAP 2020-10-21T23:50:16Z
w4 Planned maintenance (1)
’_} Health advisories (2) Action Required: Review your comput... DT3B-7C0 Azure VMware Solution West US 2020-11-06T00:00:00Z
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% Resource health
Create a SuppuTtTEqUEST
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region. A private cloud instance is running low on compute and storage capacity, which can

%% Health alerts affect its performance or your Service Level Agreements. To avoid disruption to any

Next steps

The next step is to learn key private cloud and cluster concepts.


https://docs.microsoft.com/en-us/azure/service-health/alerts-activity-log-service-notifications-portal

Platform updates for Azure VMware Solution
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Azure VMware Solution will apply important updates starting in March 2021. You'll receive a notification
through Azure Service Health that includes the timeline of the maintenance. For more information, see Host
maintenance and lifecycle management.

July 8, 2022

HCX cloud manager in Azure VMware solutions can now be accessible over a public IP address. You can pair
HCX sites and create a service mesh from on-premises to Azure VMware Solutions private cloud using Public IP

HCX with public IP is especially useful in cases where On-premises sites are not connected to Azure via Express
Route or VPN. HCX service mesh appliances can be configured with public IPs to avoid lower tunnel MTUs due
to double encapsulation if a VPN is used for on-premises to cloud connections.

For more information, please see Enable HCX over the internet

July 7, 2022

All new Azure VMware Solution private clouds are now deployed with VMware vCenter Server version 7.0
Update 3c and ESXi version 7.0 Update 3c.

Any existing private clouds will be upgraded to those versions. For more information, please see VMware ESXi
7.0 Update 3c Release Notes and VMware vCenter Server 7.0 Update 3c Release Notes.

You'll receive a notification through Azure Service Health that includes the timeline of the upgrade. You can
reschedule an upgrade as needed. This notification also provides details on the upgraded component, its effect
on workloads, private cloud access, and other Azure services.

June 7, 2022

All new Azure VMware Solution private clouds in regions (East US2, Canada Central, North Europe, and Japan

East), are now deployed in with VMware vCenter Server version 7.0 Update 3c and ESXi version 7.0 Update 3c.

Any existing private clouds in the above mentioned regions will also be upgraded to these versions. For more
information, please see VMware ESXi 7.0 Update 3c Release Notes and VMware vCenter Server 7.0 Update 3¢
Release Notes.

May 23, 2022

All new Azure VMware Solution private clouds in regions (Germany West Central, Australia East, Central US and
UK West), are now deployed with VMware vCenter Server version 7.0 Update 3c and ESXi version 7.0 Update 3c.

Any existing private clouds in the previously mentioned regions will be upgraded to those versions. For more
information, please see VMware ESXi 7.0 Update 3c Release Notes and VMware vCenter Server 7.0 Update 3c
Release Notes.

You'll receive a notification through Azure Service Health that includes the timeline of the upgrade. You can
reschedule an upgrade as needed. This notification also provides details on the upgraded component, its effect
on workloads, private cloud access, and other Azure services.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/azure-vmware-solution-platform-updates.md
https://docs.vmware.com/en/VMware-vSphere/7.0/rn/vsphere-esxi-70u3c-release-notes.html
https://docs.vmware.com/en/VMware-vSphere/7.0/rn/vsphere-vcenter-server-70u3c-release-notes.html
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https://docs.vmware.com/en/VMware-vSphere/7.0/rn/vsphere-vcenter-server-70u3c-release-notes.html

May 9, 2022

All new Azure VMware Solution private clouds in regions (France Central, Brazil South, Japan West, Australia
Southeast, Canada East, East Asia, and Southeast Asia), are now deployed with VMware vCenter Server version
7.0 Update 3c and ESXi version 7.0 Update 3c.

Any existing private clouds in the previously mentioned regions will be upgraded to those versions. For more
information, please see VMware ESXi 7.0 Update 3c Release Notes and VMware vCenter Server 7.0 Update 3¢
Release Notes.

You'll receive a notification through Azure Service Health that includes the timeline of the upgrade. You can
reschedule an upgrade as needed. This notification also provides details on the upgraded component, its effect
on workloads, private cloud access, and other Azure services.

February 18, 2022

Per VMware security advisory VMSA-2022-0004, multiple vulnerabilities in VMware ESXi have been reported to
VMware.

To address the vulnerabilities (CVE-2021-22040 and CVE-2021-22041) reported in this VMware security
advisory, ESXi hosts have been patched in all Azure VMware Solution private clouds to ESXi 6.7, Patch Release
ESXi670-202111001. All new Azure VMware Solution private clouds are deployed with the same version.

For more information on this ESXi version, see VMware ESXi 6.7, Patch Release ESXi670-202111001.

No further action is required.

December 22, 2021

Azure VMware Solution (AVS) has completed maintenance activities to address critical vulnerabilities in Apache
Log4j. The fixes documented in the VMware security advisory VMSA-2021-0028.6 to address CVE-2021-44228
and CVE-2021-45046 have been applied to these AVS managed VMware products: vCenter Server, NSX-T Data
Center, SRM and HCX. We strongly encourage customers to apply the fixes to on-premises HCX connector
appliances.

We also recommend customers to review the security advisory and apply the fixes for other affected VMware
products or workloads.

If you need any assistance or have questions, please contact us.

December 12, 2021

VMware has announced a security advisory VMSA-2021-0028, addressing a critical vulnerability in Apache
Log4j identified by CVE-2021-44228.

Azure VMware Solution is actively monitoring this issue. We are addressing this issue by applying VMware
recommended workarounds or patches for AVS managed VMware components as they become available.

Please note that you may experience intermittent connectivity to these components when we apply a fix.

We strongly recommend that you read the advisory and patch or apply the recommended workarounds for any
additional VMware products that you may have deployed in Azure VMware Solution.

If you need any assistance or have questions, please contact us.

November 23, 2021

Per VMware security advisory VMSA-2021-0027, multiple vulnerabilities in VMware vCenter Server have been


https://docs.vmware.com/en/VMware-vSphere/7.0/rn/vsphere-esxi-70u3c-release-notes.html
https://docs.vmware.com/en/VMware-vSphere/7.0/rn/vsphere-vcenter-server-70u3c-release-notes.html
https://www.vmware.com/security/advisories/VMSA-2022-0004.html
https://docs.vmware.com/en/VMware-vSphere/6.7/rn/esxi670-202111001.html
https://www.vmware.com/security/advisories/VMSA-2021-0028.html
https://portal.azure.com/#home
https://www.vmware.com/security/advisories/VMSA-2021-0028.html
https://portal.azure.com
https://www.vmware.com/security/advisories/VMSA-2021-0027.html

reported to VMware.

To address the vulnerabilities (CVE-2021-21980 and CVE-2021-22049) reported in VMware security advisory,
vCenter Server has been updated to 6.7 Update 3p release in all Azure VMware Solution private clouds.

For more information, see VMware vCenter Server 6.7 Update 3p Release Notes

No further action is required.

September 21, 2021

Per VMware security advisory VMSA-2021-0020, multiple vulnerabilities in the VMware vCenter Server have
been reported to VMware.

To address the vulnerabilities (CVE-2021-21991, CVE-2021-21992, CVE-2021-21993, CVE-2021-22005, CVE-
2021-22006, CVE-2021-22007, CVE-2021-22008, CVE-2021-22009, CVE-2021-22010, CVE-2021-22011, CVE-
2021-22012,CVE-2021-22013, CVE-2021-22014, CVE-2021-22015, CVE-2021-22016, CVE-2021-22017, CVE-
2021-22018, CVE-2021-22019, CVE-2021-22020) reported in VMware security advisory VMSA-2021-0020,
vCenter Server has been updated to 6.7 Update 30 in all Azure VMware Solution private clouds. All new Azure
VMware Solution private clouds are deployed with vCenter Server version 6.7 Update 30.

For more information, see VMware vCenter Server 6.7 Update 30 Release Notes

No further action is required.

September 10, 2021

All new Azure VMware Solution private clouds are now deployed with ESXi version ESXi670-202103001 (Build
number: 17700523). ESXi hosts in existing private clouds have been patched to this version.

For more information on this ESXi version, see VMware ESXi 6.7, Patch Release ESXi670-202103001.

July 23, 2021

All new Azure VMware Solution private clouds are now deployed with NSX-T Data Center version 3.1.2. NSX-T
Data Center version in existing private clouds will be upgraded through September, 2021 to NSX-T Data Center

3.1.2 release.

You'll receive an email with the planned maintenance date and time. You can reschedule an upgrade. The email
also provides details on the upgraded component, its effect on workloads, private cloud access, and other Azure

services.

For more information on this NSX-T Data Center version, see VMware NSX-T Data Center 3.1.2 Release Notes.

May 25, 2021

Per VMware security advisory VMSA-2021-0010, multiple vulnerabilities in VMware ESXi and vSphere Client
(HTMLS5) have been reported to VMware.

To address the vulnerabilities (CVE-2021-21985 and CVE-2021-21986) reported in VMware security advisory
VMSA-2021-0010, vCenter Server has been updated in all Azure VMware Solution private clouds.

No further action is required.

May 21, 2021

Azure VMware Solution service will do maintenance work through May 23, 2021, to apply important updates to
the vCenter Server in your private cloud. You'll receive a notification through Azure Service Health that includes


https://docs.vmware.com/en/VMware-vSphere/6.7/rn/vsphere-vcenter-server-67u3p-release-notes.html
https://www.vmware.com/security/advisories/VMSA-2021-0020.html
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the timeline of the maintenance for your private cloud.

During this time, VMware vCenter Server will be unavailable and you won't be able to manage VMs (stop, start,
create, or delete). It's recommended that, during this time, you don't plan any other activities like scaling up
private cloud, creating new networks, and so on, in your private cloud.

There is no impact to workloads running in your private cloud.

April 26, 2021

All new Azure VMware Solution private clouds are now deployed with VMware vCenter Server version 6.7U3I
and NSX-T Data Center version 2.5.2. We're not using NSX-T Data Center 3.1.1 for new private clouds because of
an identified issue in NSX-T Data Center 3.1.1 that impacts customer VM connectivity.

The VMware recommended mitigation was applied to all existing private clouds currently running NSX-T Data
Center 3.1.1 on Azure VMware Solution. The workaround has been confirmed that there's no impact to customer
VM connectivity.

March 24, 2021

All new Azure VMware Solution private clouds are deployed with VMware vCenter Server version 6.7U3l and
NSX-T Data Center version 3.1.1. Any existing private clouds will be updated and upgraded through June
2021 to the releases mentioned above.

You'll receive an email with the planned maintenance date and time. You can reschedule an upgrade. The email
also provides details on the upgraded component, its effect on workloads, private cloud access, and other Azure
services. An hour before the upgrade, you'll receive a notification and then again when it finishes.

March 15, 2021

e Azure VMware Solution service will do maintenance work through March 19, 2021, to update the

vCenter Server in your private cloud to vCenter Server 6.7 Update 3| version.

e VMware vCenter Server will be unavailable during this time, so you can't manage your VMs (stop, start,
create, delete) or private cloud scaling (adding/removing servers and clusters). However, VMware High
Availability (HA) will continue to operate to protect existing VMs.

For more information on this vCenter version, see VMware vCenter Server 6.7 Update 3| Release Notes.

March 4, 2021

e Azure VMware Solution will apply the VMware ESXi 6.7, Patch Release ESXi670-202011002 to existing
privates through March 15, 2021.

e Documented workarounds for the vSphere stack, as per VMSA-2021-0002, will also be applied through
March 15, 2021.

NOTE

This is non-disruptive and should not impact Azure VMware Services or workloads. During maintenance, various VMware
alerts, such as Lost network connectivity on DVPorts and Lost uplink redundancy on DVPorts, appear in vCenter Server
and clear automatically as the maintenance progresses.

Post update

Once complete, newer versions of VMware components appear. If you notice any issues or have any questions,


https://docs.vmware.com/en/VMware-vSphere/6.7/rn/vsphere-vcenter-server-67u3l-release-notes.html
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contact our support team by opening a support ticket.
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Planning your Azure VMware Solution deployment is critical for a successful production-ready environment for
creating virtual machines (VMs) and migration. During the planning process, you'll identify and gather what's
needed for your deployment. As you plan, make sure to document the information you gather for easy
reference during the deployment. A successful deployment results in a production-ready environment for
creating virtual machines (VMs) and migration.

In this how-to, you'll:

o |dentify the Azure subscription, resource group, region, and resource name
e |dentify the size hosts and determine the number of clusters and hosts

e Request a host quota for eligible Azure plan

e |dentify the /22 CIDR IP segment for private cloud management

e |dentify a single network segment

e Define the virtual network gateway

e Define VMware HCX network segments

After you're finished, follow the recommended next steps at the end to continue with this getting started guide.

|dentify the subscription

Identify the subscription you plan to use to deploy Azure VMware Solution. You can create a new subscription or
use an existing one.

NOTE

The subscription must be associated with a Microsoft Enterprise Agreement (EA), a Cloud Solution Provider (CSP) Azure
plan or an Microsoft Customer Agreement (MCA). For more information, see Eligibility criteria.

|dentify the resource group

Identify the resource group you want to use for your Azure VMware Solution. Generally, a resource group is

created specifically for Azure VMware Solution, but you can use an existing resource group.

|dentify the region or location

Identify the region you want Azure VMware Solution deployed.

Define the resource name

The resource name is a friendly and descriptive name in which you title your Azure VMware Solution private
cloud, for example, MyPrivateCloud.

IMPORTANT

The name must not exceed 40 characters. If the name exceeds this limit, you won't be able to create public IP addresses

for use with the private cloud.



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/plan-private-cloud-deployment.md
https://azure.microsoft.com/global-infrastructure/services/?products=azure-vmware

|dentify the size hosts

Identify the size hosts that you want to use when deploying Azure VMware Solution.

Azure VMware Solution clusters are based on hyper-converged, bare-metal infrastructure. The following table
shows the RAM, CPU, and disk capacities of the host.

VSAN CACHE VSAN CAPACITY REGIONAL
HOST TYPE CPU (GHZ) RAM (GB) TIER (TB, RAW) TIER (TB, RAW) AVAILABILITY
AV36 dual Intel 18 576 3.2 (NVMe) 15.20 (SSD) All product
core 2.3 GHz regions
(SkyLake)
AV36P dual Intel 18 768 1.5 (Intel Optane 19.20 (NVMe) Selected regions
core 2.6 GHz / Cache) *
3.9 GHz turbo
(Cascade Lake)
AV52 dual Intel 26 1536 1.5 (Intel Optane 38.40 (NVMe) Selected regions
core 2.7 GHz / Cache) *

4.0 GHz turbo
(Cascade Lake)

An Azure VMware cluster requires a minimum number of three hosts. You can only use host of the same type in
a single cluster. You can use multiple clusters with different host types in a single Azure VMware Private Cloud.
Hosts used to build or scale clusters come from an isolated pool of hosts. Those hosts have passed hardware
tests and have had all data securely deleted before being added to a cluster.

(*) details available via the Azure pricing calculator.

Determine the number of clusters and hosts

The first Azure VMware Solution deployment you do consists of a private cloud containing a single cluster. You'll
need to define the number of hosts you want to deploy to the first cluster for your deployment.

For each private cloud created, there's one vSAN cluster by default. You can add, delete, and scale clusters. The
minimum number of hosts per cluster and the initial deployment is three.

You use vSphere and NSX-T Manager to manage most other aspects of cluster configuration or operation. All
local storage of each host in a cluster is under the control of vSAN.

The Azure VMware Solution management and control plane has the following resource requirements that need
to be accounted for during solution sizing.

TYPICAL
PROVISION PROVISION TYPICAL TYPICAL RAW VSAN

DESCRIPTI PROVISION ED VRAM ED VDISK CPU USAGE VRAM DATASTORE
AREA ON ED VCPUS (GB) (GB) (GHZ) USAGE (GB) USAGE (GB)
VMware vCenter 8 24 499 1.1 3.6 1020
vSphere Server
VMware ESXi node 1 N/A N/A N/A 94 04 N/A
vSphere
VMware ESXi node 2 N/A N/A N/A 94 04 N/A

vSphere



AREA

VMware
vSphere

VMware
NSX-T Data
Center

VMware
NSX-T Data
Center

VMware
NSX-T Data
Center

VMware
NSX-T Data
Center

VMware
NSX-T Data
Center

VMware
HCX
(Optional
Add-On)

VMware
Site
Recovery
Manager
(Optional
Add-On)

VMware
vSphere
(Optional
Add-On)

DESCRIPTI
ON

ESXi node 3

NSX-T
Unified
Appliance
Node 1

NSX-T
Unified
Appliance
Node 2

NSX-T
Unified
Appliance
Node 3

NSX-T Edge
VM 1

NSX-T Edge
VM 2

HCX
Manager

SRM
Appliance

vSphere
Replication
Appliance

Total

PROVISION
ED VCPUS

N/A

54 vCPUs

PROVISION
ED VRAM
(GB)

N/A

24

24

24

32

32

12

12

192 GB

PROVISION
ED VDISK
(GB)

N/A

300

300

300

200

200

60

20

26

1,905 GB

TYPICAL
CPU USAGE
(GHZ)

94

55

55

55

1.3

13

43

54.7 GHz

TYPICAL
VRAM
USAGE (GB)

04

85

8.5

85

0.6

0.6

32

2.2

379 GB

TYPICAL
RAW VSAN
DATASTORE
USAGE (GB)

N/A

613

613

613

409

409

132

53

62

3,924 GB

These resource requirements only apply to the first cluster deployed in an Azure VMware Solution private cloud.

Subsequent clusters only need to account for the ESXi resource requirements in solution sizing.

The VMware ESXi nodes have usage values that account for the vSphere VMkernel hypervisor overhead, vSAN

overhead and NSX-T distributed router, firewall and bridging overhead. These are estimates for a standard three

cluster configuration. The storage requirements are listed as not applicable (N/A) since a boot volume separate

from the vSAN Datastore is used.

The VMware HCX and VMware Site Recovery Manager resource requirements are optional Add-Ons to the



Azure VMware Solution service. Discount these requirements in the solution sizing if they are not being used.

The VMware Site Recovery Manager Add-On has the option of configuring multiple VMware vSphere
Replication Appliances. The table above assumes one vSphere Replication appliance is used.

Sizing an Azure VMware Solution is an estimate; the sizing calculations from the design phase should be
validated during the testing phase of a project to ensure the Azure VMware Solution has been sized correctly for

the application workload.

TIP

You can always extend the cluster and add additional clusters later if you need to go beyond the initial deployment

number.

NOTE

To learn about the limits for the number of hosts per cluster, the number of clusters per private cloud, and the number of

hosts per private cloud, check Azure subscription and service limits, quotas, and constraints.

Request a host quota

It's crucial to request a host quota early, so after you've finished the planning process, you're ready to deploy
your Azure VMware Solution private cloud. Before requesting a host quota, make sure you've identified the
Azure subscription, resource group, and region. Also, make sure you've identified the size hosts and determine
the number of clusters and hosts you'll need.

After the support team receives your request for a host quota, it takes up to five business days to confirm your
request and allocate your hosts.

e EA customers

o CSP customers

Define the IP address segment for private cloud management

Azure VMware Solution requires a /22 CIDR network, for example, 1e.e.e.e/22 . This address space is carved
into smaller network segments (subnets) and used for Azure VMware Solution management segments,
including vCenter Server, VMware HCX, NSX-T Data Center, and vMotion functionality. The diagram highlights

Azure VMware Solution management IP address segments.


https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/azure-subscription-service-limits
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IMPORTANT

The /22 CIDR network address block shouldn't overlap with any existing network segment you already have on-premises
or in Azure. For details of how the /22 CIDR network is broken down per private cloud, see Routing and subnet

considerations.

Define the IP address segment for VM workloads

Like with any VMware vSphere environment, the VMs must connect to a network segment. As the production
deployment of Azure VMware Solution expands, there is often a combination of L2 extended segments from on-

premises and local NSX-T network segments.

For the initial deployment, identify a single network segment (IP network), for example, 1e.e.4.0/24 . This
network segment is used primarily for testing purposes during the initial deployment. The address block
shouldn't overlap with any network segments on-premises or within Azure and shouldn't be within the /22
network segment already defined.
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Define the virtual network gateway

Azure VMware Solution requires an Azure Virtual Network and an ExpressRoute circuit. Define whether you
want to use an existing OR new ExpressRoute virtual network gateway. If you decide to use a new virtual
network gateway, you'll create it after creating your private cloud. It's acceptable to use an existing ExpressRoute
virtual network gateway, and for planning purposes, make a note of which ExpressRoute virtual network

gateway you'll use.
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IMPORTANT

You can connect to a virtual network gateway in an Azure Virtual WAN, but it is out of scope for this quick start.

Define VMware HCX network segments

VMware HCX is an application mobility platform that simplifies application migration, workload rebalancing,

and business continuity across data centers and clouds. You can migrate your VMware vSphere workloads to

Azure VMware Solution and other connected sites through various migration types.

VMware HCX Connector deploys a subset of virtual appliances (automated) that require multiple IP segments.

When you create your network profiles, you use the IP segments. Identify the following for the VMware HCX

deployment, which supports a pilot or small product use case. Depending on the needs of your migration,

modify as necessary.

e Management network: When deploying VMware HCX on-premises, you'll need to identify a

management network for VMware HCX. Typically, it's the same management network used by your on-

premises VMware vSphere cluster. At a minimum, identify two IPs on this network segment for VMware

HCX. You might need larger numbers, depending on the scale of your deployment beyond the pilot or

small use case.




NOTE

Preparing for large environments, instead of using the management network used for the on-premises VMware
vSphere cluster, create a new /26 network and present that network as a port group to your on-premises
VMware vSphere cluster. You can then create up to 10 service meshes and 60 network extenders (-1 per service

mesh). You can stretch eight networks per network extender by using Azure VMware Solution private clouds.

e Uplink network: When deploying VMware HCX on-premises, you'll need to identify an Uplink network

for VMware HCX. Use the same network which you'll use for the Management network.

e vMotion network: When deploying VMware HCX on-premises, you'll need to identify a vMotion
network for VMware HCX. Typically, it's the same network used for vMotion by your on-premises
VMware vSphere cluster. At a minimum, identify two IPs on this network segment for VMware HCX. You
might need larger numbers, depending on the scale of your deployment beyond the pilot or small use
case.

You must expose the vMotion network on a distributed virtual switch or vSwitchO. If it's not, modify the
environment to accommodate.

NOTE

Many VMware vSphere environments use non-routed network segments for vMotion, which poses no problems.

e Replication network: When deploying VMware HCX on-premises, you'll need to define a replication
network. Use the same network as you are using for your Management and Uplink networks. If the on-
premises cluster hosts use a dedicated Replication VMkernel network, reserve two IP addresses in this
network segment and use the Replication VMkernel network for the replication network.

Determine whether to extend your networks

Optionally, you can extend network segments from on-premises to Azure VMware Solution. If you do extend

network segments, identify those networks now following these guidelines:

e Networks must connect to a vSphere Distributed Switch (vDS) in your on-premises VMware environment.

e Networks that are on a vSphere Standard Switch can't be extended.

IMPORTANT

These networks are extended as a final step of the configuration, not during deployment.

Next steps

Now that you've gathered and documented the information needed, continue to the next tutorial to create your
Azure VMware Solution private cloud.

Deploy Azure VMware Solution


https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.networking.doc/GUID-B15C6A13-797E-4BCB-B9D9-5CBC5A60C3A6.html
https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.networking.doc/GUID-350344DE-483A-42ED-B0E2-C811EE927D59.html

Deploy and configure Azure VMware Solution

8/19/2022 + 8 minutes to read « Edit Online

Once you've planned your deployment, you'll deploy and configure your Azure VMware Solution private cloud.

The diagram shows the deployment workflow of Azure VMware Solution.
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After you're finished, follow the recommended next steps at the end to continue with the steps of this getting

started guide.

Register the Microsoft.AVS resource provider

To use Azure VMware Solution, you must first register the resource provider with your subscription. For more

information about resource providers, see Azure resource providers and types.

e Portal
e Azure CLI

1. Sign in to the Azure portal.

2. On the Azure portal menu, select All services.

3. Inthe All services box, enter subscription, and then select Subscriptions.

4. Select the subscription from the subscription list to view.

5. Select Resource providers and enter Microsoft.AVS into the search.

6. If the resource provider is not registered, select Register.

Create an Azure VMware Solution private cloud

You can create an Azure VMware Solution private cloud using the Azure portal or the Azure CLI.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/deploy-azure-vmware-solution.md
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/deploy-azure-vmware-solution-workflow.png#lightbox
https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/resource-providers-and-types
https://portal.azure.com

Portal
Azure CLI

. Sign in to the Azure portal.

. Select Create a resource.

. Inthe Search services and marketplace text box, type Azure VMware solution and selectit from the

search results.

. On the Azure VMware Solution window, select Create.

. If you need more hosts, request a host quota increase.

. On the Basics tab, enter values for the fields and then select Review + Create.

TIP

You gathered this information during the planning phase of this quick start.

FIELD

Subscription

Resource group

Resource name

Location

Size of host

Number of hosts

Address block for private cloud

VALUE

Select the subscription you plan to use for the
deployment. All resources in an Azure subscription are
billed together.

Select the resource group for your private cloud. An
Azure resource group is a logical container into which
Azure resources are deployed and managed.
Alternatively, you can create a new resource group for
your private cloud.

Provide the name of your Azure VMware Solution
private cloud.

Select a location, such as east us. It's the region you
defined during the planning phase.

Select AV36.

Number of hosts allocated for the private cloud cluster.
The default value is 3, which you can increase or
decrease after deployment. If these nodes are not listed
as available, please contact support to request a quota
increase. You can also click the link labeled If you need
more hosts, request a quota increase in the Azure
portal.

Provide an IP address block for the private cloud. The
CIDR represents the private cloud management network
and is used for the cluster management services, such as
vCenter Server and NSX-T Manager. Use /22 address
space, for example, 10.175.0.0/22. The address should be
unique and not overlap with other Azure Virtual
Networks and with on-premises networks.



https://portal.azure.com
https://docs.microsoft.com/en-us/azure/azure-vmware/request-host-quota-azure-vmware-solution?wt.mc_id=portal-vmcp
https://docs.microsoft.com/en-us/azure/azure-vmware/request-host-quota-azure-vmware-solution?wt.mc_id=portal-vmcp

— Microsoft Azure £ Search resources, services, and docs (G+/)

Home > Create a resource > Marketplace > Azure VMware Solution >

Create a private cloud

Prerequisities *Basics Tags  Review and Create

Project details

Subscription * (O | AnyBuild-InternalProdClusters v ‘

Resource group * | ~ ‘
Create new

Private cloud details

Resource name * (O | Enter the name ‘
Location* @ | East US v ‘
Size of host * © | ~ ‘
Number of hosts (D O | 3 ‘

Find out how many hosts you need
If you need more hosts, request a quota increase

| Previous “ Next : Tags > l

7. Verify the information entered, and if correct, select Create.

NOTE
This step takes roughly 3-4 hours. Adding a single host in an existing or the same cluster takes between 30 - 45

minutes.

8. Verify that the deployment was successful. Navigate to the resource group you created and select your
private cloud. You'll see the status of Succeeded when the deployment has finished.

_ Microsoft Azure P Search resources, services, and docs (G+/)

Home >

Contoso-westus-sddec =

AVS Private cloud

|f‘ Search (Ctrl+/) J « [E Delete

@ Overview = # Essentials

B Activity log Resource group (change) : Contoso-westus-rg

8 Access control (LAM) I Status 1 Succeeded I
Location ! West US

® Tags
Subscription (change) : Contoso

Z® Diagnose and solve problems ; )
Subscription 1D : 1234abc-d567-8910-abdc-2e2bb 123456

Settings

B Locks Tags (change) : Click here to add tags

NOTE

For an end-to-end overview of this step, view the Azure VMware Solution: Deployment video.



https://www.youtube.com/embed/gng7JjxgayI

Connect to Azure Virtual Network with ExpressRoute

In the planning phase, you defined whether to use an existing or new ExpressRoute virtual network gateway.

Connect to Azure

Use new , Create a virtual
Virtual Network Yes— P
7 ehwark
with BxpressRRoute EffE: " I
Create virtual I_I_:Ifll.lll-httlin
network gateway optional
Create
GatewaySubnet
IMPORTANT

hosts, the better the performance.

If you plan to scale your Azure VMware Solution hosts using Azure NetApp Files datastores or Azure disk pools, deploying
the vNet close to your hosts with an ExpressRoute virtual network gateway is crucial. The closer the storage is to your

Use a new ExpressRoute virtual network gateway

IMPORTANT

You must have a virtual network with a GatewaySubnet that does not already have a virtual network gateway.

You don't already have a virtual network...

You already have a virtual network without a
GatewaySubnet...

You already have a virtual network with a GatewaySubnet...

Use an existing virtual network gateway

1. Request an ExpressRoute authorization key:

a. In the Azure portal, navigate to the Azure VMware Solution private cloud. Select Manage >

THEN

Create the following:

1. Virtual network

2. GatewaySubnet

3. Virtual network gateway

4. Connect ExpressRoute to the gateway

Create the following:

1. GatewaySubnet

2. Virtual network gateway

3. Connect ExpressRoute to the gateway

Create the following:
1. Virtual network gateway
2. Connect ExpressRoute to the gateway

Connectivity > ExpressRoute and then select + Request an authorization key.



https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-howto-add-gateway-portal-resource-manager
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-howto-add-gateway-portal-resource-manager
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Home > Contoso-westus-sddc

@ Contoso-westus-sddc | Connectivity # - X

AVS Private cloud

£ Search (Ctrl+)) « £ D Refresh

@ Overview
Azure vNet connect  Settings | B
B Activity log

ExpressRoute 1D

HCX Public IP ExpressRoute Global Reach AVS Interconnect

A Access control (1AM)

‘ fsubscriptions/1234abc-dS6: bdc-2e2bb1234! p i rosoft.N ifcuits/tnt50-cust-p01-westus... E':‘
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Settings

Sl
B Locks

Name Key

Manage Contoso-westus-sddc ('zézb'ﬁ 2345¢6-1234abc-d567-8910-abdc [,
® Connectivity |
BB (dentity
W Clusters

b. Provide a name for it and select Create.

It may take about 30 seconds to create the key. Once created, the new key appears in the list of
authorization keys for the private cloud.

Home > Contoso-westus-sddc

o Contoso-westus-sddc | Connectivity # - X

AVS Private cloud

P search (Ctrl#/) « 8 () Refresh

@ Overview
Azure vMet connect  Settings HCX  PubliclP  ExpressRoute Global Reach  AVS Interconnect
B Activity log —_——
ExpressRoute 1D
A trol (IAM] =
R Access control 1AM) [ ssubscriptions/1234abc-ds67-8910-abdc-2e26b12345 Ant50-cust-po1 o /Microsoft. ircuits/tnt50-cust-p01-westus... 0 |
@ Tags
Private peering ID
& Diagnose and solve problems | /subscriptions/1234abc-ds67-8910-abdc-2e2bb1 p p providers/Microsoft. P ircuits/tnt50-cust-p01-westus.. 0 |
Settings
i + Request an authorization key () Refresh
B Locks
Name Key
Manage Contoso-westus-sddc 2e2bb12345e6-1234abc-d567-8910-abde o] \
®  Connectivity I
B [dentity
B Clusters

c. Copy the authorization key and ExpressRoute ID. You'll need them to complete the peering. The
authorization key disappears after some time, so copy it as soon as it appears.

2. Navigate to the virtual network gateway you plan to use and select Connections > + Add.

3. On the Add connection page, provide values for the fields, and select OK.

FIELD VALUE

Name Enter a name for the connection.

Connection type Select ExpressRoute.

Redeem authorization Ensure this box is selected.

Virtual network gateway The virtual network gateway you intend to use.
Authorization key Paste the authorization key you copied earlier.

Peer circuit URI Paste the ExpressRoute ID you copied earlier.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/expressroute-global-reach/start-request-authorization-key.png#lightbox
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/expressroute-global-reach/show-global-reach-auth-key.png#lightbox

® Add connection

PrivateCloudGateway @ Directory: Microsoft

o Ensure that the ExpressRoute
associated with this authorization is
provisioned by the provider before
redeeming the authorization.

Mame *

I privatecloud-connection v I

Connection type (0

I ExpressRoute ~ |

Redeem authorization (O

*Virtual network gateway (0 &
PrivateCloudGateway

Authorization key *
| 442cb5d8 o o]

Peer circuit URI *
| fsubscriptions/750a6f9e- T o |

Subscription (&

Resource group ()

ContosoResourceGroup ]
Create new

Location (O
East US N

The connection between your ExpressRoute circuit and your Virtual Network is created.



= Microsoft Azure R Search resources, services, and docs (G+/) Connie Wilson

Dashbeoard > Resource groups » avs-ncus > er-gw-ncus

@ er-gw-ncus | Connections = - X
Virtual network gateway
2 Search (Ctrl+/) | « b add () Refresh
L Overview |;)|Search connections
Activity log Name T4  Status T4  Connection type T4  Peer ™
Access control (1AM} avs-to-azure-ncus ExpressRoute tnt38-cust-p01-northe... *=*

Tags

X & F

Diagnose and solve problems
Settings

B Configuration

(9 Connections

Il Properties

B Locks

Validate the connection

You should have connectivity between the Azure Virtual Network where the ExpressRoute terminates and the

Azure VMware Solution private cloud.

1. Use a virtual machine within the Azure Virtual Network where the Azure VMware Solution ExpressRoute

terminates. For more information, see Connect to Azure Virtual Network with ExpressRoute.
a. Log into the Azure portal.

b. Navigate to a VM that is in the running state, and under Settings, select Networking and select
the network interface resource.

A myVM - Networking - Microsoft X =

& C @ hitps//portal.azure.com/?feature.customportal=false# @microsoft.onmicrosoft.com/resource/subscriptions/00000000-0000-0000-0000-000000000000/... a

= Microsoft Azure P search resources, services, and docs (G+/) &) w user@contoso.com @
- CONTOSO, LTD.

Home > myVM - Netwerking

2 myVM - Networking X

== virtual machine

‘//) Search (Ctrl+/) ‘ « & Attach network interface ¥ Detach network interface

B overview -
myVMNic1 | myVMNic2
Activity log

Fo Access control (JAM) -
& Networlk Interfaced myVMNicl Effective security rules Topology

@ Tags Virtual network/subnet: myResourceGroup-vnet/default NIC Public 1P: 40.122.43.96 NIC Private IP: 10.1.1.4
Accelerated networking: Disabled
2 Diagnose and solve problems

Settings | Inbound port rules  Outbound port rules  Application security groups  Load balancing
2 Networking l @ Network security group myVM-nsg (attached to network interface: myVMNic1)
Impacts 0 subnets, 1 network interfaces

| Disks

Priority Name Port Protocol Source Destination Action
B size

65000 AllowVnetinBound Any Any VirtualNetwork  VirtualNetwork @ Allow
© Security

65001 AllowAzurel oadBalancerinBo...  Any Any AzureloadBala.. Any @ Allow
I';'.l Extensions

65500 DenyAllinBound Any Any Any Any @ Deny

% Continuous delivery (Preview)

% Availability + scaling

c. On the left, select Effective routes. You'll see a list of address prefixes that are contained within
the /22 CIDR block you entered during the deployment phase.

2. If you want to log into both vCenter and NSX-T Manager, open a web browser and log into the same
virtual machine used for network route validation.

You can identify the vCenter and NSX-T Manager console's IP addresses and credentials in the Azure
portal. Select your private cloud and then Manage > Identity.


https://docs.microsoft.com/en-us/azure/virtual-machines/windows/quick-create-portal
https://portal.azure.com

e e e e e

Dashbeard » avs-pc-ncus

52} avs-pc-ncus | Identity =

AVS Private cloud

|}3' Search (Ctrl+/) | &«

Login credentials
@ Overview =
vCenter credentials

Activity log Web client URL

pp, Access control (IAM)
Admin username ©
& Tags

42 Diagnose and solve problems Admin password ©

Certificate thumbprint @

Settings

B Locks NSX-T Manager credentials
Web client URL @

Manage

. Admin username @
o Connectivity

B |dentity Admin password @

=
B Clusters Certificate thumbprint @

Next steps

In the next tutorial, you'll connect Azure VMware Solution to your on-premises network through ExpressRoute.

Connect to your on-premises environment

X
[ https;//101.02/ ]
| cloudadmin@vsphere.local ] |

D]
[ https;//101.03/ m]
| admin Ty |
(D]

o]
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After you deploy your Azure VMware Solution private cloud, you'll connect it to your on-premises environment.
ExpressRoute Global Reach connects your on-premises environment to your Azure VMware Solution private
cloud. The ExpressRoute Global Reach connection is established between the private cloud ExpressRoute circuit
and an existing ExpressRoute connection to your on-premises environments.
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NOTE

You can connect through VPN, but that's out of scope for this quick start guide.

In this article, you'll:

e C(Create an ExpressRoute auth key in the on-premises ExpressRoute circuit

e Peer the private cloud with your on-premises ExpressRoute circuit


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-expressroute-global-reach-private-cloud.md
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/pre-deployment/azure-vmware-solution-on-premises-diagram.png#lightbox

e Verify on-premises network connectivity

After you're finished, follow the recommended next steps at the end to continue with the steps of this getting
started guide.

Prerequisites

e Review the documentation on how to enable connectivity in different Azure subscriptions.

e A separate, functioning ExpressRoute circuit for connecting on-premises environments to Azure, which is

circuit 7 for peering.

e Ensure that all gateways, including the ExpressRoute provider's service, supports 4-byte Autonomous
System Number (ASN). Azure VMware Solution uses 4-byte public ASNs for advertising routes.

NOTE

If advertising a default route to Azure (0.0.0.0/0), ensure a more specific route containing your on-premises networks is
advertised in addition to the default route to enable management access to Azure VMware Solution. A single 0.0.0.0/0
route will be discarded by Azure VMware Solution's management network to ensure successful operation of the service.

Create an ExpressRoute auth key in the on-premises ExpressRoute
circuit
The circuit owner creates an authorization, which creates an authorization key to be used by a circuit user to

connect their virtual network gateways to the ExpressRoute circuit. An authorization is valid for only one
connection.

NOTE

Each connection requires a separate authorization.

1. From the ExpressRoute circuits blade, under Settings, select Authorizations.

2. Enter the name for the authorization key and select Save.

Home > ExpressRoute circuits > Contoso-westus-sddc

yel Contoso-westus-sddc | Authorizations = b
ExpressRoute crcut

D search (Ctrl+/) | « - 3 Discard () Refresh
A Overview " You can create authorizations that can be redieemed by other circuit users. Circuit users are owners of virtual network

gateways (that are not within the same subscription as the ExpressRoute circuit). Each authorization can be redeemed with
B Activity log one virtual network,
% Access contral (IAM) To redeem authorizations, circult users will need the rescurce 1D of the ExgressRoute and an unused authorization key.

Learn mare
¢ Tags
& Diagnose and solve problems Resource ID

Jsubscriptions/ ... /resourceGroups/ .. |E
Settings
& Configuration Name Provisioning state Use status Authaorization key
@ Connections js-er-avs-auth Succeeded Used backd .. D
£ Authorizations ) ‘ —_———

js-er-az-auth Succeeded Available 36d91 .. (]
P Peerings

I| Enter name ‘I
Il Properties
& Locks

Once created, the new key appears in the list of authorization keys for the circuit.

3. Copy the authorization key and the ExpressRoute ID. You'll use them in the next step to complete the
peering.


https://docs.microsoft.com/en-us/azure/expressroute/expressroute-howto-set-global-reach-portal

Peer private cloud to on-premises

Now that you've created an authorization key for the private cloud ExpressRoute circuit, you can peer it with
your on-premises ExpressRoute circuit. The peering is done from the on-premises ExpressRoute circuit in the
Azure portal. You'll use the resource ID (ExpressRoute circuit ID) and authorization key of your private cloud
ExpressRoute circuit to finish the peering.

1. From the private cloud, under Manage, select Connectivity > ExpressRoute Global Reach > Add.

G i i s i)

Home > contose-westus-sddc

@ Contoso-westus-sddc | Connectivity = - X

4 AVS Private cloud

2 search (Ctrl+/) « & save () Refresh

@ Overview :
Azure vNet connect Settings ExpressRoute HCOX Public IP ExpressRoute Global Reach | AVS Interconnect

E Activity log

Identify the ExpressRoute circuits that you want to use. You can enable ExpressRoute Global Reach between the private peering of any two ExpressRoute circuits, as long as they're

. Access control (1AM} located in the supported countries/regions and were created at different peering locations. Learn more.
@ Tags Before you begin
& Diagnese and sclve problems * You understand ExpressRoute circuit provisioning workflows.
* Your ExpressRoute circuits are in a provisioning state.
Settings * Azure private peering is configured on your ExpressRoute circuits.

* Do not initiate a Global Reach connection from this page if a connection has already been initiated from the on-premises side.

B Locks
On-prem cloud connections

M

# Connectivity I T — i

Subscription Resource group ExpressRoute circuit Authorization key State
™ ety No results
B Clusters

Workload Networking
% Segments

T\ DHcP
B port mirroring

@ ons

2. Enter the ExpressRoute ID and the authorization key created in the previous section.

On-prem cloud connections X
Subscnption
| Contoso ~

Resource group

contoso-westus-rg i

ExpressRoute circuit ™ (O

f you have a circuit 1D, copy/paste below (D

Enter an ExpressRoute circurt 1D

authorization key

3. Select Create. The new connection shows in the on-premises cloud connections list.



TIP

You can delete or disconnect a connection from the list by selecting More.

_ p T s

yprivatecloud - Connectivity

Settings ExpressRoute HCX  ExpressRoute Global Reach

Identify the ExpressRoute circuits that you want use. You can enable ExpressRoute Global Reach between
the private peering of any two ExpressRoute circuits, as long as they're located in the supported
countriesfregions and were created at different peering locations. Learn maore

On-premises cloud connections (max 8)

+ Add &7 Disconnect  [§] Delete
# T, Subscription T, Resource group T, ExpressRoute circuit T Authorization key T State
1 ASP_Exp default RG - - - - Ll
Disconnect
Delete

ti\l"ity Documentation & & X

- [

=

Verify on-premises network connectivity

In your on-premises edge router, you should now see where the ExpressRoute connects the NSX-T network

segments and the Azure VMware Solution management segments.

IMPORTANT

network.

Everyone has a different environment, and some will need to allow these routes to propagate back into the on-premises

Next steps

Continue to the next tutorial to install VMware HCX add-on in your Azure VMware Solution private cloud.

Install VMware HCX
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VMware HCX Advanced and its associated Cloud Manager are no longer pre-deployed in Azure VMware
Solution. Instead, you'll install it through the Azure portal as an add-on. You'll still download the HCX Connector

OVA and deploy the virtual appliance on your on-premises vCenter Server.

Any edition of VMware HCX supports 25 site pairings (on-premises to cloud or cloud to cloud) in a single HCX
manager system. The default is HCX Advanced, but you can open a support request to have HCX Enterprise
Edition enabled. Once the service is generally available, you'll have 30 days to decide on your next steps. You can
turn off or opt out of the HCX Enterprise Edition service but keep HCX Advanced as it's part of the node cost.

Downgrading from HCX Enterprise Edition to HCX Advanced is possible without redeploying. First, ensure
you've reverted to an HCX Advanced configuration state and not using the Enterprise features. If you plan to
downgrade, ensure that no scheduled migrations, features like RAV and HCX Mobility Optimized Networking
(MON) are in use.

TIP

You can also uninstall HCX Advanced through the portal. When you uninstall HCX Advanced, make sure you don't have
any active migrations in progress. Removing HCX Advanced returns the resources to your private cloud occupied by the
HCX virtual appliances.

In this how-to, you'll:

e [nstall HCX Advanced through the Azure portal
e Download and deploy the VMware HCX Connector OVA
e Activate HCX Advanced with a license key

After you're finished, follow the recommended next steps at the end to continue with the steps of this getting
started guide.

Prerequisites

e Prepare for HCX installations

e [f you plan to use VMware HCX Enterprise, make sure you've enabled the VMware HCX Enterprise add-on
through a support request. It's a free 12-month trial in Azure VMware Solution.

e VMware blog series - cloud migration

Install VMware HCX Advanced

1. In your Azure VMware Solution private cloud, select Manage > Add-ons.

2. Select Get started for HCX Workload Mobility.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/install-vmware-hcx.md
https://rc.portal.azure.com/#create/Microsoft.Support
https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-0E254D74-60A9-479C-825D-F373C41F40BC.html
https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-A631101E-8564-4173-8442-1D294B731CEB.html
https://cloud.vmware.com/community/2019/08/08/introducing-hcx-enterprise/
https://portal.azure.com/#create/Microsoft.Support
https://blogs.vmware.com/vsphere/2019/10/cloud-migration-series-part-2.html
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Home » Contoso-westus-sddc

+ Contoso-westus-sddc | Add-ons =

AVS Private cloud

|/’3 Search (Ctrl+/) ‘ «

Disaster recovery Migration using HCX

Overview
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@ Overview

Activity log

R Access control (IAM) Enhance your private cloud with these optional features

Azure VMware Solutions offers various add-ons that can be enabled to provide additional functionality. Each service
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¢ mg has its own requirements please select one to get started
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Settings
B Locks e Disaster Recovery

Install SRM in your private cloud to
Manage enable disaster recovery in your private

cloud. SRM reguires a "BYOL" license

& Connectivity key as part of the install.

B Identity
Get Started
BE Clusters
| + Add-ons I

e HCX Workload Mobility

Install WMware HCX in your private
cloud for workload migration, HCX
advanced will be installed by default
with HCX Enterprise as an optional
upgrade viz support.

Get Started

3. Selectthel agree with terms and conditions checkbox and then select Install.

It takes around 35 minutes to install HCX Advanced and configure the Cloud Manager. Once installed, the
HCX Manager URL and the HCX keys needed for the HCX on-premises connector site pairing will display

on the Migration using HCX tab.

[NOTE!] If you aren't able to see the HCX key once installed, click the ADD button to generate the key

which you can then use for site pairing.
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Home > Contoso-westus-sddc

+ Contoso-westus-sddc | Add-ons #
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@ Overview =
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pﬂ Access control (IAM)

@ Tags HCX plan @ HCX Advanced Upgrade to HCX Enterprise (Preview)
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Settings Using the IP address below launch the HCX portal. Download HCX appliance (OVA file) from Adminstration
£ Locks page and deploy on the site where source vCenter environment is running. Learn maore.

Manage HCX Cloud Manager 1P (&) https://10.120.0.9/ )

. Connectivity
2. Connect with on-premise using HCX keys

B Identity After you deploy the VMware HCX Connector appliance on-premises and start the appliance, you're ready
B Clusters to activate using below license keys. Learn more.

+ Add-ons

Workload Networking - add () Refresh [i] Delete

== Segments HCX key name Activation key Status

IT1 DHCP am D7DSCF6583B440CTBF2B8... [ | @ nuailable e

BN Port mirroring

@ ons

or

Operations .
Uninstall HCX Advanced

M Runcommand To permanently remove all HCX components from your private cloud click the uninstall button. To
downgrade to HCX Advanced edition but keep HCX please contact support

= [ urinstal

BN plerts

Download and deploy the VMware HCX Connector OVA

In this step, you'll download the VMware HCX Connector OVA file, and then you'll deploy the VMware HCX

Connector to your on-premises vCenter Server.

1. Open a browser window, sign in to the Azure VMware Solution HCX Manager on https://x.x.x.9 port

443 with the cloudadmin@vsphere.local user credentials

2. Under Administration > System Updates, select Request Download Link. If the box is greyed, wait
a few seconds for it to generate a link.

3. Either download or receive a link for the VMware HCX Connector OVA file you deploy on your local

vCenter Server.

4. In your on-premises vCenter Server, select an OVF template to deploy the VMware HCX Connector to

your on-premises vSphere cluster.

5. Navigate to and select the OVA file that you downloaded and then select Open.


https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.vm_admin.doc/GUID-17BEDA21-43F6-41F4-8FB2-E01D275FE9B4.html

¥ Deploy OVF Template
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Enter a URL to download and install the OVF package from the Internet, or browse to a location accessible from your computer,
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6. Select a name and location, and select a resource or cluster where you're deploying the VMware HCX

Connector. Then review the details and required resources and select Next.

7. Review license terms, select the required storage and network, and then select Next.

8. Select the VMware HCX management network segment that you defined during the planning state. Then

select Next.

9. In Customize template, enter all required information and then select Next.

Deploy OVF Template

v
v
v
v
v
v
v

1 Select an OVF template

2 Select a name and folder

3 Select a compute resource

4 Review details

5 License agreements

6 Select storage

7 Select networks

8 Customize template

9 Ready to complete

Customize template
Customize the deployment properties of this software solution.

[ @ All properties have valid values

v Passwords

CLI "admin" User Password

root Password

~ Network properties

Hostname

Network 11Pv4 Address

2 settings
The password for default CLI user for this VM.

Password

Confirm Password

The password for root user.

Password

Confirm Password

4 settings

The hostname for this VM.

The IPv4 Address for this interface. Leave this

empty for DHCP base IP assignment.

»

10. Verify and then select Finish to deploy the VMware HCX Connector OVA.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-vmware-hcx/select-ovf-template.png#lightbox
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-vmware-hcx/customize-template.png#lightbox

IMPORTANT

You will need to turn on the virtual appliance manually. After powering on, wait 10-15 minutes before proceeding
to the next step.

Activate VMware HCX

After deploying the VMware HCX Connector OVA on-premises and starting the appliance, you're ready to

activate it. First, you'll need to get a license key from the Azure VMware Solution portal, and then you'll activate

itin VMware HCX Manager. Finally, you'll need a key for each on-premises HCX connector deployed.

1.

In your Azure VMware Solution private cloud, select Manage > Add-ons > Migration using HCX.
Then copy the Activation key.

HCX key name Activation key Status

am D7D9CF6583B440CTERF2BA... |D| © available

. Sign in to the on-premises VMware HCX Manager at https://HCXManagerIP:9443 with theadmin

credentials. Make sure to include the 9443 port number with the VMware HCX Manager IP address.

TIP
You defined the admin user password during the VMware HCX Manager OVA file deployment.

. InLicensing, enter your key for HCX Advanced Key and select Activate.

IMPORTANT

VMware HCX Manager must have open internet access or a proxy configured.

. In Datacenter Location, provide the nearest location for installing the VMware HCX Manager on-

premises. Then select Continue.

. InSystem Name, modify the name or accept the default and select Continue.
. Select Yes, Continue.

. InConnect your vCenter, provide the FQDN or IP address of your vCenter server and the appropriate

credentials, and then select Continue.

TIP

The vCenter Server is where you deployed the VMware HCX Connector in your datacenter.

. In Configure SSO/PSC, provide your Platform Services Controller's FQDN or IP address, and select

Continue.

NOTE

Typically, it's the same as your vCenter Server FQDN or IP address.

. Verify that the information entered is correct and select Restart.



NOTE

You'll experience a delay after restarting before being prompted for the next step.

After the services restart, you'll see vCenter Server showing as green on the screen that appears. Both vCenter
Server and SSO must have the appropriate configuration parameters, which should be the same as the previous

screen.

10254118 Version :3.

vm HCX Manager Dashboard Appliance Summary Configuratior

Type

® hcxmanager @ CPU Free 669 MHZ
b Addrese 10254119 Used 1625 MHZ Capacity 2294 MHZ
Version 3.5.3 Build 16639459 Memory Free 9717 MB
Uptime: 17 minutes O  — 19%
Current Time: Friday, 04 September 2020 08:40:17 PM UTC SESaZeaED Capacity 11989 M8
Storage Free 746
O mm 6%
Used 4.56 Capacity 796
NSX vCenter SSO

https/10.254.11.5 ° https/10.254.1.5

MANAGE MANAGE MANAGE

Uninstall HCX Advanced

You can uninstall HCX Advanced through the portal, which removes the existing pairing and software.

NOTE

It could take approximately 30 minutes to return the resources to your private cloud occupied by the HCX virtual
appliances.

1. Make sure you don't have any active migrations in progress.

2. Ensure that L2 extensions are no longer needed or the networks have been "unstretched" to the

destination.

3. For workloads using MON, ensure that you've removed the default gateways. Otherwise, it may result in

workloads not being able to communicate or function.
4. Inyour Azure VMware Solution private cloud, select Manage > Add-ons.
5. Select Get started for HCX Workload Mobility, then select Uninstall.

6. Enter yes to confirm the uninstall.

At this point, HCX Advanced no longer has the vCenter Server plugin, and if needed, you can reinstall it at any
time.

Next steps

Continue to the next tutorial to configure the VMware HCX Connector. After you've configured the VMware HCX
Connector, you'll have a production-ready environment for creating virtual machines (VMs) and migration.

Configure VMware HCX in Azure VMware Solution


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-vmware-hcx/activation-done.png#lightbox

Configure on-premises VMware HCX Connector
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Once you've installed the VMware HCX add-on, you're ready to configure the on-premises VMware HCX
Connector for your Azure VMware Solution private cloud.

In this how-to, you'll:

e Pair your on-premises VMware HCX Connector with your Azure VMware Solution HCX Cloud Manager
e Configure the network profile, compute profile, and service mesh

e Check the appliance status and validate that migration is possible

After you complete these steps, you'll have a production-ready environment for creating virtual machines (VMs)
and migration.

Prerequisites

e \VVMware HCX Connector has been installed.

e [f you plan to use VMware HCX Enterprise, make sure you've enabled the VMware HCX Enterprise add-on
through a support request. It's a free 12-month trial in Azure VMware Solution.

e [f you plan to enable VMware HCX MON, make sure you have:
o NSX-T or VDS on-premises for HCX Network Extension (no standard switch)
o One or more active stretched network segment
e \/Mware software version requirements have been met.
e Your on-premises vSphere environment (source environment) meets the minimum requirements.

e Azure ExpressRoute Global Reach is configured between on-premises and Azure VMware Solution private

cloud ExpressRoute circuits.

e All required ports are open for communication between on-premises components and Azure VMware

Solution private.

e Define VMware HCX network segments. The primary use cases for VMware HCX are workload migrations

and disaster recovery.

e Review the VMware HCX Documentation for information on using HCX.

Add a site pairing

In your data center, you can connect or pair the VMware HCX Cloud Manager in Azure VMware Solution with the
VMware HCX Connector.

IMPORTANT

As per the VMware Configuration Maximum tool the maximum site pairs is 25 in a single HCX manager system, this

includes inbound and outbound site pairings.

1. Sign in to your on-premises vCenter Server, and under Home, select HCX.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-vmware-hcx.md
https://cloud.vmware.com/community/2019/08/08/introducing-hcx-enterprise/
https://portal.azure.com/#create/Microsoft.Support
https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-0E254D74-60A9-479C-825D-F373C41F40BC.html
https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-54E5293B-8707-4D29-BFE8-EE63539CC49B.html
https://docs.vmware.com/en/VMware-HCX/services/user-guide/GUID-54E5293B-8707-4D29-BFE8-EE63539CC49B.html
https://ports.vmware.com/home/VMware-HCX
https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-BFD7E194-CFE5-4259-B74B-991B26A51758.html

. Under Infrastructure, select Site Pairing and select the Connect To Remote Site option (in the

middle of the screen).

. Enter the Azure VMware Solution HCX Cloud Manager URL or IP address that you noted earlier

https://x.x.x.9 and the credentials for a user which holds the CloudAdmin role in your private cloud.

Then select Connect.

NOTE

To successfully establish a site pair:
® Your VMware HCX Connector must be able to route to your HCX Cloud Manager IP over port 443.

® A service account from your external identity source, such as Active Directory, is recommended for site
pairing connections. For more information about setting up separate accounts for connected services, see
Access and Identity Concepts.

You'll see a screen showing that your VMware HCX Cloud Manager in Azure VMware Solution and your
on-premises VMware HCX Connector are connected (paired).

wvm  vSphere Client

HCX = o
& Dashboard Site Pairing

» Infrastructure

_;9‘ [@ hcxmanager-enterprise = @TNTSI HCX-MGR-cloud

& 025419443 & iy

= System

Jo Administration

" support

For an end-to-end overview of this procedure, view the Azure VMware Solution: HCX Site Pairing video.

Create network profiles

VMware HCX Connector deploys a subset of virtual appliances (automated) that require multiple IP segments.

When you create your network profiles, you use the IP segments you identified during the planning phase. You'll

create four network profiles:

Management
vMotion
Replication

Uplink

. Under Infrastructure, select Interconnect > Multi-Site Service Mesh > Network Profiles >

Create Network Profile.


https://www.youtube.com/embed/jXOmYUnbWZY?rel=0&vq=hd720

vm vSphere Client Menu

HCX
€ Dashboard Interconnect
- Infrastructure

& site Pairing

~ Services

@ Network Extension

\ Compute Profiles | Service Mesh I Network Profiles I Sentinel Managsment

@ Migration

4D Disaster Recovery
~ System

& Administration

© support

You have not created a Network Profile.

CREATE NETWORK PROFILE

C Refresh

2. For each network profile, select the network and port group, provide a name, and create the segment's IP
pool. Then select Create.

Create Network Profile X
vCenter * 10.254.115 o
Network * () Distributed Portgroup I Standard Switch Network () NSX Logical Switch

PortGroup T Host ID : 4 VLAN T

vian98 host-109 98

WM Network host-12 host-109 0

2 Metworks
Name *
IP Pool
S IP Pool - 0
IP Ranges Prefix Length Gateway

: HOW MANY FREE IP ADDRESSES DO YOU NEED?

Primary DNS Secondary DNS DNS Suffix

MTU * 1500
CANCEL

For an end-to-end overview of this procedure, view the Azure VMware Solution: HCX Network Profile video.

Create a compute profile

1. Under Infrastructure, select Interconnect > Compute Profiles > Create Compute Profile.
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vm vSphere Client

HCX
@ Dashboard Interconnect
~ Infrastructure

o Mult-Site Service Mesh
& site Pairing e

|| Compute Profies | senvice Mesh | MetworkProfies | sentinel Management
~ Services

@ Network Extension

4 Migration

“D Disaster Recovery
~ System

So Administration

A Compute Profile is required when deploying the HCX interconnect between two sites
@ support

You have not

a Compute Profile.

CREATE COMPUTE PROFILE

(CRefresh

What is a Compute Profile?

A Compute Profile contains the compute, storage and network settings that HCX will use on this site to deploy the Interconnect virtual appliances when a Ser

A single Compute Profile can used with multiple Service Mesh configurations.

2. Enter a name for the profile and select Continue.

Create Compute Profile

Name your Compute Profile

ComputeProfile

CONTINUE

Creating a Compute Profile

Du reation of a Compute Profie,

ach of the following elements will be defined
Services: The services that should be enabled on thi

Service Clusters: The lst of clusters on which the Se are to be enabled

@ L == Deployment Resource Pool: The r pool th Applances.
Deployment Storage: The storage that shoud
Networks:
Management Network: The
Uplink Network: Tne

VMotion Network: The

jork via which

550

3. Select the services to enable, such as migration, network extension, or disaster recovery, and then select
Continue.

NOTE

Generally, nothing changes here.

4. InSelect Service Resources, select one or more service resources (clusters) to enable the selected
VMware HCX services.

5. When you see the clusters in your on-premises datacenter, select Continue.

Create Compute Profile 1

Select Service Resources

Select one or more service r:

uhich the selected HCX Services should be enabled,

Select Resource(s) v (Datzcenie: @

310254115

e O conpusros olglzizlele)

Datacenter [ e )

[l New Cluster

6. From Select Datastore, select the datastore storage resource for deploying the VMware HCX
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Interconnect appliances. Then select Continue.

When multiple resources are selected, VMware HCX uses the first resource selected until its capacity is

exhausted.

Create Compute Profile

Select Deployment Resources and Reservations

Select each compute and storage resource for deploying the HCX Interconnect appliances. When multiple resources are selected, HCX will use first resource selected untilits capacity is exhausted.

Setect Resource v (1w TS

) [ seiect Datastore v (Gataoreo1 @) | setect Folder(options) v

Interconnect Appliance Reservation Settings (D) Datastores v | Available Storage(GB)

Type
£} CPU Reservation [} 0% > datastore-01 96262 VMFS
&5 Memory Reservation : @ 0% > [ datastore02 481 VMFS

cLose

GICISISIS[C)

([ New Cluster

L] CONTINUE

oL

7. From Select Management Network Profile, select the management network profile that you created

in previous steps. Then select Continue.

Create Compute Profile

Select Management Network Profile

Select the network profile via which the management inter

Select Management Network Profile v (_Management Net (

SFreeiPs ) ADVANCED CONFIGURATIONS v

Network FreetPs | Actons
> @ MenssementNetwork s o o CISICISICIO)
o =
N Replcaton Networc s eom
N Upink Netuiork eor
CREATE NETWORK PROFILE cLose
T
] New Cluster

& of vCenter and the ESXI hosts can be reached. If you have not already defined such a network profile you can create it here.

CONTINUE

8. From Select Uplink Network Profile, select the uplink network profile you created in the previous
procedure. Then select Continue.

Create Compute Profile

Select Uplink Network Profile

Select one or more network profiles such that one of the following is true

a The Interconnect Appliances on the remote site can be reached via this network

b. The remote side appliances can reach the local Interconnect Appliances via this network.

If you have point to point networks like Direct Connect which are not shared across multiple sites you can skip this step, since compute profiles are shared with multiple sites. In such cases Uplink network profiles can be overridden and specified during the creation of the Interconnect
Service mesh.

Setect Uplink Network Profie v (_Upink Newore @)] (SFress)

Network Freeips | Actions
S o [ e 0OBOOO
— atacenter = B
> ([ Replication Network oIt i
> Uplink Network EDIT
CREATE NETWORK PROFILE CcLOSE
[
(] New Cluster

|
8o &

CONTINUE

o®

9. From Select vMotion Network Profile, select the vMotion network profile that you created in previous
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steps. Then select Continue.

Create Compute Profile 1 2 3 4 5 6

Select vMotion Network Profile

Select the network profile via which the vMotion interface of the ESXi hosts can be reached. If you have not already defined such a network profile you can create it here. If you don't have vMotion Network, select Management Network Profile.

Select wMotion Network Profile v (_vMotion Network ) | 5Free1Ps ) ADVANCED CONFIGURATIONS v
S < CONTINUE

oo
Network FreetPs | Actions

> Replication Network 5 eor - | OO@@

> Uplink Network 5 EDIT laceuise o

> © vMotion Network s EoIT

CREATE NETWORK PROFILE cLosE

@
Q
10. From Select vSphere Replication Network Profile, select the replication network profile that you
created in previous steps. Then select Continue.
Create Compute Profile 1 2 3 4 5 6 54

Select vSphere Replication Network Profile

Select a Network Profile via which the vSphere Replication interface of ESXi Hosts can be reached. In most of the cases this is the same as Management Network Profile.
Select vSphere Replication Network Profile v ) | 5FreeiPs ) ADVANCED CONFIGURATIONS v
2 LA X J CONTINUE

Network FreelPs | Actions

> Vanagement Nturk s e g CICITISIIO)]

[ ) B
> @ Repication Network s oIt i
> Uplink Network 5 EDIT

CREATE NETWORK PROFILE CLOSE

T

11. From Select Distributed Switches for Network Extensions, select the switches containing the
virtual machines to be migrated to Azure VMware Solution on a layer-2 extended network. Then select
Continue.

NOTE

If you are not migrating virtual machines on layer-2 (L2) extended networks, you can skip this step.
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Create Compute Profile 1

Select Distributed Switches for Network Extensions

Select the Distributed Virtual Switches on which you have networks to which the Virtual Machines that will be migrated are connected.

Seiect Distrbuted Switches for Network Extensions v (

w-©)] Aovancep conricuraTIONs v

(XX Y] CONTINUE
ovs

O HoxRepication * | [y computeProfie DOOOBBG

O Hex-Uplink 1 Datacenter [ o= ) 2

(J  vMotion B

@ workoads .

cLose
—_— - 2 |-

Q@
Q
12. Review the connection rules and select Continue.
Create Compute Profile 1 2 < 4 5 6 3
Review Connection Rules Review and allow these connections for ComputeProfile X
In the topology preview below, we have marked a few  WAN Connection(s)  LAN Connection(s)
REVIEW CONNECTION RULES
Source Destination Protocol/port Purpose
10. Remote HCX-WAN-IX UDP(4500)
p (kev2 Cort .
1025415210254 156 Remote HOX-NET-EXT UDP4500) X
(HOXNETBXD
Totaitinies
([J) New Cluster : """""

o

13. Select Finish to create the compute profile.

vm vSphere Client
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@ Migration
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- System
S Administration Ser rees Deployment Networks
@ support G10.254.11.5 510.254.15 @ Replication Network ") @ eoir

(] Datacenter 7] New Cluster © vMotion Network ® eorr
e © Uplink Network @ eorr
Piceson © Management Network © eor
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EDIT DELETE REVIEW CONNECTION RULES

For an end-to-end overview of this procedure, view the Azure VMware Solution: Compute Profile video.

Create a service mesh

IMPORTANT

Make sure port UDP 4500 is open between your on-premises VMware HCX Connector 'uplink' network profile addresses
and the Azure VMware Solution HCX Cloud 'uplink’ network profile addresses. (500 UDP was previously required in legacy
versions of HCX. See https://ports.vmware.com for latest information)
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1. Under Infrastructure, select Interconnect > Service Mesh > Create Service Mesh.

vm vSphere Client

HCX
@ Dashboard Interconnect
~ Infrastructure

il Wult-Site Service Mesh
& Site Pairing _—
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You

CREATE SERVICE MESH

(G Refresh

The HCX Service Mesh is the eff

dded to a connected Site Pair that has

valid Compute Profile created on 5. Adding a Service Mesh init

al appliances on both of the sites

2. Review the pre-populated sites, and then select Continue.

NOTE

If this is your first service mesh configuration, you won't need to modify this screen.

3. Select the source and remote compute profiles from the drop-down lists, and then select Continue.

The selections define the resources where VMs can consume VMware HCX services.

Create Service Mesh 1 2 3 4 5 X

Select Compute Profiles

ompute profile each in th

urce and remote sites for enabling hybridity services. The selections will define the resources, where Virtual Machines will be able to consume HCX services

Select Remote Compute Profile v
£ homa
@ ComputeProfile
© conputrrae DOOOOO

cLose

Datacenter [ i}

[ New Cluster 6
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Select one compute profile each in t

Select Source Compute Profile

ource and remote sites

for enabling hybridity services. Th

© Computeprofiie

Datacenter

GlEITIISle)

(£ New Cluster

¢

© TNT41HCX-ComputeProfiie

cLOSE

CISISISISle)

) Cluster-1

4. Review services that will be enabled, and then select Continue.

L] CONTINUE

joXc)

5. In Advanced Configuration - Override Uplink Network profiles, select Continue.

Uplink network profiles connect to the network through which the remote site's interconnect appliances

can be reached.

6. In Advanced Configuration - Network Extension Appliance Scale Out, review and select

Continue.

You can have up to eight VLANSs per appliance, but you can deploy another appliance to add another

eight VLANSs. You must also have IP space to account for the more appliances, and it's one IP per

appliance. For more information, see VMware HCX Configuration Limits.

Edit Service Mesh 1 2 58 4 5
Advanced Configuration - Network Extension Appliance Scale Out
HCX will deploy the specified appliance count for each selected network container. HCX-NE appliances are deployed in both sites.

Local Network Container

@ dvsot

Remote Network Container

4 TNT57-OVERLAY-TZ

Appliance Count

1

[ ] ] CONTINUE

@ mrsrnex.coupure sRoFLE e e
el
3 clu =
= ’ — HOY
- Q

7. In Advanced Configuration - Traffic Engineering, review and make any modifications that you feel

are necessary, and then select Continue.

8. Review the topology preview and select Continue.

9. Enter a user-friendly name for this service mesh and select Finish to complete.

10. Select View Tasks to monitor the deployment.
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When the service mesh deployment finishes successfully, you'll see the services as green.
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11. Verify the service mesh's health by checking the appliance status.

12. Select Interconnect > Appliances.

vm vSphere Client

Hex
@ Dashboard Interconnect
~ Infrastructure

Mult-Stte Service Mesh
& site Pairing e

([computeProves. [N noworrones | sevine vargement

<« ServiceMesh v EDIT SERVICE MesH [N
STopology | BlAppliances | BlTasks

© 9/4/20,1015 PM - Service Mesh modified

Appliances on hcxmanager-enterprise

( Appliance Name v | Appliance Type v | 1P Address Tunnel Status Current Version

. @ 35316594999
a 2-6375712e7e HO |Hocwanx

Compute: New C

Storage: data:

& | Hoxwan-opT

4]

S| HOXNET-£XT

[

Extended Networks: 0/


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-vmware-hcx/service-mesh-green.png#lightbox
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-vmware-hcx/interconnect-appliance-state.png#lightbox

NOTE

After establishing the service mesh, you may notice a new datastore and a new host in your private cloud. This is
perfectly normal behavior after establishing a service mesh.

vm vSphere Client [YELTRS

g @ [h SDDC-Datacenter | AcTions -
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> [ 10.242.067

¥ Fiter
Nama 1 v Staws ~ Ty ~ | DatastoraClust.. ~ Capacity ~  Free ~
[ ma-ds-52624fdi-8d2c0409-a091-1372095b606 v Normal VMFS 5 500 TB 500 T8
(£ vsanDatastore ' Normal ¥SAN 55.89TB 46438
O Bxport | 2items
Recent Tasks  Alarms ¥
Task Name. v Target v sus v Dotails v initistor ~  Quaued For v srtTmel ~  Completion Time ~  Server v
Reconfigure vSphere
£ TNTAZ.DVS ' Completed VSPHERELOCAL\AGML.  5ms 08/04/2021,12:24:25 PM  08/04/2021,12:24:26 M ve.d14a7037c91d40068.
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All v More Tasks

The HCX interconnect tunnel status should indicate UP and in green. You're ready to migrate and protect Azure
VMware Solution VMs using VMware HCX. Azure VMware Solution supports workload migrations (with or
without a network extension). So you can still migrate workloads in your vSphere environment, along with on-
premises creation of networks and deployment of VMs onto those networks. For more information, see the
VMware HCX Documentation.

For an end-to-end overview of this procedure, view the Azure VMware Solution: Service Mesh video.

Next steps
Now that you've configured the HCX Connector, you can also learn about:
e (Create a HCX network extension

e VMware HCX Mobility Optimized Networking (MON) guidance
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Networking planning checklist for Azure VMware

Solution

8/19/2022 « 5 minutes to read  Edit Online

Azure VMware Solution offers a VMware private cloud environment accessible for users and applications from
on-premises and Azure-based environments or resources. The connectivity is delivered through networking
services such as Azure ExpressRoute and VPN connections. It requires specific network address ranges and
firewall ports to enable the services. This article provides you with the information you need to properly
configure your networking to work with Azure VMware Solution.

In this tutorial, you'll learn about:

e Virtual network and ExpressRoute circuit considerations
e Routing and subnet requirements
e Required network ports to communicate with the services

e DHCP and DNS considerations in Azure VMware Solution

Prerequisite

Ensure that all gateways, including the ExpressRoute provider's service, supports 4-byte Autonomous System
Number (ASN). Azure VMware Solution uses 4-byte public ASNs for advertising routes.

Virtual network and ExpressRoute circuit considerations

When you create a virtual network connection in your subscription, the ExpressRoute circuit is established
through peering, using an authorization key and a peering ID you request in the Azure portal. The peering is a
private, one-to-one connection between your private cloud and the virtual network.

NOTE

The ExpressRoute circuit is not part of a private cloud deployment. The on-premises ExpressRoute circuit is beyond the
scope of this document. If you require on-premises connectivity to your private cloud, you can use one of your existing
ExpressRoute circuits or purchase one in the Azure portal.

When deploying a private cloud, you receive IP addresses for vCenter Server and NSX-T Manager. To access
those management interfaces, you'll need to create more resources in your subscription's virtual network. You
can find the procedures for creating those resources and establishing ExpressRoute private peering in the
tutorials.

The private cloud logical networking comes with pre-provisioned NSX-T Data Center configuration. A Tier-0
gateway and Tier-1 gateway are pre-provisioned for you. You can create a segment and attach it to the existing
Tier-1 gateway or attach it to a new Tier-1 gateway that you define. NSX-T logical networking components
provide East-West connectivity between workloads and North-South connectivity to the internet and Azure
services.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-network-checklist.md

IMPORTANT
If you plan to scale your Azure VMware Solution hosts using Azure NetApp Files datastores or Azure disk pools, deploying
the vNet close to your hosts with an ExpressRoute virtual network gateway is crucial. The closer the storage is to your

hosts, the better the performance.

Routing and subnet considerations

The Azure VMware Solution private cloud is connected to your Azure virtual network using an Azure
ExpressRoute connection. This high bandwidth, low latency connection allows you to access services running in
your Azure subscription from your private cloud environment. The routing is Border Gateway Protocol (BGP)
based, automatically provisioned, and enabled by default for each private cloud deployment.

Azure VMware Solution private clouds require a minimum of a /22 CIDR network address block for subnets,
shown below. This network complements your on-premises networks. Therefore, the address block shouldn't
overlap with address blocks used in other virtual networks in your subscription and on-premises networks.
Within this address block, management, provisioning, and vMotion networks get provisioned automatically.

NOTE

Permitted ranges for your address block are the RFC 1918 private address spaces (10.0.0.0/8, 172.16.0.0/12,
192.168.0.0/16), except for 172.17.0.0/16.

Example /22 CIDR network address block: 1e.10.0.0/22

The subnets:

NETWORK USAGE SUBNET EXAMPLE
Private cloud management /26 10.10.0.0/26
HCX Mgmt Migrations /26 10.10.0.64/26
Global Reach Reserved /26 10.10.0.128/26
NSX-T DNS Service /32 10.10.0.192/32
Reserved /32 10.10.0.193/32
Reserved /32 10.10.0.194/32
Reserved /32 10.10.0.195/32
Reserved /30 10.10.0.196/30
Reserved /29 10.10.0.200/29
Reserved /28 10.10.0.208/28

ExpressRoute peering /27 10.10.0.224/27


https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools

NETWORK USAGE

ESXi Management

vMotion Network

Replication Network

vSAN

HCX Uplink

Reserved

Reserved

Reserved

SUBNET

/25

/25

/25

/25

/26

/26

/26

/26

Required network ports

SOURCE

Private Cloud DNS
server

On-premises DNS
Server

On-premises
network

DESTINATION

On-Premises DNS
Server

Private Cloud DNS
server

Private Cloud
vCenter server

PROTOCOL

ubP

ubP

TCP(HTTP)

PORT

53

53

80

EXAMPLE

10.10.1

10.

10.

10.

10.

10.

10.

10.

10.

10.

10.

10.

10.

10.

10.

.0/25

.128/25

.0/25

.128/25

.0/26

.64/26

.128/26

.192/26

DESCRIPTION

DNS Client - Forward
requests from Private
Cloud vCenter Server
for any on-premises
DNS queries (check
DNS section below)

DNS Client - Forward
requests from on-
premises services to
Private Cloud DNS
servers (check DNS
section below)

vCenter Server
requires port 80 for
direct HTTP
connections. Port 80
redirects requests to
HTTPS port 443. This
redirection helps if
you use
http://server
instead of
https://server .



SOURCE

Private Cloud
management
network

Private Cloud
management
network

On-premises
network

DESTINATION

On-premises Active
Directory

On-premises Active
Directory Global
Catalog

Private Cloud
vCenter Server

PROTOCOL

TCP

TCP

TCP(HTTPS)

PORT

389/636

3268/3269

443

DESCRIPTION

These ports are open
to allow
communications for
Azure VMware
Solutions vCenter to
communicate to any
on-premises Active
Directory/LDAP
server(s). These
port(s) are optional -
for configuring on-
premises AD as an
identity source on
the Private Cloud
vCenter. Port 636 is
recommended for
security purposes.

These ports are open
to allow
communications for
Azure VMware
Solutions vCenter
Server to
communicate to any
on-premises Active
Directory/LDAP
global catalog
server(s). These
port(s) are optional -
for configuring on-
premises AD as an
identity source on
the Private Cloud
vCenter Server. Port
3269 is
recommended for
security purposes.

This port allows you
to access vCenter
Server from an on-
premises network.
The default port that
the vCenter Server
system uses to listen
for connections from
the vSphere Client. To
enable the vCenter
Server system to
receive data from the
vSphere Client, open
port 443 in the
firewall. The vCenter
Server system also
uses port 443 to
monitor data transfer
from SDK clients.



SOURCE

On-premises
network

Admin Network

HCX Manager

HCX Manager

Cloud Gateway

Cloud Gateway

Cloud Gateway (local)

Cloud Gateway (local)

On-premises vCenter
Server network

DESTINATION

HCX Manager

Hybrid Cloud
Manager

Cloud Gateway

Cloud Gateway

L2C

ESXi Hosts

Cloud Gateway
(remote)

Cloud Gateway
(remote)

Private Cloud
management
network

PROTOCOL

TCP(HTTPS)

SSH

TCP(HTTPS)

HTTP TCP(HTTPS)

TCP(HTTPS)

TCP

ubDP

ubP

TCP

PORT

9443

22

8123

9443

443

80,902

4500

500

8000

DESCRIPTION

Hybrid Cloud
Manager Virtual
Appliance
Management
Interface for Hybrid
Cloud Manager
system configuration.

Administrator SSH
access to Hybrid
Cloud Manager.

Send host-based
replication service
instructions to the
Hybrid Cloud
Gateway.

Send management
instructions to the
local Hybrid Cloud
Gateway using the
REST API.

Send management
instructions from
Cloud Gateway to
L2C when L2C uses
the same path as the
Hybrid Cloud
Gateway.

Management and
OVF deployment.

Required for IPSEC
Internet key
exchange (IKEv2) to
encapsulate
workloads for the
bidirectional tunnel.
Network Address
Translation-Traversal
(NAT-T) is also
supported.

Required for IPSEC
Internet key
exchange (ISAKMP)
for the bidirectional
tunnel.

vMotion of VMs
from on-premises
vCenter Server to
Private Cloud
vCenter Server



DHCP and DNS resolution considerations

Applications and workloads running in a private cloud environment require name resolution and DHCP services
for lookup and IP address assignments. A proper DHCP and DNS infrastructure are required to provide these

services. You can configure a virtual machine to provide these services in your private cloud environment.

Use the DHCP service built-in to NSX or use a local DHCP server in the private cloud instead of routing
broadcast DHCP traffic over the WAN back to on-premises.

Next steps

In this tutorial, you learned about the considerations and requirements for deploying an Azure VMware Solution
private cloud. Once you have the proper networking in place, continue to the next tutorial to create your Azure

VMware Solution private cloud.

Create an Azure VMware Solution private cloud



Tutorial: Deploy an Azure VMware Solution private

cloud

8/19/2022 « 5 minutes to read  Edit Online

The Azure VMware Solution private gives you the ability to deploy a vSphere cluster in Azure. For each private
cloud created, there's one vSAN cluster by default. You can add, delete, and scale clusters. The minimum number
of hosts per cluster is three. More hosts can be added one at a time, up to a maximum of 16 hosts per cluster.
The maximum number of clusters per private cloud is 12. The initial deployment of Azure VMware Solution has
three hosts.

You use vCenter Server and NSX-T Manager to manage most other aspects of cluster configuration or
operation. All local storage of each host in a cluster is under the control of vSAN.

TIP

You can always extend the cluster and add more clusters later if you need to go beyond the initial deployment number.

Because Azure VMware Solution doesn't allow you to manage your private cloud with your cloud vCenter
Server at launch, you'll need to do additional steps for the configuration. This tutorial covers these steps and
related prerequisites.

In this tutorial, you'll learn how to:

e Create an Azure VMware Solution private cloud

e Verify the private cloud deployed

Prerequisites

e Appropriate administrative rights and permission to create a private cloud. You must be at minimum
contributor level in the subscription.

e Follow the information you gathered in the planning tutorial to deploy Azure VMware Solution.
e Ensure you have the appropriate networking configured as described in the Network planning checklist.

e Hosts provisioned and the Microsoft. AVS resource provider has been registered.

Create a private cloud

You can create an Azure VMware Solution private cloud using the Azure portal or the Azure CLI.

e Portal
e Azure CLI

1. Sign in to the Azure portal.
2. Select Create a resource.

3. Inthe Search services and marketplace text box, type Azure vMware Solution and select it from the
search results.

4. On the Azure VMware Solution window, select Create.

5. If you need more hosts, request a host quota increase.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-create-private-cloud.md
https://portal.azure.com
https://docs.microsoft.com/en-us/azure/azure-vmware/request-host-quota-azure-vmware-solution?wt.mc_id=portal-vmcp

6. On the Basics tab, enter values for the fields and then select Review + Create.

TIP

You gathered this information during the planning phase of this quick start.

FIELD

Subscription

Resource group

Resource name

Location

Size of host

Number of hosts

Address block for private cloud

VALUE

Select the subscription you plan to use for the
deployment. All resources in an Azure subscription are
billed together.

Select the resource group for your private cloud. An
Azure resource group is a logical container into which
Azure resources are deployed and managed.
Alternatively, you can create a new resource group for
your private cloud.

Provide the name of your Azure VMware Solution
private cloud.

Select a location, such as east us. It's the region you
defined during the planning phase.

Select AV36.

Number of hosts allocated for the private cloud cluster.
The default value is 3, which you can increase or
decrease after deployment. If these nodes are not listed
as available, please contact support to request a quota
increase. You can also click the link labeled If you need
more hosts, request a quota increase in the Azure
portal.

Provide an IP address block for the private cloud. The
CIDR represents the private cloud management network
and is used for the cluster management services, such as
vCenter Server and NSX-T Manager. Use /22 address
space, for example, 10.175.0.0/22. The address should be
unique and not overlap with other Azure Virtual
Networks and with on-premises networks.



https://docs.microsoft.com/en-us/azure/azure-vmware/request-host-quota-azure-vmware-solution?wt.mc_id=portal-vmcp

— Microsoft Azure £ Search resources, services, and docs (G+/)

Home > Create a resource > Marketplace > Azure VMware Solution >

Create a private cloud

Prerequisities *Basics Tags  Review and Create

Project details

Subscription * (O | AnyBuild-InternalProdClusters v ‘

Resource group * | ~ ‘
Create new

Private cloud details

Resource name * (O | Enter the name ‘
Location* @ | East US v ‘
Size of host * © | ~ ‘
Number of hosts (D O | 3 ‘

Find out how many hosts you need
If you need more hosts, request a quota increase

| Previous “ Next : Tags > l

7. Verify the information entered, and if correct, select Create.

NOTE
This step takes roughly 3-4 hours. Adding a single host in an existing or the same cluster takes between 30 - 45

minutes.

8. Verify that the deployment was successful. Navigate to the resource group you created and select your
private cloud. You'll see the status of Succeeded when the deployment has finished.

_ Microsoft Azure P Search resources, services, and docs (G+/)

Home >

Contoso-westus-sddec =

AVS Private cloud

|f‘ Search (Ctrl+/) J « [E Delete
@ Overview = # Essentials
B Activity log Resource group (change) : Contoso-westus-rg
8 Access control (LAM) I Status 1 Succeeded I
Location ! West US
® Tags
Subscription (change) : Contoso
Z® Diagnose and solve problems ; )
Subscription 1D : 1234abc-d567-8910-abdc-2e2bb 123456
Settings
B Locks Tags (change) : Click here to add tags

Next steps

In this tutorial, you've learned how to:

e (Create an Azure VMware Solution private cloud



e Verify the private cloud deployed

e Delete an Azure VMware Solution private cloud

Continue to the next tutorial to learn how to create a jump box. You use the jump box to connect to your

environment to manage your private cloud locally.

Access an Azure VMware Solution private cloud



Tutorial: Access an Azure VMware Solution private

cloud

8/19/2022 - 2 minutes to read  Edit Online

Azure VMware Solution doesn't allow you to manage your private cloud with your on-premises vCenter Server.
Instead, you'll need to connect to the Azure VMware Solution vCenter Server instance through a jump box.

In this tutorial, you'll create a jump box in the resource group you created in the previous tutorial and sign into
the Azure VMware Solution vCenter Server. This jump box is a Windows virtual machine (VM) on the same
virtual network you created. It provides access to both vCenter Server and the NSX Manager.

In this tutorial, you learn how to:

e Create a Windows VM to access the Azure VMware Solution vCenter

e Sign into vCenter Server from this VM

Create a new Windows virtual machine

1. In the resource group, select Add, search for Microsoft Windows 10, and select it. Then select Create.

Microsoft Windows 10 = X

Microsoft

Microsoft Windows 10 © saveforlater

Microsoft

Select a software plan

| Windows 10 Pro, Version 1909 v | ‘ Start with a pre-set configuration

FY
Overview Plans

This software is provided by Microsoft. Use of this software in Microsoft Azure is not permitted except under a volume licensing
agreement with Microsoft. By clicking Create, | acknowledge that | or the company | work for is licensed to use this software
under a volume licensing agreement with Microsoft and that the right to use it will be subject to that agreement.

Learn more

What's new for Business in the Windows 10 May 2019 Update
What's new for IT pros in the Windows 10 May 2019 Update

2. Enter the required information in the fields, and then select Review + create.

For more information on the fields, see the following table.
FIELD VALUE

Subscription Value is pre-populated with the Subscription belonging
to the Resource Group.

Resource group Value is pre-populated for the current Resource Group,
which you created in the preceding tutorial.

Virtual machine name Enter a unique name for the VM.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-access-private-cloud.md

FIELD VALUE

Region Select the geographical location of the VM.
Availability options Leave the default value selected.

Image Select the VM image.

Size Leave the default size value.

Authentication type Select Password.

Username Enter the user name for logging on to the VM.
Password Enter the password for logging on to the VM.
Confirm password Enter the password for logging on to the VM.
Public inbound ports Select None.

® To control access to the VM only when you want
to access it, use JIT access.

® To securely access the jump box server from the
internet without exposing any network port, use
an Azure Bastion.

3. Once validation passes, select Create to start the virtual machine creation process.

Connect to the local vCenter of your private cloud

1. From the jump box, sign in to vSphere Client with VMware vCenter Server SSO using a cloud admin
username and verify that the user interface displays successfully.

2. In the Azure portal, select your private cloud, and then Manage > Identity.

The URLs and user credentials for private cloud vCenter Server and NSX-T Manager display.

= Microsoft Azure P Search resources, services, and docs (G+/) _

Dashboard > avs-pc-ncus

g avs-pc-ncus | [dentity # - X
AVS Private cloud
O Saarch (Ctrl+/ «

| - ¢ i | Login credentials
@ Overview =

vCenter credentials
Activity log web client URL | hitps://10.1.0.2/ Ih|
PR Access control (JAM)

Admin username (D | cloudadmin@vsphere.local ] |
€ Taos
42 Diagnose and solve problems Admin password O E
Settings Certificate thumbprint © | I |
B Locks NSX-T Manager credentials

Web client URL @ | https://10.1.0.3/ ] |
Manage
& Connectivity Admin usemame @ | admin [Ty |
B |dentity Admin password @ E

B custers Certificate thumbprint © | |D|



file:///C:/localrun/t/1pp1/gn1d/azure/security-center/security-center-just-in-time.html#jit-configure
https://docs.microsoft.com/en-us/azure/bastion/tutorial-create-host-portal
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-access-private-cloud/ss4-display-identity.png#lightbox

Navigate to the VM you created in the preceding step and connect to the virtual machine.
If you need help with connecting to the VM, see connect to a virtual machine for details.

In the Windows VM, open a browser and navigate to the vCenter Server and NSX-T Manager URLs in two
tabs.

In the vSphere Client tab, enter the cloudadmin@vsphere.local user credentials from the previous step.

B a 3 Login x | VMware NSX | Login + v

& O ® hitps//10.210.0.2/websso/SAML2/SSO/vmep local? SAMLRequest=2VRPbSswFL%2FvUyDfweD!

VMware® vSphere

cloudadmin@vsphere.local

LOGIN

) =1| B vsphere-Cluster-1 -5 x| VMware NsX | Login + v

https://10.210.0.2/ui/#?extensionld=vsphere.core.inventory.serverObjectViewsExtension&objectid=urnvmomi-ClusterComputeResource

& O @

vm vSphere Client Menu v

I5] S} ) Cluster-1 ACTIONS v

Permissions Hosts VMs Datastores Networks

7 10.210.0.2 Summary Monitor Configure
[fh sDDC-Datacenter I o
e el & izt:: Sli/\ooctewifnor;s\:grat\ons: 1)08
Cluster-2
I e
= Capacity: 1.68TB
Free: 35.83 T8
Capacity: 41.92 T8
Recent Tasks Alarms v
Task Name v Target Status v Details ¥ Initiator Queued For v StartTime | CompletionTime v Server
HCX interconnect .
Deployment Plugin
for NGC 04/24/2020, 9:55:35 04/24/2020, 9:55:35
Deploy plug-in 3 1021002 v Completed VMCPLOCALwsph.. 4 ms 10.210.0.2
(comvmware.hybrid... PM PM
interconnect-
All ~ More Tasks

6. In the second tab of the browser, sign in to NSX-T Manager.
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B & [ vsphere - Cluster-1- Summ | 5 Nsx x v = [} X

& O o A Certificate error | https://10.210.0.3/nsx/#/app/home/overview ¥ = 7 ©

admin

Home Networking Security Inventory Plan & Troubleshoot System Advanced Networking & Security

fie

What can | search?

Overview Monitoring Dashboards v 5 Documentation

@& NETWORKING © &P securiTY ©
1Tier-O Gateway 1Tier-1 Gateway E=3 O Distributed FW Policies [E 1 Gateway Policies
<8 3 Segment ® 0 VPN services [[$ 0 Endpoint Policies Ly 1 Network Introspection EW
‘3> 0 NAT Rules " 0 Load Balancers Ll 0 Network Introspection NS
INVENTORY © {Cb SYSTEM ©
7 Virtual Machines 0O Groups @ 3 NSX Management Nodes Transport Zones
409 Services 63 Context Profiles D 7 Host Transport Nodes Z] 2 Edge Transport Nodes

[(]) 2 Host Clusters

Next steps

In this tutorial, you learned how to:

o Create a Windows VM to use to connect to vCenter Server

e Login to vCenter Server from your VM

Continue to the next tutorial to learn how to create a virtual network to set up local management for your
private cloud clusters.

Create a Virtual Network



Tutorial: Configure networking for your VMware

private cloud in Azure

8/19/2022 « 6 minutes to read  Edit Online

An Azure VMware Solution private cloud requires an Azure Virtual Network. Because Azure VMware Solution
doesn't support your on-premises vCenter Server, you'll need to do additional steps to integrate with your on-

premises environment. Setting up an ExpressRoute circuit and a virtual network gateway is also required.

If you plan to scale your Azure VMware Solution hosts using Azure NetApp Files datastores or Azure disk pools,
deploying the vNet close to your hosts with an ExpressRoute virtual network gateway is crucial. The closer the
storage is to your hosts, the better the performance.

In this tutorial, you learn how to:

e Create a virtual network
e Create a virtual network gateway

e Connect your ExpressRoute circuit to the gateway

NOTE

Before you create a new vNet, evaluate if you already have an existing vNet in Azure and plan to use it to connect to
Azure VMware Solution; or whether to create a new vNet entirely.

® To use an existing vNet in same Azure subscription as Azure VMware Solution, use the Azure vNet connect tab
under Connectivity.

® To use an existing vNet in a different Azure subscription than Azure VMware Solution, use the guidance on Connect
to the private cloud manually.

® To create a new vNet in same Azure subscription as Azure VMware Solution, use the Azure vNet connect tab or
create one manually.

Connect with the Azure vNet connect feature

You can use the Azure vNet connect feature to use an existing vNet or create a new vNet to connect to Azure
VMware Solution. Azure vNet connect is a function to configure vNet connectivity, it does not record
configuration state; browse the Azure portal to check what settings have been configured.

NOTE

Address space in the vNet cannot overlap with the Azure VMware Solution private cloud CIDR.

Prerequisites

Before selecting an existing vNet, there are specific requirements that must be met.

1. vNet must contain a gateway subnet.
. In the same region as Azure VMware Solution private cloud.
. In the same resource group as Azure VMware Solution private cloud.

vNet must contain an address space that doesn't overlap with Azure VMware Solution.

oW

Validate solution design is within Azure VMware Solution limits (https://docs.microsoft.com/azure/azure-
resource-manager/management/azure-subscription-service-limits).


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-configure-networking.md
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools
https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/azure-subscription-service-limits

Select an existing vNet

When you select an existing vNet, the Azure Resource Manager (ARM) template that creates the vNet and other
resources gets redeployed. The resources, in this case, are the public IP, gateway, gateway connection, and
ExpressRoute authorization key. If everything is set up, the deployment won't change anything. However, if
anything is missing, it gets created automatically. For example, if the GatewaySubnet is missing, then it gets
added during the deployment.

1. In your Azure VMware Solution private cloud, under Manage, select Connectivity.
2. Select the Azure vNet connect tab and then select the existing vNet.

& Contoso-westus-sddc | Connectivity =
' AVS Private cloud

|/"7 Search (Ctrl+/) | « [&] save (D Refresh

& Overview .
Azure vNet connect | Settings ExpressRoute HCX Public IP ExpressRoute Global Reach AVS Interconnect
Activity log

This is an optional feature that allows an Azure virtual network to be connected to your Azure VMware Solution private
A Access control (IAM) cloud. A vNet enables the communication between workloads in this virtual network (for example, Jumphbox) to the
private cloud created in Azure VMware Solution over ExpressRoute. Only a vNet with a valid subnet 'GatewaySubnet’

¢ Tags should be selected. You can create a new viNet or use an existing one provided the vMet address space does not overlap
£ oi o <ol bl with your private cloud CIDR. Learn mere about adding a subnet in a virtual network.
iagnose and solve problems
Virtual network I contoso-vnet-westus ~ I
Settings Create new
O Locks Address block for vnet
Manage

Address block for private cloud 10.120.0.0/22 |

¥ Connectivity

B [dentity

B Clusters

3. SelectSave.

At this point, the vNet validates if overlapping IP address spaces between Azure VMware Solution and
vNet are detected. If detected, change the network address of either the private cloud or the vNet so they
don't overlap.

Create a new vNet

When you create a new vNet, the required components to connect to Azure VMware Solution are automatically
created.

1. In your Azure VMware Solution private cloud, under Manage, select Connectivity.
2. Select the Azure vNet connect tab and then select Create new.

& Contoso-westus-sddc | Connectivity =

T AVS Private cloud

|/’-7 search (Ctrl+/) | « & save () Refresh

-

€ Overview . X
Azure vNet connect | Settings ExpreszsRoute HCX Public IP ExpressRoute Global Reach AVS Interconnect
Activity log

Thiz is an optional feature that allows an Azure virtual network to be connected to your Azure VMware Solution private
o, Access control (1AM) cloud. & vNet enables the communication between workloads in this virtual network (for example, Jumpbox) to the
private cloud created in Azure ViMware Solution over ExpressRoute, Only a viMet with a valid subnet ‘GatewaySubnet’
should be selected. You can create a new vNet or use an existing one provided the vMNet address space does not overlap
with your private cloud CIDR. Learn more about adding a subnet in a virtual network.

¢ Tags

&# Diagnose and solve problems

Virtual network | Y
Settings I Create new I
& Locks Address block for vnet
Manage

Address block for private cloud | 10.120.0.0/22 n

¥ Connectivity

B |dentity

B Clusters

3. Provide or update the information for the new vNet and then select OK.

At this point, the vNet validates if overlapping IP address spaces between Azure VMware Solution and



vNet are detected. If detected, change the private cloud or vNet's network address so they don't overlap.

Create virtual network X

This virtual network enables the communication between workloads in this virtual network (e.g. a Jumphaest) to the private cloud created in
Azure WVMware Solution over an Express route. A default address range and a subnet is selected for this virtual network. For changing the
default address range and subnet of this virtuzal network, follow these steps. Step 1: Change the "Address Range” to desired range (e.g.
172.16.0.0/18). Step 2: Add a subnet under "Subnets” with the name as "GatewaySubnet" and provide subnet's address range in CIDR notation
(e.g. 172.16.1.0/24). Learn more about virtual networks o

Name * contoso-westus-sddc-vnet v

Address space

The virtual network's address space specified as one or more address prefixes in CIDR notation (e.g. 10.0.0.0/18).

D Address range Addresses Overlap

D | 172.24.0.0/16 | 172.24.0.4 - 172.24.255.254 (65531 addresses) None i
| | (0 Addrasses) Mone

Subnets

The subnet's address range in CIDR notation (e.g. 10.0.0.0/24). It must be contained by the address space of the virtual network.

D Subnet name Address range Addresses
D Gatewaysubnet 172.24.0.0/24 172.24.0.4 - 172.24.0.254 (251 addresses) f
| | | (0 Addresses)

o [N

The vNet with the provided address range and GatewaySubnet is created in your subscription and resource
group.

Connect to the private cloud manually

Create a vNet manually

1. Sign in to the Azure portal.

2. Navigate to the resource group you created in the create a private cloud tutorial and select + Add to
define a new resource.

3. Inthe Search the Marketplace text box, type Virtual Network. Find the Virtual Network resource and
select it.

4. Onthe Virtual Network page, select Create to set up your virtual network for your private cloud.
5. Onthe Create Virtual Network page, enter the details for your virtual network.

6. On the Basics tab, enter a name for the virtual network, select the appropriate region, and select Next :
IP Addresses.

7. On the IP Addresses tab, under IPv4 address space, enter the address space you created in the


https://portal.azure.com

previous tutorial.

IMPORTANT

You must use an address space that does not overlap with the address space you used when you created your

private cloud in the preceding tutorial.

8. Select + Add subnet, and on the Add subnet page, give the subnet a name and appropriate address
range. When complete, select Add.

9. Select Review + create.

Home > Virtual Network

Create virtual network
Q Validation passed

Basics  IP Addresses  Secunity Tags  Review + create

Basics

Subscription Contoso

Resource group contosg-uswest-rg
Name contoso-uswest-vnet
Region West US

IP addresses

Address space 10.0.0.0/16

Subnet default (10.0.0.0/24)
Tags

None

Security

BastionHost Disabled

DDos protection plan Basic

Firewall Disabled

5
Create < Previous | MNext > Download a template for automation

10. Verify the information and select Create. Once the deployment is complete, you'll see your virtual

network in the resource group.

Create a virtual network gateway

Now that you've created a virtual network, you'll create a virtual network gateway.
1. In your resource group, select + Add to add a new resource.

2. Inthe Search the Marketplace text box, type Virtual network gateway. Find the Virtual Network
resource and select it.

3. OntheVirtual Network gateway page, select Create.

4. On the Basics tab of the Create virtual network gateway page, provide values for the fields, and then
select Review + create.



FIELD

Subscription

Resource group

Name

Region

Gateway type

SKU

Virtual network

Gateway subnet address range

Public IP address

VALUE

Pre-populated value with the Subscription to which the
resource group belongs.

Pre-populated value for the current resource group.
Value should be the resource group you created in a
previous test.

Enter a unique name for the virtual network gateway.

Select the geographical location of the virtual network
gateway.

Select ExpressRoute.

Leave the default value: standard.

Select the virtual network you created previously. If you
don't see the virtual network, make sure the gateway's
region matches the region of your virtual network.

This value is populated when you select the virtual
network. Don't change the default value.

Select Create new.



Home >

Create virtual network gateway

Basics Tags Review + create

Azure has provided a planning and design guide to help you configure the various VPN gateway options. Learn more,

Project details

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all

YOUT resaurces,
Subscription * Contoso W
Resource group (0 Select a virtual network to get resource group

Instance details

Mame ™ |"Pri|-.'a::e-CIc-ud-G;a!ewa}.- “ ._
Region * [ westus v
Gateway type * (D (O ven (®) expresshoute

SKU* () [ Standard el
virtual network * (2 [ contoso-uswest-vnet v |

Create wirtual network

@ Only virtual networks in the currently selected subscription and region are

listed.
Public IP address
Public IP address * (D) @ Create mew O Use existing
Public IP address name * PrivateCloudGatewayl®
Public IP address SKL Basic

Assignment

Azufe recommends using a validated VPN device with your virtual netwerk gateway. To view a list of vabdated devices and
instructions for configuration, refer to Azure’s documentation regarding validated VPN dewices.

Previous | MNext : Tags > Download a template for automation

5. Verify that the details are correct, and select Create to start your virtual network gateway deployment.

6. Once the deployment completes, move to the next section to connect your ExpressRoute connection to
the virtual network gateway containing your Azure VMware Solution private cloud.

Connect ExpressRoute to the virtual network gateway

Now that you've deployed a virtual network gateway, you'll add a connection between it and your Azure
VMware Solution private cloud.

1. Request an ExpressRoute authorization key:

a. In the Azure portal, navigate to the Azure VMware Solution private cloud. Select Manage >
Connectivity > ExpressRoute and then select + Request an authorization key.

Home > Contoso-westus-sddc

¢ Contoso-westus-sddc | Connectivity = - X
™ AVS Private cloud
< B O neren
@ Overview - )
Azure vNet connect Settings HCX  Public IP ExpressRoute Global Reach AVS Interconnect

B Activity log
ExpressRoute 1D

Ao Access control (IAM)

[ /subscriptions/1234abc -2e2bb1234 P ust-p P rosoft P ircu PO . ]
® Tags

Private peering ID
& Diagnose and solve problems ‘7Isu}:g:liptiunsﬂ?BfaI;C*dSﬁTjBQ?p'?!:dc';gzpl]f 45e6/res oups/tnt50-cust-p01-westus/providers/Microsaft Network/expressRouteCircuits Ant50-cust-po1 -westus... F:\
Settings 1

i + Request an authorization key | () Refresh
B Locks
Name Key

Manage Contoso-westus-sddc 2e2bb123456-1234abc-d567-8910-abdc B

| & Connectivity |

M |dentity

B Clusters


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/expressroute-global-reach/start-request-authorization-key.png#lightbox

b. Provide a name for it and select Create.

It may take about 30 seconds to create the key. Once created, the new key appears in the list of

authorization keys for the private cloud.

Home > Contoso-westus-sddc

o Contoso-westus-sddc | Connectivity # - x

™ AVS Private cloud

« =] () Refresh

O search (Ctrl+/)

Overview
Azure vNet connect Settings ExpressRoute | HCX Public IP ExpressRoute Global Reach AVS Interconnect

Activity log
ExpressRoute ID

| /subscriptions/1234abc-ds67-8910-abdc-2e2bb12345€6 Ant50-cust-po1 providers/Microsoft ircuits/nts0-cust-po1-westus.. B

Tags
Private peering ID

Diagnese and sclve problems | /subscriptions/1234abc-d567-8910-abdc-2e2bb1234 nt50-cust-p01-westus/providers/Microsoft. ircuits/tntS0-cust-p01-westus.. ©

@
o
A Access control 1AM)
L4
£

st + Request an authorization key () Refresh

B Locks e Key

Manage Contoso-westus-sddc 262bb12345€6-1234abc-d567-8910-abdc D
# Connectivity I

o identity

B Clusters

c. Copy the authorization key and ExpressRoute ID. You'll need them to complete the peering. The
authorization key disappears after some time, so copy it as soon as it appears.

2. Navigate to the virtual network gateway you plan to use and select Connections > + Add.

3. Onthe Add connection page, provide values for the fields, and select OK.

FIELD VALUE

Name Enter a name for the connection.

Connection type Select ExpressRoute.

Redeem authorization Ensure this box is selected.

Virtual network gateway The virtual network gateway you intend to use.
Authorization key Paste the authorization key you copied earlier.

Peer circuit URI Paste the ExpressRoute ID you copied earlier.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/expressroute-global-reach/show-global-reach-auth-key.png#lightbox
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Subscription (&

Resource group ()

ContosoResourceGroup ]
Create new

Location (O
East US N

The connection between your ExpressRoute circuit and your Virtual Network is created.
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Connie Wilson
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B Configuration
(9 Connections
Il Properties

B Locks

Next steps

In this tutorial, you learned how to:

e C(Create a Virtual Network using the vNet Connect Feature
e C(Create a Virtual Network Manually
e C(Create a Virtual Network gateway

e Connect your ExpressRoute circuit to the gateway

Continue to the next tutorial to learn how to create the NSX-T network segments used for VMs in vCenter

Server.

Create an NSX-T network segment



Tutorial: Add a network segment in Azure VMware

Solution

8/19/2022 - 3 minutes to read  Edit Online

After deploying Azure VMware Solution, you can configure an NSX-T network segment from NSX-T Manager or
the Azure portal. Once configured, the segments are visible in Azure VMware Solution, NSX-T Manager, and
vCenter Server. NSX-T Data Center comes pre-provisioned by default with an NSX-T Tier-0 gateway in
Active/Active mode and a default NSX-T Tier-1 gateway in Active/Standby mode. These gateways let you
connect the segments (logical switches) and provide East-West and North-South connectivity.

TIP

The Azure portal presents a simplified view of NSX-T operations a VMware administrator needs regularly and targeted at
users not familiar with NSX-T Manager.

In this tutorial, you learn how to:

e Add network segments using either NSX-T Manager or the Azure portal

e Verify the new network segment

Prerequisites

An Azure VMware Solution private cloud with access to the vCenter Server and NSX-T Manager interfaces. For

more information, see the Configure networking tutorial.

Use Azure portal to add an NSX-T segment

NOTE

If you plan to use DHCP you'll need to configure a DHCP server or DHCP relay before you can configure an NSX-T

network segment.

1. In your Azure VMware Solution private cloud, under Workload Networking, select Segments > Add.

2. Provide the details for the new logical segment and select OK.

Home » Azure ViMware Solution > Contoso-westus-sddc

Add segment

Azure VMware Sol... +2 Contoso-westus-sddc | Segments
Microsoft (microsoft.onmicrosoft.com) Azure Private Cloud Segment name *
- nte Ll

[ Fiter for any field..

Name

@ Contoso-eastus-sddc
@ Contoso-westus-sddc
& Contoso-private-cloud
@ Contoso_private_cloud

@ azurc_private_cloud

8 tocs [] segment name Connected gatew.
Manage O < contoso TNTS0-TH

* Connectiity [0 < TNTSO-HCX-UPLINK  TNTSO-TT

B Identity a

B Clusters

+ Add-ons

Workload Networking

% Segments

DHCP
B Port mirraring

© Dns

T+

Connected gateway
m

TNT50-T1

Type

Overlay segment
Subnet

Gateway *

[ Enter gatenay

DHCP ranges (aptional)

Example: 10.1.1.1/24

Enter DHCP ranges

“ Cancel

Example: 10.1.1.0/24 or 10.1.1.10-10.1.1.100


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-nsx-t-network-segment.md

e Segment name - Name of the segment that is visible in vCenter.

e Subnet gateway - Gateway IP address for the segment's subnet with a subnet mask. VMs are
attached to a logical segment, and all VMs connecting to this segment belong to the same subnet.
Also, all VMs attached to this logical segment must carry an IP address from the same segment.

e DHCP (optional) - DHCP ranges for a logical segment. You must configure a DHCP server or DHCP
relay to consume DHCP on Segments.

NOTE

The Connected gateway is selected by default and is read-only. It shows Tier-1 gateway and type of segment
information.

® T1 - Name of the Tier-1 gateway in NSX-T Manager. A private cloud comes with an NSX-T Tier-0 gateway
in Active/Active mode and a default NSX-T Tier-1 gateway in Active/Standby mode. Segments created
through the Azure VMware Solution console only connect to the default Tier-1 gateway, and the
workloads of these segments get East-West and North-South connectivity. You can only create more Tier-1
gateways through NSX-T Manager. Tier-1 gateways created from the NSX-T Manager console are not
visible in the Azure VMware Solution console.

® Type - Overlay segment supported by Azure VMware Solution.

The segment is now visible in Azure VMware Solution, NSX-T Manger, and vCenter.

Use NSX-T Manager to add network segment

The virtual machines (VMs) created in vCenter Server are placed onto the network segments created in NSX-T
and are visible in vCenter Server.

1. In NSX-T Manager, select Networking > Segments, and then select Add Segment.

Home Networking Security Inventory Plan & Troubleshoot System Advanced Networking & Security
«
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() Network Overview -
EXPAND ALL Filter by Name, Path or mare =

Connectivity
[ Tier-0 Gateways Segment Name Connected Gateway & Type Subnets Status
[ Tier-1 Gateways : > ef  TNT12-TO-MSFT-LS None - Flexible [ AVNel
o<z Segments : > = TNTI2-TO-PRIVATE-LS Nene - Flexible ® up

> o8 TNT12-TO-PUBLIC-LS None - Flexible ® Up ¢
Network Services
® VPN
T NAT
% Load Balancing
<» Forwarding Policies
IP Management
{8 DNS
£ pbHeP
& |P Address Pools
Settings
& IPVv6 Profiles

() REFRESH 1-3 of 3 Segments

2. Enter a name for the segment.



3. Select the Tier-1 Gateway (TNTxx-T1) as the Connected Gateway and leave the Type as Flexible.

4. Select the pre-configured overlay Transport Zone (TNTxx-OVERLAY-TZ) and then select Set Subnets.

Home Networking Security Inventory Plan & Troubleshoot System Advanced Networking & Security
«
o o e

ofg SEGMENTS  SEGMENT PROFILES ©)
7 Network Overview

[ aop secMenT | EXPAND ALL
Connectivity
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Network Services L2 VPN You have no L2 VPN Transport Zone
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¢ Load Balancing defined
_ NOTE - Before further configurations can be done, fill out mandatory fields above ( * ), click 'Save' below.
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IP Management
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Settings
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Pv6 Profiles
(C REFRESH 1- 3 of 3 Segments

5. Enter the gateway IP address and then select Add.

IMPORTANT
The IP address needs to be on a non-overlapping RFC1918 address block, which ensures connection to the VMs

on the new segment.

Set Subnets

Segment #subnets )
| ADD SUBNET 9
Gateway IP/Prefix Length DHCP Ranges
: I 10.10.230.1/24 : Enter DHCP Range
Format CIDR e 2 34
ADD CANCEL

CANCEL

6. Select Apply and then Save.




7. Select No to decline the option to continue configuring the segment.

Verify the new network segment

Verify the presence of the new network segment. In this example, Is01 is the new network segment.

1. In NSX-T Manager, select Networking > Segments.

Home Security I

nventory Plan & Troubleshoot System Advanced Networking & Security

«
<8 SEGMENTS  SEGMENT PROFILES ©)
7 Network Overview
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+ NAT
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IP Management
DNS
DHCP
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Settings
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(C REFRESH
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2. InvCenter Server, select Networking > SDDC-Datacenter.

vm vSphere Client
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(F 10.10.204 2 Summary Monitor Configure Permissions Hosts & Clusters VMs Datastores Networks
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¥ Fie
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& 1501 NSX network 4] 3 7 1010
G) Export litems

Next steps

In this tutorial, you created an NSX-T network segment to use for VMs in vCenter Server.

You can now:



e Configure and manage DHCP for Azure VMware Solution
e Create a Content Library to deploy VMs in Azure VMware Solution

e Peer on-premises environments to a private cloud



Peer on-premises environments to Azure VMware

Solution

8/19/2022 - 2 minutes to read  Edit Online

After you deploy your Azure VMware Solution private cloud, you'll connect it to your on-premises environment.
ExpressRoute Global Reach connects your on-premises environment to your Azure VMware Solution private
cloud. The ExpressRoute Global Reach connection is established between the private cloud ExpressRoute circuit
and an existing ExpressRoute connection to your on-premises environments.
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NOTE

You can connect through VPN, but that's out of scope for this quick start guide.

In this article, you'll:

e C(Create an ExpressRoute auth key in the on-premises ExpressRoute circuit

e Peer the private cloud with your on-premises ExpressRoute circuit


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-expressroute-global-reach-private-cloud.md
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e Verify on-premises network connectivity

After you're finished, follow the recommended next steps at the end to continue with the steps of this getting
started guide.

Prerequisites

e Review the documentation on how to enable connectivity in different Azure subscriptions.

e A separate, functioning ExpressRoute circuit for connecting on-premises environments to Azure, which is

circuit 7 for peering.

e Ensure that all gateways, including the ExpressRoute provider's service, supports 4-byte Autonomous
System Number (ASN). Azure VMware Solution uses 4-byte public ASNs for advertising routes.

NOTE

If advertising a default route to Azure (0.0.0.0/0), ensure a more specific route containing your on-premises networks is
advertised in addition to the default route to enable management access to Azure VMware Solution. A single 0.0.0.0/0
route will be discarded by Azure VMware Solution's management network to ensure successful operation of the service.

Create an ExpressRoute auth key in the on-premises ExpressRoute
circuit
The circuit owner creates an authorization, which creates an authorization key to be used by a circuit user to

connect their virtual network gateways to the ExpressRoute circuit. An authorization is valid for only one
connection.

NOTE

Each connection requires a separate authorization.

1. From the ExpressRoute circuits blade, under Settings, select Authorizations.

2. Enter the name for the authorization key and select Save.

Home > ExpressRoute circuits > Contoso-westus-sddc

yel Contoso-westus-sddc | Authorizations = b
ExpressRoute crcut

D search (Ctrl+/) | « - 3 Discard () Refresh
A Overview " You can create authorizations that can be redieemed by other circuit users. Circuit users are owners of virtual network

gateways (that are not within the same subscription as the ExpressRoute circuit). Each authorization can be redeemed with
B Activity log one virtual network,
% Access contral (IAM) To redeem authorizations, circult users will need the rescurce 1D of the ExgressRoute and an unused authorization key.

Learn mare
¢ Tags
& Diagnose and solve problems Resource ID

Jsubscriptions/ ... /resourceGroups/ .. |E
Settings
& Configuration Name Provisioning state Use status Authaorization key
@ Connections js-er-avs-auth Succeeded Used backd .. D
£ Authorizations ) ‘ —_———

js-er-az-auth Succeeded Available 36d91 .. (]
P Peerings

I| Enter name ‘I
Il Properties
& Locks

Once created, the new key appears in the list of authorization keys for the circuit.

3. Copy the authorization key and the ExpressRoute ID. You'll use them in the next step to complete the
peering.


https://docs.microsoft.com/en-us/azure/expressroute/expressroute-howto-set-global-reach-portal

Peer private cloud to on-premises

Now that you've created an authorization key for the private cloud ExpressRoute circuit, you can peer it with
your on-premises ExpressRoute circuit. The peering is done from the on-premises ExpressRoute circuit in the
Azure portal. You'll use the resource ID (ExpressRoute circuit ID) and authorization key of your private cloud
ExpressRoute circuit to finish the peering.

1. From the private cloud, under Manage, select Connectivity > ExpressRoute Global Reach > Add.

G i i s i)

Home > contose-westus-sddc

@ Contoso-westus-sddc | Connectivity = - X

4 AVS Private cloud

2 search (Ctrl+/) « & save () Refresh

@ Overview :
Azure vNet connect Settings ExpressRoute HCOX Public IP ExpressRoute Global Reach | AVS Interconnect

E Activity log

Identify the ExpressRoute circuits that you want to use. You can enable ExpressRoute Global Reach between the private peering of any two ExpressRoute circuits, as long as they're

. Access control (1AM} located in the supported countries/regions and were created at different peering locations. Learn more.
@ Tags Before you begin
& Diagnese and sclve problems * You understand ExpressRoute circuit provisioning workflows.
* Your ExpressRoute circuits are in a provisioning state.
Settings * Azure private peering is configured on your ExpressRoute circuits.

* Do not initiate a Global Reach connection from this page if a connection has already been initiated from the on-premises side.

B Locks
On-prem cloud connections

M

# Connectivity I T — i

Subscription Resource group ExpressRoute circuit Authorization key State
™ ety No results
B Clusters

Workload Networking
% Segments

T\ DHcP
B port mirroring
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2. Enter the ExpressRoute ID and the authorization key created in the previous section.

On-prem cloud connections X
Subscnption
| Contoso ~

Resource group

contoso-westus-rg i

ExpressRoute circuit ™ (O

f you have a circuit 1D, copy/paste below (D

Enter an ExpressRoute circurt 1D

authorization key

3. Select Create. The new connection shows in the on-premises cloud connections list.



TIP

You can delete or disconnect a connection from the list by selecting More.

_ p T s

yprivatecloud - Connectivity

Settings ExpressRoute HCX  ExpressRoute Global Reach

Identify the ExpressRoute circuits that you want use. You can enable ExpressRoute Global Reach between
the private peering of any two ExpressRoute circuits, as long as they're located in the supported
countriesfregions and were created at different peering locations. Learn maore
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+ Add &7 Disconnect  [§] Delete
# T, Subscription T, Resource group T, ExpressRoute circuit T Authorization key T State
1 ASP_Exp default RG - - - - Ll
Disconnect
Delete

ti\l"ity Documentation & & X

- [

=

Verify on-premises network connectivity

In your on-premises edge router, you should now see where the ExpressRoute connects the NSX-T network

segments and the Azure VMware Solution management segments.

IMPORTANT

network.

Everyone has a different environment, and some will need to allow these routes to propagate back into the on-premises

Next steps

Continue to the next tutorial to install VMware HCX add-on in your Azure VMware Solution private cloud.

Install VMware HCX




Tutorial: Scale clusters in a private cloud
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To get the most out of your Azure VMware Solution private cloud experience, scale the clusters and hosts to

reflect what you need for planned workloads. You can scale the clusters and hosts in a private cloud as required

for your application workload. You should address performance and availability limitations for specific services

on a case-by-case basis.

The following table describes the maximum limits for Azure VMware Solution.

RESOURCE

vSphere clusters per private cloud

Minimum number of ESXi hosts per cluster

Maximum number of ESXi hosts per cluster

ESXi hosts per private cloud

vCenter Servers per private cloud

HCX site pairings

Azure VMware Solution ExpressRoute max linked private
clouds

Azure VMware Solution ExpressRoute port speed

Public IPs exposed via VWAN

VSAN capacity limits

VMware Site Recovery Manager - Number of protected
Virtual Machines

VMware Site Recovery Manager - Number of Virtual
Machines per recovery plan

VMware Site Recovery Manager - Number of protection
groups per recovery plan

VMware Site Recovery Manager - RPO Values

VMware Site Recovery Manager - Total number of virtual
machines per protection group

LIMIT

12

16

96

25 (any edition)

4
The virtual network gateway used determines the actual max
linked private clouds. For more details, see About
ExpressRoute virtual network gateways

10 Gbps

The virtual network gateway used determines the actual
bandwidth. For more details, see About ExpressRoute virtual
network gateways

100

75% of total usable (keep 25% available for SLA)

1,000

1,000

250

5 min or higher *

500


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-scale-private-cloud.md
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways

RESOURCE LIMIT

VMware Site Recovery Manager - Total number of recovery 250
plans

* For information about Recovery Point Objective (RPO) lower than 15 minutes, see How the 5 Minute Recovery
Point Objective Works in the vSphere Replication Administration guide.

For other VMware-specific limits, use the VMware configuration maximum tool.
In this tutorial, you'll use the Azure portal to:

e Add a cluster to an existing private cloud

e Add hosts to an existing cluster

Prerequisites

You'll need an existing private cloud to complete this tutorial. If you haven't created a private cloud, follow the
create a private cloud tutorial to create one.

Add a new cluster

1. In your Azure VMware Solution private cloud, under Manage, select Clusters > Add a cluster.

N T e et e

Home Contoso-westus-sddc

J: Contoso-westus-sddc | Clusters =

ANS Private cloud

L sSearch (Ctrl+ ) Eis = Add a cluster :'_) Refresh

Overview

L]
Mame ESXi hosts
B Activity log
: B ciuster 40
o Access control (IAkM)
& Tags

&2 Diagnose and sobve problems
Settings

B Locks

Manage

& Connectivity

O identity

B Clusters I

-+ Add-ons

2. Use the slider to select the number of hosts and then select Save.


https://docs.vmware.com/en/vSphere-Replication/8.3/com.vmware.vsphere.replication-admin.doc/GUID-9E17D567-A947-49CD-8A84-8EA2D676B55A.html
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Add a cluster X

Cluster

0 You can choose to MANAGE YOUF FeSOuUrces manually to a specific host count based on
resource usage like CPU, memory demand, or storage. Please note that any changein =~ =3
the resources will impact your billing. For mone details, click here

b
0 H you need more than 3 hosts, request a quota increase. Leam mione
ESHi hosts *
O 3

@ Thece is o metering for the selacted subscription, region, and SKU. No cost data to display

The deployment of the new cluster begins.

Scale a cluster

1. In your Azure VMware Solution private cloud, under Manage, select Clusters.

2. Select the cluster you want to scale, select More (...) and then select Edit.

- add acluster () Refrash

Mamé ESXi hosts Status

B cluster-1 4@ @ succeeded

I &F Edit

3. Use the slider to select the number of hosts and then select Save.

The addition of hosts to the cluster begins.

Next steps

If you require another Azure VMware Solution private cloud, create another private cloud, following the same
networking prerequisites, cluster, and host limits.



Tutorial: Delete an Azure VMware Solution private

cloud
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If you have an Azure VMware Solution private cloud that you no longer need, you can delete it. The private cloud
includes:

e Anisolated network domain
e One or more provisioned vSphere clusters on dedicated server hosts

e Several virtual machines (VMs)

When you delete a private cloud, all VMs, their data, clusters, and network address space provisioned get
deleted. The dedicated Azure VMware Solution hosts are securely wiped and returned to the free pool.

Caution

Deleting the private cloud terminates all running workloads and components and is an irreversible operation.
Once you delete the private cloud, you cannot recover the data.

Prerequisites

If you require the VMs and their data later, make sure to backup the data before you delete the private cloud.
Unfortunately, there's no way to recover the VMs and their data.

Delete the private cloud

1. Access the Azure VMware Solutions console in the Azure portal.
2. Select the private cloud you want to delete.

3. Enter the name of the private cloud and select Yes.

NOTE

The deletion process takes a few hours to complete.



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/tutorial-delete-private-cloud.md
https://portal.azure.com

Azure VMware Solution identity concepts

8/19/2022 + 11 minutes to read « Edit Online

Azure VMware Solution private clouds are provisioned with a vCenter Server and NSX-T Manager. You'll use
vCenter to manage virtual machine (VM) workloads and NSX-T Manager to manage and extend the private
cloud. The CloudAdmin role is used for vCenter Server and the CloudAdmin role (with restricted permissions) is
used for NSX-T Manager.

vCenter Server access and identity

In Azure VMware Solution, vCenter Server has a built-in local user called cloudadmin assigned to the
CloudAdmin role. You can configure users and groups in Active Directory (AD) with the CloudAdmin role for
your private cloud. In general, the CloudAdmin role creates and manages workloads in your private cloud. But in
Azure VMware Solution, the CloudAdmin role has vCenter Server privileges that differ from other VMware
cloud solutions and on-premises deployments.

IMPORTANT

The local cloudadmin user should be treated as an emergency access account for "break glass" scenarios in your private
cloud. It's not for daily administrative activities or integration with other services.

e In avCenter Server and ESXi on-premises deployment, the administrator has access to the vCenter
Server administrator@vsphere.local account and the ESXi root account. They can also have more AD
users and groups assigned.

e Inan Azure VMware Solution deployment, the administrator doesn't have access to the administrator
user account or the ESXi root account. They can, however, assign AD users and groups to the CloudAdmin
role in vCenter Server. The CloudAdmin role doesn't have permissions to add an identity source like on-
premises LDAP or LDAPS server to vCenter Server. However, you can use Run commands to add an
identity source and assign cloudadmin role to users and groups.

The private cloud user doesn't have access to and can't configure specific management components Microsoft
supports and manages. For example, clusters, hosts, datastores, and distributed virtual switches.

NOTE

In Azure VMware Solution, the vsphere.local SSO domain is provided as a managed resource to support platform
operations. It doesn't support the creation and management of local groups and users other than those provided by
default with your private cloud.

IMPORTANT

Azure VMware Solution offers custom roles on vCenter Server but currently doesn't offer them on the Azure VMware

Solution portal. For more information, see the Create custom roles on vCenter Server section later in this article.

View the vCenter Server privileges

You can view the privileges granted to the Azure VMware Solution CloudAdmin role on your Azure VMware
Solution private cloud vCenter Server.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-identity.md

1. Sign into the vSphere Client and go to Menu > Administration.
2. Under Access Control, select Roles.

3. From the list of roles, select CloudAdmin and then select Privileges.

vm vSphere Client Menu Search in all environments cloudadmin

Administration

- Access Control RO|eS
[ roes

Global Permissions Roles provider: vc.5de22e5387034c5a97blea eastus.avs.azure.com -
w Licensing

Licenses + / b 4 [ DESCRIPTION USAGE
- Solutions Administrator A\arms

Client Plug-Ins Read-only « Acknowledge alarm

vCenter Server Extensio... No access + Create alarm
+ Deployment AutoUpdateUser + Disable alarm action

Maodify alarm
Remove alarm

System Configuration C S SIm

Centent library administrator (sample)

Customer Experience Im... Set alarm status

Datastore consumer (sample)

~ Support c .
X Network administrator (sample) Perm Issions
Upload File to Service R... = Modify permission
No cryptography administrator |
- Single Sign On « Modify role

Resource pool administrater (sample)

The CloudAdmin role in Azure VMware Solution has the following privileges on vCenter Server. For more
information, see the VMware product documentation.

PRIVILEGE DESCRIPTION

Alarms Acknowledge alarm
Create alarm
Disable alarm action
Modify alarm
Remove alarm
Set alarm status

Content Library Add library item
Create a subscription for a published library
Create local library
Create subscribed library
Delete library item
Delete local library
Delete subscribed library
Delete subscription of a published library
Download files
Evict library items
Evict subscribed library
Import storage
Probe subscription information
Publish a library item to its subscribers
Publish a library to its subscribers
Read storage
Sync library item
Sync subscribed library
Type introspection
Update configuration settings
Update files
Update library
Update library item
Update local library
Update subscribed library
Update subscription of a published library
View configuration settings


https://docs.vmware.com/en/VMware-vSphere/7.0/com.vmware.vsphere.security.doc/GUID-ED56F3C4-77D0-49E3-88B6-B99B8B437B62.html

PRIVILEGE DESCRIPTION

Cryptographic operations Direct access

Datastore Allocate space
Browse datastore
Configure datastore
Low-level file operations
Remove files
Update virtual machine metadata

Folder Create folder
Delete folder
Move folder
Rename folder

Global Cancel task
Global tag
Health
Log event
Manage custom attributes
Service managers
Set custom attribute
System tag

Host vSphere Replication
Manage replication

Network Assign network

Permissions Modify permissions
Modify role

Profile Driven Storage Profile driven storage view

Resource Apply recommendation

Assign vApp to resource pool

Assign virtual machine to resource pool
Create resource pool

Migrate powered off virtual machine
Migrate powered on virtual machine
Modify resource pool

Move resource pool

Query vMotion

Remove resource pool

Rename resource pool

Scheduled task Create task
Modify task
Remove task
Run task

Sessions Message

Validate session

Storage view View



PRIVILEGE DESCRIPTION

vApp Add virtual machine
Assign resource pool
Assign VApp
Clone
Create
Delete
Export
Import
Move
Power off
Power on
Rename
Suspend
Unregister
View OVF environment
vApp application configuration
vApp instance configuration
vApp managedBy configuration
vApp resource configuration

Virtual machine Change Configuration
Acquire disk lease
Add existing disk
Add new disk
Add or remove device
Advanced configuration
Change CPU count
Change memory
Change settings
Change swapfile placement
Change resource
Configure host USB device
Configure raw device
Configure managedBy
Display connection settings
Extend virtual disk
Modify device settings
Query fault tolerance compatibility
Query unowned files
Reload from paths
Remove disk
Rename
Reset guest information
Set annotation
Toggle disk change tracking
Toggle fork parent
Upgrade virtual machine compatibility
Edit inventory
Create from existing
Create new
Move
Register
Remove
Unregister
Guest operations
Guest operation alias modification
Guest operation alias query
Guest operation modifications
Guest operation program execution
Guest operation queries
Interaction
Answer question



PRIVILEGE

vService

Back L{p operation on virtual machine
PRGN |gd(r)eNCD media

Configure floppy media

Connect devices

Console interaction

Create screenshot

Defragment all disks

Drag and drop

Guest operating system management by VIX API

Inject USB HID scan codes

Install VMware tools

Pause or Unpause

Wipe or shrink operations

Power off

Power on

Record session on virtual machine

Replay session on virtual machine

Reset

Resume Fault Tolerance

Suspend

Suspend fault tolerance

Test failover

Test restart secondary VM

Turn off fault tolerance

Turn on fault tolerance
Provisioning

Allow disk access

Allow file access

Allow read-only disk access

Allow virtual machine download

Clone template

Clone virtual machine

Create template from virtual machine

Customize guest

Deploy template

Mark as template

Modify customization specification

Promote disks

Read customization specifications
Service configuration

Allow notifications

Allow polling of global event notifications

Manage service configuration

Modify service configuration

Query service configurations

Read service configuration
Snapshot management

Create snapshot

Remove snapshot

Rename snapshot

Revert snapshot
vSphere Replication

Configure replication

Manage replication

Monitor replication

Create dependency

Destroy dependency

Reconfigure dependency configuration
Update dependency



PRIVILEGE DESCRIPTION

vSphere tagging Assign and unassign vSphere tag
Create vSphere tag
Create vSphere tag category
Delete vSphere tag
Delete vSphere tag category
Edit vSphere tag
Edit vSphere tag category
Modify UsedBYy field for category
Modify UsedBy field for tag

Create custom roles on vCenter Server

Azure VMware Solution supports the use of custom roles with equal or lesser privileges than the CloudAdmin
role.

You'll use the CloudAdmin role to create, modify, or delete custom roles with privileges lesser than or equal to
their current role. You can create roles with privileges greater than CloudAdmin. You can't assign the role to any
users or groups or delete the role.

To prevent creating roles that can't be assigned or deleted, clone the CloudAdmin role as the basis for creating
new custom roles.

Create a custom role

1. Sign in to vCenter Server with cloudadmin@vsphere.local or a user with the CloudAdmin role.

2. Navigate to the Roles configuration section and select Menu > Administration > Access Control >
Roles.

3. Select the CloudAdmin role and select the Clone role action icon.

NOTE

Don't clone the Administrator role because you can't use it. Also, the custom role created can't be deleted by
cloudadmin@vsphere.local.

4. Provide the name you want for the cloned role.

5. Add or remove privileges for the role and select OK. The cloned role is visible in the Roles list.

Apply a custom role

1. Navigate to the object that requires the added permission. For example, to apply permission to a folder,
navigate to Menu > VMs and Templates > Folder Name.

2. Right-click the object and select Add Permission.

3. Select the Identity Source in the User drop-down where the group or user can be found.
4. Search for the user or group after selecting the Identity Source under the User section.
5. Select the role that you want to apply to the user or group.

6. Check the Propagate to children if needed, and select OK. The added permission displays in the
Permissions section.

NSX-T Manager access and identity

When a private cloud is provisioned using Azure portal, software-defined data center (SDDC) management
components like vCenter Server and NSX-T Manager are provisioned for customers.



Microsoft is responsible for the lifecycle management of NSX-T appliances like NSX-T Managers and NSX-T
Data Center Edges. They're responsible for bootstrapping network configuration, like creating the Tier-0
gateway.

You're responsible for NSX-T Data Center software-defined networking (SDN) configuration, for example:

e Network segments

o Other Tier-1 gateways

e Distributed firewall rules

o Stateful services like gateway firewall

e Load balancer on Tier-1 gateways

You can access NSX-T Manager using the built-in local user "cloudadmin” assigned to a custom role that gives
limited privileges to a user to manage NSX-T Data Center. While Microsoft manages the lifecycle of NSX-T Data
Center, certain operations aren't allowed by a user. Operations not allowed include editing the configuration of
host and edge transport nodes or starting an upgrade. For new users, Azure VMware Solution deploys them
with a specific set of permissions needed by that user. The purpose is to provide a clear separation of control
between the Azure VMware Solution control plane configuration and Azure VMware Solution private cloud user.

For new private cloud deployments, NSX-T Data Center access will be provided with a built-in local user
cloudadmin assigned to the cloudadmin role with a specific set of permissions to use NSX-T Data Center
functionality for workloads.

NSX-T Data Center cloudadmin user permissions

The following permissions are assigned to the cloudadmin user in Azure VMware Solution NSX-T Data Center.

NOTE

NSX-T Data Center cloudadmin user on Azure VMware Solution is not the same as the cloudadmin user
mentioned in the VMware product documentation.

CATEGORY TYPE OPERATION PERMISSION
Networking Connectivity Tier-0 Gateways Read-only
Tier-1 Gateways Full Access
Segments Full Access
Networking Network Services VPN Full Access
NAT Full Access
Load Balancing Full Access
Forwarding Policy Read-only
Statistics Full Access
Networking IP Management DNS Full Access
DHCP Full Access
IP Address Pools Full Access
Networking Profiles Full Access
Security East West Security Distributed Firewall Full Access
Distributed IDS and IPS Full Access
Identity Firewall Full Access
Security North South Security Gateway Firewall Full Access

URL Analysis Full Access



CATEGORY TYPE OPERATION PERMISSION
Security Network Introspection Read-only
Security Endpoint Protection Read-only
Security Settings Full Access
Inventory Full Access
Troubleshooting IPFIX Full Access
Troubleshooting Port Mirroring Full Access
Troubleshooting Traceflow Full Access
System Configuration Identity firewall Full Access
Settings Users and Roles Full Access
Settings Certificate Management Full Access
Settings (Service Certificate only) Full Access
User Interface Settings
System All other Read-only

You can view the permissions granted to the Azure VMware Solution cloudadmin role on your Azure VMware
Solution private cloud NSX-T Data Center.

1. Log in to the NSX-T Manager.

2. Navigate to Systems and locate Users and Roles.

3. Select and expand the cloudadmin role, found under Roles.
4

. Select a category like, Networking or Security, to view the specific permissions.

NOTE

Private clouds created before June 2022 will switch from admin role to cloudadmin role. You'll receive a
notification through Azure Service Health that includes the timeline of this change so you can change the NSX-T Data

Center credentials you've used for other integration.

NSX-T Data Center LDAP integration for role based access control
(RBACQ)

In an Azure VMware Solution deployment, the NSX-T Data Center can be integrated with external LDAP
directory service to add remote directory users or group, and assign them an NSX-T Data Center RBAC role, like
on-premises deployment. For more information on how to enable NSX-T Data Center LDAP integration, see the
VMware product documentation.

Unlike on-premises deployment, not all pre-defined NSX-T Data Center RBAC roles are supported with Azure
VMware solution to keep Azure VMware Solution laaS control plane config management separate from tenant
network and security configuration. Please see the next section, Supported NSX-T Data Center RBAC roles, for
more details.


https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/administration/GUID-DB5A44F1-6E1D-4E5C-8B50-D6161FFA5BD2.html

NOTE
NSX-T LDAP Integration supported only with SDDC's with NSX-T Data Center “cloudadmin” user.

Supported and unsupported NSX-T Data Center RBAC roles

In an Azure VMware Solution deployment, the following NSX-T Data Center predefined RBAC roles are
supported with LDAP integration:

e Auditor

e Cloudadmin
e | B Admin
e | B Operator
e VPN Admin

e Network Operator

In an Azure VMware Solution deployment, the following NSX-T Data Center predefined RBAC roles are not
supported with LDAP integration:

e Enterprise Admin

Network AdminSecurity Admin

Netx Partner Admin

Gl Partner Admin

You can create custom roles in NSX-T Data Center with permissions lesser than or equal to CloudAdmin role
created by Microsoft. Following are examples on how to create a supported "Network Admin" and "Security
Admin" role.

NOTE

Custom role creation will fail if you assign a permission not allowed by CloudAdmin role.

Create “AVS network admin” role

Use the following steps to create this custom role.
1. Navigate to System > Users and Roles > Roles.
2. Clone Network Admin and provide the name, AVS Network Admin.

3. Modify the following permissions to "Read Only" or "None" as seen in the Permission column in the
following table.

CATEGORY SUBCATEGORY FEATURE PERMISSION
Networking Connectivity Tier-0 Gateways Read-only
Tier-0 Gateways > OSPF None
Network Services Forwarding Policy None

4. Apply the changes and Save the Role.

Create “AVS security admin” role

Use the following steps to create this custom role.
1. Navigate to System > Users and Roles > Roles.

2. Clone Security Admin and provide the name, "AVS Security Admin”.



3. Modify the following permissions to "Read Only" or "None" as seen in the Permission column in the

following table.

CATEGORY SUBCATEGORY

Networking Network Services

Security Network Introspection
Endpoint Protection
Settings

4. Apply the changes and Save the Role.

FEATURE

Forwarding Policy

Service profiles

PERMISSION

None

None
None
None

NOTE

Identity Firewall (IDFW) feature for that user.

The NSX-T Data Center System > Identity Firewall AD configuration option isn't supported by the NSX custom role.
The recommendation is to assign the Security Operator role to the user with the custom role to allow managing the

NOTE

The NSX-T Data Center Traceflow feature isn't supported by NSX-T Data Center custom role. The recommendation is to
assign the Auditor role to the user along with above custom role to enable Traceflow feature for that user.

Next steps

Now that you've covered Azure VMware Solution access and identity concepts, you may want to learn about:

e How to configure external identity source for vCenter

e How to enable Azure VMware Solution resource

e Details of each privilege

e How Azure VMware Solution monitors and repairs private clouds



https://docs.vmware.com/en/VMware-vSphere/7.0/com.vmware.vsphere.security.doc/GUID-ED56F3C4-77D0-49E3-88B6-B99B8B437B62.html

Publish and protect APIs running on Azure VMware

Solution VMs

8/19/2022 - 2 minutes to read  Edit Online

Microsoft Azure APl Management lets you securely publish to external or internal consumers. Only the
Developer (development) and Premium (production) SKUs allow Azure Virtual Network integration to publish
APIs that run on Azure VMware Solution workloads. In addition, both SKUs enable the connectivity between the

APl Management service and the backend.

The APl Management configuration is the same for backend services that run on Azure VMware Solution virtual
machines (VMs) and on-premises. In addition, APl Management configures the virtual IP on the load balancer as
the backend endpoint for both deployments when the backend server is placed behind an NSX Load Balancer
on the Azure VMware Solution.

External deployment

An external deployment publishes APls consumed by external users that use a public endpoint. Developers and
DevOps engineers can manage APls through the Azure portal or PowerShell and the API Management
developer portal.

The external deployment diagram shows the entire process and the actors involved (shown at the top). The
actors are:

e Administrator(s): Represents the admin or DevOps team, which manages Azure VMware Solution
through the Azure portal and automation mechanisms like PowerShell or Azure DevOps.

e Users: Represents the exposed APIs' consumers and represents both users and services consuming the
APls.

The traffic flow goes through the APl Management instance, which abstracts the backend services, plugged into
the Hub virtual network. The ExpressRoute Gateway routes the traffic to the ExpressRoute Global Reach channel
and reaches an NSX Load Balancer distributing the incoming traffic to the different backend service instances.

APl Management has an Azure Public AP, and activating Azure DDoS Protection Service is recommended.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-api-management.md
https://azure.microsoft.com/services/api-management/
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Internal deployment

developers use the same management tools and developer portal as in the external deployment.

Use Azure Application Gateway for internal deployments to create a public and secure endpoint for the API. The
gateway's capabilities are used to create a hybrid deployment that enables different scenarios.

e Use the same APl Management resource for consumption by both internal and external consumers.

e Have a single APl Management resource with a subset of APIs defined and available for external
consumers.

e Provide an easy way to switch access to APl Management from the public internet on and off.

The deployment diagram below shows consumers that can be internal or external, with each type accessing the
same or different APIs.

In an internal deployment, APIs get exposed to the same APl Management instance. In front of APl Management,
Application Gateway gets deployed with Azure Web Application Firewall (WAF) capability activated. Also
deployed, a set of HTTP listeners and rules to filter the traffic, exposing only a subset of the backend services
running on Azure VMware Solution.

e Internal traffic routes through ExpressRoute Gateway to Azure Firewall and then to APl Management,
directly or through traffic rules.

e External traffic enters Azure through Application Gateway, which uses the external protection layer for API
Management.


https://docs.microsoft.com/en-us/azure/api-management/api-management-howto-integrate-internal-vnet-appgateway
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Integrate Azure VMware Solution in a hub and

spoke architecture

8/19/2022 « 6 minutes to read  Edit Online

This article provides recommendations for integrating an Azure VMware Solution deployment in an existing or a

new Hub and Spoke architecture on Azure.
The Hub and Spoke scenario assume a hybrid cloud environment with workloads on:

e Native Azure using laaS or PaaS services
e Azure VMware Solution

e vSphere on-premises

Architecture

The Hubis an Azure Virtual Network that acts as a central point of connectivity to your on-premises and Azure
VMware Solution private cloud. The Spokes are virtual networks peered with the Hub to enable cross-virtual
network communication.

Traffic between the on-premises datacenter, Azure VMware Solution private cloud, and the Hub goes through
Azure ExpressRoute connections. Spoke virtual networks usually contain laaS based workloads but can have
PaasS services like App Service Environment, which has direct integration with Virtual Network, or other PaaS
services with Azure Private Link enabled.

IMPORTANT

You can use an existing ExpressRoute Gateway to connect to Azure VMware Solution as long as it does not exceed the
limit of four ExpressRoute circuits per virtual network. However, to access Azure VMware Solution from on-premises
through ExpressRoute, you must have ExpressRoute Global Reach since the ExpressRoute gateway does not provide

transitive routing between its connected circuits.

The diagram shows an example of a Hub and Spoke deployment in Azure connected to on-premises and Azure
VMware Solution through ExpressRoute Global Reach.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-hub-and-spoke.md
https://docs.microsoft.com/en-us/azure/architecture/reference-architectures/hybrid-networking/#hub-spoke-network-topology
https://docs.microsoft.com/en-us/azure/app-service/environment/intro
https://docs.microsoft.com/en-us/azure/private-link/index
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The architecture has the following main components:

e On-premises site: Customer on-premises datacenter(s) connected to Azure through an ExpressRoute
connection.

e Azure VMware Solution private cloud: Azure VMware Solution SDDC formed by one or more
vSphere clusters, each one with a maximum of 16 hosts.

e ExpressRoute gateway: Enables the communication between Azure VMware Solution private cloud,

shared services on Hub virtual network, and workloads running on Spoke virtual networks.

e ExpressRoute Global Reach: Enables the connectivity between on-premises and Azure VMware
Solution private cloud. The connectivity between Azure VMware Solution and the Azure fabric is through
ExpressRoute Global Reach only.

e S2S VPN considerations: For Azure VMware Solution production deployments, Azure S2S VPN isn't
supported due to network requirements for VMware HCX. However, you can use it for a PoC deployment.

e Hub virtual network: Acts as the central point of connectivity to your on-premises network and Azure
VMware Solution private cloud.

e Spoke virtual network

o laaS Spoke: Hosts Azure laaS based workloads, including VM availability sets and virtual machine
scale sets, and the corresponding network components.

o PaaS Spoke: Hosts Azure PaaS services using private addressing thanks to Private Endpoint and
Private Link.

e Azure Firewall: Acts as the central piece to segment traffic between the Spokes and Azure VMware
Solution.

e Application Gateway: Exposes and protects web apps that run either on Azure laaS/PaaS or Azure
VMware Solution virtual machines (VMs). It integrates with other services like APl Management.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hub-spoke/azure-vmware-solution-hub-and-spoke-deployment.png#lightbox
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Network and security considerations

ExpressRoute connections enable traffic to flow between on-premises, Azure VMware Solution, and the Azure
network fabric. Azure VMware Solution uses ExpressRoute Global Reach to implement this connectivity.

Because an ExpressRoute gateway doesn't provide transitive routing between its connected circuits, on-premises
connectivity also must use ExpressRoute Global Reach to communicate between the on-premises vSphere
environment and Azure VMware Solution.

e On-premises to Azure VMware Solution traffic flow
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For more information on Azure VMware Solution networking and connectivity concepts, see the Azure VMware
Solution product documentation.

Traffic segmentation

Azure Firewall is the Hub and Spoke topology's central piece, deployed on the Hub virtual network. Use Azure
Firewall, or another Azure supported network virtual appliance (NVA) to establish traffic rules and segment the
communication between the different spokes and Azure VMware Solution workloads.

Create route tables to direct the traffic to Azure Firewall. For the Spoke virtual networks, create a route that sets
the default route to the internal interface of the Azure Firewall. This way, when a workload in the Virtual


https://docs.microsoft.com/en-us/azure/expressroute/expressroute-global-reach
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hub-spoke/on-premises-azure-vmware-solution-traffic-flow.png#lightbox
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hub-spoke/azure-vmware-solution-hub-vnet-traffic-flow.png#lightbox
https://docs.microsoft.com/en-us/azure/firewall/index

Network needs to reach the Azure VMware Solution address space, the firewall can evaluate it and apply the
corresponding traffic rule to either allow or deny it.
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A second level of traffic segmentation using the network security groups within the Spokes and the Hub to
create a more granular traffic policy.

NOTE

Traffic from on-premises to Azure VMware Solution: Traffic between on-premises workloads, either vSphere-based
or others, are enabled by Global Reach, but the traffic doesn't go through Azure Firewall on the hub. In this scenario, you

must implement traffic segmentation mechanisms, either on-premises or in Azure VMware Solution.

Application Gateway

Azure Application Gateway V1 and V2 have been tested with web apps that run on Azure VMware Solution VMs
as a backend pool. Application Gateway is currently the only supported method to expose web apps running on
Azure VMware Solution VMs to the internet. It can also expose the apps to internal users securely.

For more information, see the Azure VMware Solution-specific article on Application Gateway.
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Access Azure VMware Solution environment with a jump box, which is a Windows 10 or Windows Server VM

Jump box and Azure Bastion

deployed in the shared service subnet within the Hub virtual network.

IMPORTANT

Azure Bastion is the service recommended to connect to the jump box to prevent exposing Azure VMware Solution to the

internet. You cannot use Azure Bastion to connect to Azure VMware Solution VMs since they are not Azure laaS objects.

As a security best practice, deploy Microsoft Azure Bastion service within the Hub virtual network. Azure Bastion
provides seamless RDP and SSH access to VMs deployed on Azure without providing public IP addresses to
those resources. Once you provision the Azure Bastion service, you can access the selected VM from the Azure
portal. After establishing the connection, a new tab opens, showing the jump box desktop, and from that
desktop, you can access the Azure VMware Solution private cloud management plane.

IMPORTANT
Do not give a public IP address to the jump box VM or expose 3389/TCP port to the public internet.



https://docs.microsoft.com/en-us/azure/bastion/index
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Azure DNS resolution considerations
For Azure DNS resolution, there are two options available:
e Use the domain controllers deployed on the Hub (described in Identity considerations) as name servers.

e Deploy and configure an Azure DNS private zone.

The best approach is to combine both to provide reliable name resolution for Azure VMware Solution, on-

premises, and Azure.

As a general design recommendation, use the existing Active Directory-integrated DNS deployed onto at least
two Azure VMs in the Hub virtual network and configured in the Spoke virtual networks to use those Azure DNS
servers in the DNS settings.

You can use Azure Private DNS, where the Azure Private DNS zone links to the virtual network. The DNS servers
are used as hybrid resolvers with conditional forwarding to on-premises or Azure VMware Solution running
DNS using customer Azure Private DNS infrastructure.

To automatically manage the DNS records' lifecycle for the VMs deployed within the Spoke virtual networks,
enable autoregistration. When enabled, the maximum number of private DNS zones is only one. If disabled, then
the maximum number is 1000.

On-premises and Azure VMware Solution servers can be configured with conditional forwarders to resolver
VMs in Azure for the Azure Private DNS zone.



|dentity considerations

For identity purposes, the best approach is to deploy at least one domain controller on the Hub. Use two shared
service subnets in zone-distributed fashion or a VM availability set. For more information on extending your on-

premises Active Directory (AD) domain to Azure, see Azure Architecture Center.

Additionally, deploy another domain controller on the Azure VMware Solution side to act as identity and DNS

source within the vSphere environment.

As a recommended best practice, integrate AD domain with Azure Active Directory.


https://docs.microsoft.com/en-us/azure/architecture/reference-architectures/identity/adds-extend-domain
https://docs.microsoft.com/en-us/azure/architecture/reference-architectures/identity/azure-ad
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There are three primary patterns for creating outbound access to the Internet from Azure VMware Solution and
to enable inbound Internet access to resources on your Azure VMware Solution private cloud.

e Internet Service hosted in Azure
e Azure VMware Solution Managed SNAT
e Public IP to NSX edge

Your requirements for security controls, visibility, capacity, and operations drive the selection of the appropriate
method for delivery of Internet access to the Azure VMware Solution private cloud.

Internet Service hosted in Azure

There are multiple ways to generate a default route in Azure and send it towards your Azure VMware Solution
private cloud or on-premise. The options are as follows:

e An Azure firewall in a Virtual WAN Hub.
e A third-party Network Virtual Appliance in a Virtual WAN Hub Spoke Virtual Network.
e A third-party Network Virtual Appliance in a Native Azure Virtual Network using Azure Route Server.

e A default route from on-premises transferred to Azure VMware Solution over Global Reach.

Use any of these patterns to provide an outbound SNAT service with the ability to control what sources are
allowed out, to view the connection logs, and for some services, do further traffic inspection.

The same service can also consume an Azure Public IP and create an inbound DNAT from the Internet towards

targets in Azure VMware Solution.

An environment can also be built that utilizes multiple paths for Internet traffic. One for outbound SNAT (for
example, a third-party security NVA), and another for inbound DNAT (like a third party Load balancer NVA using
SNAT pools for return traffic).

Azure VMware Solution Managed SNAT

A Managed SNAT service provides a simple method for outbound internet access from an Azure VMware
Solution private cloud. Features of this service include the following.

e Easily enabled — select the radio button on the Internet Connectivity tab and all workload networks will have
immediate outbound access to the Internet through a SNAT gateway.

e No control over SNAT rules, all sources that reach the SNAT service are allowed.
e No visibility into connection logs.
e Two Public IPs are used and rotated to support up to 128k simultaneous outbound connections.

e No inbound DNAT capability is available with the Azure VMware Solution Managed SNAT.

Public IP to NSX edge

This option brings an allocated Azure Public IP directly to the NSX Edge for consumption. It allows the Azure
VMware Solution private cloud to directly consume and apply public network addresses in NSX as required.
These addresses are used for the following types of connections:


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-design-public-internet-access.md

Outbound SNAT
Inbound DNAT
Load balancing using VMware AVI third-party Network Virtual Appliances

Applications directly connected to a workload VM interface.

This option also lets you configure the public address on a third-party Network Virtual Appliance to create a

DMZ within the Azure VMware Solution private cloud.

Features include:

Scale — the soft limit of 64 public IPs can be increased by request to 1000s of Public IPs allocated if required
by an application.

Flexibility — A Public IP can be applied anywhere in the NSX ecosystem. It can be used to provide SNAT or
DNAT, on load balancers like VMware’s AVI, or third-party Network Virtual Appliances. It can also be used on
third-party Network Virtual Security Appliances on VMware segments or on directly on VMs.

Regionality — the Public IP to the NSX Edge is unique to the local SDDC. For "multi private cloud in distributed
regions,” with local exit to Internet intentions, it's much easier to direct traffic locally versus trying to control
default route propagation for a security or SNAT service hosted in Azure. If you've two or more Azure
VMware Solution private clouds connected with a Public IP configured, they can both have a local exit.

Considerations for selecting an option

The option that you select depends on the following factors:

To add an Azure VMware private cloud to a security inspection point provisioned in Azure native that inspects
all Internet traffic from Azure native endpoints, use an Azure native construct and leak a default route from
Azure to your Azure VMware Solution private cloud.

If you need to run a third-party Network Virtual Appliance to conform to existing standards for security
inspection or streamlined opex, you have two options. You can run your Public IP in Azure native with the
default route method or run it in Azure VMware Solution using Public IP to NSX edge.

There are scale limits on how many Public IPs can be allocated to a Network Virtual Appliance running in
native Azure or provisioned on Azure Firewall. The Public IP to NSX edge option allows for much higher
allocations (1000s versus 100s).

Use a Public IP to the NSX for a localized exit to the Internet from each private cloud in its local region. Using
multiple Azure VMware Solution private clouds in several Azure regions that need to communicate with each
other and the Internet, it can be challenging to match an Azure VMware Solution private cloud with a security

service in Azure. The difficulty is due to the way a default route from Azure works.

Next Steps

Enable Managed SNAT for Azure VMware Solution Workloads

Enable Public IP to the NSX Edge for Azure VMware Solution (Preview)

Disable Internet access or enable a default route



Azure VMware Solution network design

considerations

8/19/2022 - 2 minutes to read  Edit Online

Azure VMware Solution offers a VMware private cloud environment accessible for users and applications from
on-premises and Azure-based environments or resources. The connectivity is delivered through networking
services such as Azure ExpressRoute and VPN connections. There are several networking considerations to
review before setting up your Azure VMware Solution environment. This article provides solutions for use cases

you may encounter when configuring your networking with Azure VMware Solution.

Azure VMware Solution compatibility with AS-Path Prepend

Azure VMware Solution is incompatible with AS-Path Prepend for redundant ExpressRoute configurations and
doesn't honor the outbound path selection from Azure towards on-premises. If you're running 2 or more
ExpressRoute paths between on-prem and Azure plus the following listed conditions are true, you may
experience impaired connectivity or no connectivity between your on-premises networks and Azure VMware
Solution. The connectivity issue is caused when Azure VMware Solution doesn't see the AS-Path Prepend and
uses ECMP to send traffic towards your environment over both ExR circuits, resulting in issues with stateful
firewall inspection.

Checklist of conditions that are true:

e Both or all circuits are connected to Azure VMware Solution with global reach.
e The same netblocks are being advertised from two or more circuits.
e Stateful firewalls are in the network path.

e You're using AS-Path Prepend to force Azure to prefer one path over others.
Solution

If you're using BGP AS-Path Prepend to dedicate a circuit from Azure towards on-prem, open a Customer
Support Request with Azure VMware Solution to designate a primary circuit from Azure. You'll need to identify
which circuit you'd like to be primary for a given network advertisement. Azure support staff will implement the
AS-Path Prepend manually within the Azure VMware Solution environment to match your on-prem
configuration for route selection. That action doesn't affect redundancy as the other path(s) is still available if the

primary one fails.

Management VMs and default routes from on-premises

IMPORTANT

Azure VMware Solution Management VMs don't honor a default route from On-Premises.

If you're routing back to your on-premises networks using only a default route advertised towards Azure, the
vCenter Server and NSX Manager VMs won't honor that route.

Solution

To reach vCenter Server and NSX Manager, more specific routes from on-prem need to be provided to allow
traffic to have a return path route to those networks.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-network-design-considerations.md
https://portal.azure.com/#blade/Microsoft_Azure_Support/HelpAndSupportBlade/overview

Next steps

Now that you've covered Azure VMware Solution network design considerations, you might consider learning

more.

e Network interconnectivity concepts - Azure VMware Solution

Recommended content

e Tutorial - Configure networking for your VMware private cloud in Azure - Azure VMware Solution



Azure VMware Solution networking and

Interconnectivity concepts

8/19/2022 « 5 minutes to read  Edit Online

Azure VMware Solution offers a private cloud environment accessible from on-premises and Azure-based
resources. Services such as Azure ExpressRoute, VPN connections, or Azure Virtual WAN deliver the connectivity.

However, these services require specific network address ranges and firewall ports for enabling the services.

When deploying a private cloud, private networks for management, provisioning, and vMotion get created.
You'll use these private networks to access vCenter and NSX-T Manager and virtual machine vMotion or
deployment.

ExpressRoute Global Reach is used to connect private clouds to on-premises environments. It connects circuits
directly at the Microsoft Enterprise Edge (MSEE) level. The connection requires a virtual network (vNet) with an
ExpressRoute circuit to on-premises in your subscription. The reason is that vNet gateways (ExpressRoute
Gateways) can't transit traffic, which means you can attach two circuits to the same gateway, but it won't send
the traffic from one circuit to the other.

Each Azure VMware Solution environment is its own ExpressRoute region (its own virtual MSEE device), which
lets you connect Global Reach to the 'local' peering location. It allows you to connect multiple Azure VMware
Solution instances in one region to the same peering location.

NOTE

For locations where ExpressRoute Global Reach isn't enabled, for example, because of local regulations, you have to build a
routing solution using Azure laaS VMs. For some examples, see AzureCAT-AVS/networking.

Virtual machines deployed on the private cloud are accessible to the internet through the Azure Virtual WAN
public IP functionality. For new private clouds, internet access is disabled by default.

There are two ways to interconnectivity in the Azure VMware Solution private cloud:

e Basic Azure-only interconnectivity lets you manage and use your private cloud with only a single
virtual network in Azure. This implementation is best suited for Azure VMware Solution evaluations or

implementations that don't require access from on-premises environments.

e Full on-premises to private cloud interconnectivity extends the basic Azure-only implementation
to include interconnectivity between on-premises and Azure VMware Solution private clouds.

This article covers the key concepts that establish networking and interconnectivity, including requirements and
limitations. In addition, this article provides you with the information you need to know to work with Azure
VMware Solution to configure your networking.

Azure VMware Solution private cloud use cases

The use cases for Azure VMware Solution private clouds include:

e New VMware vSphere VM workloads in the cloud
e VM workload bursting to the cloud (on-premises to Azure VMware Solution only)
e VM workload migration to the cloud (on-premises to Azure VMware Solution only)

e Disaster recovery (Azure VMware Solution to Azure VMware Solution or on-premises to Azure VMware


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-networking.md
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-global-reach
https://github.com/Azure/AzureCAT-AVS/tree/main/networking

Solution)

e Consumption of Azure services

TIP

All use cases for the Azure VMware Solution service are enabled with on-premises to private cloud connectivity.

Azure virtual network interconnectivity

You can interconnect your Azure virtual network with the Azure VMware Solution private cloud implementation.
You can manage your Azure VMware Solution private cloud, consume workloads in your private cloud, and
access other Azure services.

The diagram below shows the basic network interconnectivity established at the time of a private cloud
deployment. It shows the logical networking between a virtual network in Azure and a private cloud. This
connectivity is established via a backend ExpressRoute that is part of the Azure VMware Solution service. The
interconnectivity fulfills the following primary use cases:

e Inbound access to vCenter Server and NSX-T Manager that is accessible from VMs in your Azure
subscription.

e Outbound access from VMs on the private cloud to Azure services.

e Inbound access of workloads running in the private cloud.
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On-premises interconnectivity

In the fully interconnected scenario, you can access the Azure VMware Solution from your Azure virtual
network(s) and on-premises. This implementation is an extension of the basic implementation described in the
previous section. An ExpressRoute circuit is required to connect from on-premises to your Azure VMware
Solution private cloud in Azure.

The diagram below shows the on-premises to private cloud interconnectivity, which enables the following use

cases:

e Hot/Cold vSphere vMotion between on-premises and Azure VMware Solution.

e On-Premises to Azure VMware Solution private cloud management access.
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For full interconnectivity to your private cloud, you need to enable ExpressRoute Global Reach and then request
an authorization key and private peering ID for Global Reach in the Azure portal. The authorization key and
peering ID are used to establish Global Reach between an ExpressRoute circuit in your subscription and the
ExpressRoute circuit for your private cloud. Once linked, the two ExpressRoute circuits route network traffic
between your on-premises environments to your private cloud. For more information on the procedures, see
the tutorial for creating an ExpressRoute Global Reach peering to a private cloud.

Limitations

The following table describes the maximum limits for Azure VMware Solution.

RESOURCE

vSphere clusters per private cloud

Minimum number of ESXi hosts per cluster

Maximum number of ESXi hosts per cluster

ESXi hosts per private cloud

vCenter Servers per private cloud

HCX site pairings

Azure VMware Solution ExpressRoute max linked private
clouds

Azure VMware Solution ExpressRoute port speed

Public IPs exposed via VWAN

VSAN capacity limits

VMware Site Recovery Manager - Number of protected
Virtual Machines

LIMIT

12

16

96

25 (any edition)

4
The virtual network gateway used determines the actual max
linked private clouds. For more details, see About
ExpressRoute virtual network gateways

10 Gbps

The virtual network gateway used determines the actual
bandwidth. For more details, see About ExpressRoute virtual
network gateways

100

75% of total usable (keep 25% available for SLA)

1,000


https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways

RESOURCE LIMIT

VMware Site Recovery Manager - Number of Virtual 1,000
Machines per recovery plan

VMware Site Recovery Manager - Number of protection 250
groups per recovery plan

VMware Site Recovery Manager - RPO Values 5 min or higher *

VMware Site Recovery Manager - Total number of virtual 500
machines per protection group

VMware Site Recovery Manager - Total number of recovery 250
plans

* For information about Recovery Point Objective (RPO) lower than 15 minutes, see How the 5 Minute Recovery
Point Objective Works in the vSphere Replication Administration guide.

For other VMware-specific limits, use the VMware configuration maximum tool.

Next steps

Now that you've covered Azure VMware Solution network and interconnectivity concepts, you may want to
learn about:

e Azure VMware Solution storage concepts
e Azure VMware Solution identity concepts

e Enabling the Azure VMware Solution resource provider


https://docs.vmware.com/en/vSphere-Replication/8.3/com.vmware.vsphere.replication-admin.doc/GUID-9E17D567-A947-49CD-8A84-8EA2D676B55A.html
https://configmax.vmware.com/
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Azure VMware Solution delivers VMware-based private clouds in Azure. The private cloud hardware and
software deployments are fully integrated and automated in Azure. You deploy and manage the private cloud
through the Azure portal, CLI, or PowerShell.

A private cloud includes clusters with:

e Dedicated bare-metal server hosts provisioned with VMware ESXi hypervisor

e VMware vCenter Server for managing ESXi and vSAN

o VMware NSX-T Data Center software-defined networking for vSphere workload VMs
e VMware vSAN datastore for vSphere workload VMs

e VMware HCX for workload mobility

e Resources in the Azure underlay (required for connectivity and to operate the private cloud)

As with other resources, private clouds are installed and managed from within an Azure subscription. The
number of private clouds within a subscription is scalable. Initially, there's a limit of one private cloud per
subscription. There's a logical relationship between Azure subscriptions, Azure VMware Solution private clouds,
vSAN clusters, and hosts.

The diagram shows a single Azure subscription with two private clouds that represent a development and
production environment. In each of those private clouds are two clusters.
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Hosts

Azure VMware Solution clusters are based on hyper-converged, bare-metal infrastructure. The following table
shows the RAM, CPU, and disk capacities of the host.

VSAN CACHE VSAN CAPACITY REGIONAL
HOST TYPE CPU (GHZ) RAM (GB) TIER (TB, RAW) TIER (TB, RAW) AVAILABILITY


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-private-clouds-clusters.md

VSAN CACHE VSAN CAPACITY REGIONAL
HOST TYPE CPU (GHZ) RAM (GB) TIER (TB, RAW) TIER (TB, RAW) AVAILABILITY
AV36 dual Intel 18 576 3.2 (NVMe) 15.20 (SSD) All product
core 2.3 GHz regions
(SkyLake)
AV36P dual Intel 18 768 1.5 (Intel Optane 19.20 (NVMe) Selected regions
core 2.6 GHz / Cache) *
3.9 GHz turbo
(Cascade Lake)
AV52 dual Intel 26 1536 1.5 (Intel Optane 38.40 (NVMe) Selected regions

core 2.7 GHz /
4.0 GHz turbo
(Cascade Lake)

Cache) *

An Azure VMware cluster requires a minimum number of three hosts. You can only use host of the same type in
a single cluster. You can use multiple clusters with different host types in a single Azure VMware Private Cloud.
Hosts used to build or scale clusters come from an isolated pool of hosts. Those hosts have passed hardware
tests and have had all data securely deleted before being added to a cluster.

(*) details available via the Azure pricing calculator.

Clusters

For each private cloud created, there's one vSAN cluster by default. You can add, delete, and scale clusters. The
minimum number of hosts per cluster and the initial deployment is three.

You use vSphere and NSX-T Manager to manage most other aspects of cluster configuration or operation. All
local storage of each host in a cluster is under the control of vSAN.

The Azure VMware Solution management and control plane has the following resource requirements that need
to be accounted for during solution sizing.

TYPICAL
PROVISION PROVISION TYPICAL TYPICAL RAW VSAN

DESCRIPTI PROVISION ED VRAM ED VDISK CPU USAGE VRAM DATASTORE
AREA ON ED VCPUS (GB) (GB) (GHZ) USAGE (GB) USAGE (GB)
VMware vCenter 8 24 499 1.1 3.6 1020
vSphere Server
VMware ESXi node 1 N/A N/A N/A 9.4 0.4 N/A
vSphere
VMware ESXi node 2 N/A N/A N/A 9.4 0.4 N/A
vSphere
VMware ESXi node 3 N/A N/A N/A 9.4 0.4 N/A
vSphere
VMware NSX-T 6 24 300 5.5 85 613
NSX-T Data Unified
Center Appliance

Node 1



TYPICAL

PROVISION PROVISION TYPICAL TYPICAL RAW VSAN
DESCRIPTI PROVISION ED VRAM ED VDISK CPU USAGE VRAM DATASTORE
AREA ON ED VCPUS (GB) (GB) (GHZ) USAGE (GB) USAGE (GB)
VMware NSX-T 6 24 300 55 8.5 613
NSX-T Data Unified
Center Appliance
Node 2
VMware NSX-T 6 24 300 5.5 85 613
NSX-T Data Unified
Center Appliance
Node 3
VMware NSX-TEdge 8 32 200 13 0.6 409
NSX-T Data VM 1
Center
VMware NSX-TEdge 8 32 200 13 0.6 409
NSX-T Data VM 2
Center
VMware HCX 4 12 60 1 32 132
HCX Manager
(Optional
Add-On)
VMware SRM 4 12 20 1 1 53
Site Appliance
Recovery
Manager
(Optional
Add-On)
VMware vSphere 4 8 26 43 2.2 62
vSphere Replication
(Optional Appliance
Add-On)
Total 54 vCPUs 192 GB 1,905 GB 54.7 GHz 379 GB 3,924 GB

These resource requirements only apply to the first cluster deployed in an Azure VMware Solution private cloud.

Subsequent clusters only need to account for the ESXi resource requirements in solution sizing.

The VMware ESXi nodes have usage values that account for the vSphere VMkernel hypervisor overhead, vSAN
overhead and NSX-T distributed router, firewall and bridging overhead. These are estimates for a standard three
cluster configuration. The storage requirements are listed as not applicable (N/A) since a boot volume separate
from the vSAN Datastore is used.

The VMware HCX and VMware Site Recovery Manager resource requirements are optional Add-Ons to the
Azure VMware Solution service. Discount these requirements in the solution sizing if they are not being used.

The VMware Site Recovery Manager Add-On has the option of configuring multiple VMware vSphere
Replication Appliances. The table above assumes one vSphere Replication appliance is used.

Sizing an Azure VMware Solution is an estimate; the sizing calculations from the design phase should be
validated during the testing phase of a project to ensure the Azure VMware Solution has been sized correctly for
the application workload.



TIP

You can always extend the cluster and add additional clusters later if you need to go beyond the initial deployment

number.

The following table describes the maximum limits for Azure VMware Solution.

RESOURCE

vSphere clusters per private cloud

Minimum number of ESXi hosts per cluster

Maximum number of ESXi hosts per cluster

ESXi hosts per private cloud

vCenter Servers per private cloud

HCX site pairings

Azure VMware Solution ExpressRoute max linked private
clouds

Azure VMware Solution ExpressRoute port speed

Public IPs exposed via VWAN

vSAN capacity limits

VMware Site Recovery Manager - Number of protected
Virtual Machines

VMware Site Recovery Manager - Number of Virtual
Machines per recovery plan

VMware Site Recovery Manager - Number of protection
groups per recovery plan

VMware Site Recovery Manager - RPO Values

VMware Site Recovery Manager - Total number of virtual
machines per protection group

VMware Site Recovery Manager - Total number of recovery
plans

LIMIT

12

16

96

25 (any edition)

4

The virtual network gateway used determines the actual max
linked private clouds. For more details, see About
ExpressRoute virtual network gateways

10 Gbps

The virtual network gateway used determines the actual
bandwidth. For more details, see About ExpressRoute virtual
network gateways

100

75% of total usable (keep 25% available for SLA)

1,000

1,000

250

5 min or higher *

500

250

* For information about Recovery Point Objective (RPO) lower than 15 minutes, see How the 5 Minute Recovery

Point Objective Works in the vSphere Replication Administration guide.



https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways
https://docs.vmware.com/en/vSphere-Replication/8.3/com.vmware.vsphere.replication-admin.doc/GUID-9E17D567-A947-49CD-8A84-8EA2D676B55A.html

For other VMware-specific limits, use the VMware configuration maximum tool.

VMware software versions

The VMware solution software versions used in new deployments of Azure VMware Solution private cloud
clusters are:

SOFTWARE VERSION
vCenter Server 7.0 U3c
ESXi 7.0 U3c
VSAN 7.0 U3c
VvSAN on-disk format 10

HCX 433
NSX-T Data Center 3.1.2

NOTE: NSX-T Data Center is the only supported version of
NSX Data Center.

The currently running software version is applied to new clusters added to an existing private cloud. For more
information, see the VMware software version requirements for HCX and Understanding vSAN on-disk format
versions and compatibility.

Host maintenance and lifecycle management

One benefit of Azure VMware Solution private clouds is the platform is maintained for you. Microsoft is
responsible for the lifecycle management of VMware software (ESXi, vCenter, and vSAN). Microsoft is also
responsible for the lifecycle management of NSX-T appliances, bootstrapping the network configuration, such as
creating the Tier-0 gateway and enabling North-South routing. You're responsible for NSX-T SDN configuration:
network segments, distributed firewall rules, Tier 1 gateways, and load balancers.

Microsoft is responsible for applying any patches, updates, or upgrades to ESXi, vCenter, vSAN, and NSX-T in
your private cloud. The impact of patches, updates, and upgrades on ESXi, vCenter, and NSX-T is different.

e ESXi - There's no impact to workloads running in your private cloud. Access to vCenter and NSX-T isn't
blocked during this time. It's recommended that, during this time, you don't plan any other activities like
scaling up private cloud, scheduling or initiating active HCX migrations, making HCX configuration
changes and so on, in your private cloud.

e vCenter - There's no impact to workloads running in your private cloud. During this time, vCenter will be
unavailable and you won't be able to manage VMs (stop, start, create, or delete). It's recommended that,
during this time, you don't plan any other activities like scaling up private cloud, creating new networks,
and so on, in your private cloud. If you are using SRM or vSphere replication user interfaces, it is
recommended to not configure vSphere replications and configure or execute site recovery plans during
the vCenter upgrade.

o NSX-T - There's workload impact and when a particular host is being upgraded, the VMs on that host
might lose connectivity from 2 seconds to maximum 1 minute with any and all of the following
symptoms:

o Pingerrors


https://configmax.vmware.com/
https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/rn/VMware-NSX-T-Data-Center-312-Release-Notes.html
https://docs.vmware.com/en/VMware-HCX/4.3/hcx-user-guide/GUID-54E5293B-8707-4D29-BFE8-EE63539CC49B.html
https://kb.vmware.com/s/article/2148493

o Packet loss
o Error messages (for example, Destination Host Unreachable and Net unreachable)

During this upgrade window, all access to the NSX-T management plane will be blocked. You can't make
configuration changes to the NSX-T environment for the duration. However, your workloads will continue
to run as normal, subject to the upgrade impact detailed above.

It's recommended that, during the upgrade time, you don't plan any other activities like scaling up private
cloud, and so on, in your private cloud. These can prevent the upgrade from starting or could have
adverse impacts on the upgrade and the environment.

You'll be notified before patches/updates or upgrades are applied to your private clouds. We'll also work with
you to schedule a maintenance window before applying updates or upgrades to your private cloud.

Software updates include:
e Patches - Security patches or bug fixes released by VMware
e Updates - Minor version change of a VMware stack component

e Upgrades - Major version change of a VMware stack component

NOTE

Microsoft tests a critical security patch as soon as it becomes available from VMware.

Documented VMware workarounds are implemented in lieu of installing a corresponding patch until the next
scheduled updates are deployed.

Host monitoring and remediation

Azure VMware Solution continuously monitors the health of both the underlay and the VMware components.
When Azure VMware Solution detects a failure, it takes action to repair the failed components. When Azure
VMware Solution detects a degradation or failure on an Azure VMware Solution node, it triggers the host
remediation process.

Host remediation involves replacing the faulty node with a new healthy node in the cluster. Then, when possible,
the faulty host is placed in VMware vSphere maintenance mode. VMware vMotion moves the VMs off the faulty
host to other available servers in the cluster, potentially allowing zero downtime for live migration of workloads.
If the faulty host can't be placed in maintenance mode, the host is removed from the cluster.

Azure VMware Solution monitors the following conditions on the host:

® Processor status

e Memory status

e Connection and power state

e Hardware fan status

e Network connectivity loss

e Hardware system board status

e Errors occurred on the disk(s) of a VSAN host
e Hardware voltage

e Hardware temperature status

e Hardware power status

e Storage status



e Connection failure

NOTE

Azure VMware Solution tenant admins must not edit or delete the above defined VMware vCenter Server alarms, as
these are managed by the Azure VMware Solution control plane on vCenter Server. These alarms are used by Azure

VMware Solution monitoring to trigger the Azure VMware Solution host remediation process.

Backup and restoration

Private cloud vCenter Server and NSX-T Data Center configurations are on an hourly backup schedule. Backups
are kept for three days. If you need to restore from a backup, open a support request in the Azure portal to
request restoration.

Azure VMware Solution continuously monitors the health of both the physical underlay and the VMware
Solution components. When Azure VMware Solution detects a failure, it takes action to repair the failed
components.

Next steps
Now that you've covered Azure VMware Solution private cloud concepts, you may want to learn about:

e Azure VMware Solution networking and interconnectivity concepts
e Azure VMware Solution storage concepts

e How to enable Azure VMware Solution resource


https://rc.portal.azure.com/#create/Microsoft.Support

Run command in Azure VMware Solution
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In Azure VMware Solution, vCenter Server has a built-in local user called cloudadmin assigned to the
CloudAdmin role. The CloudAdmin role has vCenter Server privileges that differ from other VMware cloud
solutions and on-premises deployments. The Run command feature lets you perform operations that would
normally require elevated privileges through a collection of PowerShell cmdlets.

Azure VMware Solution supports the following operations:
e Configure an external identity source
e View and set storage policies

e Deploy disaster recovery using JetStream

NOTE

Run commands are executed one at a time in the order submitted.

View the status of an execution

You can view the status of any executed run command, including the output, errors, warnings, and information
logs of the cmdlets.

1. Sign in to the Azure portal.
2. Select Run command > Run execution status.

You can sort by the various columns by selecting the column.

22 S X e (]

Home > Contoso-westus-sddc

Contoso-westus-sddc | Run command x
" AVS Private cloud

0 Search (Ctrl+/) « () Refresh

@ Overview .
Packages Run execution status
Activity log

A Access control {IAM) Execution name Package name Packa... Command name  Started time... | End time stamp Status
¢ Tags remove_externalidentity Microsoft.AvS.Management 1.0.30 Remove-Externalld 7/20/2021, 12:58:4; 7/20/2021, 12:59:3' @ Succeeded
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Manage getidentitysource Microsoft.AvS.Management 1.0.30 Get-Externalidentit 7/20/2021, 10:40:3.  7/20/2021, 10:45:31 @ Succeeded
P it check_letserverdetails ISDR.Configuration 1.0.20 Invoke-Preflightiet  7/20/2021, 7:52:56  7/20/2021, 8:04:57 € Failed
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B identit checkDRsystem JSDR.Configuration 1.0.20 Invoke-Preflightlet  7/20/2021, 5:56:33  7/20/2021, 5:57:54 @ Succeeded
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amaneja-jsdrcheck JSDR.Configuration 1.0.20 Invoke-Preflightlet  7/19/2021, 2:11:41  7/19/2021,2:13:09 @ Succeeded
B clust - N -
% Clusters
installJSDR_withDNSRegistered JSDR.Configuration 1.0.20 Install-JetDR 7H16/2021, 8:26:40  7/16/2021,8:33:09 @ Failed
Warkload Networking
del_jetdr_4 JSDR.Canfiguration 1.0.20 Uninstall-JetDR 7/16/2021, 8:17:22  7/16/2021,8:18:06 €} Failed
% Segments
del_jetdr_3 JSDR.Configuration 1.0.20 Uninstall-JetDR 7/16/2021, 8:07:16  7/16/2021,8:08:26 €@ Succeeded
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3. Select the execution you want to view. A pane opens with details about the execution, and other tabs for

the various types of output generated by the cmdlet.

Run execution - remove_externalidentity X

Details Qutput Error Warning nfarmation

You can view more details about the execution including the output, errors, warnings, and information.

e Details - Summary of the execution details, such as the name, status, package, cmdlet name, and

error if the command failed.

e Output - Messages output by the cmdlet. May include progress or the result of the operation. Not

all cmdlets have output.

Run execution - remove_externalidentity X

Details Qutput Error Warning nformation

Identity source avslab.local removed.

e Error - Error messages generated in the execution of the cmdlet. This is in addition to the

terminating error message on the details pane.



Run execution - remove_externalidentity X

Vienter already has JetDR plugin. Please unregister wlenter or cleanup any

e Warning - Warning messages generated during the execution.

Run execution - remove_externalidentity X

finished w/
ished w/f

e [nformation - Progress and diagnostic generated messages during the execution of a cmdlet.



Run execution - remove_externalidentity X

Check for powe
: Vienter Addres
k for ClosdAdmin role in w
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s required configuration

luste Cluster-1" provided for protection exists in the Datacent
Protected cluster satisfies the number of h uirement

Cancel or delete a job

Method 1

This method attempts to cancel the execution, and then deletes it upon completion.

IMPORTANT

Method 1 is irreversible.

1. Select Run command > Run execution status and then select the job you want to cancel.

Run execution - remove_externalidentity X
Cancel + delete |5 Rerur Refre
Details Qutput o arming nformation

2. Select Yes to cancel and remove the job for all users.

Method 2



1. Select Run command > Packages > Run execution status.

2. Select More (...) for the job you want to cancel and delete.

P Search resources, services, and docs (G+/)

Home > Contoso-westus-sddc

= Contoso-westus-sddc | Run command - x
AVS Private cloud

P Search (Ctrl+)) « O Refresh

@ Overview
Packages | Run execution status

Activity log

An, Access control (IAM) Execution name Package name Packa... Command name  Started time... | = End time stamp Status
¢ Tegs remove_externalidentity Microsoft AVS. Management 1030 Remove-Externalld  7/20/2021, 12:58:4; 7/20/2021, 12:59:3' @ Succeeded
&’ Diagnose and solve problems removeGroup Microsoft.AVS.Management 1.0.30 Remove-GroupFrol 7/20/2021, 12:52:0. 7/20/2021,12:53:4 @ Succeeded
Settings addADgroup Microsoft.AvS.Management 1.0.30 Add-GroupToClouc  7/20/2021, 12:08:4  7/20/2021, 12:09:2. @ Succeeded
A Locks addexternalldentity Microsoft.AVS.Management 1.030 New-AvsLDAPIderr  7/20/2021, 11:13:2  7/20/2021, 11:14:0: €@ Succeeded
Manage getidentitysource Micrasoft.AVS.Management 1.030 Get-Externalidentit  7/20/2021, 10:40:3.  7/20/2021, 10:45:31 @ Succeeded
check_letserverdetails JSDR.Configuration 1.0.20 Invoke-Preflightlet  7/20/2021, 7:52:56 7/20/2021, 8:04:57 € Failed
® Connectivity -
= dentit checkDRsystem JSDR.Configuration 1.0.20 Invoke-Preflightiet  7/20/2021, 5:56:33  7/20/2021, 5:57:54 @ Succeeded
entity
B clust amaneja-jsdrcheck ISDR.Configuration 1.0.20 Invoke-Preflightiet  7/19/2021, 2:11:41  7/19/2021, 2:13:09 @ Succeeded
5 Clusters
instalJSDR_withDNSRegistered JSDR.Configuration 1.0.20 Install-JletDR 7/16/2021, 8:26:40 7/16/2021, 8:33:09 @ Failed
Worldoad Networking . )
del_jetdr 4 JSDR.Configuration 1.0.20 Uninstall-JetDR 7/16/2021,8:17:22  7/16/2021, 8:18:06 @ Failed X
«> Segments + delete
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© ons
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3. Select Yes to cancel and remove the job for all users.

Next steps

Now that you've learned about the Run command concepts, you can use the Run command feature to:

e Configure storage policy - Each VM deployed to a vSAN datastore is assigned a vSAN storage policy. You
can assign a vVSAN storage policy in an initial deployment of a VM or when you do other VM operations,

such as cloning or migrating.

e Configure external identity source for vCenter (Run command) - Configure Active Directory over LDAP or
LDAPS for vCenter Server, which enables the use of an external identity source as an Active Directory.

Then, you can add groups from the external identity source to the CloudAdmin role.

e Deploy disaster recovery using JetStream - Store data directly to a recovery cluster in vSAN. The data
gets captured through 1/O filters that run within vSphere. The underlying data store can be VMFS, VSAN,
vVol, or any HCI platform.
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It's important that proper measures are taken to secure your Azure VMware Solution deployments. Use this
information as a high-level guide to achieve your security goals.

General

Use the following guidelines and links for general security recommendations for both Azure VMware Solution

and VMware best practices.

RECOMMENDATION

Review and follow VMware Security Best Practices

Keep up to date on VMware Security Advisories

Enable Microsoft Defender for Cloud

Follow the Microsoft Security Response Center blog

Review and implement recommendations within the Azure
Security Baseline for Azure VMware Solution

Network

COMMENTS

It's important to stay updated on Azure security practices
and VMware Security Best Practices.

Subscribe to VMware notifications in my.vmware.com and
regularly review and remediate any VMware Security
Advisories.

Microsoft Defender for Cloud provides unified security
management and advanced threat protection across hybrid
cloud workloads.

Microsoft Security Response Center

Azure security baseline for VMware Solution

The following are network-related security recommendations for Azure VMware Solution.

RECOMMENDATION

Only allow trusted networks

Use Azure Firewall Premium

Deploy and configure Network Security Groups on VNET

COMMENTS

Only allow access to your environments over ExpressRoute
or other secured networks. Avoid exposing your
management services like vCenter Server, for example, on
the internet.

If you must expose management services on the internet,
use Azure Firewall Premium with both IDPS Alert and Deny
mode along with TLS inspection for proactive threat
detection.

Ensure any VNET deployed has Network Security Groups
configured to control ingress and egress to your
environment.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-security-recommendations.md
https://docs.vmware.com/en/VMware-vSphere/7.0/com.vmware.vsphere.security.doc/GUID-412EF981-D4F1-430B-9D09-A4679C2D04E7.html
https://www.vmware.com/security/advisories.html
https://docs.microsoft.com/en-us/azure/defender-for-cloud/index
https://msrc-blog.microsoft.com/
https://docs.microsoft.com/en-us/security/benchmark/azure/baselines/vmware-solution-security-baseline/
https://docs.microsoft.com/en-us/azure/firewall/premium-migrate
https://docs.microsoft.com/en-us/azure/virtual-network/network-security-groups-overview

RECOMMENDATION COMMENTS

Review and implement recommendations within the Azure Azure security baseline for Azure VMware Solution
security baseline for Azure VMware Solution

HCX

See the following information for recommendations to secure your HCX deployment.

RECOMMENDATION COMMENTS

Stay current with HCX service updates HCX service updates can include new features, software fixes,
and security patches. Apply service updates during a
maintenance window where no new HCX operations are
queued up by following these steps.


https://docs.microsoft.com/en-us/security/benchmark/azure/baselines/vmware-solution-security-baseline/
https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-F4AEAACB-212B-4FB6-AC36-9E5106879222.html
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Azure VMware Solution private clouds provide native, cluster-wide storage with VMware vSAN. Local storage
from each host in a cluster is used in a vVSAN datastore, and data-at-rest encryption is available and enabled by
default. You can use Azure Storage resources to extend storage capabilities of your private clouds.

vSAN clusters

Local storage in each cluster host is claimed as part of a vSAN datastore. All diskgroups use an NVMe cache tier
of 1.6 TB with the raw, per host, SSD-based capacity of 15.4 TB. The size of the raw capacity tier of a cluster is the
per host capacity times the number of hosts. For example, a four host cluster provides 61.6-TB raw capacity in
the vSAN capacity tier.

Local storage in cluster hosts is used in the cluster-wide vSAN datastore. All datastores are created as part of
private cloud deployment and are available for use immediately. The cloudadmin user and all users assigned to
the CloudAdmin role can manage datastores with these vSAN privileges:

e Datastore AllocateSpace
e Datastore.Browse

e Datastore.Config

e Datastore.DeleteFile

e Datastore.FileManagement

e Datastore.UpdateVirtualMachineMetadata

IMPORTANT

You can't change the name of datastores or clusters. You can select a cluster name other than "Cluster-n" where n > 1

when provisioning from somewhere other than the portal (AzureCLI or PowerShell).

Storage policies and fault tolerance

The default storage policy is set to RAID-1 (Mirroring) FTT-1, with Object Space Reservation set to Thin
provisioning. Unless you adjust the storage policy or apply a new policy, the cluster grows with this
configuration. This is the policy that will be applied to the workload VMs. To set a different storage policy, see
Configure storage policy.

In a three-host cluster, FTT-1 accommodates a single host's failure. Microsoft governs failures regularly and
replaces the hardware when events are detected from an operations perspective.

NOTE

When you log on to the vSphere Client, you may notice a VM Storage Policy called vSAN Default Storage Policy with
Object Space Reservation set to Thick provisioning. Please note that this is not the default storage policy applied to
the cluster. This policy exists for historical purposes and will eventually be modified to Thin provisioning.



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/concepts-storage.md

NOTE

All of the software-defined data center (SDDC) management VMs (vCenter, NSX manager, NSX controller, NSX edges, and
others) use the Microsoft vSAN Management Storage Policy, with Object Space Reservation set to Thick
provisioning.

TIP

If you're unsure if the cluster will grow to four or more, then deploy using the default policy. If you're sure your cluster will
grow, then instead of expanding the cluster after your initial deployment, we recommend deploying the extra hosts during
deployment. As the VMs are deployed to the cluster, change the disk's storage policy in the VM settings to either RAID-5
FTT-1 or RAID-6 FTT-2. In reference to SLA for Azure VMware Solution, note that more than 6 hosts should be
configured in the cluster to use an FTT-2 policy (RAID-1, or RAID-6). Also note that the storage policy is not automatically
updated based on cluster size. Similarly, changing the default does not automatically update the running VM policies.

Data-at-rest encryption

vSAN datastores use data-at-rest encryption by default using keys stored in Azure Key Vault. The encryption
solution is KMS-based and supports vCenter Server operations for key management. When a host is removed
from a cluster, all data on SSDs is invalidated immediately.

Azure storage integration

You can use Azure storage services in workloads running in your private cloud. The Azure storage services
include Storage Accounts, Table Storage, and Blob Storage. The connection of workloads to Azure storage
services doesn't traverse the internet. This connectivity provides more security and enables you to use SLA-
based Azure storage services in your private cloud workloads. You can also connect Azure disk pools or Azure
NetApp Files datastores to expand the storage capacity.

Alerts and monitoring

Microsoft provides alerts when capacity consumption exceeds 75%. In addition, you can monitor capacity
consumption metrics that are integrated into Azure Monitor. For more information, see Configure Azure Alerts
in Azure VMware Solution.

Next steps
Now that you've covered Azure VMware Solution storage concepts, you may want to learn about:

e Attach disk pools to Azure VMware Solution hosts (Preview) - You can use disks as the persistent storage
for Azure VMware Solution for optimal cost and performance.

e Configure storage policy - Each VM deployed to a vSAN datastore is assigned at least one VM storage
policy. You can assign a VM storage policy in an initial deployment of a VM or when you perform other
VM operations, such as cloning or migrating.

e Scale clusters in the private cloud - You can scale the clusters and hosts in a private cloud as required for
your application workload. Performance and availability limitations for specific services should be
addressed on a case by case basis.

e Azure NetApp Files with Azure VMware Solution - You can use Azure NetApp Files to migrate and run the
most demanding enterprise file-workloads in the cloud: databases, SAP, and high-performance
computing applications, with no code changes. Azure NetApp Files volumes can be attached to virtual
machines and can also be connected as data stores directly to Azure VMware Solution. This functionality


https://azure.microsoft.com/support/legal/sla/azure-vmware/v1_1/

is in preview.

vSphere role-based access control for Azure VMware Solution - You use vCenter Server to manage VM
workloads and NSX-T Manager to manage and extend the private cloud. Access and identity
management use the CloudAdmin role for vCenter Server and restricted administrator rights for NSX-T
Manager.
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Microsoft Azure native services let you monitor, manage, and protect your virtual machines (VMs) in a hybrid
environment (Azure, Azure VMware Solution, and on-premises). In this article, you'll integrate Azure native
services in your Azure VMware Solution private cloud. You'll also learn how to use the tools to manage your
VMs throughout their lifecycle.

The Azure native services that you can integrate with Azure VMware Solution include:

e Azure Arc extends Azure management to any infrastructure, including Azure VMware Solution, on-
premises, or other cloud platforms. Azure Arc-enabled servers lets you manage your Windows and Linux
physical servers and virtual machines hosted outside of Azure, on your corporate network, or another
cloud provider. You can attach a Kubernetes cluster hosted in your Azure VMware Solution environment
using Azure Arc enabled Kubernetes.

e Azure Monitor collects, analyzes, and acts on telemetry from your cloud and on-premises
environments. It requires no deployment. You can monitor guest operating system performance to
discover and map application dependencies for Azure VMware Solution or on-premises VMs. Your Log
Analytics workspace in Azure Monitor enables log collection and performance counter collection using
the Log Analytics agent or extensions.

With Azure Monitor, you can collect data from different sources to monitor and analyze and different
types of data for analysis, visualization, and alerting. You can also create alert rules to identify issues in
your environment, like high use of resources, missing patches, low disk space, and heartbeat of your
VMs. You can set an automated response to detected events by sending an alert to IT Service
Management (ITSM) tools. Alert detection notification can also be sent via email.

e Microsoft Defender for Cloud strengthens data centers' security and provides advanced threat
protection across hybrid workloads in the cloud or on-premises. It assesses Azure VMware Solution VMs'

vulnerability, raises alerts as needed, and forwards them to Azure Monitor for resolution. For instance, it

assesses missing operating system patches, security misconfigurations, and endpoint protection. You can

also define security policies in Microsoft Defender for Cloud.

e Azure Update Management manages operating system updates for your Windows and Linux
machines in a hybrid environment in Azure Automation. It monitors patching compliance and forwards
patching deviation alerts to Azure Monitor for remediation. Azure Update Management must connect to
your Log Analytics workspace to use stored data to assess the status of updates on your VMs.

e Log Analytics workspace stores log data. Each workspace has its own data repository and
configuration to store data. You can monitor Azure VMware Solution VMs through the Log Analytics
agent. Machines connected to the Log Analytics Workspace use the Log Analytics agent to collect data
about changes to installed software, Microsoft services, Windows registry and files, and Linux daemons
on monitored servers. When data is available, the agent sends it to Azure Monitor Logs for processing.
Azure Monitor Logs applies logic to the received data, records it, and makes it available for analysis. Use
the Azure Arc enabled servers VM extensions support to deploy Log Analytics agents on VMs.

Benefits

e Azure native services can be used to manage your VMs in a hybrid environment (Azure, Azure VMware
Solution, and on-premises).

e Integrated monitoring and visibility of your Azure, Azure VMware Solution, and on-premises VMs.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/integrate-azure-native-services.md
https://docs.microsoft.com/en-us/azure/azure-arc/servers/overview
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https://docs.microsoft.com/en-us/azure/azure-monitor/data-platform
file:///C:/localrun/t/1pp1/gn1d/azure/security-center/security-center-services.html
https://docs.microsoft.com/en-us/azure/azure-monitor/agents/log-analytics-agent
https://docs.microsoft.com/en-us/azure/azure-arc/servers/manage-vm-extensions

e With Azure Update Management in Azure Automation, you can manage operating system updates for both
your Windows and Linux machines.

e Microsoft Defender for Cloud provides advanced threat protection, including:
o File integrity monitoring
o Fileless security alerts
o QOperating system patch assessment
o Security misconfigurations assessment
o Endpoint protection assessment

e Easily deploy the Log Analytics agent using Azure Arc enabled servers VM extension support for new and
existing VMs.

e Your Log Analytics workspace in Azure Monitor enables log collection and performance counter collection
using the Log Analytics agent or extensions. Collect data and logs to a single point and present that data to
different Azure native services.

e Added benefits of Azure Monitor include:
o Seamless monitoring
o Better infrastructure visibility
o Instant notifications

o Automatic resolution

o

Cost efficiency

Topology

The diagram shows the integrated monitoring architecture for Azure VMware Solution VMs.
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The Log Analytics agent enables collection of log data from Azure, Azure VMware Solution, and on-premises
VMs. The log data is sent to Azure Monitor Logs and stored in a Log Analytics workspace. You can deploy the
Log Analytics agent using Arc enabled servers VM extensions support for new and existing VMs.

Once the Log Analytics workspace collects the logs, you can configure the Log Analytics workspace with
Defender for Cloud to assess the vulnerability status of Azure VMware Solution VMs and raise an alert for any


https://docs.microsoft.com/en-us/azure/azure-arc/servers/manage-vm-extensions

critical vulnerability. For instance, it assesses missing operating system patches, security misconfigurations, and
endpoint protection.

You can configure the Log Analytics workspace with Microsoft Sentinel for alert detection, threat visibility,
hunting, and threat response. In the preceding diagram, Defender for Cloud is connected to Microsoft Sentinel
using the Defender for Cloud connector. Defender for Cloud forwards the environment vulnerability to
Microsoft Sentinel to create an incident and map with other threats. You can also create the scheduled rules
query to detect unwanted activity and convert it to the incidents.

Before you start

If you are new to Azure or unfamiliar with any of the services previously mentioned, review the following
articles:

e Automation account authentication overview

e Designing your Azure Monitor Logs deployment and Azure Monitor

e Planning and Supported platforms for Microsoft Defender for Cloud

e Enable Azure Monitor for VMs overview

e Whatis Azure Arc enabled servers? and What is Azure Arc enabled Kubernetes?

e Update Management overview

Enable Azure Update Management

Azure Update Management in Azure Automation manages operating system updates for your Windows and
Linux machines in a hybrid environment. It monitors patching compliance and forwards patching deviation
alerts to Azure Monitor for remediation. Azure Update Management must connect to your Log Analytics
workspace to use stored data to assess the status of updates on your VMs.

1. Before you can add Log Analytics Workspace to Azure Update Management, you first need to Create an
Azure Automation account.

TIP

You can use an Azure Resource Manager (ARM) template to create an Automation account. Using an ARM

template takes fewer steps compared to other deployment methods.

2. Create a Log Analytics workspace in the Azure portal. If you prefer, you can also create a workspace via
CLI, PowerShell, or Azure Resource Manager template.

3. Enable Update Management from an Automation account. In the process, you'll link your Log Analytics
workspace with your automation account.

4. Once you've enabled Update Management, you can deploy updates on VMs and review the results.

Enable Microsoft Defender for Cloud

Assess the vulnerability of Azure VMware Solution VMs and raise alerts as needed. These security alerts can be
forwarded to Azure Monitor for resolution. For more information, see Supported features for VMs.

Defender for Cloud offers many features, including:

e File integrity monitoring
e Fileless attack detection

e Operating system patch assessment


file:///C:/localrun/t/1pp1/gn1d/azure/security-center/security-center-services.html
https://docs.microsoft.com/en-us/azure/automation/automation-security-overview
https://docs.microsoft.com/en-us/azure/azure-monitor/logs/workspace-design
https://docs.microsoft.com/en-us/azure/azure-monitor/overview
file:///C:/localrun/t/1pp1/gn1d/azure/security-center/security-center-planning-and-operations-guide.html
file:///C:/localrun/t/1pp1/gn1d/azure/security-center/security-center-os-coverage.html
https://docs.microsoft.com/en-us/azure/azure-monitor/vm/vminsights-enable-overview
https://docs.microsoft.com/en-us/azure/azure-arc/servers/overview
https://docs.microsoft.com/en-us/azure/azure-arc/kubernetes/overview
https://docs.microsoft.com/en-us/azure/automation/update-management/overview
https://docs.microsoft.com/en-us/azure/automation/update-management/overview
https://docs.microsoft.com/en-us/azure/automation/automation-create-standalone-account
https://docs.microsoft.com/en-us/azure/automation/quickstart-create-automation-account-template
https://docs.microsoft.com/en-us/azure/azure-monitor/logs/quick-create-workspace
https://docs.microsoft.com/en-us/azure/azure-monitor/logs/resource-manager-workspace
https://docs.microsoft.com/en-us/azure/azure-monitor/logs/powershell-workspace-configuration
https://docs.microsoft.com/en-us/azure/azure-monitor/logs/resource-manager-workspace
https://docs.microsoft.com/en-us/azure/automation/update-management/enable-from-automation-account
https://docs.microsoft.com/en-us/azure/automation/update-management/deploy-updates
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e Security misconfigurations assessment

e Endpoint protection assessment

NOTE

Microsoft Defender for Cloud is a pre-configured tool that doesn't require deployment, but you'll need to enable it in the

Azure portal.

1. Add Azure VMware Solution VMs to Defender for Cloud.

2. Enable Microsoft Defender for Cloud. Defender for Cloud assesses the VMs for potential security issues. It

also provides security recommendations in the Overview tab.

3. Define security policies in Defender for Cloud.

For more information, see Integrate Microsoft Defender for Cloud with Azure VMware Solution.

Onboard VMs to Azure Arc enabled servers

Extend Azure management to any infrastructure, including Azure VMware Solution, on-premises, or other cloud
platforms. For information on enabling Azure Arc enabled servers for multiple Windows or Linux VMs, see
Connect hybrid machines to Azure at scale.

Onboard hybrid Kubernetes clusters with Azure Arc-enabled
Kubernetes

Attach a Kubernetes cluster hosted in your Azure VMware Solution environment using Azure Arc enabled
Kubernetes. For more information, see Create an Azure Arc-enabled Kubernetes cluster.

Deploy the Log Analytics agent

Monitor Azure VMware Solution VMs through the Log Analytics agent. Machines connected to the Log Analytics
workspace use the Log Analytics agent to collect data about changes to installed software, Microsoft services,
Windows registry and files, and Linux daemons on monitored servers. When data is available, the agent sends it
to Azure Monitor Logs for processing. Azure Monitor Logs applies logic to the received data, records it, and
makes it available for analysis.

Deploy the Log Analytics agent by using Azure Arc-enabled servers VM extension support.

Enable Azure Monitor

Can collect data from different sources to monitor and analyze and different types of data for analysis,
visualization, and alerting. You can also create alert rules to identify issues in your environment, like high use of
resources, missing patches, low disk space, and heartbeat of your VMs. You can set an automated response to
detected events by sending an alert to IT Service Management (ITSM) tools. Alert detection notification can also
be sent via email.

Monitor guest operating system performance to discover and map application dependencies for Azure VMware
Solution or on-premises VMs. Your Log Analytics workspace in Azure Monitor enables log collection and
performance counter collection using the Log Analytics agent or extensions.

1. Design your Azure Monitor Logs deployment
2. Enable Azure Monitor for VMs overview

3. Configure Log Analytics workspace for Azure Monitor for VMs.
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4. Create alert rules to identify issues in your environment:

e Create, view, and manage metric alerts using Azure Monitor.

Create, view, and manage log alerts using Azure Monitor.

Action rules to set automated actions and notifications.

Connect Azure to ITSM tools using IT Service Management Connector.

Next steps

Now that you've covered Azure VMware Solution network and interconnectivity concepts, you may want to
learn about integrating Microsoft Defender for Cloud with Azure VMware Solution.
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Integrate Microsoft Defender for Cloud with Azure

VMware Solution

8/19/2022 « 4 minutes to read » Edit Online

Microsoft Defender for Cloud provides advanced threat protection across your Azure VMware Solution and on-
premises virtual machines (VMs). It assesses the vulnerability of Azure VMware Solution VMs and raises alerts
as needed. These security alerts can be forwarded to Azure Monitor for resolution. You can define security
policies in Microsoft Defender for Cloud. For more information, see Working with security policies.

Microsoft Defender for Cloud offers many features, including:

e File integrity monitoring

e Fileless attack detection

e QOperating system patch assessment

e Security misconfigurations assessment

e Endpoint protection assessment

The diagram shows the integrated monitoring architecture of integrated security for Azure VMware Solution
VMs.

On-premises environment

Domain Controller On-premises VIV On-premises VM
Log Analytics Agent
Azure Sentinel
A
:®
jm}
. . 1T
Sentinel Security .
Center Connector Log Analytic
Workspace
Log Analytics Agent

Azure VMware Solution

Domain Centroller Azure VMware Azure VMware
Selution VM Solution VM

Security Center

Log Analytics agent collects log data from Azure, Azure VMware Solution, and on-premises VMs. The log data
is sent to Azure Monitor Logs and stored in a Log Analytics Workspace. Each workspace has its own data
repository and configuration to store data. Once the logs are collected, Microsoft Defender for Cloud
assesses the vulnerability status of Azure VMware Solution VMs and raises an alert for any critical vulnerability.
Once assessed, Microsoft Defender for Cloud forwards the vulnerability status to Microsoft Sentinel to create an
incident and map with other threats. Microsoft Defender for Cloud is connected to Microsoft Sentinel using
Microsoft Defender for Cloud Connector.
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Prerequisites

e Plan for optimized use of Defender for Cloud.

Review the supported platforms in Defender for Cloud.

Create a Log Analytics workspace to collect data from various sources.

Enable Microsoft Defender for Cloud in your subscription.

NOTE

Microsoft Defender for Cloud is a pre-configured tool that doesn't require deployment, but you'll need to enable
it.

o Enable Microsoft Defender for Cloud.

Add Azure VMware Solution VMs to Defender for Cloud

1. In the Azure portal, search on Azure Arc and select it.

2. Under Resources, select Servers and then + Add.

Home » Azure Arc

g Azure Arc| Servers

== Microsoft

« + Add | €% Manageview »» () Refresh & Exporito CSV °F Openguery [ Resource Explarer Assigntags | O Feedback
[ el J
venien Subscription == all Resource group == all X location == all X g Add filter

Bl All Azure Arc resources

Showing 110 1 of 1 records. No grouping ~ | [ Listview
Resources

[ Name * Status Resource group T4 Subscription T4, Datacenter (tag) ™ Operating system T4
B servers

[ & contoso-1 Connected Contoso-RG System Center DPM Azure.. Windows.

& Kubemetes clusters (preview)

3. Select Generate script.

Home > Azure Arc >

Select a method

To connect servers (both from on-premises and other clouds) to Azure, deploy the Azure Connected Machine agent to your servers.
Select from one of the options below to onboard your servers. Learn more

Add servers using interactive script Add servers at scale

Generate a script to onboard the target server, Use If you are running the deployment at scale, you will

this opticn to run the script which will prompt for need to provide a Service Principal Name with the

your Azure legin during deployment time, minimum set of Azure permissicns to onbeard
your servers.

Generate script Learn more View instructions

4. On the Prerequisites tab, select Next.

5. On the Resource details tab, fill in the following details and then select Next: Tags.
e Subscription
e Resource group
e Region

e QOperating system
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e Proxy Server details
6. On the Tags tab, select Next.
7. On the Download and run script tab, select Download.

8. Specify your operating system and run the script on your Azure VMware Solution VM.

View recommendations and passed assessments
Recommendations and assessments provide you with the security health details of your resource.
1. In Microsoft Defender for Cloud, select Inventory from the left pane.

2. For Resource type, select Servers - Azure Arc.

Home > Secunty Center

ity Center | Inventory

sbscript

[ps | Y Subscrptions () Refresh = Add non-Azure servers 5 Open query 4 Download CSV report (&) T c @ Learn more
General
© Ovenview # Isthe new asset inventory helpful for you? O ¥es O No
& Gettir - T ——

Filter by name Resource groups All Resource typss servers - azure arc Recommendations All Agent monitoring All Azure Defender ANl
Z= Recor ations

Security findings contsin X @ Tag X *o Add filter

U Security alerts

Total Resources. Unhealthy Resources Unmonitored Resources
# Inventory

-« - -
& Community 1 7y -[ ) 1
Cloud Security -

[[] Resource name Ty Resource type Ty, Subscription T, Agent monitoring Ty, Azure Defender ™, Recommendations Ty
O Secure Score

[ & Contoso-1 System Center DPM Azure.. @ Monitored —
@ Regulatory compliance
U Azure Defender Page [ 1w |of 1

3. Select the name of your resource. A page opens showing the security health details of your resource.

4. Under Recommendation list, select the Recommendations, Passed assessments, and Unavailable
assessments tabs to view these details.

Home > Security Center »

Contoso-1

Azure Arc machine security health

Resource health Total recommendations Recommendations summary
. Contoso-1 2 High 1 I
n—-.-"
Medium 1
Low 1]

~  Azure Arc machine information

~ Recommendation list

Recommendations (2)  Passed assessments (0] Unavailable assessments (3)

Recommendation T Status
A vulnerability assessment solution should be enabled on your virtual machines m & Medium
Log Analytics agent should be installed on your Windows-based Azure Arc machines Preview 0 High

Deploy a Microsoft Sentinel workspace

Microsoft Sentinel provides security analytics, alert detection, and automated threat response across an
environment. It's a cloud-native, security information event management (SIEM) solution that's built on top of a
Log Analytics Workspace.



Since Microsoft Sentinel is built on top of a Log Analytics workspace, you'll only need to select the workspace

you want to use.
1. In the Azure portal, search for Microsoft Sentinel, and select it.
2. On the Microsoft Sentinel workspaces page, select + Add.

3. Select the Log Analytics workspace and select Add.

Enable data collector for security events

1. On the Microsoft Sentinel workspaces page, select the configured workspace.
2. Under Configuration, select Data connectors.

3. Under the Connector Name column, select Security Events from the list, and then select Open

connector page.

4. On the connector page, select the events you wish to stream and then select Apply Changes.

Home > Azure Sentinel workspaces > Azure Sentinel >

Security Events

B Security Events Instructions  Next steps
- N
Connected $¢ Microsoft @ 5 minutes ago 1. Download and install the agent
Status Provider Last Log Received - .
N Security Events logs are collected only from Windows agents,
s (R 4 3

Workbooks  Queries Analytic rules templates Choose where to install the agent:

v Install agent on Azure Windows Virtual Machine

Data received Go to log analytics
12¢ ~ Install agent on non-Azure Windows Machine
0
&
5( 2. Select which events to stream
# Al events - All windows security and Applocker events.
= * Common - A standard set of events for auditing purposes.
X * Minimal - A small set of events that might indicate potential threats. By enabling this option, you won't be able to have a full audit trail.
o & Naone - No security or AppLocker events,
Movember & November 15
g () Wene () Minimal () Cammon (8) Al Events
105.58«
Data types

# SecurityEvents

Connect Microsoft Sentinel with Microsoft Defender for Cloud

1. On the Microsoft Sentinel workspace page, select the configured workspace.
2. Under Configuration, select Data connectors.

3. Select Microsoft Defender for Cloud from the list and then select Open connector page.

Home > Azure Sentinel workspaces > Azure Sentinel

gz8 Azure Sentinel | Data connectors
[ [

Selected workspace: “ogupdatemanagement

O Refresh

General - 61 o2 A0
Connectors Connected Coming soon
@ Overview
»
O Logs [/ Search by name or provider Providers : All Data Types : All Status : All ©  Azure Security Center
@ News & guides Status 1.  Connector name T4 Connected # Microsoft (023 hours ...
- Status Provider Last Log Recev...
Threat management i -
n Azure Information Protection (Preview) [ =
. &8 icrosor scription
& Incidents Wicrozoft . N
Azure Security Center is 3 security management tool
al Workbooks that allows you to gain insight into your security state
o : 2] Azure Security Center across hybrid cloud workloads, reduce your exposure
© Hunting Microsoft 0 attacks, and respond to detected threats quickly.
= Follow these Instructions to stream your security
& Notebooks (Preview) . alerts fram Azure Security Center into Sentinel, This
lotebooks (Preview Azure Security Center for loT (Preview) ° e
9 crosatt connection gives you more insight into your
& Entity behavior ’ erganization’s network by view dashboards, create
custom alerts, run playbaoks and investigate.
&) Threat intelligence (Preview] & Azure Web Application Firewall (WAF)
Wicrasoft For more information>
Configuration
Reizted contert
8 Data connectors Barracuda CloudGen Firewall | Open connector page |
74 Open connector page
rraeas pen pag:
& Analytics - - -

4. Select Connect to connect the Microsoft Defender for Cloud with Microsoft Sentinel.

5. Enable Create incident to generate an incident for Microsoft Defender for Cloud.



Create rules to identify security threats

After connecting data sources to Microsoft Sentinel, you can create rules to generate alerts for detected threats.
In the following example, we'll create a rule for attempts to sign in to Windows server with the wrong password.

1. On the Microsoft Sentinel overview page, under Configurations, select Analytics.
2. Under Configurations, select Analytics.
3. Select +Create and on the drop-down, select Scheduled query rule.
4. On the General tab, enter the required information and then select Next: Set rule logic.
e Name
e Description
® Tactics
e Severity
e Status
5. Onthe Set rule logic tab, enter the required information, and then select Next.

e Rule query (here showing our example query)

SecurityEvent

|where Activity startswith '4625'

| summarize count () by IpAddress,Computer
|where count_ > 3

e Map entities

e Query scheduling
o Alert threshold
e Event grouping
e Suppression

6. On the Incident settings tab, enable Create incidents from alerts triggered by this analytics
rule and select Next: Automated response.



Home = Microsoft Sentinel =

Analytics rule wizard - Create new rule & X

General Set rule logic Incident settings (Praview) Automated response Review and create

Create an analytics rule that will run on your data to detect threats.

Analytics rule details

Name *

Description

Tactics and technigues

| 0 selected RV |
Severity

| Medium N |
Status

(@) oiszbled )

Next : Set rule logic >

7. Select Next: Review.

8. On the Review and create tab, review the information, and select Create.

TIP

After the third failed attempt to sign in to Windows server, the created rule triggers an incident for every unsuccessful
attempt.

View alerts

You can view generated incidents with Microsoft Sentinel. You can also assign incidents and close them once

they're resolved, all from within Microsoft Sentinel.
1. Go to the Microsoft Sentinel overview page.
2. Under Threat Management, select Incidents.

3. Select an incident and then assign it to a team for resolution.



Home > Azure Sentinel workspaces > Azure Sentinel

= Azure Sentinel | Incidents

Selected workspace: ‘lagupdatemanagement’

‘,"‘ Search (Ctrl+/)

General

@ Overview

& Logs

& News & guides
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# workbooks
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Configuration
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Alerts
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Open incidents by severity
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TIP

After resolving the issue, you can close it.

Hunt security threats with queries

You can create queries or use the available pre-defined query in Microsoft Sentinel to identify threats in your
environment. The following steps run a pre-defined query.

1. On the Microsoft Sentinel overview page, under Threat management, select Hunting. A list of pre-

defined queries is displayed.

TIP

Home = Microsoft Sentinel

| £ Search (Ctrl+/)

General

@ Overview

¢3 Microsoft Sentinel | Hunting
Selected workspace: 'CyberSecuritySOC'

O Refresh (D Last 24 hours ~~

You can also create a new query by selecting New Query.

+ New Query [> Run all queries (Preview)

Columns

@ Logs

& News & guides
Threat management
& Incidents

# workbooks

© Hunting

& Notebooks

#* Entity behavier

& Threat intelligence (Preview)

@ = -
@) 224 /249 = 0,0 BEo
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0] — $ D % ™ w prs
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PreAttack  Initial Ac.. Execution  Persiste.,  Privilege.. Defense.. Credenti.. Discovery
| O Search queries Favorites : All Provider : All
D 4 Query Ty Provider Ty Data Source Ty Results 4
D *  Changes made to AWS ... Micrasoft AWSCloudTrail -

D % Consent to Application ... Microsoft
—

AuditLogs +1 (@ -

Data sources : All

RO

My bookmarks

2 ] =
16 27 31
Lateral ... Collection  Exfiltrati

Tactics : All
Results delta (Pre... Ty
N/A @
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2. Select a query and then select Run Query.

3. Select View Results to check the results.

Next steps

Now that you've covered how to protect your Azure VMware Solution VMs, you may want to learn about:




e Using the workload protection dashboard
e Advanced multistage attack detection in Microsoft Sentinel

e Integrating Azure native services in Azure VMware Solution
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Protect web apps on Azure VMware Solution with

Azure Application Gateway

8/19/2022 « 5 minutes to read  Edit Online

Azure Application Gateway is a layer 7 web traffic load balancer that lets you manage traffic to your web
applications. It's offered in both Azure VMware Solution v1.0 and v2.0. Both versions tested with web apps

running on Azure VMware Solution.
The capabilities include:

e Cookie-based session affinity
e URL-based routing
e \Web Application Firewall (WAF)

For a complete list of features, see Azure Application Gateway features.

This article shows you how to use Application Gateway in front of a web server farm to protect a web app
running on Azure VMware Solution.

Topology

The diagram shows how Application Gateway is used to protect Azure laaS virtual machines (VMs), Azure virtual
machine scale sets, or on-premises servers. Application Gateway treats Azure VMware Solution VMs as on-

premises servers.

HTTP Backend Pool
Setting

VMs
App Gateway
frontend IP HTTP / HTTPS
Browser K listener Rule
:
VMSS
(S R @ .......... @ _.(\/' ——
_L E’J e

VMs

IMPORTANT

Azure Application Gateway is currently the only supported method to expose web apps running on Azure VMware
Solution VMs.

The diagram shows the testing scenario used to validate the Application Gateway with Azure VMware Solution
web applications.
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The Application Gateway instance gets deployed on the hub in a dedicated subnet with an Azure public IP

address. Activating the Azure DDoS Protection Standard for the virtual network is recommended. The web
server is hosted on an Azure VMware Solution private cloud behind NSX TO and T1 Gateways. Additionally,
Azure VMware Solution uses ExpressRoute Global Reach to enable communication with the hub and on-
premises systems.

Prerequisites

e An Azure account with an active subscription.

e An Azure VMware Solution private cloud deployed and running.

Deployment and configuration
1. In the Azure portal, search for Application Gateway and select Create application gateway.

2. Provide the basic details as in the following figure; then select Next: Frontends>.
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Home > avs-test-rg > New > Application Gateway >

Create application gateway
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\— Resource group * (1)
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Create new

Instance details
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Enable autoscaling
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Minimum scale units * ()

o |
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10 |

Availability zone (O
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HTTP2 (&

(®) Disabled () Enabled

Configure virtual network

Virtual network * (0
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Create new

Subnet * (0

| AppGwSubnet (192.168.2.0/27) N |

Manage subnet configuration

Previous I Next : Frontends > I

3. Choose the frontend IP address type. For public, choose an existing public IP address or create a new one.
Select Next: Backends>.



NOTE
Only standard and Web Application Firewall (WAF) SKUs are supported for private frontends.

4. Add a backend pool of the VMs that run on Azure VMware Solution infrastructure. Provide the details of
web servers that run on the Azure VMware Solution private cloud and select Add. Then select Next:
Configuration>.

5. On the Configuration tab, select Add a routing rule.

6. On the Listener tab, provide the details for the listener. If HTTPS is selected, you must provide a
certificate, either from a PFX file or an existing Azure Key Vault certificate.

7. Select the Backend targets tab and select the backend pool previously created. For the HTTP settings
field, select Add new.

8. Configure the parameters for the HTTP settings. Select Add.

9. If you want to configure path-based rules, select Add multiple targets to create a path-based rule.
10. Add a path-based rule and select Add. Repeat to add more path-based rules.
11. When you have finished adding path-based rules, select Add again; then select Next: Tags>.
12. Add tags and then select Next: Review + Create>.

13. Avalidation runs on your Application Gateway. If it's successful, select Create to deploy.

Configuration examples

Now you'll configure Application Gateway with Azure VMware Solution VMs as backend pools for the following
use cases:

e Hosting multiple sites
e Routing by URL

Hosting multiple sites

This procedure shows you how to define backend address pools using VMs running on an Azure VMware
Solution private cloud on an existing application gateway.

NOTE

This procedure assumes you have multiple domains, so we'll use examples of www.contoso.com and www.fabrikam.com.

1. In your private cloud, create two different pools of VMs. One represents Contoso and the second
Fabrikam.


https://www.contoso.com
https://www.fabrikam.com

Menu

vm vSphere Client

m =2 8 @

2 % contoso-web-01 & & @ | acTionse
v [H10.176.0.2 Summary Monitor Configure Permissions Datastores Networks
~ [H sDDC-Datacenter
> £ Discovered virtual machine Guest O.S.'- Mlcr.osoft Windows Server ?O‘\G or later (64-bit)
Compatibility: ESXi 6.7 and later (VM version 14)

v [ Migrated VMs VMware Tools:
5 photon-vm2
Eﬁ photon-vm3
1 photon-vm4
Eﬁ photon-vmsS

» £ Templates

DNS Name:
IP Addresses:
Host:

Launch Web Console

Launch Remote Conscle @ ==

~ [ web-servers
~ [] Contoso

VM Hardware

[ contoso-web-01

[ contoso-web-02

CPU
~ [ Fabrikam
[ fabrikam-web-01 bl
[ fabrikam-web-02 Hard disk 1

5 hex-homelab-sm-1X-R1
5 hex-homelab-sm-NE-R1
% hex-homelab-sm-Wo-R1
5 vEBA-0.4.1

Metwork adapter 1

CD/DVD drive 1

Video card

Running, version:10346 (Current)

More info

contoso-web-01

172.16.2.20
esx22-r07.p0l.rstnOl.vmep.vs.management

2 CPU(s)
|:| 4 GB, 0.28 GB memaory active
40 GB

VM-Segment-01 (connected)
Disconnected

a8MB

We've used Windows Server 2016 with the Internet Information Services (IIS) role installed. Once the

VMs are installed, run the following PowerShell commands to configure IIS on each of the VMs.

Install-WindowsFeature -Name Web-Server

Add-Content -Path C:\inetpub\wwwroot\Default.htm -Value $($env:computername)

In an existing application gateway instance, select Backend pools from the left menu, select Add, and

enter the new pools' details. Select Add in the right pane.

Home >

i@ appgw-avs | Backend pools

~' Application gateway | @ Directory: Microsoft

P Search (Cmds/) «

+ Add | () Refresh

Add backend pool x

A backend pool is a collection of resources o which your application gateway can send traffic
A backend pool can contain virtual machines, virtual machines scale sets, IP addresses, domain
names, or an App Service.
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In the Listeners section, create a new listener for each website. Enter the details for each listener and

select Add.

. On the left, select HTTP settings and select Add in the left pane.

setting and select Save.

Fill in the details to create a new HTTP
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5. Create the rules in the Rules section of the left menu. Associate each rule with the corresponding listener.
Select Add.

6. Configure the corresponding backend pool and HTTP settings. Select Add.

7. Test the connection. Open your preferred browser and navigate to the different websites hosted on your
Azure VMware Solution environment, for example, http://www.fabrikam.com.

L ] [ www.fabrikam.com

(O & www.fabrikam.com

FABRIKAM-WEB-01

Routing by URL

The following steps define backend address pools using VMs running on an Azure VMware Solution private
cloud. The private cloud is on an existing application gateway. You then create routing rules that make sure web
traffic arrives at the appropriate servers in the pools.

1. In your private cloud, create a virtual machine pool to represent the web farm.
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http://www.fabrikam.com

vm vSphere Client

g 9 % contoso-web-03 =
v [110176.0.2 summary Monitor Configure Permissiot

v SDDC-Datacenter
Guest OS: Microsof

Compatibility: ESXi 6.7
VWMware Tools: Running,
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Windows Server 2016 with IIS role installed has been used to illustrate this tutorial. Once the VMs are
installed, run the following PowerShell commands to configure IIS for each VM tutorial.

The first virtual machine, contoso-web-01, hosts the main website.

Install-WindowsFeature -Name Web-Server
Add-Content -Path C:\inetpub\wwwroot\Default.htm -Value $($env:computername)

The second virtual machine, contoso-web-02, hosts the images site.

Install-WindowsFeature -Name Web-Server
New-Item -Path "C:\inetpub\wwwroot\" -Name "images" -ItemType "directory"
Add-Content -Path C:\inetpub\wwwroot\images\test.htm -Value $($env:computername)

The third virtual machine, contoso-web-03, hosts the video site.

Install-WindowsFeature -Name Web-Server
New-Item -Path "C:\inetpub\wwwroot\" -Name "video" -ItemType "directory"
Add-Content -Path C:\inetpub\wwwroot\video\test.htm -Value $($env:computername)

2. Add three new backend pools in an existing application gateway instance.

a. Select Backend pools from the left menu.

b. Select Add and enter the details of the first pool, contoso-web.
¢. Add one VM as the target.

d. Select Add.



e. Repeat this process for contoso-images and contoso-video, adding one unique VM as the target.

Home > Add backend pool x
i appgw-avs | Backend pools
=" Application gateway | @ Directory: Microsoft

Abackend pool is a collection of resourees to which your application gateway can send traffic.
£ Search (Cmd+/) « O Refresh A backend pool can contain virtual machines, virtual machines scale sets, IP addresses, domain

names, or an App Service

& Overview [ seareh backend pools N

lame *
Activity log Name Rules associated [ contoso-video .
fa Access control (IAM) contoso-web 1

Add backend pool without targets
Pl it
® 105 contoso-images 0 &N - )

& Diagnose and solve problerms

Backend targets
Settings 1item
Target type Target
& Configuration
@ Web application firevall [ 1P address or FaDN ~ | [17216235 -
[ 17 address or FaDN M |

% Backend pools

= HTTP settings

3. In the Listeners section, create a new listener of type Basic using port 8080.

4. On the left navigation, select HTTP settings and select Add in the left pane. Fill in the details to create a
new HTTP setting and select Save.

Add HTTP setting X

HTTP settings name *

I ccntoso—web—sening| "

Backend protocol

(®) Hre () HTTPS

Backend port *
| 80

Additional settings
Cookie-based affinity (0

O Enable @ Disable

Connection draining ()

O Enable @ Disable

Request time-out (seconds) * (O
[20 |

Override backend path @O

Host name

By default, Application Gateway does not change the incoming HTTP host header from the client and sends the header
unaltered to the backend. Multi-tenant services like App service or AP| management rely on a specific host header or SNI
extension to resolve to the correct endpoint. Change these settings to overwrite the incoming HTTP host header.

Override with new host name
o e
| [ o )
\ Yes A

Host name override
Pick host name from backend target

Owverride with specific domain name

£.g. contoso.com

Use custom probe (O

O Yes @ Mo

5. Create the rules in the Rules section of the left menu and associate each rule with the previously created
listener. Then configure the main backend pool and HTTP settings, and then select Add.
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Add a routing rule X

appgw-avs

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

Rule name * contoso-urlpath-rules v

*Listener *Backend targets

Choose a backend pool to which this routing rule will send traffic. You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend pool O Redirection

- | contoso-web ~ |
Backend target * (0

| contoso-web-setting Y |

HTTP settings * (O
Path-based routing

You can route traffic from this rule's listener to different backend targets based on the URL path of the request. You can also
apply a different set of HTTP settings based on the URL path.

Path based rules

Path Target name HTTP setting name Backend pool
fimages/* contoso-images contoso-web-setting contoso-images b
Svideo/™* contoso-video contaso-web-setting contoso-video see

Add multiple targets to create a path-based rule

6. Test the configuration. Access the application gateway on the Azure portal and copy the public IP address
in the Overview section.

a. Open a new browser window and enter the URL http://<app-gw-ip-address>:8080 .

o [ 52.224.75.131:8080 x +

()  ® NotSecure | 52.224.75.131 2 &' InPrivate

v

CONTOSO-WEB-01

b. Change the URL to http://<app-gw-ip-address>:8080/images/test.htm .

[} 52.224.75.131:8080fimages/t: X +

(=) (D) Not Secure | 52.224.75.131 g & InPrivate

CONTOSO-WEB-02

¢. Change the URL again to http://<app-guw-ip-address>:8088/video/test.htm .



[) 52.224.75.131:8080/videoftes: x +

(@ Not Secure | 52.224.75.131 &' InPrivate |

CONTOSO-WEB-03

Next Steps

Now that you've covered using Application Gateway to protect a web app running on Azure VMware Solution,
you may want to learn about:

Configuring Azure Application Gateway for different scenarios.

Deploying Traffic Manager to balance Azure VMware Solution workloads.

Integrating Azure NetApp Files with Azure VMware Solution-based workloads.

Protecting Azure resources in virtual networks.


https://docs.microsoft.com/en-us/azure/application-gateway/configuration-overview
https://docs.microsoft.com/en-us/azure/ddos-protection/ddos-protection-overview

Deploy Azure Traffic Manager to balance Azure

VMware Solution workloads

8/19/2022 - 3 minutes to read  Edit Online

This article walks through the steps of how to integrate Azure Traffic Manager with Azure VMware Solution. The
integration balances application workloads across multiple endpoints. This article also walks through the steps
of how to configure Traffic Manager to direct traffic between three Azure Application Gateway spanning several
Azure VMware Solution regions.

The gateways have Azure VMware Solution virtual machines (VMs) configured as backend pool members to
load balance the incoming layer 7 requests. For more information, see Use Azure Application Gateway to protect
your web apps on Azure VMware Solution

The diagram shows how Traffic Manager provides load balancing for the applications at the DNS level between
regional endpoints. The gateways have backend pool members configured as IIS Servers and referenced as
Azure VMware Solution external endpoints. Connection over the virtual network between the two private cloud
regions uses an ExpressRoute gateway.
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Before you begin, first review the Prerequisites and then we'll walk through the procedures to:

e Verify configuration of your application gateways and the NSX-T segment
e Create your Traffic Manager profile

e Add external endpoints into your Traffic Manager profile

Prerequisites
e Three VMs configured as Microsoft IIS Servers running in different Azure VMware Solution regions:

o West US


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/deploy-traffic-manager-balance-workloads.md
https://docs.microsoft.com/en-us/azure/traffic-manager/traffic-manager-overview
https://docs.microsoft.com/en-us/azure/application-gateway/overview
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/traffic-manager/traffic-manager-topology.png#lightbox

o West Europe

o East US (on-premises)

e An application gateway with external endpoints in the Azure VMware Solution regions mentioned above.

e Host with internet connectivity for verification.

e An NSX-T network segment created in Azure VMware Solution.

Verify your application gateways configuration

The following steps verify the configuration of your application gateways.

1. In the Azure portal, select Application gateways to view a list of your current application gateways:

e AVS-GW-WUS
o AVS-GW-EUS (on-premises)
e AVS-GW-WEU

S

Home

Application gateways =

+

== Editeolumns () Refrech

Subseriptions: 1 of 3 selected - Don't see & subscription? Open Directory + Subscription settings

p— ][ Azure VMware Sokution Test | [ A resource groups

v Al locations

| [ alitgs ~ | [ No grouping v

5items
[ Mame 1o Public IP address Private [P address
[ @ av 52.180.100.194

52.186.106.59

O 4 avs-ew-weu 2054136190

2. Select one of your previously deployed application gateways.

Resource group T4
Contoso-RG-WUS
Contoso-RG-EUS

Contoso-RG-WEU

Location Ty Subscription T4
West US Contoso AVS
East US

West Eurcpe

A window opens showing various information on the application gateway.

Home > Application gateways

lication gatew... & AVS-GW-WUS

- Add == Editcolumns - [0 Delete () Refresh
Fiter by name ¢ Overview ~  Resource group (change)
o Cantoso-RG-WUS
Activity log
] Name 7y a ocation
B, Access control (IAM) WestUs
O ¢ avsew-wus -
* T Subscription (change)

[ ¢ avs-ew-rus

0O ¢ asew-weu

Contoso-AVS

& Diagnose and solve problems

Subscription ID

78e3

Show data for last
HTTP settings

B3 Frontend IP configurations

1
L. Rules 10

N 3
£ Rewrites

Health probes

Properties

B Locks

1 hour

Sum Total Requests

Virtual network/subnet
West-VNet/west-gateway-subnet

Fron P

address
4 (west-pip)

e IP address

er
Standard V2

6hours 12 hour

Tdays  30dayc )

& SumFailed Requests 2

3. Select Backend pools to verify the configuration of one of the backend pools. You see one VM backend
pool member configured as a web server with an IP address of 172.29.1.10.
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_ Microsoft Azure & Search resources, services, and docs (G=/)

Home > Application gateways -

Edit backend pool

AVS-GW-WUS | Backend poaols >

A backend pool is a collection of resources to which your application gateway can send traffic. A
backend poal can contain virtual machines, virtual machines scale sets, IP addrasses domain names, or

an App Service.

Add backend pool without targets
Backend targets
1item

Target type Target

IP address or FODN

P address or FQDMN W

Associated mule
AVS-west-rule

Cancel

4. Verify the configuration of the other application gateways and backend pool members.

Verify the NSX-T segment configuration

The following steps verify the configuration of the NSX-T segment in the Azure VMware Solution environment.

1. Select Segments to view your configured segments. You see Contoso-segment1 connected to Contoso-

TO1 gateway, a Tier-1 flexible router.

»

2. SelectTier-1

1P Management

Gateways to see a list of Tier-1 gateways with the number of linked segments.

VM NSX
Home Networking  Security  Inventory  Plan & Troubleshoot  System Advanced Networking & Security
«
1 SEGMEN S &)
055 SEGMENTS SEGMENT S ®
%) Netweork Overview
ADD SEGMENT | by Name, Path or more =
Connactivity
Tier-0 Gateways Segment Name Connected Gateway & Typa Subnets Status
Tier-1 Gateways > % segment3 TNT45-T1] Tierl - Flexible 1 ® Up
SERVICE-NSERTION T1-Service-ns | Tier - Flexible 1 ®up
e Cery e I i > of Contoso-segment] Contoso-TO1 | Tier! - Flexible 1 ®up I
VPN > TNTAS-TO-MSFT-LS None - Flexible ®upC
» NAT > af TNTA5-TO-PRIVATELS None - Flexible ®up ¢
¥ Load Balancing
> e TNT4S-TOPUBLICLS Mone - Flexible ®uUp
Forwarding Pelicies
: VLANIG TNT45-T1| Tien - Flexible 1 ®Up ~
* REFRESH 1- 2161 21 Segments
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3. Select the segment linked to Contoso-TO1. A window opens showing the logical interface configured on
the Tier-01 router. It serves as a gateway to the backend pool member VM connected to the segment.

4. In the vSphere client, select the VM to view its details.

NOTE

Its IP address matches VM backend pool member configured as a web server from the preceding section:
172.29.1.10.

vm vSphere Client

1] @2 =] 2 5 Web-1West ¥ 5 L ACTIONS v

B EastUs-WestUs-Wo-RI = summary Monitor Configure Permissions Datastores Metworks
Teb-WestUS-[X-m
teb-WestUS-NE-R1

Guest 05 Microsott Wincl 2016 or later (64-bit) PU USAGE
Compatibility: ESXi 6.7 and lat sion 14) (] 91 MHz
VMware Tools: R rsion 10346 (Current)

F Pancrama-1

MEMORY USAGE
8 pythorym

655 MB

% Servicelnsertion-NS-282a72bc-Ocf1-4did-28¢ STORAGE USAGH
) Testiortest J 220.14 GB
vs.management

7 Veras-backup

£ vm-PaloAlio

‘Web-1West
[ web-2-Joshua

VM Hardware v Notes ~
B Winl0-vM

3 win172-25 Edit Notes.
@ Winl0-VM-temp Related Objecls ~

(3 Win2016-template i B3 custar Custom Attributes Y

Recent Tasks Alarms &

5. Select the VM, then select ACTIONS > Edit Settings to verify connection to the NSX-T segment.

Create your Traffic Manager profile

1. Sign in to the Azure portal. Under Azure Services > Networking, select Traffic Manager profiles.
2. Select + Add to create a new Traffic Manager profile.

3. Provide the following information and then select Create:

e Profile name
e Routing method (use weighted)
e Subscription

e Resource group

Add external endpoints into the Traffic Manager profile

1. Select the Traffic Manager profile from the search results pane, select Endpoints, and then + Add.
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2. For each of the external endpoints in the different regions, enter the required details and then select Add:

e Type

e Name

e Fully Qualified domain name (FQDN) or IP

e \Weight (assign a weight of 1 to each endpoint).

Once created, all three shows in the Traffic Manager profile. The monitor status of all three must be

Online.

3. Select Overview and copy the URL under DNS Name.

Home > Traffic er prof

Traffic Manager pr...  « Q Contoso - TM- Profile | Endpoints 3 X
+ anage v & Disable profile () Refresh —> Move [i Delete profile
" DNS name
bkt b [Fetp7/contosotm-profie traficmanager.net |
Name o -
& ATM-Ea
& Diagnose and solve problems
O Sear
Name T4 Monitor status T Type T4 Weight T
Online External endpoint
Online External endpoint
On-Prem Online External endpoint
Page [ 1 |of

L] D contoso-tm-profiletraffiemans x4+

[
InPrivate 4

Not Secure | contoso-tm-profile.trafficmanager.net

IS-WestEU

5. Refresh your browser. The screenshot shows traffic directing to another set of backend pool members in

the West US region.

L [ contoso-tm-profiletraffieman: x  +

[
InPrivate 4

Not Secure | contoso-tm-profile.trafficmanager.net

[1S-WestUS

6. Refresh your browser again. The screenshot shows traffic directing to the final set of backend pool

members on-premises.
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Next steps

Now that you've covered integrating Azure Traffic Manager with Azure VMware Solution, you may want to learn
about:

e Using Azure Application Gateway on Azure VMware Solution
e Traffic Manager routing methods
e Combining load-balancing services in Azure

e Measuring Traffic Manager performance


https://docs.microsoft.com/en-us/azure/traffic-manager/traffic-manager-routing-methods
https://docs.microsoft.com/en-us/azure/traffic-manager/traffic-manager-load-balancing-azure
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Configure Azure Alerts in Azure VMware Solution

8/19/2022 + 3 minutes to read « Edit Online

In this article, you'll learn how to configure Azure Action Groups in Microsoft Azure Alerts to receive
notifications of triggered events that you define. You'll also learn about using Azure Monitor Metrics to gain

deeper insights into your Azure VMware Solution private cloud.

NOTE
Incidents affecting the availability of an Azure VMware Solution host and its corresponding restoration are sent
automatically to the Account Administrator, Service Administrator (Classic Permission), Co-Admins (Classic Permission),

and Owners (RBAC Role) of the subscription(s) containing Azure VMware Solution private clouds.

Supported metrics and activities

The following metrics are visible through Azure Monitor Metrics.

SIGNAL NAME SIGNAL TYPE MONITOR SERVICE
Datastore Disk Total Capacity Metric Platform
Percentage Datastore Disk Used Metric Platform
Percentage CPU Metric Platform
Average Effective Memory Metric Platform
Average Memory Overhead Metric Platform
Average Total Memory Metric Platform
Average Memory Usage Metric Platform
Datastore Disk Used Metric Platform

All Administrative operations Activity Log Administrative
Register Microsoft.AVS resource Activity Log Administrative

provider. (Microsoft.AVS/privateClouds)

Create or update a PrivateCloud. Activity Log Administrative
(Microsoft. AVS/privateClouds)

Delete a PrivateCloud. Activity Log Administrative
(Microsoft.AVS/privateClouds)

Configure an alert rule

1. From your Azure VMware Solution private cloud, select Monitoring > Alerts, and then New alert rule.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-alerts-for-azure-vmware-solution.md
https://docs.microsoft.com/en-us/azure/azure-monitor/alerts/action-groups
https://docs.microsoft.com/en-us/azure/azure-monitor/alerts/alerts-overview
https://docs.microsoft.com/en-us/azure/azure-monitor/essentials/data-platform-metrics
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Dashboard > avs-pc-ncus

Ej avs-pe-ncus | Alerts 2 - x

AVS Private cloud

R search (Ctrl+/) «

5:@3 Manage zlert rules pﬂ Manage actions L view classic alerts O Refresh ' Feedback
@ Overview

Activity log

A Access control (1AM)

L Tags

& Diagnose and solve problems
Settings

£ Locks

Manage

& Connectivity
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B Clusters

Workload Networking

< Segments

T DHCP

BN Port mirroring

@ oDns

Monitoring

| B Alerts
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A new configuration screen opens where you'll:

e Define the Scope

Configure a Condition
e Set up the Action Group
e Define the Alert rule details

Create alert rule

Rules management

D e e e e e e e = mm e e e e e e e e

Condition name

o Whenever the Activity Log has an event with Category="Administrative’, Signal name="All Administrative operations'

Select condition

o You can only define one Activity Log signal per alert rule. To alert on more signals, please create additional alert rules.

Action group

Send notifications or invoke actions when the alert rule triggers, by selecting or creating a new action group. Learn more
Action group name Contains actions
Send email action group 1 Email Azure Resource Manager Role @

Select action group

Alert rule details

Provide details on your alert rule so that you can identify and manage it later.

Alert rule name * @ Email alert \/
Description Send email to owners on all administrative operations on the lab e
Save alert rule to resource group * (@O | contosorg ~
Enable alert rule upon creation

Create alert rule
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2. Under Scope, select the target resource you want to monitor. By default, the Azure VMware Solution

private cloud from where you opened the Alerts menu has been defined.

3. Under Condition, select Add condition, and in the window that opens, selects the signal you want to

create for the alert rule.

In our example, we've selected Percentage Datastore Disk Used, which is relevant from an Azure

VMware Solution SLA perspective.

Configure signal logic X
Choose a signal below and configure the logic on the next screen to define the alert condition.

Signal type @ Monitor service (@

[ an v [ v |

Displaying 1 - 12 signals out of total 12 signals

| J search by signal name

Signal name

Datastore Disk Total Capacity

Percentage Datastore Disk Used

Percentage CPU

Average Effective Memory

Average Memory Cverhead

Average Total Memory

Average Memory Usage

Datastore Disk Used

All Administrative operations

Register Microsoft.AVS resource provider, (Microsoft.AvS/privateClouds)
Create or update a PrivateCloud. (Microsoft.AVS/privateClouds)

Delete a PrivateCloud. (Microsoft.AVS/privateClouds)

4. Define the logic that will trigger the alert and then select Done.

Ty

signal type

Metric
Metric
Metric
Metric
Metric
Metric

Metric

TR R R R RO

Metric

g Activity Log
g Activity Log
g Activity Log

g Activity Log

T4

Monitor service Ty
Flatform
Flatform
Platform
Platform
Flatform
Flatform
Flatform
Platform
Administrative
Administrative
Administrative

Administrative

In our example, only the Threshold and Frequency of evaluation have been adjusted.


https://azure.microsoft.com/support/legal/sla/azure-vmware/v1_1/

Configure signal logic

Define the logic for triggering an alert. Use the chart to view trends in the data.
< Edit signal

selected signal: Percentage Datastore Disk Used (Platform)

Selact time series (D) Chart period @

= Prev  Mext >
Aggregate i Cwer the last 6 hours

#

2 Ph 3PM 4P 5PN & Ph TPM

Percentage Datastore Disk Used [Awg)
SVE-DC-NOUE

45+

Split by dimensions

Use dimensions to monitor specific time series. If you select more than one dimension value, each time series that results from the
combination will trigger its own alert and will be charged separately. About monitoring multiple time series (D

Dimension name Operator Dimension values

custom value

Select dimension ~ | | = ~ 0 selected s

UTC+01:00

Alert logic

Threshold @
P = - ~
G oo )

Operator (O Aggregation type * @ Threshold value * (D

o Manitoring 1 time series ($0.1/time series)

| Greater than ~ | | Average ~ | | 63

Condition preview
Whenever the average percentage datastore disk used is greater than 65%
Evaluated based on

Aggregation granularity (Period) * (@ Frequency of evaluation (O

30 minutes ~ | | Every 15 Minutes

. Under Actions, select Add action groups. The action group defines how the notification is received and

who receives it. You can receive notifications by email, SMS, Azure Mobile App Push Notification or voice

message.
. Select an existing action group or select Create action group to create a new one.

. In the window that opens, on the Basics tab, give the action group a name and a display name.
. Select the Notifications tab, select a Notification Type and Name. Then select OK.

Our example is based on email notification.


https://azure.microsoft.com/features/azure-portal/mobile-app/

Home > Alerts » Manage actions > Emall/SMS message/PushNoice %
Create action group Add or edit an Email/SMS/Push/Voice action

B email

Email * [ on-call@contoso.com

Basics  Motifications  Actions  Tags  Review + create

Notifications

Configure the method in which users will be notified when the action group triggers. Select notification types, provide D SMS (Carrier charges may 3pply]

reciever details and add a unique description. This step is optional. Country code
Phone numt
Natification type (O Name (@ Selected (0 e number
[ Email/SMS message/PushiVaice v | [ Notify on-call team | Email @ A
Email Azure Resource Manager Role Natify subscription owners Owner A [] Azure app Push Natifications
Azure account emal O
\ > |
[ veice
Country code
Phone number
Enable the commeon alert schema. Leam more
Bl o )
[l | Previous | [ NextActions» |

9. (Optional) Configure the Actions if you want to take proactive actions and receive notification on the
event. Select an available Action type and then select Review + create.

e Automation Runbooks - to automate tasks based on alerts

e Azure Functions - for custom event-driven serverless code execution

e |TSM - to integrate with a service provider like ServiceNow to create a ticket
e Logic App - for more complex workflow orchestration

e Webhooks - to trigger a process in another service

10. Under the Alert rule details, provide a name, description, resource group to store the alert rule, the
severity. Then select Create alert rule.

The alert rule is visible and can be managed from the Azure portal.

£ Er T e U

Dashboard > avs-pc-ncus > avs-Ncus > avs-pe-ncus >

Rules - %
Rules management
T New alert rule Edit columns. ;h Manage actions [ view classic alerts O Refresh [> Enable D Disable i Delete
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As soon as a metric reaches the threshold as defined in an alert rule, the Alerts menu is updated and
made visible.
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Depending on the configured Action Group, you'll receive a notification through the configured medium.
In our example, we've configured email.
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Work with metrics

1. From your Azure VMware Solution private cloud, select Monitoring > Metrics. Then select the metric
you want from the drop-down.
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2. You can change the diagram's parameters, such as the Time range or the Time granularity.
Other options are:

e Drill into Logs and query the data in the related Log Analytics workspace

e Pin this diagram to an Azure Dashboard for convenience.
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Next steps

Now that you've configured an alert rule for your Azure VMware Solution private cloud, you may want to learn
even more about:

o Azure Monitor Metrics
o Azure Monitor Alerts

e Azure Action Groups

You can also continue with one of the other Azure VMware Solution how-to guides.
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Attach disk pools to Azure VMware Solution hosts
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Azure disk pools offer persistent block storage to applications and workloads backed by Azure Disks. You can
use disks as the persistent storage for Azure VMware Solution for optimal cost and performance. For example,
you can scale up by using disk pools instead of scaling clusters if you host storage-intensive workloads. You can
also use disks to replicate data from on-premises or primary VMware vSphere environments to disk storage for
the secondary site. To scale storage independent of the Azure VMware Solution hosts, we support surfacing
ultra disks, premium SSD and standard SSD as the datastores.

IMPORTANT

Azure disk pools on Azure VMware Solution (Preview) is currently in public preview. This preview version is provided
without a service level agreement, and it's not recommended for production workloads. Certain features might not be
supported or might have constrained capabilities. For more information, see Supplemental Terms of Use for Microsoft
Azure Previews.

Azure managed disks are attached to one iSCSI controller virtual machine deployed under the Azure VMware
Solution resource group. Disks get deployed as storage targets to a disk pool, and each storage target shows as
an iSCSI LUN under the iSCSI target. You can expose a disk pool as an iSCSI target connected to Azure VMware
Solution hosts as a datastore. A disk pool surfaces as a single endpoint for all underlying disks added as storage
targets. Each disk pool can have only one iSCSI controller.

The diagram shows how disk pools work with Azure VMware Solution hosts. Each iSCSI controller accesses
managed disk using a standard Azure protocol, and the Azure VMware Solution hosts can access the iSCSI
controller over iSCSI.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/attach-disk-pools-to-azure-vmware-solution-hosts.md
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-types
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-types
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-types
https://azure.microsoft.com/support/legal/preview-supplemental-terms/
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On-premises

Supported regions

You can only connect the disk pool to an Azure VMware Solution private cloud in the same region. For a list of
supported regions, see Regional availability. If your private cloud is deployed in a non-supported region, you
can redeploy it in a supported region. Azure VMware Solution private cloud and disk pool colocation provide
the best performance with minimal network latency.

Prerequisites

e Scalability and performance requirements of your workloads are identified. For details, see Planning for
Azure disk pools.

e Azure VMware Solution private cloud deployed with a virtual network configured. For more information,
see Network planning checklist and Configure networking for your VMware private cloud.

o If you select ultra disks, use an Ultra Performance ExpressRoute virtual network gateway for the
disk pool network connection to your Azure VMware Solution private cloud and then enable
ExpressRoute FastPath.


https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-planning
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-howto-linkvnet-arm

o If you select premium SSDs or standard SSDs, use a Standard (1 Gbps) or High Performance (2
Gbps) ExpressRoute virtual network gateway for the disk pool network connection to your Azure
VMware Solution private cloud.

e You must use Standard_DS##_v3 to host iSCSI. If you encounter quota issues, request an increase in
vCPU quota limits per Azure VM series for Dsv3 series.

e Disk pool as the backing storage deployed and exposed as an iSCSI target with each disk as an individual
LUN. For details, see Deploy an Azure disk pool.

IMPORTANT

The disk pool must be deployed in the same subscription as the VMware cluster, and it must be attached to the

same VNET as the VMware cluster.

Add a disk pool to your private cloud

You'll attach to a disk pool surfaced through an iSCSI target as the VMware datastore of an Azure VMware
Solution private cloud.

IMPORTANT

While in Public Preview, only attach a disk pool to a test or non-production cluster.

e Azure CLI

e Portal

Check if the subscription is registered to Microsoft.Avs .

az provider show -n "Microsoft.AVS" --query registrationState

If it's not already registered, then register it.

az provider register -n "Microsoft.AvVS"

Check if the subscription is registered to cloudsantxperience AFEC in Microsoft.AVS.

az feature show --name "CloudSanExperience" --namespace "Microsoft.AvVS"

If it's not already registered, then register it.

az feature register --name "CloudSanExperience" --namespace "Microsoft.AvVS"

The registration may take approximately 15 minutes to complete, you can use the following command to check
status:

az feature show --name "CloudSanExperience" --namespace "Microsoft.AVS" --query properties.state


file:///C:/localrun/t/1pp1/gn1d/azure/azure-portal/supportability/per-vm-quota-requests.html
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-deploy

TIP

If the registration is stuck in an intermediate state for longer than 15 minutes to complete, unregister and then re-
register the flag.

az feature unregister --name "CloudSanExperience" --namespace "Microsoft.AvVS"
az feature register --name "CloudSanExperience" --namespace "Microsoft.AvVS"

Check if the vmware extension is installed.

az extension show --name vmware

If the extension is already installed, check if the version is 3.0.0. If an older version is installed, update the

extension.

az extension update --name vmware

If it's not already installed, install it.

az extension add --name vmware

Attach the iSCSI LUN

Create and attach an iSCSI datastore in the Azure VMware Solution private cloud cluster using
Microsoft.StoragePool provided iSCSI target. The disk pool attaches to a virtual network through a delegated
subnet, which is done with the Microsoft.StoragePool/diskPools resource provider. If the subnet isn't delegated,

the deployment fails.

#Initialize input parameters
resourceGroupName="<yourRGName>"
name="'<desiredDataStoreName>"
cluster="<desiredCluster>"'
privateCloud="<privateCloud>"
lunName="'<desiredLunName>"

az vmware datastore disk-pool-volume create --name $name --resource-group $resourceGroupName --cluster
$cluster --private-cloud $privateCloud --target-id /subscriptions/11111111-1111-1111-1111-
111111111111/resourceGroups/ResourceGroupl/providers/Microsoft.StoragePool/diskPools/mpio-
diskpool/iscsiTargets/mpio-iscsi-target --lun-name $lunName

TIP

You can display the help on the datastores.

az vmware datastore -h

To confirm that the attach succeeded, you can use the following commands:

Show the details of an iSCSI datastore in a private cloud cluster.



az vmware datastore show --name MyCloudSANDatastorel --resource-group MyResourceGroup --cluster -Cluster-1 -
-private-cloud MyPrivateCloud

List all the datastores in a private cloud cluster.

az vmware datastore list --resource-group MyResourceGroup --cluster Cluster-1 --private-cloud MyPrivateCloud

Disconnect a disk pool from your private cloud

When you disconnect a disk pool, the disk pool resources aren't deleted. There's no maintenance window
required for this operation. But, be careful when you do it.

First, power off the VMs and remove all objects associated with the disk pool datastores, which includes:
e VMs (remove from inventory)

e Templates

e Snapshots

Then, delete the private cloud datastore.

1. Navigate to your Azure VMware Solution in the Azure portal.
2. Select Storage under Manage.
3. Select the disk pool you want to disconnect from and select Disconnect.
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& Access control (IAM) Name T Storage type TL Details Tier T Client clusters Connection health Virtual network TL
¢ Tags myLOB1pool Disk pool iscsl Basic (/O abc) 1 Healthy wnet?
# Diagnose and solve problems myDevsStoragepool Disk pool iscsl Premium {170 xyz) 1 Healthy wnet1
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Next steps

Now that you've attached a disk pool to your Azure VMware Solution hosts, you may want to learn about:

e Managing an Azure disk pool. Once you've deployed a disk pool, there are various management actions
available to you. You can add or remove a disk to or from a disk pool, update iSCSI LUN mapping, or add
ACLs.

e Deleting a disk pool. When you delete a disk pool, all the resources in the managed resource group are
also deleted.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/attach-disk-pools-to-azure-vmware-solution-hosts/disconnect-a-disk-pool.png#lightbox
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-manage
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-deprovision

e Disabling iSCSI support on a disk. If you disable iSCSI support on a disk pool, you effectively can no

longer use a disk pool.

e Moving disk pools to a different subscription. Move an Azure disk pool to a different subscription, which
involves moving the disk pool itself, contained disks, managed resource group, and all the resources.

e Troubleshooting disk pools. Review the common failure codes related to Azure disk pools (preview). It

also provides possible resolutions and some clarity on disk pool statuses.


https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-deprovision
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-move-resource
https://docs.microsoft.com/en-us/azure/virtual-machines/disks-pools-troubleshoot
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Azure NetApp Files is an enterprise-class, high-performance, metered file storage service. The service supports
the most demanding enterprise file-workloads in the cloud: databases, SAP, and high-performance computing
applications, with no code changes. For more information on Azure NetApp Files, see Azure NetApp Files
documentation.

Azure VMware Solution supports attaching Network File System (NFS) datastores as a persistent storage option.
You can create NFS datastores with Azure NetApp Files volumes and attach them to clusters of your choice. You
can also create virtual machines (VMs) for optimal cost and performance.

IMPORTANT

Azure NetApp Files datastores for Azure VMware Solution hosts is currently in public preview. This version is provided
without a service-level agreement and is not recommended for production workloads. Some features may not be
supported or may have constrained capabilities. For more information, see Supplemental Terms of Use for Microsoft Azure

Previews.

By using NFS datastores backed by Azure NetApp Files, you can expand your storage instead of scaling the
clusters. You can also use Azure NetApp Files volumes to replicate data from on-premises or primary VMware
environments for the secondary site.

Create your Azure VMware Solution and create Azure NetApp Files NFS volumes in the virtual network
connected to it using an ExpressRoute. Ensure there's connectivity from the private cloud to the NFS volumes
created. Use those volumes to create NFS datastores and attach the datastores to clusters of your choice in a
private cloud. As a native integration, no other permissions configured via vSphere are needed.

The following diagram demonstrates a typical architecture of Azure NetApp Files backed NFS datastores
attached to an Azure VMware Solution private cloud via ExpressRoute.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/attach-azure-netapp-files-to-azure-vmware-solution-hosts.md
https://docs.microsoft.com/en-us/azure/azure-netapp-files/azure-netapp-files-introduction
https://docs.microsoft.com/en-us/azure/azure-netapp-files/index
https://azure.microsoft.com/support/legal/preview-supplemental-terms/
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On-premises

Before you begin the prerequisites, review the Performance best practices section to learn about optimal

performance of NFS datastores on Azure NetApp Files volumes.

. Deploy Azure VMware Solution private cloud and a dedicated virtual network connected via ExpressRoute

gateway. The virtual network gateway should be configured with the Ultra performance SKU and have
FastPath enabled. For more information, see Configure networking for your VMware private cloud and
Network planning checklist.

Create an NFSv3 volume for Azure NetApp Files in the same virtual network created in the previous step.

a. Verify connectivity from the private cloud to Azure NetApp Files volume by pinging the attached
target IP

b. Verify the subscription is registered to the ANFAvsDatastore feature inthe Microsoft.NetApp
namespace. If the subscription isn't registered, register it now.

az feature register --name "ANFAvsDataStore" --namespace "Microsoft.NetApp"

az feature show --name "ANFAvsDataStore" --namespace "Microsoft.NetApp" --query
properties.state


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/attach-netapp-files-to-cloud/architecture-netapp-files-nfs-datastores.png#lightbox
https://docs.microsoft.com/en-us/azure/azure-netapp-files/azure-netapp-files-create-volumes

¢. Based on your performance requirements, select the correct service level needed for the Azure
NetApp Files capacity pool. For optimal performance, it's recommended to use the Ultra tier. Select
option Azure VMware Solution Datastore listed under the Protocol section.

d. Create a volume with Standard network features if available for ExpressRoute FastPath

connectivity.

e. Under the Protocol section, select Azure VMware Solution Datastore to indicate the volume is
created to use as a datastore for Azure VMware Solution private cloud.

f. If you're using export policies to control access to Azure NetApp Files volumes, enable the Azure
VMware private cloud IP range, not individual host IPs. Faulty hosts in a private cloud could get

replaced so if the IP isn't enabled, connectivity to datastore will be impacted.

Supported regions

Azure VMware Solution currently supports the following regions:
America : East US, West US, Central US, South Central US, North Central US, Canada East, Canada Central .

Europe : West Europe, North Europe, UK West, UK South, France Central, Switzerland West, Germany West
Central.

Asia : Southeast Asia, Japan West.
Australia : Australia East, Australia Southeast.
Brazil : Brazil South.

The list of supported regions will expand as the preview progresses.

Performance best practices

There are some important best practices to follow for optimal performance of NFS datastores on Azure NetApp
Files volumes.

e Create Azure NetApp Files volumes using Standard network features to enable optimized connectivity from
Azure VMware Solution private cloud via ExpressRoute FastPath connectivity.

e For optimized performance, choose UltraPerformance gateway and enable ExpressRoute FastPath from a
private cloud to Azure NetApp Files volumes virtual network. View more detailed information on gateway
SKUs at About ExpressRoute virtual network gateways.

e Based on your performance requirements, select the correct service level needed for the Azure NetApp Files

capacity pool. For best performance, it's recommended to use the Ultra tier.

e Create multiple datastores of 4-TB size for better performance. The default limit is 8 but it can be increased
up to a maximum of 256 by submitting a support ticket. To submit a support ticket, go to Create an Azure
support request.

e Work with your Microsoft representative to ensure that the Azure VMware Solution private cloud and the
Azure NetApp Files volumes are deployed within same Availability Zone.

Attach an Azure NetApp Files volume to your private cloud

e Portal
e Azure CLI

To attach an Azure NetApp Files volume to your private cloud using Portal, follow these steps:

1. Sign in to the Azure portal.


https://docs.microsoft.com/en-us/azure/azure-netapp-files/configure-network-features
https://docs.microsoft.com/en-us/azure/azure-netapp-files/azure-netapp-files-configure-export-policy
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-howto-linkvnet-arm
https://docs.microsoft.com/en-us/azure/expressroute/expressroute-about-virtual-network-gateways
https://docs.microsoft.com/en-us/azure/azure-portal/supportability/how-to-create-azure-support-request
https://docs.microsoft.com/en-us/azure/availability-zones/az-overview

2. Select Subscriptions to see a list of subscriptions.
3. From the list, select the subscription you want to use.
4. Under Settings, select Resource providers.

5. Search for Microsoft.AVS and select it.

6. Select Register.

7. Under Settings, select Preview features.

a. Verify you're registered for both the cloudsanExperience and AnfDatstoreExperience features.

8. Navigate to your Azure VMware Solution. Under Manage, select Storage (preview).
9. Select Connect Azure NetApp Files volume.

10. In Connect Azure NetApp Files volume, select the Subscription, NetApp account, Capacity pool,
and Volume to be attached as a datastore.

_ e ot ion i dooria 0

Home > MyTestCloud

= MyTestCloud | Storage (preview)

onnect a disk pool |+ Connect Az

‘Connect a disk pool

11. Verify the protocol is NFS. You'll need to verify the virtual network and subnet to ensure connectivity to
the Azure VMware Solution private cloud.

12. Under Associated cluster, select the Client cluster to associate the NFS volume as a datastore
13. Under Data store, create a personalized name for your Datastore name.

a. When the datastore is created, you should see all of your datastores in the Storage (preview).

b. You'll also notice that the NFS datastores are added in vCenter.

Disconnect an Azure NetApp Files-based datastore from your private

cloud

You can use the instructions provided to disconnect an Azure NetApp Files-based (ANF) datastore using either
Azure portal or Azure CLI. There's no maintenance window required for this operation. The disconnect action
only disconnects the ANF volume as a datastore, it doesn't delete the data or the ANF volume.

Disconnect an ANF datastore using the Azure Portal

1. Select the datastore you want to disconnect from.

2. Right-click on the datastore and select disconnect.

Disconnect an ANF datastore using Azure CLI


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/attach-netapp-files-to-cloud/connect-netapp-files-portal-experience-1.png#lightbox

az vmware datastore delete --name ANFDatastorel --resource-group MyResourceGroup --cluster Cluster-1 --
private-cloud MyPrivateCloud

Next steps

Now that you've attached a datastore on Azure NetApp Files-based NFS volume to your Azure VMware Solution

hosts, you can create your VMs. Use the following resources to learn more.

e Service levels for Azure NetApp Files

e Datastore protection using Azure NetApp Files snapshots
e About ExpressRoute virtual network gateways

e Understand Azure NetApp Files backup

e Guidelines for Azure NetApp Files network planning

FAQs

e Are there any special permissions required to create the datastore with the Azure NetApp
Files volume and attach it onto the clusters in a private cloud?

No other special permissions are needed. The datastore creation and attachment is implemented via
Azure VMware Solution control plane.

e Which NFS versions are supported?
NFSv3 is supported for datastores on Azure NetApp Files.
e Should Azure NetApp Files be in the same subscription as the private cloud?

It's recommended to create the Azure NetApp Files volumes for the datastores in the same VNet that has
connectivity to the private cloud.

e How many datastores are we supporting with Azure VMware Solution?

The default limit is 8 but it can be increased up to a maximum of 256 by submitting a support ticket. To
submit a support ticket, go to Create an Azure support request.

e What latencies and bandwidth can be expected from the datastores backed by Azure NetApp
Files?

We're currently validating and working on benchmarking. For now, follow the Performance best practices
outlined in this article.

e What are my options for backup and recovery?

Azure NetApp Files (ANF) supports snapshots of datastores for quick checkpoints for near term recovery
or quick clones. ANF backup lets you offload your ANF snapshots to Azure storage. This feature is
available in public preview. Only for this technology are copies and stores-changed blocks relative to
previously offloaded snapshots in an efficient format. This ability decreases Recovery Point Objective
(RPO) and Recovery Time Objective (RTO) while lowering backup data transfer burden on the Azure
VMware Solution service.

e How do | monitor Storage Usage?

Use Metrics for Azure NetApp Files to monitor storage and performance usage for the Datastore volume
and to set alerts.

e What metrics are available for monitoring?

Usage and performance metrics are available for monitoring the Datastore volume. Replication metrics
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are also available for ANF datastore that can be replicated to another region using Cross Regional

Replication. For more information about metrics, see Metrics for Azure NetApp Files.

What happens if a new node is added to the cluster, or an existing node is removed from the

cluster?

When you add a new node to the cluster, it will automatically gain access to the datastore. Removing an

existing node from the cluster won't affect the datastore.
How are the datastores charged, is there an additional charge?

Azure NetApp Files NFS volumes that are used as datastores will be billed following the capacity pool
based billing model. Billing will depend on the service level. There's no extra charge for using Azure

NetApp Files NFS volumes as datastores.
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Attach Azure NetApp Files to Azure VMware

Solution VMs
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Azure NetApp Files is an Azure service for migration and running the most demanding enterprise file-workloads
in the cloud: databases, SAP, and high-performance computing applications, with no code changes. In this article,
you'll set up, test, and verify the Azure NetApp Files volume as a file share for Azure VMware Solution workloads
using the Network File System (NFS) protocol. The guest operating system runs inside virtual machines (VMs)
accessing Azure NetApp Files volumes.

Azure NetApp Files and Azure VMware Solution are created in the same Azure region. Azure NetApp Files is
available in many Azure regions and supports cross-region replication. For information on Azure NetApp Files
configuration methods, see Storage hierarchy of Azure NetApp Files.

Services where Azure NetApp Files are used:

e Active Directory connections: Azure NetApp Files supports Understand guidelines for Active
Directory Domain Services site design and planning for Azure NetApp Files.

e Share Protocol: Azure NetApp Files supports Server Message Block (SMB) and Network File System
(NFS) protocols. This support means the volumes can be mounted on the Linux client and can be mapped
on Windows client.

e Azure VMware Solution: Azure NetApp Files shares can be mounted from VMs that are created in the
Azure VMware Solution environment.

The diagram shows a connection through Azure ExpressRoute to an Azure VMware Solution private cloud. The
Azure VMware Solution environment accesses the Azure NetApp Files share mounted on Azure VMware
Solution VMs.
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Prerequisites
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Azure subscription with Azure NetApp Files enabled

Subnet for Azure NetApp Files

Linux VM on Azure VMware Solution

Windows VMs on Azure VMware Solution

Create and mount Azure NetApp Files volumes

You'll create and mount Azure NetApp Files volumes onto Azure VMware Solution VMs.
1. Create a NetApp account.

2. Set up a capacity pool.

3. Create an SMB volume for Azure NetApp Files.

4. Create an NFS volume for Azure NetApp Files.

5. Delegate a subnet to Azure NetApp Files.

Verify pre-configured Azure NetApp Files

You'll verify the pre-configured Azure NetApp Files created in Azure on Azure NetApp Files Premium service

level.

1. In the Azure portal, under STORAGE, select Azure NetApp Files. A list of your configured Azure
NetApp Files will show.

Home >
Azure NetApp Files =
Microsoft
T~ Add Edit columns O Refresh % Assign tags

Subscriptions: All 3 selected - Don't see a subscription? Cpen Directory + Subscription settings

| Filter by name... | | All subscriptions ~ | | All resource groups ~ | | All locations ~
3 items

D Name Ty Type T4 Resource group T4 Location T4

|:| | Contoso-anfi MNetApp account Contoso-anfrgl West Europe

|:| & Contoso-anf2 MNetApp account Contoso-anfrg2 East US

|:| '_n__ Contoso-anf3 MNetApp account Contoso-anfrg3 East Europe

2. Select a configured NetApp Files account to view its settings. For example, select Contoso-anf2.

3. Select Capacity pools to verify the configured pool.
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» Contoso-anf2 =

= |
Nethpp account

|P kearch ictrl+) | « [ Delete
B Cuarvion & A\ Essentials
9 s Resource group Location
| Ac y
& A hyyleg Contoso-anfrg2 East US
Pa. Access control (1AM) Subscription Subscription 1D
Azure VMware Solution-sc 7BEHd52-7558-7tdp-87 45-7 8t
L4 Tags
. Storage service
Automation
= Emortlemplat == Capacity pools — Volumes
} = purchased pool of capacity used _‘ Container for active filesystem,
Resource explorer 2 i :
to provision volumes associated meta-data and
snapshots
Settings Learn more
Learn more
il properties
5 Locks

The Capacity pools page opens showing the capacity and service level. In this example, the storage pool is

configured as 4 TiB with a Premium service level.
4. Select Volumes to view volumes created under the capacity pool. (See preceding screenshot.)

5. Select a volume to view its configuration.

= anfpool (Contoso-anf/anfpool) | Volumes

Capacity pool

A2 search (Ctrl+)) | « -t Add volume ('_) Refresh
€ Tags e
|;) ISES.'ch volumes
Automation Name T4 Quota T4 Protocoltype Ty Mount path
5 Export template : Contaso-anfvolume 200 GiB MFSV3 10.22.3.4/ANFVOLUME
Resource explorer T; Contoso-volume 200 GiB NFSvd.1 10.22.3 4/kptest
Settings ?; Contoscanfvalurme 100 GiB MNFSv4.1 10.22.3.4,/UD
Hi Properties
ﬂ Locks

A window opens showing the configuration details of the volume.

= anfpool (Contoso-anf/anfpooll/anfvolume) =

Volume

[~ bearch e+ | « [ Resize & Edit [ Delete

B Overview o A Essentials

= e Resource group : Contoso-anfrg3 Capacity pool : anfpool
B Activity log
Mount path :10.22.3 4 /ANFYOLUME Protocol type : NFSv3
Ao i P yp
Access control (1AM)
b Subscription i Azure VMware Solution-sc Kerberos : Disabled
Tags
Subscription ID i 765tt452-7558-Ttdp-8745-78trt Location :EastUs 2
Automation Quota : 200 GiB Service level : Premium
3 Export template Virtual network/subnet | ANFVNET/myvnetl Hide snapshot path : No
Security Style 1 Unix

Resource explorer

You can see that anfvolume has a size of 200 GiB and is in capacity pool anfpool1. It's exported as an NFS
file share via 10.22.3.4;/ANFVOLUME. One private IP from the Azure Virtual Network (VNet) was created
for Azure NetApp Files and the NFS path to mount on the VM.

To learn about Azure NetApp Files volume performance by size or "Quota," see Performance

considerations for Azure NetApp Files.

Verify pre-configured Azure VMware Solution VM share mapping

To make your Azure NetApp Files share accessible to your Azure VMware Solution VM, you'll need to
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understand SMB and NFS share mapping. Only after configuring the SMB or NFS volumes, can you mount them
as documented here.

e SMB share: Create an Active Directory connection before deploying an SMB volume. The specified
domain controllers must be accessible by the delegated subnet of Azure NetApp Files for a successful
connection. Once the Active Directory is configured within the Azure NetApp Files account, it will appear
as a selectable item while creating SMB volumes.

e NFS share: Azure NetApp Files contributes to creating the volumes using NFS or dual protocol (NFS and
SMB). A volume's capacity consumption counts against its pool's provisioned capacity. NFS can be
mounted to the Linux server by using the command lines or /etc/fstab entries.

Next steps

Now that you've covered integrating Azure NetApp Files with your Azure VMware Solution workloads, you may
want to learn about:

e Resource limitations for Azure NetApp Files

e Guidelines for Azure NetApp Files network planning

e Cross-region replication of Azure NetApp Files volumes
e Azure NetApp Files NFS FAQs

e Azure NetApp Files SMB FAQs
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Install Cloud Backup for Virtual Machines
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Cloud Backup for Virtual Machines is a plug-in installed in the Azure VMware Solution and enables you to back
up and restore Azure NetApp Files datastores and virtual machines (VMs).

Use Cloud Backup for VMs to:

e Build and securely connect both legacy and cloud-native workloads across environments and unify
operations

e Provision and resize datastore volumes right from the Azure portal
e Take VM consistent snapshots for quick checkpoints

e Quickly recover VMs

Prerequisites

Before you can install Cloud Backup for Virtual Machines, you need to create an Azure service principle with the
required Azure NetApp Files privileges. If you've already created one, you can skip to the installation steps
below.

Install Cloud Backup for Virtual Machines using the Azure portal

You'll need to install Cloud Backup for Virtual Machines through the Azure portal as an add-on.
1. Sign in to your Azure VMware Solution private cloud.

2. Select Run command > Packages > NetApp.CBS.AVS > Install-NetAppCBSA.

| Run command
[0 search (ctrl+) | « O Refresh A Feedback
—+ Add-ons 7

Packages Run execution status
Workload Networking —_—

& Segments

“~  Name Description
T DHCP

> JSDR.Configuration 3.1.1 Powershell Module for confguration of JetStream Software on AVS. See JetStream Software, Inc. for support
& Port mirroring

> MicrosoftAvVS.Management 40.68 Various cmdlets for adminstrator level tasks in managing Azure WMWare Solutions
@ DnNs

> NetApp.CBS.AVS 1.0.11-preview Netapp CBS Appliance. See NetApp, Inc. for support
Operations v NetAppCBSAVS 10.12-preview Netapp €85 Appliance, See NetApp, Inc, for support
™ Run command Install-NetAppCBSAppliance Installs Cloud Backup for Virtual Machines to protect Virtual Machines and datastores based on Azure NetApp Files.
Mrieing Install-NetAppCBSApplianceUsingDHCP Installs Cloud Backup for Virtual Machines to protect Virtual Machines and datastores based on Azure NetApp Files.
B Alerts Invoke-ResetNetAppCBSApplianceVCente...  Resets the vCenter account used internally by the appliance.
# Metrics Invoke-UpgradeNetAppCBSAppliance Upgrades Cloud Backup for Virtual Machines for protection of Virtual Machines and datastores based on Azure NetApp Files.
&l Diagnostic settings Uninstall-NetAppCBSAppliance Uninstalls the virtual appliance.

3. Provide the required values, then select Run.
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Run command - Install-NetAppCBSAppliance X

Installs Cloud Backup for Virtual Machines to protect Virtual Machines and datastores

based on Azure MetApp Files,

Command parameters

AcceptMetAppEuladggrement * ®

(.:) False

ApplianceVirtualMachineMName * @

EsxiCluster (1)

VmDatastore * @

MetworkMapping * @

a7

ApplianceMetworkMame * ®

AppliancelPAddress * @

Metmask * (1)

Gateway * @

PrimaryDhs * @

ApplianceUser * @

AppliancePassward * ®

MaintenancelUserPassword * @

FIELD

ApplianceVirtualMachineName

EsxiCluster

VmDatastore

NetworkMapping

ApplianceNetworkName

AppliancelPAddress

Netmask

Gateway

VALUE

VM name for the appliance.

Destination ESXi cluster name to be used for deploying
the appliance.

Datastore to be used for the appliance.

Destination network to be used for the appliance.

Network name to be used for the appliance.

IPv4 address to be used for the appliance.

Subnet mask.

Gateway IP address.
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FIELD VALUE

PrimaryDNS Primary DNS server IP address.

ApplianceUser User Account for hosting API services in the appliance.

AppliancePassword Password of the user hosting API services in the
appliance.

MaintenanceUserPassword Password of the appliance maintenance user.

IMPORTANT

You can also install Cloud Backup for Virtual Machines using DHCP by running the package
NetAppCBSApplianceUsingDHCP . If you install Cloud Backup for Virtual Machines using DHCP, you don't need to
provide the values for the PrimaryDNS, Gateway, Netmask, and AppliancelPAddress fields. These values will be

automatically generated.

4. Check Notifications or the Run Execution Status tab to see the progress. For more information about
the status of the execution, see Run command in Azure VMware Solution.

Upon successful execution, the Cloud Backup for Virtual Machines will automatically be displayed in the

VMware vSphere client.

Upgrade Cloud Backup for Virtual Machines

You can execute this run command to upgrade the Cloud Backup for Virtual Machines to the next available
version.

IMPORTANT

Before you initiate the upgrade, you must:

® Back up the MySQL database of Cloud Backup for Virtual Machines.

® Take snapshot copies of Cloud Backup for Virtual Machines.

1. Select Run command > Packages > NetApp.CBS.AVS > Invoke-UpgradeNetAppCBSAppliance.
2. Provide the required values, and then select Run.

3. Check Notifications or the Run Execution Status pane to monitor the progress.

Uninstall Cloud Backup for Virtual Machines

You can execute the run command to uninstall Cloud Backup for Virtual Machines.

IMPORTANT

Before you initiate the upgrade, you must:

® Backup the MySQL database of Cloud Backup for Virtual Machines.
® Ensure that there are no other VMs installed in the VMware vSphere tag: AvS_ANF_CLOUD_ADMIN_VM_TAG . All VMs

with this tag will be deleted when you uninstall.




1. Select Run command > Packages > NetApp.CBS.AVS > Uninstall-NetAppCBSAppliance.
2. Provide the required values, and then select Run.

3. Check Notifications or the Run Execution Status pane to monitor the progress.

Change vCenter account password

You can execute this command to reset the vCenter account password:

1. SelectRun command > Packages > NetApp.CBS.AVS > Invoke-
ResetNetAppCBSApplianceVCenterPasswordA.

2. Provide the required values, then select Run.

3. Check Notifications or the Run Execution Status pane to monitor the progress.

Next steps

e Back up Azure NetApp Files datastores and VMs using Cloud Backup for Virtual Machines
e Restore VMs using Cloud Backup for Virtual Machines



Back up Azure NetApp Files datastores and VMs

using Cloud Backup for Virtual Machines
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From the VMware vSphere client, you can back up datastores and Virtual Machines (VMs) to the cloud.

Configure subscriptions

Before you back up your Azure NetApp Files datastores, you must add your Azure and Azure NetApp Files cloud
subscriptions.

Add Azure cloud subscription

1. Sign in to the VMware vSphere client.

2. From the left navigation, select Cloud Backup for Virtual Machines.
3. Select the Settings page and then select the Cloud Subscription tab.
4

. Select Add and then provide the required values from your Azure subscription.

Add Azure NetApp Files cloud subscription account

1. From the left navigation, select Cloud Backup for Virtual Machines.

2. Select Storage Systems.

3. Select Add to add the Azure NetApp Files cloud subscription account details.
4

. Provide the required values and then select Add to save your settings.

Create a backup policy

You must create backup policies before you can use Cloud Backup for Virtual Machines to back up Azure
NetApp Files datastores and VMs.

1. In the left navigation of the vCenter web client page, select Cloud Backup for Virtual Machines >
Policies.

2. On the Policies page, select Create to initiate the wizard.

3. On the New Backup Policy page, select the vCenter Server that will use the policy, then enter the policy
name and a description.

e Only alphanumeric characters and underscores (_) are supported in VM, datastore, cluster,
policy, backup, or resource group names. Other special characters are not supported.

4. Specify the retention settings. The maximum retention value is 255 backups. If the "Backups to keep"
option is selected during the backup operation, Cloud Backup for Virtual Machines will retain backups
with the specified retention count and delete the backups that exceed the retention count.

5. Specify the frequency settings. The policy specifies the backup frequency only. The specific protection
schedule for backing up is defined in the resource group. Therefore, two or more resource groups can
share the same policy and backup frequency but have different backup schedules.

6. Optional: In the Advanced fields, select the fields that are needed. The Advanced field details are listed
in the following table.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/backup-azure-netapp-files-datastores-vms.md

FIELD ACTION

VM consistency Check this box to pause the VMs and create a VMware
snapshot each time the backup job runs.
When you check the VM consistency box, backup
operations might take longer and require more storage
space. In this scenario, the VMs are first paused, then
VMware performs a VM consistent snapshot. Cloud
Backup for Virtual Machines then performs its backup
operation, and then VM operations are resumed.
VM guest memory is not included in VM consistency

snapshots.

Include datastores with independent disks Check this box to include any datastores with
independent disks that contain temporary data in your
backup.

Scripts Enter the fully qualified path of the prescript or

postscript that you want the Cloud Backup for Virtual
Machines to run before or after backup operations. For
example, you can run a script to update Simple Network
Management Protocol (SNMP) traps, automate alerts,
and send logs. The script path is validated at the time
the script is executed.

NOTE: Prescripts and postscripts must be located on the
virtual appliance VM. To enter multiple scripts, press
Enter after each script path to list each script on a
separate line. The semicolon (;) character is not allowed.

7. Select Add to save your policy. You can verify that the policy has been created successfully and review the
policy configuration by selecting the policy in the Policies page.

Resource groups

A resource group is the container for VMs and datastores that you want to protect.

Do not add VMs in an inaccessible state to a resource group. Although a resource group can contain a VM in an
inaccessible state, the inaccessible state will cause backups for the resource group to fail.

Considerations for resource groups

You can add or remove resources from a resource group at any time.

e Back up a single resource: To back up a single resource (for example, a single VM), you must create a
resource group that contains that single resource.

e Back up multiple resources: To back up multiple resources, you must create a resource group that
contains multiple resources.

e Optimize snapshot copies: To optimize snapshot copies, group the VMs and datastores that are associated
with the same volume into one resource group.

e Backup policies: Although it's possible to create a resource group without a backup policy, you can only
perform scheduled data protection operations when at least one policy is attached to the resource group. You
can use an existing policy, or you can create a new policy while creating a resource group.

e Compatibility checks: Cloud Backup for VMs performs compatibility checks when you create a resource
group. Reasons for incompatibility might be:

o Virtual machine disks (VMDKs) are on unsupported storage.
o Ashared PCl device is attached to a VM.

o You have not added the Azure subscription account.



Create a resource group using the wizard

1. In the left navigation of the vCenter web client page, select Cloud Backup for Virtual Machines >

Resource Groups. Then select + Create to start the wizard

— vSphere Client O,

Resource Groups

Cloud Backup for Virtual Machines

& Dashboard vCenter Server

B Settings # Ed

Resource Groups
Name

@ Policies
Storage Systems

v

@ > G

Description Policies Last Run Status

2. On the General Info & Notification page in the wizard, enter the required values.

3. On the Resource page, do the following:

FIELD

Scope

Datacenter

Available entities

ACTION

Select the type of resource you want to protect:
® Datastores
® Virtual Machines

Navigate to the VMs or datastores

Select the resources you want to protect. Then select >
to move your selections to the Selected entities list.

When you select Next, the system first checks that Cloud Backup for Virtual Machines manages and is

compatible with the storage on which the selected resources are located.

IMPORTANT

If you receive the message

selected <resource-name> is not Cloud Backup for Virtual Machines compatible then a selected resource

is not compatible with Cloud Backup for Virtual Machines.

. On the Spanning disks page, select an option for VMs with multiple VMDKs across multiple datastores:

o Always exclude all spanning datastores (This is the default option for datastores)
e Always include all spanning datastores (This is the default for VMs)
e Manually select the spanning datastores to be included

. On the Policies page, select or create one or more backup policies.

e Touse an existing policy, select one or more policies from the list.
e Tocreate a new policy:

a. Select + Create.

b. Complete the New Backup Policy wizard to return to the Create Resource Group wizard.

. Onthe Schedules page, configure the backup schedule for each selected policy. In the Starting field,

enter a date and time other than zero. The date must be in the format day/month/year. You must fill in

each field. The Cloud Backup for Virtual Machines creates schedules in the time zone in which the Cloud

Backup for Virtual Machines is deployed. You can modify the time zone by using the Cloud Backup for

Virtual Machines GUI.
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7. Review the summary. If you need to change any information, you can return to any page in the wizard to
do so. Select Finish to save your settings.

After you select Finish, the new resource group will be added to the resource group list.

If the pause operation fails for any of the VMs in the backup, then the backup is marked as not VM-
consistent even if the policy selected has VM consistency selected. In this case, it's possible that some of
the VMs were successfully paused.

Other ways to create a resource group

In addition to using the wizard, you can:

e Create a resource group for a single VM:
1. Select Menu > Hosts and Clusters.

2. Right-click the Virtual Machine you want to create a resource group for and select Cloud Backup for
Virtual Machines. Select + Create.

e Create a resource group for a single datastore:
1. Select Menu > Hosts and Clusters.

2. Right-click a datastore, then select Cloud Backup for Virtual Machines. Select + Create.

Back up resource groups

Backup operations are performed on all the resources defined in a resource group. If a resource group has a

policy attached and a schedule configured, backups occur automatically according to the schedule.

Prerequisites

e You must have created a resource group with a policy attached. Do not start an on-demand backup job when
a job to back up the Cloud Backup for Virtual Machines MySQL database is already running. Use the
maintenance console to see the configured backup schedule for the MySQL database.

Back up resource groups on demand

1. In the left navigation of the vCenter web client page, select Cloud Backup for Virtual Machines >
Resource Groups, then select a resource group. Select Run Now to start the backup.

= vsphereClient O,

Resource Groups
Cloud Backup for Virtual Machines

& Dashboard vCenter Server -
Settings
= doemm pen X o » £
Name Description Policies Last Run Status
@@ Policies

Storage Systems

1.1 If the resource group has multiple policies configured, then in the Backup Now dialog box, select the
policy you want to use for this backup operation.
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2. Select OK to initiate the backup.

NOTE

You can't rename a backup once it is created.

3. Optional: Monitor the operation progress by selecting Recent Tasks at the bottom of the window or on
the dashboard Job Monitor for more details. If the pause operation fails for any of the VMs in the backup,
then the backup completes with a warning and is marked as not VM-consistent even if the selected policy
has VM consistency selected. In this case, it is possible that some of the VMs were successfully paused. In
the job monitor, the failed VM details will show the paused as failed.

Next steps

e Restore VMs using Cloud Backup for Virtual Machines



Restore VMs using Cloud Backup for Virtual

Machines
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Cloud Backup for Virtual Machines enables you to restore virtual machines (VMs) from the cloud backup to the
vCenter.

This topic covers how to:

e Restore VMs from backups
e Restore deleted VMs from backups
e Restore VM disks (VMDKs) from backups

e Recovery of Cloud Backup for Virtual Machines internal database

Restore VMs from backups

When you restore a VM, you can overwrite the existing content with the backup copy that you select or you can
restore to a new VM.

You can restore VMs to the original datastore mounted on the original ESXi host (this overwrites the original

VM).

Prerequisites to restore VMs

e A backup must exist: you must have created a backup of the VM using the Cloud Backup for Virtual Machines
before you can restore the VM.

NOTE

Restore operations cannot finish successfully if there are snapshots of the VM that were performed by software other
than the Cloud Backup for Virtual Machines.

e The VM must not be in transit: the VM that you want to restore must not be in a state of vMotion or Storage
vMotion.

e High Availability (HA) configuration errors: ensure there are no HA configuration errors displayed on the
vCenter ESXi Host Summary screen before restoring backups to a different location.

Considerations for restoring VMs from backups

e VM is unregistered and registered again: The restore operation for VMs unregisters the original VM, restores
the VM from a backup snapshot, and registers the restored VM with the same name and configuration on the
same ESXi server. You must manually add the VMs to resource groups after the restore.

e Restoring datastores: You cannot restore a datastore, but you can restore any VM in the datastore.

e VMware consistency snapshot failures for a VM: Even if a VMware consistency snapshot for a VM fails, the

VM is nevertheless backed up. You can view the entities contained in the backup copy in the Restore wizard
and use it for restore operations.

Restore a VM from a backup

1. In the VMware vSphere web client GUI, select Menu in the toolbar. Select Inventory and then Virtual
Machines and Templates.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/restore-azure-netapp-files-vms.md

2. In the left navigation, right-click a Virtual Machine, then select NetApp Cloud Backup. In the drop-down
list, select Restore to initiate the wizard.

3. In the Restore wizard, on the Select Backup page, select the backup snapshot copy that you want to restore.

NOTE

You can search for a specific backup name or a partial backup name, or you can filter the backup list by selecting
the filter icon and then choosing a date and time range, selecting whether you want backups that contain

VMware snapshots, whether you want mounted backups, and the location. Select OK to return to the wizard.

4. Onthe Select Scope page, select Entire Virtual Machine in the Restore scope field, then select Restore
location, and then enter the destination ESXi information where the backup should be mounted.

When restoring partial backups, the restore operation skips the Select Scope page.

Enable Restart VM checkbox if you want the VM to be powered on after the restore operation.
On the Select Location page, select the location for the primary or secondary location.
Review the Summary page and then select Finish.

Optional: Monitor the operation progress by selecting Recent Tasks at the bottom of the screen.

© v ® N o v

Although the VMs are restored, they are not automatically added to their former resource groups. Therefore,
you must manually add the restored VMs to the appropriate resource groups.

Restore deleted VMs from backups

You can restore a deleted VM from a datastore primary or secondary backup to an ESXi host that you select. You
can also restore VMs to the original datastore mounted on the original ESXi host, which creates a clone of the
VM.

Prerequisites to restore deleted VMs

e You must have added the Azure cloud Subscription account. The user account in vCenter must have the

minimum vCenter privileges required for Cloud Backup for Virtual Machines.

e A backup must exist. You must have created a backup of the VM using the Cloud Backup for Virtual Machines
before you can restore the VMDKs on that VM.

Considerations for restoring deleted VMs

You cannot restore a datastore, but you can restore any VM in the datastore.

Restore deleted VMs
1. Select Menu and then select the Inventory option.

2. Select a datastore, then select the Configure tab, then the Backups in the Cloud Backup for Virtual

Machines section.
3. Select (double-click) a backup to see a list of all VMs that are included in the backup.
4. Select the deleted VM from the backup list and then select Restore.

5. Onthe Select Scope page, select Entire Virtual Machine in the Restore scope field, then select the
restore location, and then enter the destination ESXi information where the backup should be mounted.

6. Enable Restart VM checkbox if you want the VM to be powered on after the restore operation.
7. On the Select Location page, select the location of the backup that you want to restore to.

8. Review the Summary page, then select Finish.

Restore VMDKs from backups

You can restore existing VMDKSs or deleted or detached VMDKs from either a primary or secondary backup. You



can restore one or more VMDKs on a VM to the same datastore.

Prerequisites to restore VMDKs

e A backup must exist. You must have created a backup of the VM using the Cloud Backup for Virtual
Machines.

e The VM must not be in transit. The VM that you want to restore must not be in a state of vMotion or Storage
vMotion.

Considerations for restoring VM DKs
o [f the VMDK is deleted or detached from the VM, then the restore operation attaches the VMDK to the VM.

e Attach and restore operations connect VMDKs using the default SCSI controller. VMDKs that are attached to a
VM with a NVME controller are backed up, but for attach and restore operations they are connected back

using a SCSI controller.

Restore VMDKs
1. In the VMware vSphere web client GUI, select Menu in the toolbar. Select Inventory, then Virtual
Machines and Templates.

2. In the left navigation, right-click a VM and select NetApp Cloud Backup. In the drop-down list, select
Restore.

3. In the Restore wizard, on the Select Backup page, select the backup copy from which you want to restore. To
find the backup, do one of the following options:

e Search for a specific backup name or a partial backup name

e Filter the backup list by selecting the filter icon and a date and time range. Select if you want backups
that contain VMware snapshots, if you want mounted backups, and primary location. Select OK to
return to the wizard.

4. On the Select Scope page, select Particular virtual disk in the Restore scope field, then select the virtual
disk and destination datastore.

5. Onthe Select Location page, select the snapshot copy that you want to restore.
6. Review the Summary page and then select Finish.

7. Optional: Monitor the operation progress by clicking Recent Tasks at the bottom of the screen.

Recovery of Cloud Backup for Virtual Machines internal database

You can use the maintenance console to restore a specific backup of the MySQL database (also called an NSM
database) for Cloud Backup for Virtual Machines.

1. Open a maintenance console window.

2. From the main menu, enter option 1) Application Configuration.

3. From the Application Configuration menu, enter option 6) MySQL backup and restore.
4

. From the MySQL Backup and Restore Configuration menu, enter option 2) List MySQL backups. Make
note of the backup you want to restore.

v

From the MySQL Backup and Restore Configuration menu, enter option 3) Restore MySQL backup.
6. At the prompt “Restore using the most recent backup,” enter n.

7. At the prompt “Backup to restore from,” enter the backup name, and then select Enter. The selected backup
MySQL database will be restored to its original location.

If you need to change the MySQL database backup configuration, you can modify:

e The backup location (the default is: /opt/netapp/protectionservice/mysqldumps )
e The number of backups kept (the default value is three)

e The time of day the backup is recorded (the default value is 12:39 a.m.)



. Open a maintenance console window.

. From the main menu, enter option 1) Application Configuration.

. From the Application Configuration menu, enter option 6) MySQL backup and restore.

. From the MySQL Backup & Restore Configuration, menu, enter option 1) Configure MySQL backup.

MySQL Backup & Restore Configuration Menu:

Configure MySQL backup

)
)
)
)

) Back
) Exit

Enter your choice: 1
Backup Location (Current sopt-/nmetapp/protectionservicesmysqgldumps):

Count for number of backups to keep (Current 3):
Time of backup in hh:mm amspm format (Current 12:38 AM):
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Azure Backup Server contributes to your business continuity and disaster recovery (BCDR) strategy. With Azure
VMware Solution, you can only configure a virtual machine (VM)-level backup using Azure Backup Server.

Azure Backup Server can store backup data to:

e Disk: For short-term storage, Azure Backup Server backs up data to disk pools.

e Azure cloud: For both short-term and long-term storage off-premises, Azure Backup Server data stored in
disk pools can be backed up to the Microsoft Azure cloud by using Azure Backup.

Use Azure Backup Server to restore data to the source or an alternate location. That way, if the original data is
unavailable because of planned or unexpected issues, you can restore data to an alternate location.

This article helps you prepare your Azure VMware Solution environment to back up VMs by using Azure Backup
Server. We walk you through the steps to:

e Determine the recommended VM disk type and size to use.
e (Create a Recovery Services vault that stores the recovery points.
e Set the storage replication for a Recovery Services vault.

e Add storage to Azure Backup Server.

Supported VMware features

e Agentless backup: Azure Backup Server doesn't require an agent to be installed on the vCenter Server or
ESXi server to back up the VM. Instead, provide the IP address or fully qualified domain name (FQDN) and
the sign in credentials used to authenticate the VMware vCenter Server with Azure Backup Server.

e Cloud-integrated backup: Azure Backup Server protects workloads to disk and the cloud. The backup and
recovery workflow of Azure Backup Server helps you manage long-term retention and offsite backup.

e Detect and protect VMs managed by vCenter: Azure Backup Server detects and protects VMs deployed
on a vCenter Server or ESXi hosts. Azure Backup Server also detects VMs managed by vCenter Server so that
you can protect large deployments.

e Folder-level auto protection: vCenter Server lets you organize your VMs in VM folders. Azure Backup
Server detects these folders. You can use it to protect VMs at the folder level, including all subfolders. When
protecting folders, Azure Backup Server protects the VMs in that folder and protects VMs added later. Azure
Backup Server detects new VMs daily, protecting them automatically. As you organize your VMs in recursive
folders, Azure Backup Server automatically detects and protects the new VMs deployed in the recursive
folders.

e Azure Backup Server continues to protect vMotioned VMs within the cluster: As VMs are
vMotioned for load balancing within the cluster, Azure Backup Server automatically detects and continues
VM protection.

e Recover necessary files faster: Azure Backup Server can recover files or folders from a Windows VM
without recovering the entire VM.

Limitations

e Update Rollup 1 for Azure Backup Server v3 must be installed.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/set-up-backup-server-for-azure-vmware-solution.md

e You can't back up user snapshots before the first Azure Backup Server backup. After Azure Backup Server

finishes the first backup, then you can back up user snapshots.

e Azure Backup Server can't protect VMware VMs with pass-through disks and physical raw device mappings
(pPRDMs).

e Azure Backup Server can't detect or protect VMware vApps.
To set up Azure Backup Server for Azure VMware Solution, you must finish the following steps:

e Set up the prerequisites and environment.
e Create a Recovery Services vault.
e Download and install Azure Backup Server.

e Add storage to Azure Backup Server.

Deployment architecture

Azure Backup Server is deployed as an Azure infrastructure as a service (laaS) VM to protect Azure VMware
Solution VMs.
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Prerequisites for the Azure Backup Server environment

Consider the recommendations in this section when you install Azure Backup Server in your Azure environment.

Azure Virtual Network

Ensure that you configure networking for your VMware private cloud in Azure.

Determine the size of the VM

Use the MABS Capacity Planner to determine the correct VM size. Based on your inputs, the capacity planner will
give you the required memory size and CPU core count. Use this information to choose the appropriate Azure
VM size. The capacity planner also provides total disk size required for the VM along with the required disk
IOPS. We recommend using a standard SSD disk for the VM. By pooling more than one SSD, you can achieve
the required IOPS.


https://www.microsoft.com/en-us/download/details.aspx?id=54301

Follow the instructions in the Create your first Windows VM in the Azure portal tutorial. You'll create the VM in
the virtual network that you created in the previous step. Start with a gallery image of Windows Server 2019
Datacenter to run the Azure Backup Server.

NOTE

Azure Backup Server is designed to run on a dedicated, single-purpose server. You can't install Azure Backup Server on a
computer that:

® Runs as a domain controller.

® Has the Application Server role installed.

® |s a System Center Operations Manager management server.
® Runs Exchange Server.

® |s a node of a cluster.

Disks and storage

Azure Backup Server requires disks for installation.
REQUIREMENT RECOMMENDED SIZE

Azure Backup Server installation Installation location: 3 GB
Database files drive: 900 MB
System drive: 1 GB for SQL Server installation

You'll also need space for Azure Backup Server to copy the
file catalog to a temporary installation location when you

archive.
Disk for storage pool Two to three times the protected data size.
(Uses basic volumes, can't be on a dynamic disk) For detailed storage calculation, see DPM Capacity Planner.

To learn how to attach a new managed data disk to an existing Azure VM, see Attach a managed data disk to a
Windows VM by using the Azure portal.

NOTE
A single Azure Backup Server has a soft limit of 120 TB for the storage pool.

Store backup data on local disk and in Azure

Storing backup data in Azure reduces backup infrastructure on the Azure Backup Server VM. For operational
recovery (backup), Azure Backup Server stores backup data on Azure disks attached to the VM. After the disks
and storage space are attached to the VM, Azure Backup Server manages the storage for you. The amount of
storage depends on the number and size of disks attached to each Azure VM. Each size of the Azure VM has a
maximum number of disks that can be attached. For example, A2 is four disks, A3 is eight disks, and A4 is 16

disks. Again, the size and number of disks determine the total backup storage pool capacity.

IMPORTANT

You should not retain operational recovery data on Azure Backup Server-attached disks for more than five days. If data is

more than five days old, store it in a Recovery Services vault.

To store backup data in Azure, create or use a Recovery Services vault. When you prepare to back up the Azure
Backup Server workload, you configure the Recovery Services vault. Once configured, each time an online
backup job runs, a recovery point gets created in the vault. Each Recovery Services vault holds up to 9,999


https://docs.microsoft.com/en-us/azure/virtual-machines/windows/quick-create-portal
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https://docs.microsoft.com/en-us/azure/virtual-machines/windows/attach-managed-disk-portal

recovery points. Depending on the number of recovery points created and how long kept, you can keep backup

data for many years. For example, you could create monthly recovery points and keep them for five years.

IMPORTANT

Whether you send backup data to Azure or keep it locally, you must register Azure Backup Server with a Recovery

Services vault.

Scale deployment

If you want to scale your deployment, you have the following options:

e Scale up:Increase the size of the Azure Backup Server VM from A series to DS3 series, and increase the local
storage.

e Offload data: Send older data to Azure and keep only the newest data on the storage attached to the Azure
Backup Server machine.

e Scale out: Add more Azure Backup Server machines to protect the workloads.

.NET Framework

The VM must have .NET Framework 3.5 SP1 or higher installed.

Join a domain

The Azure Backup Server VM must be joined to a domain. A domain user with administrator privileges on the
VM must install Azure Backup Server.

Azure Backup Server deployed in an Azure VM can back up workloads on the VMs in Azure VMware Solution.
The workloads should be in the same domain to enable the backup operation.

Create a Recovery Services vault

A Recovery Services vault is a storage entity that stores the recovery points created over time. It also contains
backup policies that are associated with protected items.

1. Sign in to the Azure portal, and on the left menu, select All services.

2. Inthe All services dialog box, enter Recovery Services and select Recovery Services vaults from
the list.

The list of Recovery Services vaults in the subscription appears.
3. On the Recovery Services vaults dashboard, select Add.
The Recovery Services vault dialog box opens.
4. Enter values and then select Create.

e Name: Enter a friendly name to identify the vault. The name must be unique to the Azure subscription.
Specify a name that has at least two but not more than 50 characters. The name must start with a
letter and consist only of letters, numbers, and hyphens.

e Subscription: Choose the subscription to use. If you're a member of only one subscription, you'll see
that name. If you're not sure which subscription to use, use the default (suggested) subscription. There
are multiple choices only if your work or school account is associated with more than one Azure
subscription.

e Resource group: Use an existing resource group or create a new one. To see the list of available
resource groups in your subscription, select Use existing, and then select a resource from the drop-
down list. To create a new resource group, select Create new and enter the name.

e | ocation: Select the geographic region for the vault. To create a vault to protect Azure VMware


https://portal.azure.com/

Solution virtual machines, the vault mustbe in the same region as the Azure VMware Solution private
cloud.
It can take a while to create the Recovery Services vault. Monitor the status notifications in the
Notifications area in the upper-right corner of the portal. After creating your vault, it's visible in the list

of Recovery Services vaults. If you don't see your vault, select Refresh.

Set storage replication

The storage replication option lets you choose between geo-redundant storage (the default) and locally
redundant storage. Geo-redundant storage copies the data in your storage account to a secondary region,
making your data durable. Locally redundant storage is a cheaper option that isn't as durable. To learn more

about geo-redundant and locally redundant storage options, see Azure Storage redundancy.

IMPORTANT
Changing the setting of Storage replication type Locally-redundant/Geo-redundant for a Recovery Services vault
must be done before you configure backups in the vault. After you configure backups, the option to modify it is disabled,

and you can't change the storage replication type.

1. From Recovery Services vaults, select the new vault.
2. Under Settings, select Properties. Under Backup Configuration, select Update.

3. Select the storage replication type, and select Save.

Download and install the software package

Follow the steps in this section to download, extract, and install the software package.

Download the software package

1. Sign in to the Azure portal.

2. If you already have a Recovery Services vault open, continue to the next step.

TIP
If you don't have a Recovery Services vault open, and you're in the Azure portal, in the list of resources enter

Recovery Services > Recovery Services vaults.

3. From the list of Recovery Services vaults, select a vault.

The selected vault dashboard opens.


https://docs.microsoft.com/en-us/azure/storage/common/storage-redundancy
https://portal.azure.com/
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The Settings option opens by default. If closed, select Settings to open it.

4. Select Backup to open the Getting Started wizard.




Settings

SUPPORT + TROUBLESHOOTING

7. Troubleshoot >
B Audit logs >
4 New support request »

GETTING STARTED

& Backup >
& Site Recovery >
GEMERAL

4t Properties >

MONITORING AND REPORTS
= lobs >

B} Alerts and Events >

5. In the window that opens:
a. From the Where is your workload running? menu, select On-Premises.

Where is your workload running?

| On-Premises RV |

What do you want to backup?

| VMware Virtual Machines s |

D Files and folders

D Hyper-\ Virtual Machines
VMware Virtual Machines
D Microsoft SQL Server
D Microsoft SharePoint
D Microsoft Exchange

D System State

D Bare Metal Recovery

b. From the What do you want to back up? menu, select the workloads you want to protect by
using Azure Backup Server.

c. Select Prepare Infrastructure to download and install Azure Backup Server and the vault
credentials.



Where is your workload running?

| On-Premises A |

What do you want to backup?

| VMware Virtual Machines N |

Step: Prepare Infrastructure

6. In the Prepare infrastructure window that opens:
a. Select the Download link to install Azure Backup Server.

b. Select Already downloaded or using the latest Azure Backup Server installation and then
Download to download the vault credentials. You'll use these credentials when you register the
Azure Backup Server to the Recovery Services vault. The links take you to the Download Center,
where you download the software package.

Prepare infrastructure X

|:| Already using System Center Data Protection Manager or any other System Center
Product

Azure Backup Server
Please follow the steps mentioned below.

1. Install Microsoft Azure Backup Server
Download

2. Download vault credentials to register the server to the vault. Vault credentials will
expire after 2 days.

D Already downloaded or using the latest Azure Backup Server installation

Download

3. Post infrastructure preparation, please use Microsoft Azure Backup Server Ul{on-
premises) to configure backup.

Learn More

7. On the download page, select all the files and select Next.

NOTE

You must download all the files to the same folder. Because the download size of the files together is greater than

3 GB, it might take up to 60 minutes for the download to complete.




Choose the download you want

File Name Size
Download Summary:
MicrosoftAzureBackuplnstaller.exe 434 KB
1. MicrosoftAzureBackuplinstaller.exe
2. MicrosoftAzureBackuplnstaller-1.bin
MicrosoftAzureBackuplnstaller-1.bin 701.4 MB 3. MicrosoftAzureBackuplnstaller-2.bin
4. MicrosoftAzureBackuplnstaller-
5. MicrosoftAzureBackuplnstaller-4.bin

MicrosoftAzureBackuplnstaller-2.bin 7019 MB 6. MicrosoftAzureBackuplnstaller-5.bin
MicrosoftAzureBackuplnstaller-3.bin 7019 MB
MicrosoftAzureBackuplnstaller-4.bin 7019 MB

Total Size: 3.2 GB
MicrosoftAzureBackuplnstaller-5.bin 446.1 MB

Extract the software package

If you downloaded the software package to a different server, copy the files to the VM you created to deploy
Azure Backup Server.

WARNING
At least 4 GB of free space is required to extract the setup files.

1. After you've downloaded all the files, double-click MicrosoftAzureBackuplnstaller.exe to open the
Microsoft Azure Backup setup wizard, and then select Next.

2. Select the location to extract the files to and select Next.

3. Select Extract to begin the extraction process.

5! Microsoft Azure Backup

Ready to Extract

Setup is now ready to begin extracting Microsoft Azure Backup on your
computer,

Click Extract to continue with the extraction, or didk Badk if you want to review or
change any settings.

Destination location: ~
C:\Microsoft Azure Backup

| < Back I Extract || Cancel |

4. Once extracted, select the option to Execute setup.exe and then select Finish.

TIP

You can also locate the setup.exe file from the folder where you extracted the software package.

Install the software package

1. On the setup window under Install, select Microsoft Azure Backup to open the setup wizard.



2. On the Welcome screen, select Next to continue to the Prerequisite Checks page.

3. To determine if the hardware and software meet the prerequisites for Azure Backup Server, select Check

Again. If met successfully, select Next.

4. The Azure Backup Server installation package comes bundled with the appropriate SQL Server binaries
that are needed. When you start a new Azure Backup Server installation, select the Install new Instance
of SQL Server with this Setup option. Then select Check and Install.

Microsoft Azure Backup Setup x|
E*—-? SQL Settings
h ‘L.J Please wat while the wizard checks for required hardware and software.
4
Installation Stages Micresoft Azure Backup requires a database. You can only use a local instance of SQL Server. 2014
i Stendard or higher.
@ Welcome
@ Prerequisite Checks I & |nstall new Instance of SQL Server with this Setup I
7 Use an existing instance of SQL Server
. Select the appropriate option and click on the bution to perform the
@ Installation settings prerequisite check and install the missing Windows components.
@ Secunty settings
@ Microsoft Update Opt-In
@ Summary of setiings
@ [nstallation
< Back Nest 5 Cance! Help
NOTE
If you want to use your own SQL Server instance, the supported SQL Server versions are SQL Server 2014 SP1 or
higher, 2016, and 2017. All SQL Server versions should be Standard or Enterprise 64-bit. The instance used by
Azure Backup Server must be local only; it can't be remote. If you use an existing SQL Server instance for Azure
Backup Server, the setup only supports the use of named instances of SQL Server.

If a failure occurs with a recommendation to restart the machine, do so, and select Check Again. For any
SQL Server configuration issues, reconfigure SQL Server according to the SQL Server guidelines. Then
retry to install or upgrade Azure Backup Server using the existing instance of SQL Server.

Manual configuration

When you use your own SQL Server instance, make sure you add builtin\Administrators to the sysadmin
role to the main database sysadmin role.

Configure reporting services with SQL Server 2017

If you use your instance of SQL Server 2017, you must configure SQL Server 2017 Reporting Services
(SSRS) manually. After configuring SSRS, make sure to set the IsInitialized property of SSRS to True.
When set to True, Azure Backup Server assumes that SSRS is already configured and skips the SSRS



configuration.

To check the SSRS configuration status, run:

$configset =Get-WmiObject -namespace
"root\Microsoft\SqlServer\ReportServer\RS_SSRS\v14\Admin" -class
MSReportServer_ConfigurationSetting -ComputerName localhost

$configset.IsInitialized

Use the following values for SSRS configuration:

Service Account: Use built-in account should be Network Service.

Web Service URL: Virtual Directory should be ReportServer_<SQLInstanceName>.

Database: DatabaseName should be ReportServer$<SQLInstanceName>.

Web Portal URL: Virtual Directory should be Reports_<SQLInstanceName>.

Learn more about SSRS configuration.

NOTE

Microsoft Online Services Terms (OST) governs the licensing for SQL Server used as the database for Azure Backup
Server. According to OST, only use SQL Server bundled with Azure Backup Server as the database for Azure
Backup Server.

5. After the installation is successful, select Next.

6. Provide a location for installing Microsoft Azure Backup Server files, and select Next.

NOTE

The scratch location is required for backup to Azure. Ensure the scratch location is at least 5% of the data planned
for backing up to the cloud. For disk protection, separate disks need configuring after the installation finishes. For
more information about storage pools, see Configure storage pools and disk storage.



https://docs.microsoft.com/en-us/sql/reporting-services/report-server/configure-and-administer-a-report-server-ssrs-native-mode
https://www.microsoft.com/licensing/product-licensing/products
https://docs.microsoft.com/en-us/previous-versions/system-center/system-center-2012-r2/hh758075(v=sc.12)

- Microsoft Azure Backup Setup ]

E--__f? Installation Settings
h “.J Specify installation locations for the MAB program files. Cache location and seitings for SQL Sarver,

Lo E ~Microsoft Azure Backup Fies
@ Welcome Program files:
@ Prerequisite Checks CProgram Files'\Microsoft Azure Backup \DF M Change... |
& SOL Settings

Seratch Location (Must have free space at lsast 5% of the data backed-up to eloud):
@ Installation settings C:\Program Files\Microsoft Azure Backup\DPM\DPM\Cache Crange..._|
@ Security seitings
@ Microsoft Lpdate Opt-In Diatabass files:
@ Summary of setiings C\Program Files\Microsoft Azure Backup\DPM\DPM\DPMDB Change.. |
@ Installation

Space requirements
Reguired Available
System drive: 2160 MB 25382 MB
Program files drive: 4500 MB 25382 MB
Cache files drive: Min 5% of backed up data 25382 MH
Database files dive: 300 MB 25382 MB

For more detais on storage requirement click on the link below,
http: /oo microsoft. com/fud ink/ ?Linkld=177402

<Back [ Ned> Cancsl | Heb

7. Provide a strong password for restricted local user accounts, and select Next.

8. Select whether you want to use Microsoft Update to check for updates, and select Next.

10.

11.

12.

NOTE

We recommend having Windows Update redirect to Microsoft Update, which offers security and important
updates for Windows and other products like Azure Backup Server.

. Review the Summary of Settings, and select Install.

The installation happens in phases.

e The first phase installs the Microsoft Azure Recovery Services Agent.

e The second phase checks for internet connectivity. If available, you can continue with the installation. If
not available, you must provide proxy details to connect to the internet.

e The final phase checks the prerequisite software. If not installed, any missing software gets installed
along with the Microsoft Azure Recovery Services Agent.

Select Browse to locate your vault credentials to register the machine to the Recovery Services vault, and
then select Next.

Select a passphrase to encrypt or decrypt the data sent between Azure and your premises.

TIP

You can automatically generate a passphrase or provide your minimum 16-character passphrase.

Enter the location to save the passphrase, and then select Next to register the server.




IMPORTANT

Save the passphrase to a safe location other than the local server. We strongly recommend using the Azure Key

Vault to store the passphrase.

After the Microsoft Azure Recovery Services Agent setup finishes, the installation step moves on to the

installation and configuration of SQL Server and the Azure Backup Server components.
13. After the installation step finishes, select Close.

Install Update Rollup 1

Installing the Update Rollup 1 for Azure Backup Server v3 is mandatory before you can protect the workloads.
You can find the bug fixes and installation instructions in the knowledge base article.

Add storage to Azure Backup Server

Azure Backup Server v3 supports Modern Backup Storage that offers:

e Storage savings of 50%.
e Backups that are three times faster.
e More efficient storage.

e Workload-aware storage.

Volumes in Azure Backup Server

Add the data disks with the Azure Backup Server VM's required storage capacity if not already added.

Azure Backup Server v3 only accepts storage volumes. When you add a volume, Azure Backup Server formats
the volume to Resilient File System (ReFS), which Modern Backup Storage requires.

Add volumes to Azure Backup Server disk storage

1. In the Management pane, rescan the storage and then select Add.
2. Select from the available volumes to add to the storage pool.
3. After you add the available volumes, give them a friendly name to help you manage them.

4. Select OK to format these volumes to ReFS so that Azure Backup Server can use Modern Backup Storage
benefits.

Next steps

Now that you've covered how to set up Azure Backup Server for Azure VMware Solution, you can use the

following resources to learn more.

e Configuring backups for your Azure VMware Solution VMs.

® Protecting your Azure VMware Solution VMs with Microsoft Defender for Cloud integration.


https://support.microsoft.com/en-us/help/4534062/

Back up Azure VMware Solution VMs with Azure

Backup Server

8/19/2022 « 12 minutes to read « Edit Online

This article shows you how to back up VMware virtual machines (VMs) running on Azure VMware Solution with
Azure Backup Server. First, thoroughly go through Set up Microsoft Azure Backup Server for Azure VMware
Solution.

Then, we'll walk through all of the necessary procedures to:

e Setup a secure channel so that Azure Backup Server can communicate with VMware vCenter Server over
HTTPS.

e Add the account credentials to Azure Backup Server.
e Add the vCenter Server to Azure Backup Server.

e Setup a protection group that contains the VMware VMs you want to back up, specify backup settings, and
schedule the backup.

Create a secure connection to the vCenter server

By default, Azure Backup Server communicates with VMware vCenter Server over HTTPS. To set up the HTTPS
connection, download the VMware certificate authority (CA) certificate and import it on the Azure Backup
Server.

Set up the certificate

1. In the browser, on the Azure Backup Server machine, enter the vSphere Web Client URL.

NOTE

If the VMware Getting Started page doesn't appear, verify the connection and browser proxy settings and try
again.

2. On the VMware Getting Started page, select Download trusted root CA certificates.

Getting Started For Administrators

To access vSphere remotely, use the Web-Based Datastore Browser

vSphere Web Client Use your web browser to find and download files (for
Log in to vSphere Web Client b 4 example, virtual machine and virtual disk files).

Far help, see i Browse dalasiores in the vSphere inventory

vSphere Documentation For Developers

vSphere Web Services SDK

Learn about our latest SDKs. Toolkits, and APis for
managing VMware ESX. ESXi, and ViMware vCenter.

Get sample code, reference documentation, participate

g
vCenter Servers

in our Forum Discussions, and view our latest Sessions
and Webinars.

Learn more about the Web Services SDK

Browse objects managed by vSphere

Download trusted root CA certificates



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/backup-azure-vmware-solution-virtual-machines.md

3. Save the download.zip file to the Azure Backup Server machine, and then extract its contents to the
certs folder, which contains the:

e Root certificate file with an extension that begins with a numbered sequence like .0 and .1.
e CRL file with an extension that begins with a sequence like .r0 or .r1.

4. In the certs folder, right-click the root certificate file and select Rename to change the extension to .crt.
The file icon changes to one that represents a root certificate.
5. Right-click the root certificate, and select Install Certificate.

6. In the Certificate Import Wizard, select Local Machine as the destination for the certificate, and

select Next.

Welcome to the Certificate Import Wizard

This wizard helps you copy cerEficates, certificate trust lists, and certificate revocation
lists from your deki ko & certificate store.

4 certficate, which & issued by a certfication authority, & a confrmation of your identity
and contains information used to protect data or to establish secure nebwark
connectons. A certificate store & the System area where certificates are kept,

Store Locabion
) Cusrent User

To continue, didk Mext.

NOTE

If asked, confirm that you want to allow changes to the computer.

7. Select Place all certificates in the following store, and select Browse to choose the certificate store.



& £4 Certificate Import Wizard

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@ Place al certificates in the following store |

Certificate store:

| =1

I MNext || Cancel |

8. Select Trusted Root Certification Authorities as the destination folder, and select OK.

9. Review the settings, and select Finish to start importing the certificate.

x

& £4 Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have specified the fallowing settings:

L P T e AT Trusted Root Certification Authorities

Caontent Certificate

| Finish || Cancel |

10. After the certificate import is confirmed, sign in to the vCenter Server to confirm that your connection is
secure.

Enable TLS 1.2 on Azure Backup Server

VMware vSphere 6.7 onwards has TLS enabled as the communication protocol.

1. Copy the following registry settings, and paste them into Notepad. Then save the file as TLS.REG without
the .txt extension.



Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\.NETFramework\v2.0.50727]
"SystemDefaultTlsVersions"=dword:00000001
"SchUseStrongCrypto"=dword: 00000001
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\.NETFramework\v4.0.30319]
"SystemDefaultTlsVersions"=dword:00000001
"SchUseStrongCrypto"=dword: 00000001
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v2.0.50727]
"SystemDefaultTlsVersions"=dword:00000001
"SchUseStrongCrypto"=dword: 00000001
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4.0.30319]
"SystemDefaultTlsVersions"=dword:00000001

"SchUseStrongCrypto"=dword: 00000001

2. Right-click the TLS.REG file, and select Merge or Open to add the settings to the registry.

Add the account on Azure Backup Server

1. Open Azure Backup Server, and in the Azure Backup Server console, select Management > Production
Servers > Manage VMware.

<
~ |Sea¢ch ligt below 2 \'| || Search in details aleo (Shkow)
| Camputer Mame Typa Clustar Mame Darman Agent St AgentUpd..  Throttling
There are no compulers with agents installed. To inatall agents, click Install.

Number of diska: 0
Total copocity:  OKB

2. In the Manage Credentials dialog box, select Add.



mmmwnam&mm You can add, update or delete a credential. These credentials are used 1o

smmnwumwsmmnm 1o sutherticate. Acedertial can be
ddmdu#lmmuimmumknmm lmmmdﬂmamﬂﬂi firat change th credential of these

productnn senees and then comebach hare to delste credentisl.
Credential Prodistion Servers  Descnplion
Vimwae backup cred 0

credential for secuning voentenvm | with MABS

View Details l Add Updats Comiata I Help I

3. Inthe Add Credential dialog box, enter a name and a description for the new credential. Specify the
user name and password you defined on the VMware server.

NOTE

If the VMware server and Azure Backup Server aren't in the same domain, specify the domain in the User name
box.

Description:
|cradfu'mdhg MABS to Voenter server |

Password:

4. Select Add to add the new credential.

This tablie shows the list of cradentials curently avalable. You can add, update or delete a credential. Theas credentials are usad to
autherticate while communicating

saryer.
Mote: Production Senvars show the number of Froduction Senvers that ane using this credentsal to sutherticate. A credertial can be
dedeted only f no preduction server is using this credential. F you want 1o delste 8 credertial, it change the credential of these
prodiction servers and then comsback hane te delste condertial.

Credartial Production Servers Descrpdion
Comoeo Vcarter credantial 0 cred for connacting MABS to Voamar senver
Vimweare backup cred o

cradential for secusng veentervm 1 wih MAES

[ViewDstais | | Add || Updste || Doiete || Hep |

Add the vCenter Server to Azure Backup Server

In the Azure Backup Server console, select Management > Production Servers > Add



Help

There are no computers with agents installed. To install agents, click Install.

| Search list beiow £ w| [ search in dewils also (Slow)
CompulerNa., Type Cluster Name Domain | Agent. AgentU.. Throtlling

2. Select VMware Servers, and select Next.

g Select Production Server type

Solect Production Server type
i O Windows Servers
@ Salect Production Server
e Inctal agent to protect Windows sorvers,
# Salect agent deployment
mathod

Enler crmdertials @) Vibware Servers
Connect with ViMware servem to protect Vidwans ViMa,

.I;.l
:
i
:

cBack || Nets |[ Cowed |[ Hep |

3. Specify the IP address of the vCenter Server.



Select Computers

Select VMware Servers

Add a WMware vCenter or ESXi hast server and its credentials

Server Mame./|P Address: Added Viware Servers:

(— e Sorver

443
Specify Credential |

I

4. In the SSL Port box, enter the port used to communicate with the vCenter Server.

TIP

Port 443 is the default port, but you can change it if your vCenter Server listens on a different port.

5. In the Specify Credential box, select the credential that you created in the previous section.

6. Select Add to add the vCenter Server to the servers list, and select Next.

T &) Select Computers

Select Vibware Servers
e Add 2 VMware wCemier ar ESKi host senver and fis credentials
& Sehect Production Server Server Mame 1P Addreas: Added Whware Serems:
e Vi S Guiei
@ Selece Uikbware Servers S5L Por
& Summany 443 &
@ Firish Specty < Bamove
Contoso Vicenter cres »
Deescription:
=

7. On the Summary page, select Add to add the vCenter Server to Azure Backup Server.

The new vCenter Server gets added immediately. vCenter Server doesn't need an agent.



-~
iﬁ) Sum rary
S
@ Salect Produclion Server
e =
@ Select Vidware Seroers Task
& Summary Add computer woenterm 1 oomtoso.com
# Firish
Chek Addltn begn.
[cack [[| a8 J[[ coesl [[ Hob |

8. On the Finish page, review the settings, and then select Close.

L Finish
You have successfully added the selected servers.

Stepm Tasks

& Select Production Server Task Resutts
bpe Add computer veentervmlcontoso.com Success

& Select Vidwane: Servers

& Summary

@ Finish

You see the vCenter Server listed under Production Server with:
e Type as VMware Server

e Agent Status as OK

If you see Agent Status as Unknown, select Refresh.

Configure a protection group

Protection groups gather multiple VMs and apply the same data retention and backup settings to all VMs in the

group.



1. In the Azure Backup Server console, select Protection > New.

File Acton View Help

Gld| = & 3| ®

New Selfservice  Recoverypaint | Check Options  About Help

TECOVETY sfatus updates
Prolecti.. | Manage Reports Options Help
{

4 [ata Source Health Groupby: @ Protectiongroup ) Computer
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ok m | Protection Group Member Type Proleckion Status

M Waming (0}

All Protection Groups

No protection group has been cieated.
Before you stan protecting data. DPM recommends that you do the fellowing:
1. Add desks to the DPM storage pool, enless you wanl 1o use custom volumes.
2. Install a protection agent on each computer that you wanl 1o protect.
Sign up for Azure Backup and register this DPM Server for Online Protection if you want to use enline protectic
Meed help geting staed?
Details:

5 Monioring
| nreciosmt |
7 Recovery

Gl Reporting
g Management

2. On the Create New Protection Group wizard welcome page, select Next.

Welcome to the New Protection Group Wizard
n This wizard helos you create & new prodection group that DFM wil use Lo protect date.

Stepa: A profection group is a colledion of data sowrces that share the same protediion canfiguration. You use this wizasd
& Welcoma speciy your recovery goals that are defined by retention range, synchronization and recovery point schedules.
@ Select profecton group type
@ Select group members .
# Specily protection rules
@ Select data protecion
method
# Saloct short e goals
@ Chogss consistency chack
options
@ Summary How data prolection works:
* S 1. DPM ceates a reglica of the selected data sources on the DPM server.

2 D®M synchimnizes the replica with the data sources and creates recovery points on a recuming schaduls.
1. Backups are perfomed &a follows:

Digh basad peotection. DPI stores the mplica of the dats on disks and perodic full backups am crestad on disk,
Orline ion. DPM pedomns pericdic backups of the d data to Asure Bachup

[[] Do not show this Wislcome page again

3. Onthe Select Protection Group Type page, select Servers, and then select Next. The Select Group
Members page appears.

4. On the Select Group Members page, select the VMs (or VM folders) that you want to back up, and then
select Next.



NOTE
When you select a folder or VMs, folders inside that folder are also selected for backup. You can uncheck folders or
VMs you don't want to back up. If a VM or folder is already being backed up, you can't select it, which ensures

duplicate recovery points aren't created for a VM.

Select Group Members.
D Selact the data that you want to protest.

Steps: To choose the data to protect, select the check boxes in the Available members saction. To exclude a folder, expand the
@ Welcome directory structure, and clearthe check box of the folder,

@ Select protection group fype fmdomt:_wﬁndﬁammwﬁlnvﬂnﬁhhmm.dd&hmuwaaidduwtod
"]
L]

Select group members LUnsupported configurations.

Select data protection Avalable members Selected members

method | @8] AzureBackupserver - Selected Members Computer
@ Select shorttem goals =g VMware Servers |

. l—:---” veentervml.contoso.com

@ Choose consistency check = o Datacenters

options =-{Je= Europe
# Summary EEL Datacenter

&-L o vm

@ Siatus |+E| B

B[ Bugbash Real VM | _
[ Ja Chandra-TESTFolde

m [Ja CRM App
Dﬂ Finance
#-{Jo- Loc Testing
mJaw 2015
-4 2018 p!
= Jew 2017 L
E& Vs £
<| [ | [>
Update data sources
Rafrash 1o clasr the eache snd ratieve the lstest
data sources,
W Excluded folders: 0 \View
= Excluded file types: 0  Exclude Files
<Back MNec> || Cancel |[ Hep |

5. On the Select Data Protection Method page, enter a name for the protection group and protection

settings.

6. Set the short-term protection to Disk, enable online protection, and then select Next.



Select Data Protecion Method
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7. Specify how long you want to keep data backed up to disk.

e Retention range: The number of days that disk recovery points are kept.

e Express Full Backup: How often disk recovery points are taken. To change the times or dates when
short-term backups occur, select Modify.

Create Mew Protection Group X

L Specify Short-Term Goals
lm DFM will create a protection plan using your short-term recovery goals.

Steps: g®  Specify your shortdem recovery goals for disk-based protection.
& Welcome
Retention range: -
@ Select protection group type = E das
' For applications the recovery point is as per synchronization frequency when they support incremental,
@ 58|idddﬁ'fa protection atherwise the recovery point is 28 per express full backup.
metho
Recovery points: Based on express full schedule (8:00 PM Everyday)

@ Select short4em goals
@ Review disk storage Express Full Backup: |8:00 PM Everyday A

allocation | 2 I—‘ T

# Choose replica creation

8. On the Review Disk Storage Allocation page, review the disk space provided for the VM backups.

e The recommended disk allocations are based on the retention range you specified, the workload type,
and the protected data size. Make any changes required, and then select Next.

e Data size: Size of the data in the protection group.
e Disk space: Recommended amount of disk space for the protection group. If you want to modify this
setting, select space lightly larger than the amount you estimate each data source grows.

e Storage pool details: Shows the status of the storage pool, which includes total and remaining disk
size.



Create Mew Protection Group

Review Disk Storage Allocation
E_ I Review disk space allocated in the storage poal for this protection group.

a: Rewiew target storage assigned for each data source and change f need be
# Welcome Disk: storage allocation for new members
Select protection group type Total data size:

-
@ Select group members Disk storage 1o be provisoned an DPM:
@ Select data protection

et Disk: storage allocation details:

0.01 GB
10.00 MB

@ Select shottem goals Data Source

Data Size
* “;"‘"!“**"““‘1’ FC-MABS-TMSDPMINSTANCE master on_

Space To ..
0.01 GB

Target Storage

10.00 ME Disk - 2027.91 GB

w

@ Choose replica creation
method

& Choose consistency check
ons

Specify online protection data

Avalable target disk storage:

@ Specify online backup
® Name Friendy N... Hlowed Datasa ..

Specfy online retention pelicy Ed Disk All

# Choose oniine replication
@ Summary
@ Status

Total Spa...
204733 GB

Fres Space
202791 GB

Undempeo..
D KE|

< Back

Cancel

NOTE

investigating it.

In some scenarios, the data size reported is higher than the actual VM size. We're aware of the issue and currently

9. On the Choose Replica Creation Method page, indicate how you want to take the initial backup, and

select Next.

e The defaultis Automatically over the network and Now. If you use the default, specify an off-peak

time. If you choose Later, specify a day and time.

e For large amounts of data or less-than-optimal network conditions, consider replicating the data

offline by using removable media.
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10. For Consistency check options, select how and when to automate the consistency checks and select
Next.

e You can run consistency checks when replica data becomes inconsistent, or on a set schedule.
e [f you don't want to configure automatic consistency checks, you can run a manual check by right-
clicking the protection group Perform Consistency Check.

11. On the Specify Online Protection Data page, select the VMs or VM folders that you want to back up,
and then select Next.

TIP

You can select the members individually or choose Select All to choose all members.

Specify Online Protection Data
D Specty the data that you would like DPM to help protect oniine
Steps:

Wielcome:

Select protection group hype Selected members Computer
SAP-VM veentervml.contosc.com

— Select the data source you want to protect onine

Select group members

HR-MNode! veentervml.contosc.com
TEST-DVS veentervml.contoso.com
HR-Node2 veentervml.contoso.com

Select dats protecton
mtincd

O0O0oo

BEM-WM veentervml.contoso.com

,__

Exch-Model veentervml.contosc.com

Tl

Shreesh VM veentervml.contoso.com
Exch-Nodel veentervml.contoso.com

O

12. On the Specify Online Backup Schedule page, indicate how often you want to back up data from local
storage to Azure.

e Cloud recovery points for the data to get generated according to the schedule.



e After the recovery point gets generated, it's then transferred to the Recovery Services vault in Azure.

Specity Onlne Backup Schedule
D Specty ariine backup schedule which DPM wil use 1o generate your protection pisn

iy Define the scheduls when you want 1o create a backap copy

O Morth ) Year
A followeng ey (Maparmum allowed 1 two tmes 8 day)

[g00Pm v|  [Mons ~|

13. On the Specify Online Retention Policy page, indicate how long you want to keep the recovery points
created from the backups to Azure.

e There's no time limit for how long you can keep data in Azure.

e The only limit is that you can't have more than 9,999 recovery points per protected instance. In this
example, the protected instance is the VMware vCenter Server.

Specity Online Retenbon Poboy
D Spactly orine backup schaduie which DPM will use 19 generste your protection plan

() Spechy the rtention polcy which DPM will use to generste your protection plan
@ Welcome
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@ Select protecton group hpe
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14. On the Summary page, review the settings and then select Create Group.



Summary
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Monitor with the Azure Backup Server console

After you configure the protection group to back up Azure VMware Solution VMs, you can monitor the backup
job status and alert by using the Azure Backup Server console. Here's what you can monitor.

e In the Monitoring task area:
o Under Alerts, you can monitor errors, warnings, and general information. You can view active and
inactive alerts and set up email notifications.
o Under Jobs, you can view jobs started by Azure Backup Server for a specific protected data source or
protection group. You can follow job progress or check resources consumed by jobs.
e |n the Protection task area, you can check the status of volumes and shares in the protection group. You can
also check configuration settings such as recovery settings, disk allocation, and the backup schedule.
e |nthe Management task area, you can view the Disks, Online, and Agents tabs to check the status of
disks in the storage pool, registration to Azure, and deployed DPM agent status.
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Restore VMware virtual machines

In the Azure Backup Server Administrator Console, there are two ways to find recoverable data. You can search
or browse. When you recover data, you might or might not want to restore data or a VM to the same location.
For this reason, Azure Backup Server supports three recovery options for VMware VM backups:

e Original location recovery (OLR): Use OLR to restore a protected VM to its original location. You can
restore a VM to its original location only if no disks were added or deleted since the backup occurred. If disks
were added or deleted, you must use alternate location recovery.

e Alternate location recovery (ALR): Use when the original VM is missing, or you don't want to disturb the
original VM. Provide the location of an ESXi host, resource pool, folder, and the storage datastore and path. To
help differentiate the restored VM from the original VM, Azure Backup Server appends "-Recovered”to the
name of the VM.

e |ndividual file location recovery (ILR): If the protected VM is a Windows Server VM, individual files or
folders inside the VM can be recovered by using the ILR capability of Azure Backup Server. To recover
individual files, see the procedure later in this article. Restoring an individual file from a VM is available only
for Windows VM and disk recovery points.

Restore a recovery point

1. In the Azure Backup Server Administrator Console, select the Recovery view.

2. Using the Browse pane, browse or filter to find the VM you want to recover. After you select a VM or
folder, the **Recovery points for pane display the available recovery points.
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3. In the Recovery points for pane, select a date when a recovery point was taken. For example, calendar
dates in bold have available recovery points. Alternately, you can right-click the VM, select Show all

recovery points, and then select the recovery point from the list.

NOTE
For short-term protection, select a disk-based recovery point for faster recovery. After short-term recovery points

expire, you see only Online recovery points to recover.

4. Before recovering from an online recovery point, ensure the staging location contains enough free space
to house the full uncompressed size of the VM you want to recover. The staging location can be viewed or
changed by running the Configure Subscription Settings Wizard.
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5. Select Recover to open the Recovery Wizard.
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6. Select Next to go to the Specify Recovery Options screen. Select Next again to go to the Select



Recovery Type screen.

NOTE

VMware vSphere workloads don't support enabling network bandwidth throttling.

7. On the Select Recovery Type page, either recover to the original instance or a new location.

e [f you choose Recover to original instance, you don't need to make any more choices in the wizard.
The data for the original instance is used.

e [f you choose Recover as virtual machine on any host, then on the Specify Destination screen,
provide the information for ESXi Host, Resource Pool, Folder, and Path.

Recovery Wizard =]
Select Recovery Type
& Select the type of ecovery you wand 1o perfeem
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@ Raview mcovery sehection p‘ #* Recoverto gnpnal nstance
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8. On the Summary page, review your settings and select Recover to start the recovery process.
The Recovery status screen shows the progression of the recovery operation.

Restore an individual file from a VM

You can restore individual files from a protected VM recovery point. This feature is only available for Windows
Server VMs. Restoring individual files is similar to restoring the entire VM, except you browse into the VMDK
and find the files you want before you start the recovery process.

NOTE

Restoring an individual file from a VM is available only for Windows VM and disk recovery points.

1. In the Azure Backup Server Administrator Console, select the Recovery view.

2. Using the Browse pane, browse or filter to find the VM you want to recover. After you select a VM or
folder, the **Recovery points for pane display the available recovery points.
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3. Inthe Recovery points for pane, use the calendar to select the wanted recovery points' date.
Depending on how the backup policy was configured, dates can have more than one recovery point.

4. After you select the day when the recovery point was taken, make sure you choose the correct Recovery
time.

NOTE

If the selected date has multiple recovery points, choose your recovery point by selecting it in the Recovery time

drop-down menu.

After you choose the recovery point, the list of recoverable items appears in the Path pane.

5. To find the files you want to recover, in the Path pane, double-click the item in the Recoverable Item
column to open it. Then select the file or folders you want to recover. To select multiple items, select the
Ctrl key while you select each item. Use the Path pane to search the list of files or folders that appear in
the Recoverable Item column.

NOTE

Search list below doesn't search into subfolders. To search through subfolders, double-click the folder. Use the
Up button to move from a child folder into the parent folder. You can select multiple items (files and folders), but
they must be in the same parent folder. You can't recover items from multiple folders in the same recovery job.
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6. When you've selected the items for recovery, in the Administrator Console tool ribbon, select Recover to
open the Recovery Wizard. In the Recovery Wizard, the Review Recovery Selection screen shows

the selected items to be recovered.
7. On the Specify Recovery Options screen, do one of the following steps:

e Select Modify to enable network bandwidth throttling. In the Throttle dialog box, select Enable
network bandwidth usage throttling to turn it on. Once enabled, configure the Settings and
Work Schedule.

e Select Next to leave network throttling disabled.

8. On the Select Recovery Type screen, select Next. You can only recover your files or folders to a
network folder.

9. On the Specify Destination screen, select Browse to find a network location for your files or folders.
Azure Backup Server creates a folder where all recovered items are copied. The folder name has the
prefix MABS_day-month-year. When you select a location for the recovered files or folder, the details for

that location are provided.

Recovery Wizard X
Specify Destination
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@ Select recovery type
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@ Specify recovery options
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*

Destination contoso-svr.DEMOTEST.svr.Backup -001 Browse

Destination path: ‘C \stage

Racovery status

10. On the Specify Recovery Options screen, choose which security setting to apply. You can opt to modify
the network bandwidth usage throttling, but throttling is disabled by default. Also, SAN Recovery and
Notification aren't enabled.

11. On the Summary screen, review your settings and select Recover to start the recovery process. The
Recovery status screen shows the progression of the recovery operation.



Next steps

Now that you've covered backing up your Azure VMware Solution VMs with Azure Backup Server, you may
want to learn about:

e Troubleshooting when setting up backups in Azure Backup Server.

o Lifecycle management of Azure VMware Solution VMs.


https://docs.microsoft.com/en-us/azure/backup/backup-azure-mabs-troubleshoot

Prepare Azure Site Recovery resources for disaster

recovery of Azure VMware Solution VMs

8/19/2022 - 3 minutes to read  Edit Online

This article describes how to prepare Azure resources and components so that you can set up disaster recovery
of Azure VMware Solution VMs using Azure Site Recovery service. Azure VMware Solution provides private
clouds in Azure. These private clouds contain vSphere clusters, built from dedicated bare-metal Azure
infrastructure.

This article is the first tutorial in a series that shows you how to set up disaster recovery for Azure VMware
Solution VMs.

In this tutorial, you learn how to:

e Verify that the Azure account has replication permissions.

e C(Create a Recovery Services vault. A vault holds metadata and configuration information for VMs, and other
replication components.

e Setup an Azure virtual network (VNet). When Azure VMs are created after failover, they're joined to this
network.

NOTE

Tutorials show you the simplest deployment path for a scenario. They use default options where possible, and don't show
all possible settings and paths. For detailed instructions, review the article in the How To section of the Site Recovery Table
of Contents.

NOTE

Some of the concepts of using Azure Site Recovery for Azure VMware Solution overlap with disaster recovery of on-prem
VMware VMs and hence documentation will be cross-referenced accordingly.

Before you start

e Deploy an Azure VMware Solution private cloud in Azure
e Review the architecture for VMware disaster recovery

e Read common questions for VMware

If you don't have an Azure subscription, create a free account before you begin. Then sign in to the Azure portal.

Verify account permissions

If you just created your free Azure account, you're the administrator of your subscription and you have the
permissions you need. If you're not the subscription administrator, work with the administrator to assign the

permissions you need. To enable replication for a new virtual machine, you must have permission to:

e Create a VM in the selected resource group.
e Create a VM in the selected virtual network.

e \Write to an Azure storage account.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/site-recovery/avs-tutorial-prepare-azure.md
https://docs.microsoft.com/en-us/azure/site-recovery/site-recovery-overview
https://docs.microsoft.com/en-us/azure/site-recovery/vmware-azure-architecture
https://docs.microsoft.com/en-us/azure/site-recovery/vmware-azure-common-questions
https://azure.microsoft.com/pricing/free-trial/
https://portal.azure.com

e Write to an Azure managed disk.

To complete these tasks your account should be assigned the Virtual Machine Contributor built-in role. In
addition, to manage Site Recovery operations in a vault, your account should be assigned the Site Recovery
Contributor built-in role.

Create a Recovery Services vault

1. From the Azure portal menu, select Create a resource, and search the Marketplace for Recovery.

2. Select Backup and Site Recovery from the search results, and in the Backup and Site Recovery page,
click Create.

3. In the Create Recovery Services vault page, select the Subscription. We're using Contoso
Subscription.

4. In Resource group, select an existing resource group or create a new one. For this tutorial we're using
contosoRG.

5. In Vault name, enter a friendly name to identify the vault. For this set of tutorials we're using
ContosoVMVault.

6. In Region, select the region in which the vault should be located. We're using West Europe.

7. Select Review + create.

Microsoft Azure 2 Search resources, services, and docs (G+/)

Home > Mew > Backup and Site Recovery > Create Recovery Services vault

Create Recovery Services vault it

Basics®™ Tags Review + create

Project Details

Select the subscription and the resource group in which you want to create the vault.

Subscription * © | Contoso Subscription ~ |
Resource group * ([ | contosoRG o |
Create new

Instance Details

Vault name * (00 I ConstosoVMVault hl |

Region * () | West Europe e |

The new vault will now be listed in Dashboard > All resources, and on the main Recovery Services
vaults page.

Set up an Azure network

Azure VMware Solution VMs are replicated to Azure managed disks. When failover occurs, Azure VMs are



created from these managed disks, and joined to the Azure network you specify in this procedure.

1.

2.

10.

In the Azure portal, select Create a resource > Networking > Virtual network.

Keep Resource Manager selected as the deployment model.

. In Name, enter a network name. The name must be unique within the Azure resource group. We're using

ContosoASRnet in this tutorial.

. In Address space, enter the virtual network's address range in CDR notation. We're using 10.1.0.0/24.
. In Subscription, select the subscription in which to create the network.

. Specify the Resource group in which the network will be created. We're using the existing resource

group contosoRG.

In Location, select the same region as that in which the Recovery Services vault was created. In our
tutorial it's West Europe. The network must be in the same region as the vault.

In Address range, enter the range for the network. We're using 10.1.0.0/24, and not using a subnet.

We're leaving the default options of basic DDoS protection, with no service endpoint, or firewall on the
network.

Select Create.


https://portal.azure.com

Create virtual network O x

Name *

| ContosoASRnet v |
Address space * (@

| 10.1.0.0/24 |

10.1.0.0 - 10.1.0.255 (256 addresses)
[] Add an I1Pv6 address space O

Subscription *

| Contoso Subscription 7 |

Resource group *

| contosoRG ' |
Create new

Location *

| (Europe) West Europe s |

Subnet

Name *

| default |

Address range * @
| 101.00724 |

10.1.0.0 - 10.1.0.255 (256 addresses)
DDoS protection (@)

(®) Basic () Standard

Service endpoints (D
CEETED) cerbied )

Firewall &
CEETED) cerbied )

Automation options

The virtual network takes a few seconds to create. After it's created, you'll see it in the Azure portal dashboard.

Next steps

Prepare infrastructure

® | earn about Azure networks.

e Learn about managed disks.


https://docs.microsoft.com/en-us/azure/virtual-network/virtual-networks-overview
https://docs.microsoft.com/en-us/azure/virtual-machines/managed-disks-overview

Prepare Azure VMware Solution for disaster

recovery to Azure Site Recovery

8/19/2022 « 5 minutes to read  Edit Online

This article describes how to prepare Azure VMware Solution servers for disaster recovery to Azure using the
Azure Site Recovery services.

This is the second tutorial in a series that shows you how to set up disaster recovery to Azure for Azure VMware
Solution VMs. In the first tutorial, we set up the Azure components needed for Azure VMware Solution disaster
recovery.

In this article, you learn how to:

e Prepare an account on the vCenter server or vSphere ESXi host, to automate VM discovery.
e Prepare an account for automatic installation of the Mobility service on VMware VMs.
e Review VMware server and VM requirements and support.

e Prepare to connect to Azure VMs after failover.

NOTE

Tutorials show you the simplest deployment path for a scenario. They use default options where possible, and don't show
all possible settings and paths. For detailed instructions, review the article in the How To section of the Site Recovery Table
of Contents.

Before you start

Make sure you've prepared Azure as described in the first tutorial in this series.

Prepare an account for automatic discovery

Site Recovery needs access to Azure VMware Solution servers to:

e Automatically discover VMs. At least a read-only account is required.

e Orchestrate replication, failover, and failback. You need an account that can run operations such as creating
and removing disks, and powering on VMs.

Create the account as follows:

1. To use a dedicated account, create a role at the vCenter level. Give the role a name such as
Azure_Site_Recovery.

2. Assign the role the permissions summarized in the table below.

3. Create a user on the vCenter server or vSphere host. Assign the role to the user.

VMware account permissions

TASK ROLE/PERMISSIONS DETAILS


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/site-recovery/avs-tutorial-prepare-avs.md
https://docs.microsoft.com/en-us/azure/site-recovery/site-recovery-overview

TASK

VM discovery

Full replication, failover, failback

ROLE/PERMISSIONS

At least a read-only user

Data Center object —> Propagate to
Child Object, role=Read-only

Create a role (Azure_Site_Recovery)
with the required permissions, and
then assign the role to a VMware user
or group

Data Center object —> Propagate to
Child Object, role=Azure_Site_Recovery

Datastore -> Allocate space, browse
datastore, low-level file operations,
remove file, update virtual machine
files

Network -> Network assign

Resource -> Assign VM to resource
pool, migrate powered off VM, migrate
powered on VM

Tasks -> Create task, update task
Virtual machine -> Configuration

Virtual machine -> Interact -> answer
question, device connection, configure
CD media, configure floppy media,
power off, power on, VMware tools
install

Virtual machine -> Inventory ->
Create, register, unregister

Virtual machine -> Provisioning ->
Allow virtual machine download, allow
virtual machine files upload

Virtual machine -> Snapshots ->
Remove snapshots

DETAILS

User assigned at datacenter level, and
has access to all the objects in the
datacenter.

To restrict access, assign the No
access role with the Propagate to
child object, to the child objects
(vSphere hosts, datastores, VMs and
networks).

User assigned at datacenter level, and
has access to all the objects in the
datacenter.

To restrict access, assign the No
access role with the Propagate to
child object, to the child objects
(vSphere hosts, datastores, VMs and
networks).

Prepare an account for Mobility service installation

The Mobility service must be installed on machines you want to replicate. Site Recovery can do a push

installation of this service when you enable replication for a machine, or you can install it manually, or using

installation tools.

e In this tutorial, we're going to install the Mobility service with the push installation.

e For this push installation, you need to prepare an account that Site Recovery can use to access the VM. You

specify this account when you set up disaster recovery in the Azure console.



Prepare the account as follows:
Prepare a domain or local account with permissions to install on the VM.

e Windows VMs: To install on Windows VMs if you're not using a domain account, disable Remote User
Access control on the local machine. To do this, in the registry >
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System, add
the DWORD entry LocalAccountTokenFilterPolicy, with a value of 1.

e Linux VMs: To install on Linux VMs, prepare a root account on the source Linux server.

Check VMware requirements

Make sure VMware servers and VMs comply with requirements.

1. Verify Azure VMware solution software versions.

Verify VMware server requirements.

For Linux VMs, check file system and storage requirements.

Check network and storage support.

Check what's supported for Azure networking, storage, and compute, after failover.

Your Azure VMware Solution VMs you replicate to Azure must comply with Azure VM requirements.

N o vk~ W

In Linux virtual machines, device name or mount point name should be unique. Ensure that no two
devices/mount points have the same names. Note that name aren't case-sensitive. For example, naming two
devices for the same VM as device? and Device7 isn't allowed.

Prepare to connect to Azure VMs after failover

After failover, you might want to connect to the Azure VMs from your Azure VMware Solution network.
To connect to Windows VMs using RDP after failover, do the following:

e Internet access. Before failover, enable RDP on the Azure VMware Solution VM before failover. Make sure
that TCP, and UDP rules are added for the Public profile, and that RDP is allowed in Windows Firewall >
Allowed Apps, for all profiles.

e Site-to-site VPN access:
o Before failover, enable RDP on the Azure VMware Solution VM.

o RDP should be allowed in the Windows Firewall -> Allowed apps and features for Domain and
Private networks.

o Check that the operating system's SAN policy is set to OnlineAll. Learn more.

e There should be no Windows updates pending on the VM when you trigger a failover. If there are, you won't
be able to sign in to the virtual machine until the update completes.

e On the Windows Azure VM after failover, check Boot diagnostics to view a screenshot of the VM. If you
can't connect, check that the VM is running and review these troubleshooting tips.

To connect to Linux VMs using SSH after failover, do the following:

o On the Azure VMware Solution VM before failover, check that the Secure Shell service is set to start
automatically on system boot.

Check that firewall rules allow an SSH connection.

On the Azure VM after failover, allow incoming connections to the SSH port for the network security group
rules on the failed over VM, and for the Azure subnet to which it's connected.

Add a public IP address for the VM.

You can check Boot diagnostics to view a screenshot of the VM.
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https://social.technet.microsoft.com/wiki/contents/articles/31666.troubleshooting-remote-desktop-connection-after-failover-using-asr.aspx
https://docs.microsoft.com/en-us/azure/site-recovery/site-recovery-monitor-and-troubleshoot

Failback requirements

If you plan to fail back to your Azure VMware Solution cloud, there are a number of prerequisites for failback.

You can prepare these now, but you don't need to. You can prepare after you fail over to Azure.

Next steps
Setup disaster recovery

e [f you're replicating multiple VMs, perform capacity planning.


https://docs.microsoft.com/en-us/azure/site-recovery/site-recovery-deployment-planner

Setup Azure Site Recovery for Azure VMware

Solution VMs

8/19/2022 « 10 minutes to read « Edit Online

This article describes how to enable replication for Azure VMware Solution VMs, for disaster recovery to Azure
using the Azure Site Recovery service.

This is the third tutorial in a series that shows you how to set up disaster recovery to Azure for Azure VMware
Solution VMs. In the previous tutorial, we prepared Azure VMware Solution environment for disaster recovery
to Azure.

In this tutorial, you learn how to:

e Set up the source replication settings, and a Site Recovery configuration server in Azure VMware Solution
private cloud

e Set up the replication target settings.
e (Create a replication policy.

e Enable replication for a VMware VM.

NOTE

Tutorials show you the simplest deployment path for a scenario. They use default options where possible, and don't show
all possible settings and paths. For detailed instructions, review the article in the How To section of the Site Recovery Table
of Contents.

Before you start

Complete the previous tutorials:

1. Make sure you've set up Azure for disaster recovery to Azure.
2. Follow these steps to prepare your Azure VMware Solution deployment for disaster recovery to Azure.

3. In this tutorial we show you how to replicate a single VM. If you're deploying multiple VMs you should use
the Deployment Planner Tool. Learn more about this tool.

4. This tutorial uses a number of options you might want to do differently:

e The tutorial uses an OVA template to create the configuration server VMware VM. If you can't do this

for some reason, follow these instructions to set up the configuration server manually.

e In this tutorial, Site Recovery automatically downloads and installs MySQL to the configuration server.
If you prefer, you can set it up manually instead. Learn more.

Select a protection goal

1. In Recovery Services vaults, select the vault name. We're using ContosoVMVault for this scenario.
In Getting Started, select Site Recovery. Then select Prepare Infrastructure.
In Protection goal > Where are your machines located, select On-premises.

In Where do you want to replicate your machines, select To Azure.

v oA wonN

In Are your machines virtualized, select Yes, with VMware vSphere Hypervisor. Then select OK.
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Set up the source environment

In your source environment, you need a single, highly available, on-premises machine to host these on-

premises Site Recovery components:

e Configuration server: The configuration server coordinates communications between Azure VMware

Solution private cloud and Azure, and manages data replication.

e Process server: The process server acts as a replication gateway. It receives replication data; optimizes it
with caching, compression, and encryption, and sends it to a cache storage account in Azure. The process
server also installs the Mobility Service agent on VMs you want to replicate, and performs automatic
discovery of Azure VMware Solution VMs.

e Master target server: The master target server handles replication data during failback from Azure.

All of these components are installed together on a single Azure VMware Solution machine that's known as the
configuration server. By default, for Azure VMware Solution disaster recovery, we set up the configuration
server as a highly available VMware VM. To do this, you download a prepared Open Virtualization Application
(OVA) template, and import the template into VMware to create the VM.

e The latest version of the configuration server is available in the portal. You can also download it directly from
the Microsoft Download Center.

e [f for some reason you can't use an OVA template to set up a VM, follow these instructions to set up the
configuration server manually.

e The license provided with OVF template is an evaluation license valid for 180 days. Windows running on the
VM must be activated with the required license.

Download the VM template

1. In the vault, go to Prepare Infrastructure > Source.

2. In Prepare source, select + Configuration server.

3. In Add Server, check that Configuration server for VMware appears in Server type.
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. Download the OVA template for the configuration server.

Import the template in VMware

1. Sign in to the VMware vCenter server or vSphere ESXi host with the VMware vSphere Client.

2. On the File menu, select Deploy OVF Template to start the Deploy OVF Template Wizard.
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What is a Datacenter?

A datacenter is the primary container of inventory objects

such as hosts and virtual machines. From the datacenter,

you can add and organize inventory objects. Typically, you

add hosts, folders, and clusters to a datacenter Virtual Machines

vCenter Server can contain multiple datacenters. Large ster
companies might use multiple datacenters to represent 2
organizational units in their enterprise.

Inventory objects can interact within datacenters, but Host ™y
interaction across datacenters is limited. For example, you

can move a virtual machine with viMotion technology

across hosts within a datacenter but not to a host in

another datacenter. Datacenter

enter Server

Basic Tasks

[ Add a host

Explore Further

[l Create a cluster

B create a folder =| Learn more about datacenters
| Learn about hosts
| Learn about clusters

3. On Select source, enter the location of the downloaded OVF.
4. On Review details, select Next.
5. OnSelect name and folder and Select configuration, accept the default settings.

6. On Select storage, for best performance select Thick Provision Eager Zeroed in Select virtual disk
format.

7. On the rest of the wizard pages, accept the default settings.

8. On Ready to complete, to set up the VM with the default settings, select Power on after deployment
> Finish.

TIP

If you want to add an additional NIC, clear Power on after deployment > Finish. By default, the template
contains a single NIC. You can add additional NICs after deployment.

Add an additional adapter

If you want to add an additional NIC to the configuration server, add it before you register the server in the
vault. Adding additional adapters isn't supported after registration.

1. In the vSphere Client inventory, right-click the VM and select Edit Settings.
In Hardware, select Add > Ethernet Adapter. Then select Next.

Select an adapter type and a network.

> won

To connect the virtual NIC when the VM is turned on, select Connect at power on. Select Next > Finish.
Then select OK.

Register the configuration server

After the configuration server is set up, you register it in the vault.

1. From the VMware vSphere Client console, turn on the VM.

2. The VM boots up into a Windows Server 2016 installation experience. Accept the license agreement, and
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enter an administrator password.

. After the installation finishes, sign in to the VM as the administrator.
. The first time you sign in, the Azure Site Recovery Configuration Tool starts within a few seconds.
. Enter a name that's used to register the configuration server with Site Recovery. Then select Next.

. The tool checks that the VM can connect to Azure. After the connection is established, select Sign in to sign

in to your Azure subscription. The credentials must have access to the vault in which you want to register the

configuration server. Ensure that necessary roles are assigned to this user.

. The tool performs some configuration tasks and then reboots.

. Sign in to the machine again. In a few seconds, the Configuration Server Management Wizard starts

automatically.

Configure settings and add the VMware server

Finish setting up and registering the configuration server. Before proceeding, ensure all pre-requisites are met

for successful set up of configuration server.

1.

In the configuration server management wizard, select Setup connectivity. From the dropdowns, first
select the NIC that the in-built process server uses for discovery and push installation of mobility service on
source machines, and then select the NIC that Configuration Server uses for connectivity with Azure. Then
select Save. You cannot change this setting after it's configured.

. InSelect Recovery Services vault, select your Azure subscription and the relevant resource group and

vault.

. InInstall third-party software, accept the license agreement. Select Download and Install to install

MySQL Server. If you placed MySQL in the path, this step can be skipped. Learn more

. InValidate appliance configuration, prerequisites are verified before you continue.

5. InConfigure vCenter Server/vSphere ESXi server, enter the FQDN or IP address of the vCenter server,

or vSphere host, where the VMs you want to replicate are located. Enter the port on which the server is
listening. Enter a friendly name to be used for the VMware server in the vault.

. Enter user credentials to be used by the configuration server to connect to the VMware server. Ensure that

the user name and password are correct and is a part of the Administrators group of the virtual machine to
be protected. Site Recovery uses these credentials to automatically discover VMware VMs that are available
for replication. Select Add, and then select Continue.

. In Configure virtual machine credentials, enter the user name and password that will be used to

automatically install Mobility Service on VMs when replication is enabled.

e For Windows machines, the account needs local administrator privileges on the machines you want to
replicate.

e For Linux, provide details for the root account.

. SelectFinalize configuration to complete registration.

. After registration finishes, open the Azure portal and verify that the configuration server and VMware server

are listed on Recovery Services Vault > Manage > Site Recovery Infrastructure > Configuration

Servers.

After the configuration server is registered, Site Recovery connects to VMware servers by using the specified
settings, and discovers VMs.

NOTE

It can take 15 minutes or more for the account name to appear in the portal. To update immediately, select

Configuration Servers > server name > Refresh Server.

Set up the target environment
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Select and verify target resources.

1. Select Prepare infrastructure > Target. Select the Azure subscription you want to use. We're using a
Resource Manager model.

2. Site Recovery checks that you have one or more virtual networks. You should have these when you set up
the Azure components in the first tutorial in this tutorial series.

+ t + MNetwork

+/ Step 1: Select Azure subscription

* Subscniption @
ASR GQLs in PROD v
* Select the deployment model used after

failover @
Resource Manager W

+/ Step 2: Ensure that at least one compatible
Azure virtual network exist

MNetwork(s) @

Found 4 compatible Azure virtual networks out
of 19 available in the subscription

Create a replication policy

1. Open the Azure portal. Search for and select Recovery Services vaults.
2. Select the Recovery Services vault (ContosoVMVault in this tutorial).

3. To create a replication policy, select Site Recovery infrastructure > Replication Policies >
+Replication Policy.

4. In Create replication policy, enter the policy name. We're using VMwareRepPolicy.

5. InRPO threshold, use the default of 60 minutes. This value defines how often recovery points are
created. An alert is generated if continuous replication exceeds this limit.

6. In Recovery point retention, specify how longer each recovery point is retained. For this tutorial we're
using 72 hours. Replicated VMs can be recovered to any point in a retention window.

7. In App-consistent snapshot frequency, specify how often app-consistent snapshots are created.
We're using the default of 60 minutes. Select OK to create the policy.
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* Name @

| VMwareRepPolicy ¢|
Source type @

VMware / Physical machines 4

Target type @

Azure v

* RPO threshold in mins @

60

* Recovery point retention in hours @

5

24

* App-consistent snapshot frequency in mins @

60

Failback replication policy name @

A replication policy for failback
from Azure to on-premises will be
automatically created with the same
settings.

e The policy is automatically associated with the configuration server.

e A matching policy is automatically created for failback by default. For example, if the replication policy is rep-

policy, then the failback policy is rep-policy-failback. This policy isn't used until you initiate a failback from
Azure.

Note: In VMware-to-Azure scenario the crash-consistent snapshot is taken at 5 min interval.

Enable replication

Enable replication for VMs as follows:

1.
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Select Replicate application > Source.

In Source, select On-premises, and select the configuration server in Source location.

In Machine type, select Virtual Machines.

In vCenter/vSphere Hypervisor, select the vSphere host, or vCenter server that manages the host.

Select the process server (installed by default on the configuration server VM). Then select OK. Health status
of each process server is indicated as per recommended limits and other parameters. Choose a healthy
process server. A critical process server cannot be chosen. You can either troubleshoot and resolve the errors
or set up a scale-out process server.

In Target, select the subscription and the resource group in which you want to create the failed-over VMs.
We're using the Resource Manager deployment model.

Select the Azure network and subnet to which Azure VMs connect when they're created after failover.
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10.

11.

12.
13.

14.
15.

. Select Configure now for selected machines to apply the network setting to all VMs on which you

enable replication. Select Configure later to select the Azure network per machine.

. InVirtual Machines > Select virtual machines, select each machine you want to replicate. You can only

select machines for which replication can be enabled. Then select OK. If you are not able to view/select any

particular virtual machine, learn more about resolving the issue.

In Properties > Configure properties, select the account to be used by the process server to

automatically install Mobility Service on the machine.

In Replication settings > Configure replication settings, verify that the correct replication policy is
selected.

Select Enable Replication. Site Recovery installs the Mobility Service when replication is enabled for a VM.
You can track progress of the Enable Protection job in Settings > Jobs > Site Recovery Jobs. After the
Finalize Protection job runs and a recovery point generation is complete, the machine is ready for failover.
It can take 15 minutes or longer for changes to take effect and appear in the portal.

To monitor VMs you add, check the last discovered time for VMs in Configuration Servers > Last
Contact At. To add VMs without waiting for the scheduled discovery, highlight the configuration server
(don't select it) and select Refresh.

Next steps

After enabling replication, run a drill to make sure everything's working as expected.

Run a disaster recovery drill
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Run a disaster recovery drill from Azure VMware

Solution to Azure

8/19/2022 - 3 minutes to read  Edit Online

This article describes how to run a disaster recovery drill for an Azure VMware Solution VM to Azure using the
Azure Site Recovery service. A drill validates your replication strategy without data loss.

This is the fourth tutorial in a series that shows you how to set up disaster recovery to Azure for Azure VMware
Solution machines.

In this tutorial, learn how to:

e Setup an isolated network for the test failover
® Prepare to connect to the Azure VM after failover

e Run a test failover for a single machine.

NOTE

Tutorials show you the simplest deployment path for a scenario. They use default options where possible, and don't show
all possible settings and paths. If you want to learn about the disaster recovery drill steps in more detail, review this
article.

Before you start

Complete the previous tutorials:

1. Make sure you've set up Azure for disaster recovery to Azure.
2. Follow these steps to prepare your Azure VMware Solution deployment for disaster recovery to Azure.

3. Setup disaster recovery for Azure VMware Solution VMs.

Verify VM properties

Before you run a test failover, verify the VM properties, and make sure that the VMware VM complies with Azure
requirements.

1. In Protected Items, click Replicated Items > and the VM.

2. Inthe Replicated item pane, there's a summary of VM information, health status, and the latest available
recovery points. Click Properties to view more details.

3. InCompute and Network, you can modify the Azure name, resource group, target size, availability set, and
managed disk settings.

4. You can view and modify network settings, including the network/subnet in which the Azure VM will be
located after failover, and the IP address that will be assigned to it.

5. In Disks, you can see information about the operating system and data disks on the VM.

Create a network for test failover

We recommended that for test failover, you choose a network that's isolated from the production recovery site
network specific in the Compute and Network settings for each VM. By default, when you create an Azure
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virtual network, it is isolated from other networks. The test network should mimic your production network:

e The test network should have same number of subnets as your production network. Subnets should have the
same names.
e The test network should use same IP address class and subnet range.

e Update the DNS of the test network with the IP address specified for the DNS VM in Compute and
Network settings. Read test failover considerations for Active Directory for more details.

Run a test failover for a single VM
When you run a test failover, the following happens:

1. A prerequisites check runs to make sure all of the conditions required for failover are in place.

2. Failover processes the data, so that an Azure VM can be created. If you select the latest recovery point, a

recovery point is created from the data.

3. An Azure VM is created using the data processed in the previous step.

Run the test failover as follows:

1. InSettings > Replicated Items, click the VM > +Test Failover.

2. Select the Latest processed recovery point for this tutorial. This fails over the VM to the latest available
point in time. The time stamp is shown. With this option, no time is spent processing data, so it provides a
low RTO (recovery time objective).

3. InTest Failover, select the target Azure network to which Azure VMs will be connected after failover occurs.

4. Click OK to begin the failover. You can track progress by clicking on the VM to open its properties. Or you can
click the Test Failover job in vault name > Settings > Jobs > Site Recovery jobs.

5. After the failover finishes, the replica Azure VM appears in the Azure portal > Virtual Machines. Check that
the VM is the appropriate size, that it's connected to the right network, and that it's running.

6. You should now be able to connect to the replicated VM in Azure.

7. To delete Azure VMs created during the test failover, click Cleanup test failover on the VM. In Notes,
record and save any observations associated with the test failover.

In some scenarios, failover requires additional processing that takes around eight to ten minutes to complete.
You might notice longer test failover times for VMware Linux machines, VMware VMs that don't have the DHCP
service enables, and VMware VMs that don't have the following boot drivers: storvsc, vmbus, storflt, intelide,

atapi.

Connect after failover

If you want to connect to Azure VMs using RDP/SSH after failover, prepare to connect. If you encounter any

connectivity issues after failover, follow the troubleshooting guide.

Next steps

Run a failover
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Fail over Azure VMware Solution VMs

8/19/2022 + 3 minutes to read « Edit Online

This article describes how to fail over an Azure VMware Solution VM to Azure with Azure Site Recovery.

This is the fifth tutorial in a series that shows you how to set up disaster recovery to Azure for Azure VMware
Solution VMs.

In this tutorial, you learn how to:

o Verify that the Azure VMware Solution VM properties conform with Azure requirements.

e Fail over specific VMs to Azure.

NOTE

Tutorials show you the simplest deployment path for a scenario. They use default options where possible and don't show
all possible settings and paths. If you want to learn about failover in detail, see Fail over VMs.

Learn about different types of failover. If you want to fail over multiple VMs in a recovery plan, review this
article.

Before you start

Complete the previous tutorials:

1. Make sure you've set up Azure for disaster recovery to Azure.

2. Follow these steps to prepare your Azure VMware Solution deployment for disaster recovery to Azure.
3. Set up disaster recovery for Azure VMware Solution VMs.
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. Run a disaster recovery drill to make sure that everything's working as expected.

Verify VM properties

Before you run a failover, check the VM properties to make sure that the VMs meet Azure requirements.
Verify properties as follows:

1. In Protected Items, select Replicated Items, and then select the VM you want to verify.

2. In the Replicated item pane, there's a summary of VM information, health status, and the latest
available recovery points. Select Properties to view more details.

3. InCompute and Network, you can modify these properties as needed:

e Azure name

Resource group

Target size

Availability set

Managed disk settings

4. You can view and modify network settings, including:

o The network and subnet in which the Azure VM will be located after failover.
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e The IP address that will be assigned to it.

5. In Disks, you can see information about the operating system and data disks on the VM.

Run a failover to Azure
1. In Settings > Replicated items, select the VM you want to fail over, and then select Failover.
2. In Failover, select a Recovery Point to fail over to. You can use one of the following options:

e [atest: This option first processes all the data sent to Site Recovery. It provides the lowest Recovery
Point Objective (RPO) because the Azure VM that's created after failover has all the data that was
replicated to Site Recovery when the failover was triggered.

e |atest processed: This option fails the VM over to the latest recovery point processed by Site
Recovery. This option provides a low RTO (Recovery Time Objective) because no time is spent
processing unprocessed data.

e |atest app-consistent: This option fails the VM over to the latest app-consistent recovery point
processed by Site Recovery.

e Custom: This option lets you specify a recovery point.

3. Select Shut down machine before beginning failover to attempt to shut down source VMs before
triggering the failover. Failover continues even if the shutdown fails. You can follow the failover progress
on the Jobs page.

In some scenarios, failover requires additional processing that takes around 8 to 10 minutes to complete. You
might notice longer test failover times for:

e VMware VMs running a Mobility service version older than 9.8.
VMware Linux VMs.
VMware VMs that don't have the DHCP service enabled.

VMware VMs that don't have the following boot drivers: storvsc, vmbus, storflt, intelide, atapi.

WARNING

Don't cancel a failover in progress. Before failover is started, VM replication is stopped. If you cancel a failover in progress,
failover stops, but the VM won't replicate again.

Connect to failed-over VM

1. If you want to connect to Azure VMs after failover by using Remote Desktop Protocol (RDP) and Secure Shell
(SSH), verify that the requirements have been met.

2. After failover, go to the VM and validate by connecting to it.

3. Use Change recovery point if you want to use a different recovery point after failover. After you commit
the failover in the next step, this option will no longer be available.

4. After validation, select Commit to finalize the recovery point of the VM after failover.

5. After you commit, all the other available recovery points are deleted. This step completes the failover.

TIP

If you encounter any connectivity issues after failover, follow the troubleshooting guide.

Next steps

After failover, reprotect the Azure VMs to Azure VMware Solution private cloud. Then, after the VMs are
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reprotected and replicating to the Azure VMware Solution private cloud, fail back from Azure when you're ready.

Reprotect Azure VMs Failback from Azure



Reprotect from Azure to Azure VMware Solution

private cloud

8/19/2022 « 4 minutes to read » Edit Online

After failover of Azure VMware Solution VMs to Azure, the first step in failing back to your Azure VMware

Solution private cloud is to reprotect the Azure VMs that were created during failover. This article describes how
to do this.

Before you begin

1.

Follow the steps in this article to prepare for reprotection and failback, including setting up a process server
in Azure, and an Azure VMware Solution private cloud master target server, and configuring a site-to-site
VPN, or ExpressRoute private peering, for failback.

. Make sure that the Azure VMware Solution private cloud configuration server is running and connected to

Azure. During failback, the VM must exist in the configuration server database. Otherwise, failback is
unsuccessful.

. Delete any snapshots on the Azure VMware Solution private cloud master target server. Reprotection won't

work if there are snapshots. The snapshots on the VM are automatically merged during a reprotect job.

. If you're reprotecting VMs gathered into a replication group for multi-VM consistency, make sure they all

have the same operating system (Windows or Linux) and make sure that the master target server you deploy
has the same type of operating system. All VMs in a replication group must use the same master target
server.

5. Open the required ports for failback.

10.

11.

. Ensure that the vCenter Server is connected before failback. Otherwise, disconnecting disks and attaching

them back to the virtual machine fails.

. If a vCenter server manages the VMs to which you'll fail back, make sure that you have the required

permissions. If you perform a read-only user vCenter discovery and protect virtual machines, protection
succeeds, and failover works. However, during reprotection, failover fails because the datastores can't be
discovered, and aren't listed during reprotection. To resolve this problem, you can update the vCenter
credentials with an appropriate account/permissions, and then retry the job.

. If you used a template to create your virtual machines, ensure that each VM has its own UUID for the disks. If

the Azure VMware Solution VM UUID clashes with the UUID of the master target server because both were

created from the same template, reprotection fails. Deploy from a different template.

. If you're failing back to an alternate vCenter Server, make sure that the new vCenter Server and the master

target server are discovered. Typically if they're not the datastores aren't accessible, or aren't visible in
Reprotect.

Verify the following scenarios in which you can't fail back:

e [f you're using either the ESXi 5.5 free edition or the vSphere 6 Hypervisor free edition. Upgrade to a
different version.

e [f you have a Windows Server 2008 R2 SP1 physical server.
e VMware VMs can't fail back to Hyper-V.

e VMs that have been migrated.

e A VM that's been moved to another resource group.

e Areplica Azure VM that's been deleted.

e Areplica Azure VM that isn't protected.

Review the types of failback you can use - original location recovery and alternate location recovery.
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Enable reprotection

Enable replication. You can reprotect specific VMs, or a recovery plan:

If you reprotect a recovery plan, you must provide the values for every protected machine.

If VMs belong to a replication group for multi-VM consistency, they can only be reprotected using a recovery
plan. VMs in a replication group must use the same master target server

NOTE

The amount of data sent from Azure to erstwhile source during reprotect, can be anything between 0 bytes and sum of

disk size for all protected machines, and can't be calculated.

Before you start

After a VM boots in Azure after failover, it takes some time for the agent to register back to the configuration
server (up to 15 minutes). During this time, you won't be able to reprotect and an error message indicates
that the agent isn't installed. If this happens, wait for a few minutes, and then reprotect.

If you want to fail back the Azure VM to an existing Azure VMware Solution VM, mount the VM datastores
with read/write access on the master target server's ESXi host.

If you want to fail back to an alternate location, for example if the Azure VMware Solution VM doesn't exist,
select the retention drive and datastore that are configured for the master target server. When you fail back
to the Azure VMware Solution private cloud, the virtual machines in the failback protection plan use the
same datastore as the master target server. A new VM is then created in vCenter.

Enable reprotection as follows:

1.

Select Vault > Replicated items. Right-click the virtual machine that failed over, and then select Re-
Protect. Or, from the command buttons, select the machine, and then select Re-Protect.

. Verify that the Azure to On-premises direction of protection is selected.

. In Master Target Server and Process Server, select the on-premises master target server and the

process server.

. For Datastore, select the datastore to which you want to recover the disks in Azure VMware Solution.

This option is used when the Azure VMware Solution VM is deleted, and you need to create new disks.

This option is ignored if the disks already exist. You still need to specify a value.

. Select the retention drive.

The failback policy is automatically selected.

. Select OK to begin reprotection.

Re-protect

To fail back you'll need a process server and a master target server. You can use the same process server that was used during failover ar
click here add to a new one on the Canfiguration Servers page.

NAME PROCESS SERVER MASTER TARGET DATA STORE RETENTION DRIVE FAILEACK POLICY
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8. Ajob begins to replicate the Azure VM to the Azure VMware Solution private cloud. You can track the
progress on the Jobs tab.

e When the reprotection succeeds, the VM enters a protected state.

e The Azure VMware Solution VM is turned off during reprotection. This helps ensure data consistency
during replication.

e Don't turn on the Azure VMware Solution VM after reprotection finishes.

Next steps

e [f you encounter any issues, review the troubleshooting article.

e After the Azure VMs are protected, you can run a failback. Failback shuts down the Azure VM and boots the

Azure VMware Solution VM. Expect some downtime for the application, and choose a failback time
accordingly.


https://docs.microsoft.com/en-us/azure/site-recovery/vmware-azure-troubleshoot-failback-reprotect

Fail back VMs to Azure VMware Solution private

cloud

8/19/2022 - 2 minutes to read  Edit Online

This article describes how to failback Azure VMs to an Azure VMware Solution private cloud, following failover

of Azure VMware Solution VMs to Azure with Azure Site Recovery. After failback, you enable replication so that

the Azure VMware Solution VMs start replicating to Azure.

Before you start

1.
2.

Learn about VMware vSphere failback.

Make sure you've reviewed and completed the steps to prepare for failback, and that all the required
components are deployed. Components include a process server in Azure, a master target server, and a VPN
site-to-site connection (or ExpressRoute private peering) for failback.

. Make sure you've completed the requirements for reprotection and failback, and that you've enabled

reprotection of Azure VMs, so that they're replicating from Azure to the Azure VMware Solution private
cloud. VMs must be in a replicated state in order to fail back.

Run a failover to fail back

1.

Make sure that Azure VMs are reprotected and replicating to the Azure VMware Solution private cloud.
e A VM needs at least one recovery point in order to fail back.
e [f you fail back a recovery plan, then all machines in the plan should have at least one recovery point.

In the vault > Replicated items, select the VM. Right-click the VM > Unplanned Failover.

3. In Confirm Failover, verify the failover direction (from Azure).

Select the recovery point that you want to use for the failover.

e We recommend that you use the Latest recovery point. The app-consistent point is behind the latest
point in time, and causes some data loss.

e latest is a crash-consistent recovery point.

e With Latest, a VM fails over to its latest available point in time. If you have a replication group for
multi-VM consistency within a recovery plan, each VM in the group fails over to its independent latest
pointin time.

e [f you use an app-consistent recovery point, each VM fails back to its latest available point. If a
recovery plan has a replication group, each group recovers to its common available recovery point.

. Failover begins. Azure Site Recovery shuts down the Azure VMs.

After failover completes, check everything's working as expected. Check that the Azure VMs are shut down.

With everything verified, right-click the VM > Commit, to finish the failover process. Commit removes the
failed-over Azure VM.

NOTE

For Windows VMs, Azure Site Recovery disables the VMware tools during failover. During failback of the Windows VM, the
VMware tools are enabled again.

Reprotect from Azure VMware Solution to Azure



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/site-recovery/avs-tutorial-failback.md
https://docs.microsoft.com/en-us/azure/site-recovery/site-recovery-overview
https://docs.microsoft.com/en-us/azure/site-recovery/failover-failback-overview
https://docs.microsoft.com/en-us/azure/site-recovery/vmware-azure-prepare-failback

After committing the failback, the Azure VMs are deleted. The VM is back in the Azure VMware Solution private

cloud, but it isn't protected. To start replicating VMs to Azure again,as follows:

1. In the vault > Replicated items, select failed back VMs, and then select Re-Protect.
2. Specify the process server that's used to send data back to Azure.

3. Select OK to begin the reprotect job.

NOTE

After an Azure VMware Solution VM starts, it takes up to 15 minutes for the agent to register back to the configuration
server. During this time, reprotect fails and returns an error message stating that the agent isn't installed. If this occurs,

wait for a few minutes, and reprotect.

Next steps

After the reprotect job finishes, the Azure VMware Solution VM is replicating to Azure. As needed, you can run
another failover to Azure.



Create an Azure VMware Solution assessment

8/19/2022 + 9 minutes to read « Edit Online

This article describes how to create an Azure VMware Solution assessment for on-premises servers in VMware
environment with Azure Migrate: Discovery and assessment.

Azure Migrate helps you to migrate to Azure. Azure Migrate provides a centralized hub to track discovery,
assessment, and migration of on-premises infrastructure, applications, and data to Azure. The hub provides
Azure tools for assessment and migration, as well as third-party independent software vendor (ISV) offerings.

Before you start

e Make sure you've created an Azure Migrate project.

e [f you've already created a project, make sure you've added the Azure Migrate: Discovery and assessment
tool.

e To create an assessment, you need to set up an Azure Migrate appliance for VMware, which discovers the on-
premises servers, and sends metadata and performance data to Azure Migrate: Discovery and assessment.
Learn more.

e You could also import the server metadata in comma-separated values (CSV) format.

Azure VMware Solution (AVS) Assessment overview

There are three types of assessments you can create using Azure Migrate: Discovery and assessment.

*ASSESSMENT TYPE DETAILS

Azure VM Assessments to migrate your on-premises servers to Azure
virtual machines. You can assess your on-premises servers in
VMware and Hyper-V environment, and physical servers for
migration to Azure VMs using this assessment type.

Azure SQL Assessments to migrate your on-premises SQL servers from
your VMware environment to Azure SQL Database or Azure
SQL Managed Instance.

Azure App Service Assessments to migrate your on-premises ASPNET web
apps, running on IS web servers, from your VMware
environment to Azure App Service.

Azure VMware Solution (AVS) Assessments to migrate your on-premises servers to Azure
VMware Solution (AVS). You can assess your on-premises
servers in VMware environment for migration to Azure
VMware Solution (AVS) using this assessment type. Learn
more

NOTE

Azure VMware Solution (AVS) assessment can be created for servers in VMware environment only.

There are two types of sizing criteria that you can use to create Azure VMware Solution (AVS) assessments:


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/migrate/how-to-create-azure-vmware-solution-assessment.md
https://docs.microsoft.com/en-us/azure/migrate/migrate-services-overview
https://docs.microsoft.com/en-us/azure/migrate/create-manage-projects
https://docs.microsoft.com/en-us/azure/migrate/how-to-assess
https://docs.microsoft.com/en-us/azure/migrate/how-to-set-up-appliance-vmware
https://docs.microsoft.com/en-us/azure/migrate/migrate-appliance
https://docs.microsoft.com/en-us/azure/migrate/tutorial-discover-import
https://docs.microsoft.com/en-us/azure/migrate/how-to-set-up-appliance-vmware
https://docs.microsoft.com/en-us/azure/migrate/how-to-set-up-appliance-hyper-v
https://docs.microsoft.com/en-us/azure/migrate/how-to-set-up-appliance-physical
https://docs.microsoft.com/en-us/azure/migrate/how-to-set-up-appliance-vmware
https://docs.microsoft.com/en-us/azure/migrate/concepts-azure-vmware-solution-assessment-calculation

ASSESSMENT DETAILS

Performance-based Assessments based on collected
performance data of on-premises
servers.

As on-premises Assessments based on on-premises
sizing.

DATA

Recommended Node size: Based on
CPU and memory utilization data
along with node type, storage type,
and FTT setting that you select for the
assessment.

Recommended Node size: Based on
the on-premises server size along with
the node type, storage type, and FTT
setting that you select for the
assessment.

Run an Azure VMware Solution (AVS) assessment

1. On the Overview page > Servers, databases and web apps, click Assess and migrate servers.

2. In Azure Migrate: Discovery and assessment, click Assess.

3. In Assess servers > Assessment type, select Azure VMware Solution (AVS).

4. In Discovery source:

e [f you discovered servers using the appliance, select Servers discovered from Azure Migrate

appliance.

e [f you discovered servers using an imported CSV file, select Imported servers.

5. Click Edit to review the assessment properties.

Home > Azure Migrate >

Create assessment

Basics Select servers to assess Review + create assessment

An assessment is created on a group of servers that you migrate together. Assessment helps you determine the Azure readiness of your Windows, Linux and SQL servers running on-premises or on any

cloud. You can assess the servers discovered via the Azure Migrate appliance as well as the servers imported into Azure Migrate. Learn more.

Assessment details
Assessment type * D Azure VMware Solution (AVS) v Help me choose

@ Creates assessment for migrating on-premises VMware
machines to Azure VMware Solution (AVS). Click here
to learn more about AVS.

Discovery source * Servers discovered from Azure Migrate appliance v
Assessment properties (Showing 4 of 13)

Sizing criteria As on-premises

Target location East US

Reserved capacity (compute) No reserved instances

Azure Hybrid Benefit AHUB benefits do apply to Microsoft based guest OS's

running in AVS, For non-Microsoft guest OS please consult
your vendor for details.

6. In Assessment properties > Target Properties:

e In Target location, specify the Azure region to which you want to migrate.

o Size and cost recommendations are based on the location that you specify.

e The Storage type is defaulted to vSAN. This is the default storage type for an AVS private cloud.

e InReserved Instances, specify whether you want to use reserve instances for Azure VMware



Solution nodes when you migrate your VMs.
e [f you select to use a reserved instance, you can't specify 'Discount (%)

® |[earn more

7. InVM Size:

e The Node type is defaulted to AV36. Azure Migrate recommends the node of nodes needed to
migrate the servers to AVS.

e InFTT setting, RAID level, select the Failure to Tolerate and RAID combination. The selected FTT
option, combined with the on-premises server disk requirement, determines the total vSAN storage
required in AVS.

e |In CPU Oversubscription, specify the ratio of virtual cores associated with one physical core in the
AVS node. Oversubscription of greater than 4:1 might cause performance degradation, but can be
used for web server type workloads.

e In Memory overcommit factor, specify the ratio of memory over commit on the cluster. A value of
1 represents 100% memory use, 0.5 for example is 50%, and 2 would be using 200% of available
memory. You can only add values from 0.5 to 10 up to one decimal place.

e In Dedupe and compression factor, specify the anticipated dedupe and compression factor for
your workloads. Actual value can be obtained from on-premises vSAN or storage config and this may
vary by workload. A value of 3 would mean 3x so for 300GB disk only 100GB storage would be used.
A value of 1 would mean no dedupe or compression. You can only add values from 1 to 10 up to one
decimal place.

8. In Node Size:

10.

e InSizing criterion, select if you want to base the assessment on static metadata, or on
performance-based data. If you use performance data:

o InPerformance history, indicate the data duration on which you want to base the
assessment
o InPercentile utilization, specify the percentile value you want to use for the performance
sample.
e In Comfort factor, indicate the buffer you want to use during assessment. This accounts for
issues like seasonal usage, short performance history, and likely increases in future usage. For

example, if you use a comfort factor of two:

COMPONENT EFFECTIVE UTILIZATION ADD COMFORT FACTOR (2.0)
Cores 2 4
Memory 8 GB 16 GB

. InPricing:

o |n Offer, Azure offer you're enrolled in is displayed. The Assessment estimates the cost for that offer.
e In Currency, select the billing currency for your account.

e InDiscount (%), add any subscription-specific discounts you receive on top of the Azure offer. The
default setting is 0%.

Click Save if you make changes.


https://azure.microsoft.com/support/legal/offer-details/

Edit properties
Assess2202
TARGET PROPERTIES

Target location ©

Storage type @

Reserved instances @

East US N vSAN A No reserved instances v
VM SIZE
Node type O FTT setting, RAID level (O CPU Oversubscription
AV36 v | 1, RAID-1 v [ v
Memory overcommit factor (O Dedupe and compression factor ()
1 | [ 1.5 |
NODE SIZE
Sizing criterion @ Performance history © Percentile utilization ©
| Performance-based % | Not applicable v Not applicable v
Comfort factor @
E v
PRICING
Offer () Currency @ Discount (%) @
Pay-As-You-Go N US Dollar () N | ‘ 0

Performance history and Percentile utilization are not applicable for assessments with certain inventory sources. Learn more.

o AHUB benefits do apply to Microsoft based guest OS's running in AVS. For non-Microsoft guest OS please consult your vendor for

details

Discard |

11. In Assess Servers, click Next.

12. InSelect servers to assess > Assessment name > specify a name for the assessment.

13. InSelect or create a group > select Create New and specify a group name.



Home > Azure Migrate >

Create assessment X

Basics  Select servers to assess  Review + create assessment
Assessment hame my-assessment M

Select or create a group

Use Exsting

mygroup-1 v
Add machines to the group How to create groups using dependency visualization?
Appliance name 2 selected hd
Selectall Clear selection ~ Search to filter machines Previous Page 10of 7
Name IP address Operating system Machine type

Microsoft Windows Serve 6 or latel 4 are

9... Microsoft Windows Server 2016 or later (64-.. lware

< Previous Next >

14. Select the appliance, and select the servers you want to add to the group. Then click Next.

15. InReview + create assessment, review the assessment details, and click Create Assessment to
create the group and run the assessment.

NOTE

For performance-based assessments, we recommend that you wait at least a day after starting discovery before
you create an assessment. This provides time to collect performance data with higher confidence. Ideally, after you
start discovery, wait for the performance duration you specify (day/week/month) for a high-confidence rating.

Review an Azure VMware Solution (AVS) assessment

An Azure VMware Solution (AVS) assessment describes:

e Azure VMware Solution (AVS) readiness: Whether the on-premises servers are suitable for migration to
Azure VMware Solution (AVS).

e Number of Azure VMware Solution nodes: Estimated number of Azure VMware Solution nodes
required to run the servers.

e Utilization across AVS nodes: Projected CPU, memory, and storage utilization across all nodes.

o Utilization includes up front factoring in the following cluster management overheads such as the
vCenter Server, NSX Manager (large), NSX Edge, if HCX is deployed also the HCX Manager and IX
appliance consuming ~ 44vCPU (11 CPU), 75GB of RAM and 722GB of storage before compression
and deduplication.

o Limiting factor determines the number of hosts/nodes required to accommodate the resources.

e Monthly cost estimation: The estimated monthly costs for all Azure VMware Solution (AVS) nodes
running the on-premises VMs.

You can click on Sizing assumptions to understand the assumptions that went in node sizing and resource
utilization calculations. You can also edit the assessment properties, or recalculate the assessment.

View an assessment

1. In Windows, Linux and SQL Server > Azure Migrate: Discovery and assessment, click the



number next to ** Azure VMware Solution**.

. In Assessments, select an assessment to open it. As an example (estimations and costs for example
only):

Cost and readiness

Monthly cost estimate (USD) & AVS readiness for on-premises servers Assessed virtual machines (O
20158.95 i
41 41
Average cost estimate per VM
(USD) Ry unth conditions
[0} 41 0
m™491.68 [
0
Readiness urknown
0
Utilization across AVS nodes  Sizing assumptions
Total AVS nodes required () CPU resources Memory resources (. Storage resources (0
F 3 s nodes 108 cores svaitabie 1728 ce vaiavie 46080 s waacie
78.7% utilized 23.78% utilized 50.47% utilized
Modle type: AV36 e bt
85 used 23 free 41092 used 1317.08 free 23256.56 used 2282342 free
A Limiting factor ©

@ The recomm

exceed the 2

dations provided in this assessment are an estimate and should not be taken as a guarantee of the actual price and number of nodes, Estimates can ch
able space of 75% storage, Azure VMware Solution will monitor and send out communication to recommend adding more node(s) as accordance wit

ge during migration as datapoints bacome clearer, Once customers
ated SLA terms and conditions.

. Review the assessment summary. You can click on Sizing assumptions to understand the assumptions
that went in node sizing and resource utilization calculations. You can also edit the assessment properties,
or recalculate the assessment.

Review Azure VMware Solution (AVS) readiness

1. In Azure readiness, verify whether servers are ready for migration to AVS.

2. Review the server status:

e Ready for AVS:The server can be migrated as-is to Azure (AVS) without any changes. It will startin
AVS with full AVS support.

e Ready with conditions: There might be some compatibility issues example internet protocol or
deprecated OS in VMware and need to be remediated before migrating to Azure VMware Solution. To
fix any readiness problems, follow the remediation guidance the assessment suggests.

e Not ready for AVS: The VM will not start in AVS. For example, if the on-premises VMware VM has an
external device attached such as a cd-rom the VMware VMotion operation will fail (if using VMware
VMotion).

e Readiness unknown: Azure Migrate couldn't determine the readiness of the server because of
insufficient metadata collected from the on-premises environment.

3. Review the Suggested tool:

e VMware HCX or Enterprise: For VMware servers, VMware Hybrid Cloud Extension (HCX) solution is
the suggested migration tool to migrate your on-premises workload to your Azure VMware Solution
(AVS) private cloud. Learn More.

e Unknown: For servers imported via a CSV file, the default migration tool is unknown. Though for
VMware servers, it is suggested to use the VMware Hybrid Cloud Extension (HCX) solution.

4. Click on an AVS readiness status. You can view VM readiness details, and drill down to see VM details,

including compute, storage, and network settings.

Review cost details

This view shows the estimated cost of running servers in Azure VMware Solution.

1. Review the monthly total costs. Costs are aggregated for all servers in the assessed group.

e Cost estimates are based on the number of AVS nodes required considering the resource



requirements of all the servers in total.

e As the pricing for Azure VMware Solution is per node, the total cost does not have compute cost and
storage cost distribution.

e The cost estimation is for running the on-premises servers in AVS. AVS assessment doesn't consider
PaaS or SaaS costs.

2. You can review monthly storage cost estimates. This view shows aggregated storage costs for the
assessed group, split over different types of storage disks.

3. You can drill down to see details for specific servers.

Review confidence rating

When you run performance-based assessments, a confidence rating is assigned to the assessment.

e Arating from 1-star (lowest) to 5-star (highest) is awarded.

e The confidence rating helps you estimate the reliability of the size recommendations provided by the
assessment.

e The confidence rating is based on the availability of data points needed to compute the assessment.

e For performance-based sizing, AVS assessments need the utilization data for CPU and server memory. The
following performance data is collected but not used in sizing recommendations for AVS assessments:

o The disk IOPS and throughput data for every disk attached to the server.

o The network I/0 to handle performance-based sizing for each network adapter attached to a server.

Confidence ratings for an assessment are as follows.

DATA POINT AVAILABILITY CONFIDENCE RATING
0%-20% 1 Star
21%-40% 2 Star
41%-60% 3 Star
61%-80% 4 Star
81%-100% 5 Star

Learn more about performance data

Next steps

e Learn how to use dependency mapping to create high confidence groups.

® [earn more about how AVS assessments are calculated.


https://docs.microsoft.com/en-us/azure/migrate/concepts-azure-vmware-solution-assessment-calculation
https://docs.microsoft.com/en-us/azure/migrate/how-to-create-group-machine-dependencies
https://docs.microsoft.com/en-us/azure/migrate/concepts-azure-vmware-solution-assessment-calculation

Create a placement policy in Azure VMware

Solution

8/19/2022 « 10 minutes to read « Edit Online

In Azure VMware Solution, clusters in a private cloud are a managed resource. As a result, the CloudAdmin role
can't make certain changes to the cluster from the vSphere Client, including the management of Distributed
Resource Scheduler (DRS) rules.

The placement policy feature is available in all Azure VMware Solution regions. Placement policies let you
control the placement of virtual machines (VMs) on hosts within a cluster through the Azure portal. When you
create a placement policy, it includes a DRS rule in the specified vSphere cluster. It also includes additional logic
for interoperability with Azure VMware Solution operations.

A placement policy has at least five required components:
e Name - Defines the name of the policy and is subject to the naming constraints of Azure Resources.
e Type - Defines the type of control you want to apply to the resources contained in the policy.

e Cluster - Defines the cluster for the policy. The scope of a placement policy is a vSphere cluster, so only
resources from the same cluster may be part of the same placement policy.

e State - Defines if the policy is enabled or disabled. In certain scenarios, a policy might be disabled
automatically when a conflicting rule gets created. For more information, see Considerations below.

e Virtual machine - Defines the VMs and hosts for the policy. Depending on the type of rule you create,
your policy may require you to specify some number of VMs and hosts. For more information, see
Placement policy types below.

Prerequisite

You must have Contributor level access to the private cloud to manage placement policies.

Placement policy types

VM-VM policies
VM-VM policies specify if selected VMs should run on the same host or must be kept on separate hosts. In
addition to choosing a name and cluster for the policy, VM-VM policies require that you select at least two VMs

to assign. The assignment of hosts isn't required or permitted for this policy type.

e VM-VM Affinity policies instruct DRS to try to keeping the specified VMs together on the same host. It's

useful for performance reasons, for example.

e VM-VM Anti-Affinity policies instruct DRS to try keeping the specified VMs apart from each other on
separate hosts. It's useful in availability scenarios where a problem with one host doesn't affect multiple
VMs within the same policy.

VM-Host policies

VM-Host policies specify if selected VMs can run on selected hosts. To avoid interference with platform-
managed operations such as host maintenance mode and host replacement, VM-Host policies in Azure
VMware Solution are always preferential (also known as "should" rules). Accordingly, VM-Host policies may not
be honored in certain scenarios. For more information, see Monitor the operation of a policy below.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/create-placement-policy.md
https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/resource-name-rules
https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.resmgmt.doc/GUID-793013E2-0976-43B7-9A00-340FA76859D0.html

Certain platform operations dynamically update the list of hosts defined in VM-Host policies. For example,
when you delete a host that is a member of a placement policy, the host is removed if more than one host is
part of that policy. Also, if a host is part of a policy and needs to be replaced as part of a platform-managed
operation, the policy is updated dynamically with the new host.

In addition to choosing a name and cluster for the policy, a VM-Host policy requires that you select at least one
VM and one host to assign to the policy.

e VM-Host Affinity policies instruct DRS to try running the specified VMs on the hosts defined.

e VM-Host Anti-Affinity policies instruct DRS to try running the specified VMs on hosts other than those
defined.

Considerations

Cluster scale in

Azure VMware Solution attempts to prevent certain DRS rule violations from occurring when performing cluster
scale-in operations.

You can't remove the last host from a VM-Host policy. However, if you need to remove the last host from the
policy, you can remediate it by adding another host to the policy before removing the host from the cluster.
Alternatively, you can delete the placement policy before removing the host.

You can't have a VM-VM Anti Affinity policy with more VMs than the number of hosts in a cluster. If removing a
host would result in fewer hosts in the cluster than VMs, you'll receive an error preventing the operation. You
can remediate it by first removing VMs from the rule and then removing the host from the cluster.

Rule conflicts

If DRS rule conflicts are detected when you create a VM-VM policy, it results in that policy being created in a
disabled state following standard VMware DRS Rule behavior. For more information on viewing rule conflicts,
see Monitor the operation of a policy below.

Create a placement policy

There is no defined limit to the number of policies that you create. However, the more placement constraints you
create, the more challenging it is for vSphere DRS to effectively move virtual machines within the cluster and
provide the resources needed by the workloads.

Make sure to review the requirements for the policy type.

1. In your Azure VMware Solution private cloud, under Manage, select Placement policies > + Create.

TIP

You may also select the Cluster from the Placement Policy overview pane and then select Create.

2. Provide a descriptive name, select the policy type, and select the cluster where the policy is created. Then
select Enabled.

WARNING

If you disable the policy, then the policy and the underlying DRS rule are created, but the policy actions are
ignored until you enable the policy.

3. If you selected VM-Host affinity or VM-Host anti-affinity as the type, select + Add hosts and the


https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.resmgmt.doc/GUID-69C738B6-5FC8-4189-9CB5-DD90A5A05979.html

hosts to include in the policy. You can select multiple hosts.

NOTE

VMs contained in those associated policies.

The select hosts pane shows how many VM-Host policies are associated with the host and the total number of

4. Select + Add virtual machine and the VMs to include in the policy. You can select multiple VMs.

NOTE

VMs contained in those associated policies.

The select hosts pane shows how many VM-Host policies are associated with the host and the total number of

5. Once you've finished adding the VMs you want, select Add virtual machines.
6. Select Next: Review and create to review your policy.
7. Select Create policy. If you want to make changes, select Back: Basics.

8. After the placement policy gets created, select Refresh to see it in the list.
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Home > Lamna_Healthcare PC
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@ Overview Cluster:
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Settings
Name 7 Type Hosts VMs Provisioning state State
B Locks
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Edit a placement policy

You can change the state of a policy, add a new resource, or unassign an existing resource.

Change the policy state

You can change the state of a policy to Enabled or Disabled.

1. In your Azure VMware Solution private cloud, under Manage, select Placement policies.

2. For the policy you want to edit, select More (..) and then select Edit.

TIP

You can't enable a policy from the Settings drop-down.

You can disable a policy from the Placement policy overview by selecting Disable from the Settings drop-down.

3. If the policy is enabled but you want to disable it, select Disabled and then select Disabled on the

confirmation message. Otherwise, if the policy is disabled and you want to enable it, select Enable.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/placement-policies/create-placement-policy-8.png#lightbox

4. Select Review + update.
5. Review the changes and select Update policy. If you want to make changes, select Back: Basics.

Update the resources in a policy

You can add new resources, such as a VM or a host, to a policy or remove existing ones.
1. In your Azure VMware Solution private cloud, under Manage, select Placement policies.

2. For the policy you want to edit, select More (...) and then Edit.
To remove an existing resource, select one or more resources you want to remove and select Unassign.
To add a new resource, select Edit virtual machine or Edit host, select the resource you'd like to add,

and then select Save.
3. Select Next : Review and update.

4. Review the changes and select Update policy. If you want to make changes, select Back : Basics.

Delete a policy

You can delete a placement policy and its corresponding DRS rule.
1. In your Azure VMware Solution private cloud, under Manage, select Placement policies.
2. For the policy you want to edit, select More (...) and then select Delete.

3. Select Delete on the confirmation message.

Monitor the operation of a policy

Use the vSphere Client to monitor the operation of a placement policy's corresponding DRS rule.

As a holder of the CloudAdmin role, you can view, but not edit, the DRS rules created by a placement policy on
the cluster's Configure tab under VM/Host Rules. It lets you view additional information, such as if the DRS rules

are in a conflict state.

Additionally, you can monitor various DRS rule operations, such as recommendations and faults, from the

cluster's Monitor tab.

Restrict VM Movement

For certain extremely sensitive applications vMotion may cause unexpected service interruptions or disruptions.
For these types of applications, it may be desirable to restrict VM movement to manually-initiated vMotion only.
With the Restrict VM movement Placement Policy, DRS-initiated vMotions can be disabled. For most workloads

this is not necessary and may cause unintended performance impacts due to noisy neighbors on the same host.

Enable Restricted VM movement for specific VMs
1. Navigate to Manage Placement policies and click Restrict VM movement.
2. Select the VM or VMs you want to restrict, then click Select.

3. The VM or VMS you selected appears in the VMs with restricted movement tab.
In the vSphere Client, a VM override will be created to set DRS to partially automated for that VM.
DRS will no longer migrate the VM automatically.
Manual vMotion of the VM and automatic initial placement of the VM will continue to function.

FAQs

Are placement policies the same as DRS affinity rules?



Yes, and no. While vSphere DRS implements the current set of policies, we have simplified the experience.
Modifying VM groups and Host groups are a cumbersome operation, especially as hosts are ephemeral in
nature and could be replaced in a cloud environment. As hosts are replaced in the vSphere inventory in an on-
premises environment, the vSphere admin must modify the host group to ensure that the desired VM-Host
placement constraints remain in effect. Placement policies in Azure VMware Solution update the Host groups
when a host is rotated or changed. Similarly, if you scale in a cluster, the Host Group is automatically updated, as
applicable. This eliminates the overhead of managing the Host Groups for the customer.

As this is an existing functionality available in vCenter, why can't | use it directly?

Azure VMware Solution provides a VMware private cloud in Azure. In this managed VMware infrastructure,
Microsoft manages the clusters, hosts, datastores, and distributed virtual switches in the private cloud. At the
same time, the tenant is responsible for managing the workloads deployed on the private cloud. As a result, the
tenant administering the private cloud does not have the same set of privileges as available to the VMware
administrator in an on-premises deployment.

Further, the lack of the desired granularity in the vSphere privileges presents some challenges when managing
the placement of the workloads on the private cloud. For example, vSphere DRS rules commonly used on-
premises to define affinity and anti-affinity rules can't be used as-is in an Azure VMware Solution environment,
as some of those rules can block day-to-day operation the private cloud. Placement Policies provides a way to
define those rules using the Azure VMware Solution portal, thereby circumventing the need to use DRS rules.
Coupled with a simplified experience, they also ensure that the rules don't impact the day-to-day infrastructure
maintenance and operation activities.

What is the difference between the VM-Host affinity policy and Restrict VM movement?

A VM-Host affinity policy is used to restrict the movement of VMs to a group of hosts included in the VM-Host
affinity policy. Thus, a VM can be vMotioned within the set of hosts selected in the VM-Host affinity policy.
Alternatively, Restrict VM movement ensures that the selected VM remains on the host on which it currently
resides.

What caveats should | know about?

The VM-Host MUST rules aren't supported because they block maintenance operations.

VM-Host SHOULD rules are preferential rules, where vSphere DRS tries to accommodate the rules to the extent
possible. Occasionally, vSphere DRS may vMotion VMs subjected to the VM-Host SHOULD rules to ensure that
the workloads get the resources they need. It's a standard vSphere DRS behavior, and the Placement policies
feature does not change the underlying vSphere DRS behavior.

If you create conflicting rules, those conflicts may show up on the vCenter Server, and the newly defined rules
may not take effect. It's a standard vSphere DRS behavior, the logs for which can be observed in the vCenter
Server.
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In Azure VMware Solution, vCenter Server has a built-in local user called cloudadmin assigned to the
CloudAdmin role. You can configure users and groups in Active Directory (AD) with the CloudAdmin role for
your private cloud. In general, the CloudAdmin role creates and manages workloads in your private cloud. But in
Azure VMware Solution, the CloudAdmin role has vCenter Server privileges that differ from other VMware

cloud solutions and on-premises deployments.

IMPORTANT

The local cloudadmin user should be treated as an emergency access account for "break glass" scenarios in your private
cloud. It's not for daily administrative activities or integration with other services.

e |n avCenter Server and ESXi on-premises deployment, the administrator has access to the vCenter
Server administrator@vsphere.local account and the ESXi root account. They can also have more AD
users and groups assigned.

e Inan Azure VMware Solution deployment, the administrator doesn't have access to the administrator
user account or the ESXi root account. They can, however, assign AD users and groups to the CloudAdmin
role in vCenter Server. The CloudAdmin role doesn't have permissions to add an identity source like on-
premises LDAP or LDAPS server to vCenter Server. However, you can use Run commands to add an
identity source and assign cloudadmin role to users and groups.

The private cloud user doesn't have access to and can't configure specific management components Microsoft
supports and manages. For example, clusters, hosts, datastores, and distributed virtual switches.

NOTE

In Azure VMware Solution, the vsphere.local SSO domain is provided as a managed resource to support platform
operations. It doesn't support the creation and management of local groups and users other than those provided by
default with your private cloud.

NOTE

Run commands are executed one at a time in the order submitted.

In this how-to, you learn how to:

List all existing external identity sources integrated with vCenter Server SSO
Add Active Directory over LDAP, with or without SSL

Add existing AD group to cloudadmin group

Remove AD group from the cloudadmin role

e Remove existing external identity sources

Prerequisites


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-identity-source-vcenter.md

e Establish connectivity from your on-premises network to your private cloud.

e [f you have AD with SSL, download the certificate for AD authentication and upload it to an Azure Storage
account as blob storage. Then, you'll need to grant access to Azure Storage resources using shared access
signature (SAS).

o [f you use FQDN, enable DNS resolution on your on-premises AD.

e Enable DNS Forwarder from Azure portal Ref: Configure DNS forwarder for Azure VMware Solution -
Azure VMware Solution | Microsoft Docs

List external identity

You'll run the Get-ExternalldentitySources cmdlet to list all external identity sources already integrated with

vCenter Server SSO.
1. Sign in to the Azure portal.

2. SelectRun command > Packages > Get-ExternalldentitySources.

= Microsoft Azure R search resources, services, and docs (G+/)

Home > Contoso-westus-sddc

Contoso-westus-sddc | Run command - X
= AVS Private cloud

P search (Ctrl+/) « () Refresh

@ Overview Run execution status
Activity log

Ao Access control (IAM) v Name Description
¢ Tags v JSDRConfiguration (1020) @
& Diagnose and sclve problems Install-JetDR This top level Cmdlet Downloads JetDr bundle from MMS, creates a new user, assigns elevated privillages to the user,
deploys JetDr Management Server Appliance(MSA), registers vCenter to the JetDr MSA, configures cluster.
Settings . - - :
9 Invoke-Preflight/etDRInstall This Cmdlet checks and displays current state of the system It checks whether the minimal requirements for the script to
B Locks run are met. It also checks if the cluster has minimum of 4 hosts, if the cluster details are correct, if there is already a Vi
with the same name provided for installing Msa, if there is any jetdr plugin present in the vCenter.
Manage Invoke-Preflight/etDRSystemCheck  This Cmdlet checks and displays current state of the system It checks whether the minimal requirements for the script to
run are met,
& Connectivity B R R
Invoke-PreflightJetDRUninstall This Cmdlet checks and displays current state of the system It checks whether the minimal requirements for the script to
B (dentity run are met. It also checks if the cluster has minimum of 4 hosts, if the cluster details are correct and if any VCenter is
registered to the MSA
i Clusters .
Uninstall-JetDR The top level Cmdlet creates a new user, assigns elevated privilleges to the user, unconfigures cluster, unregisters vCenter
from the JetDr MSA, removes the user.

Warkload Networking

o]

v MicrosoftAvS.Management (1030
% Segments

Add-GroupToCloudAdmins Add group to Cloud Admin
T DHCP
Get-ExternalldentitySources Get all current external sources connected to vCenter S5O
X Port mirroring - . . L
New-AvsLDAPIdentitySource Allow customers to add an LDAP Secure external identity source (Active Directory over LDAP) for use with single sign on to
@ ons vCenter,
New-AvsL DAPSIdentitySource Allow customers to add an LDAPS Secure external identity source (Active Directory over LDAP) for use with single sign on
Operations to vCenter.
™ Run command Remove-ExternalldentitySources Remove all external identity sources
- Remove-GroupFromCloudAdmins  Remove previously added AD group from CloudAdmins
Monitoring /
Set-AvsVMStoragePolicy Set the storage policy on a VM
M lerts VisterEaEReey 98 polles
@il Metrics

&  Advisor recommendations

3. Provide the required values or change the default values, and then select Run.


https://docs.microsoft.com/en-us/azure/storage/common/storage-sas-overview
https://portal.azure.com
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/run-command/run-command-overview.png#lightbox

Run command - Get-ExternalldentitySources X

Get all current external sources connected to vCenter S50

Details
Retain up to
60
day nour nUtE

Specify name for execution *

Timegut *

5 |

[ run |

FIELD VALUE

Retain up to Retention period of the cmdlet output. The default value
is 60 days.

Specify name for execution Alphanumeric name, for example, getExternalldentity.

Timeout The period after which a cmdlet exits if taking too long to
finish.

4. Check Notifications or the Run Execution Status pane to see the progress.

Packages Run execution status

(© Commands are executed one at a time in the order submitted

Execution name Package name Package version Command name Started time... |  End time stamp Status
Get-StoragePolicies-Exec Microsoft AVS.Management 3051 Get-StoragePolicies 2/16/2022, 10:08:5 2/16/2022, 10:09:5 @ Succeeded
Get-CloudAdminGroups-Exec1 Microsoft AVS.Management 3.051 Get-CloudAdminGroups 2/16/2022, 10:07:2:  2/16/2022, 10:08:5 @ Succeeded

Add Active Directory over LDAP with SSL

You'll run the New-LDAPSIdentitySource cmdlet to add an AD over LDAP with SSL as an external identity source

to use with SSO into vCenter Server.

1. Download the certificate for AD authentication and upload it to an Azure Storage account as blob storage.

If multiple certificates are required, upload each certificate individually.

2. For each certificate, Grant access to Azure Storage resources using shared access signature (SAS). These

SAS strings are supplied to the cmdlet as a parameter.

IMPORTANT

Make sure to copy each SAS string, because they will no longer be available once you leave this page.

3. Select Run command > Packages > New-LDAPSIdentitySource.

4. Provide the required values or change the default values, and then select Run.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/run-command/run-packages-execution-command-status.png#lightbox
https://docs.microsoft.com/en-us/azure/storage/common/storage-sas-overview

FIELD

Name

DomainName

DomainAlias

PrimaryUrl

SecondaryURL

BaseDNUsers

BaseDNGroups

Credential

CertificateSAS

GroupName

Retain up to

Specify name for execution

Timeout

VALUE

User-friendly name of the external identity source, for
example, avslab.local.

The FQDN of the domain.

For Active Directory identity sources, the domain's
NetBIOS name. Add the NetBIOS name of the AD
domain as an alias of the identity source if you're using
SSPI authentications.

Primary URL of the external identity source, for example,
Idaps://yourserver:636.

Secondary fall-back URL if there's primary failure.

Where to look for valid users, for example,
CN=users,DC=yourserver,DC=internal. Base DN is
needed to use LDAP Authentication.

Where to look for groups, for example, CN=group1,
DC=yourserver,DC= internal. Base DN is needed to
use LDAP Authentication.

The username and password used for authentication
with the AD source (not cloudadmin). The user must be
in the username@avsldap.local format.

Path to SAS strings with the certificates for
authentication to the AD source. If you're using multiple
certificates, separate each SAS string with a comma. For
example, pathtocert1,pathtocert2.

Group in the external identity source that gives the
cloudadmin access. For example, avs-admins.

Retention period of the cmdlet output. The default value
is 60 days.

Alphanumeric name, for example, addexternalldentity.

The period after which a cmdlet exits if taking too long to
finish.

5. Check Notifications or the Run Execution Status pane to see the progress.

Add Active Directory over LDAP

NOTE
We don't recommend this method. Instead, use the Add Active Directory over LDAP with SSL method.

You'll run the New-LDAPIdentitySource cmdletto add AD over LDAP as an external identity source to use with

SSO into vCenter Server.



1. Select Run command > Packages > New-LDAPIdentitySource.

2. Provide the required values or change the default values, and then select Run.
FIELD VALUE

Name User-friendly name of the external identity source, for
example, avslap.local.

DomainName The FQDN of the domain.

DomainAlias For Active Directory identity sources, the domain's
NetBIOS name. Add the NetBIOS name of the AD
domain as an alias of the identity source if you're using
SSPI authentications.

PrimaryUrl Primary URL of the external identity source, for example,
Idap://yourserver:389.

SecondaryURL Secondary fall-back URL if there's primary failure.

BaseDNUsers Where to look for valid users, for example,
CN=users,DC=yourserver,DC=internal. Base DN is
needed to use LDAP Authentication.

BaseDNGroups Where to look for groups, for example, CN=group1,
DC=yourserver,DC= internal. Base DN is needed to
use LDAP Authentication.

Credential Username and password used for authentication with
the AD source (not cloudadmin).

GroupName Group to give cloud admin access in your external
identity source, for example, avs-admins.

Retain up to Retention period of the cmdlet output. The default value
is 60 days.

Specify name for execution Alphanumeric name, for example, addexternalldentity.

Timeout The period after which a cmdlet exits if taking too long to
finish.

3. Check Notifications or the Run Execution Status pane to see the progress.

Add existing AD group to cloudadmin group

You'll run the Add-GroupToCloudAdmins cmdlet to add an existing AD group to cloudadmin group. The users in
this group have privileges equal to the cloudadmin (cloudadmin@vsphere.local) role defined in vCenter Server
SSO.

1. Select Run command > Packages > Add-GroupToCloudAdmins.

2. Provide the required values or change the default values, and then select Run.



FIELD

GroupName

Retain up to

Specify name for execution

Timeout

VALUE

Name of the group to add, for example,
VcAdminGroup.

Retention period of the cmdlet output. The default value
is 60 days.

Alphanumeric name, for example, addADgroup.

The period after which a cmdlet exits if taking too long to
finish.

3. Check Notifications or the Run Execution Status pane to see the progress.

Remove AD group from the cloudadmin role

You'll run the Remove-GroupFromCloudAdmins cmdlet to remove a specified AD group from the cloudadmin role.

1. Select Run command > Packages > Remove-GroupFromCloudAdmins.

2. Provide the required values or change the default values, and then select Run.

FIELD

GroupName

Retain up to

Specify name for execution

Timeout

VALUE

Name of the group to remove, for example,
VcAdminGroup.

Retention period of the cmdlet output. The default value
is 60 days.

Alphanumeric name, for example, removeADgroup.

The period after which a cmdlet exits if taking too long to
finish.

3. Check Notifications or the Run Execution Status pane to see the progress.

Remove existing external identity sources

You'll run the Remove-ExternalldentitySources cmdlet to remove all existing external identity sources in bulk.

1. Select Run command > Packages > Remove-ExternalldentitySources.

2. Provide the required values or change the default values, and then select Run.

FIELD

Retain up to

Specify name for execution

Timeout

VALUE

Retention period of the cmdlet output. The default value
is 60 days.

Alphanumeric name, for example,
remove_externalldentity.

The period after which a cmdlet exits if taking too long to
finish.



3. Check Notifications or the Run Execution Status pane to see the progress.

Next steps
Now that you've learned about how to configure LDAP and LDAPS, you can learn more about:

e How to configure storage policy - Each VM deployed to a vSAN datastore is assigned at least one VM
storage policy. You can assign a VM storage policy in an initial deployment of a VM or when you do other
VM operations, such as cloning or migrating.

e Azure VMware Solution identity concepts - Use vCenter Server to manage virtual machine (VM)
workloads and NSX-T Manager to manage and extend the private cloud. Access and identity
management use the CloudAdmin role for vCenter Server and restricted administrator rights for NSX-T
Manager.
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In this article, you'll set up GitHub Enterprise Server, the "on-premises" version of GitHub.com, on your Azure

VMware Solution private cloud. The scenario covers a GitHub Enterprise Server instance that can serve up to

3,000 developers running up to 25 jobs per minute on GitHub Actions. It includes the setup of (at time of
writing) preview features, such as GitHub Actions. To customize the setup for your particular needs, review the

requirements listed in Installing GitHub Enterprise Server on VMware.

Before you begin

GitHub Enterprise Server requires a valid license key. You may sign up for a trial license. If you're looking to

extend the capabilities of GitHub Enterprise Server via an integration, you may qualify for a free five-seat

developer license. Apply for this license through GitHub's Partner Program.

Install GitHub Enterprise Server on VMware

1. Download the current release of GitHub Enterprise Server for VMware ESXi/vSphere (OVA) and deploy

the OVA template you downloaded.

GitHub On-premises

Choose this option if you are running GitHub on your
own hardware. Download the image below, then
launch a new VM with the image.

Download for VMware ESXi/vSphere (OVA)

SHA256:
eab2f77fe728a7b8a6c8b8a8e105dd462ad775315e55904d7¢f7cd9b1eaddfs

Need help? Check out our administration guides.

Change Hypervisor

vm vSphere Client

T New Virtual Machine

B New R

Settings b

Update Manager v

Recent Tasks VSAN

GitHub in the Cloud

Choose this option if you are installing or running
GitHub on a cloud service such as Amazon Web
Services, Microsoft Azure, or Google Cloud Platform.

Select your platform =

B o

107TB

Anribute Value



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-github-enterprise-server.md
https://github.com/
https://docs.github.com/en/enterprise/admin/installation/installing-github-enterprise-server-on-vmware#hardware-considerations
https://enterprise.github.com/trial
https://partner.github.com/
https://enterprise.github.com/releases/2.19.0/download
https://docs.vmware.com/en/VMware-vSphere/6.5/com.vmware.vsphere.vm_admin.doc/GUID-17BEDA21-43F6-41F4-8FB2-E01D275FE9B4.html

2. Provide a recognizable name for your new virtual machine, such as GitHubEnterpriseServer. You don't
need to include the release details in the VM name, as these details become stale when the instance is
upgraded.

3. Select all the defaults for now (we'll edit these details shortly) and wait for the OVA to be imported.

4. Once imported, adjust the hardware configuration based on your needs. In our example scenario, we'll

need the following configuration.

STANDARD SET UP + "BETA

RESOURCE STANDARD SETUP FEATURES" (ACTIONS)
vCPUs 4 8

Memory 32 GB 61 GB

Attached storage 250 GB 300 GB

Root storage 200 GB 200 GB

Your needs may vary. Refer to the guidance on hardware considerations in Installing GitHub Enterprise
Server on VMware. Also see Adding CPU or memory resources for VMware to customize the hardware
configuration based on your situation.

Configure the GitHub Enterprise Server instance
O Enterprise

Install GitHub Enterprise

T llation of GitHub Enterprise, upload your license and p

s the API. SSH administrative access uses authorized S

New password

Confirm password

ur license? Download it here.

After the newly provisioned virtual machine (VM) has powered on, configure it through your browser. You'll be
required to upload your license file and set a management console password. Be sure to write down this
password somewhere safe.


https://docs.github.com/en/enterprise/admin/installation/installing-github-enterprise-server-on-vmware#creating-the-github-enterprise-server-instance
https://docs.github.com/en/enterprise/admin/installation/installing-github-enterprise-server-on-vmware#hardware-considerations
https://docs.github.com/en/enterprise/admin/enterprise-management/increasing-cpu-or-memory-resources#adding-cpu-or-memory-resources-for-vmware
https://docs.github.com/en/enterprise/admin/installation/installing-github-enterprise-server-on-vmware#configuring-the-github-enterprise-server-instance

SSH access

This gra 5SS to the appliance to perform specific You can acces

dppliance via ssh -p 122 adming19.1.1.26 g .

Authorized SSH keys

Add new SSH key

Add key

We recommend at least take the following steps:

1. Upload a public SSH key to the management console so that you can access the administrative shell via
SSH.

2. Configure TLS on your instance so that you can use a certificate signed by a trusted certificate authority.
Apply your settings.

O Enterprise

Configuring your instance

Your settings are being applied and your instance is restarting at https://10.1.1.26.

Preparing storage device
configuration
Reloading system services

Running migrations

Reloading application services

3. While the instance restarts, configure blob storage for GitHub Actions.

NOTE

GitHub Actions is currently available as a limited beta on GitHub Enterprise Server release 2.22.

External blob storage is necessary to enable GitHub Actions on GitHub Enterprise Server (currently
available as a "beta" feature). Actions use this external blob storage to store artifacts and logs. Actions on


https://docs.github.com/en/enterprise/admin/configuration/accessing-the-administrative-shell-ssh
https://docs.github.com/en/enterprise/admin/configuration/configuring-tls
https://docs.github.com/en/enterprise/admin/github-actions

GitHub Enterprise Server supports Azure Blob Storage as a storage provider (and some others). So we'll
provision a new Azure storage account with a storage account type of BlobStorage.

Instance details

The default deployment model is Resource Manager, which supports the latest Azure features. You may choose to deploy using
the classic deployment model instead. Choose classic deployment model

Storage account name * (0 | ghesactionsstoragebd0903 s
Location * | (US) East US v |
Performance (0 (®) Standard

Account kind O | BlobStorage " |
Replication | Read-access geo-redundant storage (RA-GRS) % |

@ Accounts with the selected kind, replication and performance type only

support block and append blobs. Page blobs, file shares, tables, and queues
will not be available.

Blob access tier (default) &) O Cool '@) Hot

4. Once the new BlobStorage resource deployment completes, save the connection string (available under
Access keys). You'll need this string shortly.

5. After the instance restarts, create a new admin account on the instance. Be sure to make a note of this
user's password as well.

Welcome to GitHub Enterprise

Create admin account

Username *

octocat v

Email address *

octocat@github.com v

Password *

ure it's at least 15 characters OR at least 7 characters including a number and a lowercase latter.
Learn mare.

Confirm your password *

| — ;

Help me set up an organization next
zations are separate fram perso

ounts and are best suited for businesses wha need to

iszions

ny empl

Learn mare about arganizations

Create admin account

Other configuration steps

To harden your instance for production use, the following optional setup steps are recommended:
1. Configure high availability for protection against:

e Software crashes (OS or application level)

e Hardware failures (storage, CPU, RAM, and so on)


https://docs.github.com/en/enterprise/admin/github-actions/enabling-github-actions-and-configuring-storage#about-external-storage-requirements
https://docs.microsoft.com/en-us/azure/storage/common/storage-account-overview
https://help.github.com/enterprise/admin/guides/installation/configuring-github-enterprise-for-high-availability/

e Virtualization host system failures
e Logically or physically severed network

2. Configure backup-utilities, providing versioned snapshots for disaster recovery, hosted in availability that

is separate from the primary instance.

3. Setup subdomain isolation, using a valid TLS certificate, to mitigate cross-site scripting and other related

vulnerabilities.

Set up the GitHub Actions runner

NOTE

GitHub Actions is currently available as a limited beta on GitHub Enterprise Server release 2.22.

At this point, you should have an instance of GitHub Enterprise Server running, with an administrator account
created. You should also have external blob storage that GitHub Actions uses for persistence.

Create somewhere for GitHub Actions to run; again, we'll use Azure VMware Solution.

1. Provision a new VM on the cluster and base it on a recent release of Ubuntu Server.

New Virtual Machine

v 15elect a creation type Select a name and folder
2 Select a name and folder Specify a unique name and target location
Virtual machine name: ubuntu-20.04.-live-server-amde4.actions-runner

5 Select a guest OF Select a location for the virtual machine

nize haraware W EJ:":: 2242

8 Ready to complete [ SDDC-Datacenter

CANCEL NEXT

2. Continue through the set up selecting the compute resource, storage, and compatibility.

3. Select the guest OS you want installed on the VM.


https://docs.github.com/en/enterprise/admin/configuration/configuring-backups-on-your-appliance
https://github.com/github/backup-utils
https://docs.github.com/en/enterprise/admin/configuration/enabling-subdomain-isolation
https://docs.github.com/en/enterprise/admin/github-actions
http://releases.ubuntu.com/20.04.1/

New Virtual Machine

+ 15elect a creation type Select a guest 0OS

+ 2 Select a name and folder Choose the guest 05 that will be installed on the virtual machine

+ 3 Select a compute resource

« 4 Select storage dentifying the guest operating system here allows the wizard to provide the appropriate
L defaults for the operating system installation

5 Select compatibility

6 Select a quest OS Guest 05 Family: [Linux [

Guest OS5 Version ||j|3J":[J Linux (64-bit) ol

Compatibility: ESXi 6.7 and later (WM version 14)

4. Once the VM is created, power it up and connect to it via SSH.

5. Install the Actions runner application, which runs a job from a GitHub Actions workflow. Identify and
download the most current Linux x64 release of the Actions runner, either from the releases page or by
running the following quick script. This script requires both curl and jq to be present on your VM.

LATEST\_RELEASE\_ASSET\_URL=$( curl https://api.github.com/repos/actions/runner/releases/latest | \
jq -r '.assets | .[] | select(.name | match("actions-runner-linux-armé4")) | .url' )
DOWNLOAD\_URL=$( curl $LATEST\_RELEASE\_ASSET\_URL | \

jq -r '.browser\_download\_url' )

curl -OL $DOWNLOAD\_URL

You should now have a file locally on your VM, actions-runner-linux-arm64-* targz. Extract this tarball

locally:
tar xzf actions-runner-linux-armé4-\*.tar.gz

This extraction unpacks a few files locally, including a config.sh and run.sh script.

Enable GitHub Actions

NOTE

GitHub Actions is currently available as a limited beta on GitHub Enterprise Server release 2.22.



https://github.com/actions/runner
https://github.com/actions/runner/releases
https://stedolan.github.io/jq/
https://docs.github.com/en/enterprise/admin/github-actions

Configure and enable GitHub Actions on the GitHub Enterprise Server instance.

1.

10.

11.

12.

Access the GitHub Enterprise Server instance's administrative shell over SSH, and then run the following
commands:

. Set an environment variable containing your Blob storage connection string.

export CONNECTION\_STRING="<your connection string from the blob storage step>"

. Configure actions storage.

ghe-config secrets.actions.storage.blob-provider azure

ghe-config secrets.actions.storage.azure.connection-string "$CONNECTION\_STRING"

. Apply the settings.

ghe-config-apply

. Execute a precheck to install additional software required by Actions on GitHub Enterprise Server.

ghe-actions-precheck -p azure -cs "$CONNECTION\_STRING"

. Enable actions, and re-apply the configuration.

ghe-config app.actions.enabled true

ghe-config-apply

. Check the health of your blob storage.

ghe-actions-check -s blob

You should see output: Blob Storage is healthy.

. Now that GitHub Actions is configured, enable it for your users. Sign in to your GitHub Enterprise

Server instance as an administrator, and select the & in the upper right corner of any page.

. In the left sidebar, select Enterprise overview, then Policies, Actions, and select the option to enable

Actions for all organizations.

Configure your runner from the Self-hosted runners tab. Select Add new and then New runner from
the drop-down. You'll be presented with a set of commands to run.

Copy the command to configure the runner, for instance:

./config.sh --url https://10.1.1.26/enterprises/octo-org --token AAAAAAS5RHF34QLYBDCHWLJIC7L73MA

Copy the config.sh command and paste it into a session on your Actions runner (created previously).


https://docs.github.com/en/enterprise/admin/configuration/accessing-the-administrative-shell-ssh

B8 ghadmin@runnerd01: ~/actions-runner.3

# Authentication

Connected to GitHub
# Runner Reg ration
Enter the name of runner: [press Enter for runner8@l] example

This runner will have the following labels: 'self-hosted’,
Enter any additional labels (ex. label-1,label-2): [pr

Runner successfully added
Runner connection is good

# Runner settings

Enter name of work folder: [press Enter for wo

13. Usethe ./run.sh command to runthe runner:

TIP
To make this runner available to organizations in your enterprise, edit its organization access. You can limit access

to a subset of organizations, and even to specific repositories.

Policies Self-hosted runners
Host your own runners and customize the environment used to run jobs in your GitHub Actions workflows. Runners added to ek
this enterprise account can be used to process jobs in multiple organizations in your enterprise. Learn more about self-hosted

runners

Runner groups Move to group

1 runner A

] ® Main Edit name and organization access

self-hosted  Linux X64 ~

| Default 3

(Optional) Configure GitHub Connect

Although this step is optional, we recommend it if you plan to consume open-source actions available on
GitHub.com. It allows you to build on the work of others by referencing these reusable actions in your

workflows.

To enable GitHub Connect, follow the steps in Enabling automatic access to GitHub.com actions using GitHub

Connect.

Once GitHub Connect is enabled, select the Server to use actions from GitHub.com in workflow runs

option.


https://docs.github.com/en/enterprise/admin/github-actions/enabling-automatic-access-to-githubcom-actions-using-github-connect

Server can use actions from GitHub.com in workflows runs

Allow actions from GitHub.com to be referenced and used in workflow files.
Enabled ~ @ Requires users to connect to a GitHub.com account.

Server can use actions from GitHub.com in
workflow runs

~ Enabled

Dizabled

issues, topics, and users on GitHub.com.

Set up and run your first workflow

Now that Actions and GitHub Connect is set up, let's put all this work to good use. Here's an example workflow

that references the excellent octokit/request-action, allowing us to "script" GitHub through interactions using the
GitHub API, powered by GitHub Actions.

In this basic workflow, we'll use octokit/request-action to open an issue on GitHub using the API.

nams: Opsn lssue

onsz

push

Jobs:
my-job:
name: My Job
runs-cn: self-hosted
steps:
name: Open issue
uscs: ocktokit/request-actionBvi.x
id: issue
wilhs:
rouke: POST /repos/:reposilory/issues
repository: S1{ github.repository }}
title: Hello world
=nv
GITHUB TOKEN: ${{ secrets GITHUE TOKEN |}
- name: Log issue
run: |
echo issue #51{ fromJson(steps,issue.outputs.data).id )

AP

opecned

NOTE

GitHub.com hosts the action, but when it runs on GitHub Enterprise Server, it automatically uses the GitHub Enterprise
Server API.

If you chose not to enable GitHub Connect, you could use the following alternative workflow.


https://github.com/octokit/request-action

name: Open Issue

on:
push

Jjobs:
my-job:

name: My Jok

runs-on: self-hosted

steps:

- name: COpen issue

run: |
curl -H "Authorization: bhearer $HITHUH_TGKHN" -d '"{"title":

"Hello world"}' "SGITHUER API1 _URL/repos/S{{ github.repository }}/issues"”

(=R -
GITHUB_TOKEN: ${{ segrets.GLTHUB TOKEN ))

1. Navigate to a repo on your instance, and add the above workflow as: .github/workflows/hello-world.yml

29 lines (27 sloc) 775 Bytes Raw Bame 0 2 O

name: My Workflow

on:
push:
branches: # array of glob patterns matching against refs/heads. Optional; defaults to all
- master # triggers on pushes that contain changes in master
jobs:
my-job:

name: My Job
runs-on: self-hosted
steps:
- name: Context
env:
GITHUB_CONTEXT: ${{ toJson(github) }}
run: |
echo "$GITHUB_CONTEXT"
- name: Open issue
uses: octokit/request-action@vz.x
id: issue
with:
route: POST /repos/:repository/issues
repositery: ${{ github.repository }}
title: Hello world
env:
GITHUB_TOKEN: ${{ secrets.GITHUB_TOKEN }}
- name: Log issue
run: |

echo issue #§{{ fromlson(steps.issue.outputs.data).id }} opened
2. In the Actions tab for your repo, wait for the workflow to execute.

<> Code @ lssues 4 17 Pull requests ® Actions [ Projects M wiki | Insights 8 Settings

Workflows New workflow Open Issue

Al workflows Q. workflow:"Open lssue” (%]

2 Open Issue

1 Result Event-  Status~  Branch~  Actor~
+ Hello world cone
T B 31 seconds ago
Open Issue #2: Commit 49dc042 pushed by octocat @155

You can see it being processed by the runner.



BR ghadmin@runner001: ~/actions-runner.2 - O X

$ ./run.sh

Connected to GitHub

If everything ran successfully, you should see a new issue in your repo, entitled "Hello world."

Code @ Issues 1 Pull requests Actions Projects Wiki Insights Settings

(® 10pen « 4Closed Author~  Label~  Projects - Milestones~  Assignee~  Sort~

- ® Hello world

Congratulations! You just completed your first Actions workflow on GitHub Enterprise Server, running on your
Azure VMware Solution private cloud.

This article set up a new instance of GitHub Enterprise Server, the self-hosted equivalent of GitHub.com, on top
of your Azure VMware Solution private cloud. The instance includes support for GitHub Actions and uses Azure
Blob Storage for persistence of logs and artifacts. But we're just scratching the surface of what you can do with
GitHub Actions. Check out the list of Actions on GitHub's Marketplace, or create your own.

Next steps

Now that you've covered setting up GitHub Enterprise Server on your Azure VMware Solution private cloud, you
may want to learn about:

e How to get started with GitHub Actions
e How to join the beta program

e Administration of GitHub Enterprise Server


https://github.com/marketplace
https://docs.github.com/en/actions/creating-actions
https://docs.github.com/en/actions
https://docs.github.com/en/get-started/signing-up-for-github/signing-up-for-a-new-github-account
https://githubtraining.github.io/admin-training/#/00_getting_started

Enable Managed SNAT for Azure VMware Solution

workloads

8/19/2022 - 2 minutes to read  Edit Online

In this article, you'll learn how to enable Azure VMware Solution’s Managed Source NAT (SNAT) to connect to
the Internet outbound. A SNAT service translates from RFC1918 space to the public Internet for simple
outbound Internet access. The SNAT service won't work when you have a default route from Azure.

With this capability, you:

e Have a basic SNAT service with outbound Internet connectivity from your Azure VMware Solution private
cloud.

e Have no control of outbound SNAT rules.
e Are unable to view connection logs.

e Have alimit of 128 000 concurrent connections.

Prerequisites

e Azure Solution VMware private cloud

e DNS Server configured on the NSX-T Datacenter

Reference architecture

The architecture shows Internet access to and from your Azure VMware Solution private cloud using a Public IP
directly to the NSX Edge.
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Configure Outbound Internet access using Managed SNAT in the
Azure port

1. Log in to the Azure portal and then search for and select Azure VMware Solution.

2. Select the Azure VMware Solution private cloud.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/enable-managed-snat-for-workloads.md
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/public-ip-nsx-edge/architecture-internet-access-avs-public-ip-snat-expanded.png#lightbox

3. In the left navigation, under Workload Networking, select Internet Connectivity.

4. Select Connect using SNAT button and select Save. You have successfully enabled outbound Internet

access for your Azure VMware Solution private cloud using our Managed SNAT service.

Next steps

Internet connectivity design considerations (Preview)
Enable Public IP to the NSX Edge for Azure VMware Solution (Preview)

Disable Internet access or enable a default route



Enable Public IP to the NSX Edge for Azure

VMware Solution

8/19/2022 « 5 minutes to read  Edit Online

In this article, you'll learn how to enable Public IP to the NSX Edge for your Azure VMware Solution.

TIP

Before you enable Internet access to your Azure VMware Solution, review the Internet connectivity design considerations.

Public IP to the NSX Edge is a feature in Azure VMware Solution that enables inbound and outbound internet
access for your Azure VMware Solution environment.

IMPORTANT

The use of Public IPv4 addresses can be consumed directly in Azure VMware Solution and charged based on the Public
IPv4 prefix shown on Pricing - Virtual Machine IP Address Options..

The Public IP is configured in Azure VMware Solution through the Azure portal and the NSX-T Data center
interface within your Azure VMware Solution private cloud.

With this capability, you have the following features:

e A cohesive and simplified experience for reserving and using a Public IP down to the NSX Edge.
e The ability to receive up to 1000 or more Public IPs, enabling Internet access at scale.

e Inbound and outbound internet access for your workload VMs.

e DDoS Security protection against network traffic in and out of the Internet.

e HCX Migration support over the Public Internet.

Reference architecture

The architecture shows Internet access to and from your Azure VMware Solution private cloud using a Public IP
directly to the NSX Edge.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/enable-public-ip-nsx-edge.md
https://azure.microsoft.com/pricing/details/ip-addresses/
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Configure a Public IP in the Azure portal

1. Log on to the Azure portal.
Search for and select Azure VMware Solution.

Select the Azure VMware Solution private cloud.

uioh W

In the left navigation, under Workload Networking, select Internet connectivity.

Select the Connect using Public IP down to the NSX-T Edge button.

TIP

see Internet connectivity design considerations.

Before selecting a Public IR ensure you understand the implications to your existing environment. For more information,

5. Select Public IP.

Address spaces

00f16 Oof64

+ Add

DHCP
B Port mirroring

@ ons

&8 Internet connectivity (preview)

Operations

Public IP addresses

\ ) Refresh

‘ | Public IP name

6. Enter the Public IP name and select a subnet size from the Address space dropdown and select

Configure.

7. This Public IP should be configured within 20 minutes and will show the subnet.



file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/public-ip-nsx-edge/architecture-internet-access-avs-public-ip-expanded.png#lightbox

MNetworks Address spaces.  Public 1P addresses
@ Datastores 2 of 16 1 28 of 128

Workload Networking + Add Refresh

=5 Segments

- ohcp Public IP name Public IP address space Address Range Address count provisio...  Provisioning state

B Port mirroring 20.95.192.64/26 20.95.192.64-20.95.192 64 © Succeeded

8. If you don't see the subnet, refresh the list. If the refresh fails, try the configuration again.

9. After configuring the Public IP, select the Connect using the Public IP down to the NSX-T Edge
checkbox to disable all other Internet options.

10. SelectSave.

You have successfully enabled Internet connectivity for your Azure VMware Solution private cloud and reserved
a Microsoft allocated Public IP. You can now configure this Public IP down to the NSX Edge for your workloads.
The NSX-T Datacenter is used for all VM communication. There are several options for configuring your
reserved Public IP down to the NSX Edge.

There are three options for configuring your reserved Public IP down to the NSX Edge: Outbound Internet
Access for VMs, Inbound Internet Access for VMs, and Gateway Firewall used to Filter Traffic to VMs at T1
Gateways.

Outbound Internet access for VMs

A Sourced Network Translation Service (SNAT) with Port Address Translation (PAT) is used to allow many VMs to
one SNAT service. This connection means you can provide Internet connectivity for many VMs.

IMPORTANT

To enable SNAT for your specified address ranges, you must configure a gateway firewall rule and SNAT for the specific
address ranges you desire. If you don't want SNAT enabled for specific address ranges, you must create a No-NAT rule for
the address ranges to exclude. For your SNAT service to work as expected, the No-NAT rule should be a lower priority
than the SNAT rule.

Add rule

1. From your Azure VMware Solution private cloud, select vCenter Credentials
Locate your NSX-T URL and credentials.

Login to VMWare NSX-T.

Navigate to NAT Rules.

Select the T1 Router.

Select ADD NAT RULE.

o v b~ wN

Configure rule

1. Enter a name.
Select SNAT.

Optionally, enter a source such as a subnet to SNAT or destination.

> won

Enter the translated IP. This IP is from the range of Public IPs you reserved from the Azure VMware Solution

Portal.

5. Optionally, give the rule a higher priority number. This prioritization will move the rule further down the rule
list to ensure more specific rules are matched first.

6. Click SAVE.

Logging can be enabled by way of the logging slider. For more information on NSX-T NAT configuration and
options, see the NSX-T NAT Administration Guide


https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/administration/GUID-7AD2C384-4303-4D6C-A44A-DEF45AA18A92.html

No NAT rule for specific address ranges

A No NAT rule can be used to exclude certain matches from performing Network Address Translation. This

p

1

2
3
4.
5

6.

olicy can be used to allow private IP traffic to bypass the NAT rule.

. From your Azure VMware Solution private cloud, select vCenter Credentials.
. Locate your NSX-T URL and credentials.

. Login to VMWare NSX-T and then select NAT Rules.

Select the T1 Router and then select ADD NAT RULE.

. The Source IP is the range of addreses you do not want to be translated and Destination IP is the range of
IP addresses that you do not want the "Source IP" to reach.

Select SAVE.

Inbound Internet Access for VMs

A
a

Destination Network Translation Service (DNAT) is used to expose a VM on a specific Public IP address and/or
specific port. This service provides inbound internet access to your workload VMs.

Log in VMware NSX-T

1
2
3

C

1.
2.
3.

. From your Azure VMware Solution private cloud, select VMware credentials.
. Locate your NSX-T URL and credentials.
. Login to VMware NSX-T.

onfigure the DNAT rule

Name the rule.
Select DNAT as the action.

Enter the reserved Public IP in the destination match. This IP is from the range of Public IPs reserved from the
Azure VMware Solution Portal.

Enter the VM Private IP in the translated IP

5. Select SAVE.

Optionally, configure the Translated Port or source IP for more specific matches.

The VM is now exposed to the internet on the specific Public IP and/or specific ports.

G

ateway Firewall used to filter traffic to VMs at T1 Gateways

You can provide security protection for your network traffic in and out of the public internet through your

G

1

2.

ateway Firewall.

. From your Azure VMware Solution Private Cloud, select VMware credentials.
Locate your NSX-T URL and credentials.

. Login to VMware NSX-T.

. From the NSX-T home screen, select Gateway Policies.

. Select Gateway Specific Rules, choose the T1 Gateway and select ADD POLICY.
. Select New Policy and enter a policy name.

Select the Policy and select ADD RULE.

. Configure the rule.

a. Select New Rule.
b. Enter a descriptive name.

c. Configure the source, destination, services, and action.



9. Select Match External Address to apply firewall rules to the external address of a NAT rule.

For example, the following rule is set to Match External Address, and this setting will allow SSH traffic inbound
to the Public IP

Gateway Firewall

A ed Ru Gateway Specific Rules

Gateway Contoso Gateway

Category: LOCAL GATEWAY

If Match Internal Address was specified, the destination would be the internal or private IP address of the VM.
For more information on the NSX-T Gateway Firewall see the NSX-T Gateway Firewall Administration Guide The
Distributed Firewall could be used to filter traffic to VMs. This feature is outside the scope of this document. For
more information, see NSX-T Distributed Firewall Administration Guide.

Next steps

Internet connectivity design considerations (Preview)
Enable Managed SNAT for Azure VMware Solution Workloads (Preview)
Disable Internet access or enable a default route

Enable HCX access over the internet


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/public-ip-nsx-edge/gateway-specific-rules-match-external-connectivity-expanded.png#lightbox
https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/administration/GUID-A52E1A6F-F27D-41D9-9493-E3A75EC35481.html
https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/administration/GUID-6AB240DB-949C-4E95-A9A7-4AC6EF5E3036.html

Disable internet access or enable a default route

8/19/2022 « 2 minutes to read = Edit Online

In this article, you'll learn how to disable Internet access or enable a default route for your Azure VMware
Solution private cloud. There are multiple ways to set up a default route. You can use a Virtual WAN hub,
Network Virtual Appliance in a Virtual Network, or use a default route from on-premise. If you don't set up a
default route, there will be no Internet access to your Azure VMware Solution private cloud.

With a default route setup, you can achieve the following tasks:

e Disable Internet access to your Azure VMware Solution private cloud.

NOTE

Ensure that a default route is not advertised from on-premises or Azure as that will override this setup.

e Enable Internet access by generating a default route from Azure Firewall or third-party Network Virtual
Appliance.

Prerequisites

e |[f Internet access is required, a default route must be advertised from an Azure Firewall, Network Virtual
Appliance or Virtual WAN Hub.

e Azure VMware Solution private cloud.

Disable Internet access or enable a default route in the Azure portal

1. Log in to the Azure portal.

2. Search for Azure VMware Solution and select it.

3. Locate and select your Azure VMware Solution private cloud.

4. On the left navigation, under Workload networking, select Internet connectivity.
5

. Select the Don't connect or connect using default route from Azure button and select Save.
If you don't have a default route from on-premises or from Azure, you have successfully disabled Internet
connectivity to your Azure VMware Solution private cloud.

Next steps

Internet connectivity design considerations (Preview)
Enable Managed SNAT for Azure VMware Solution Workloads

Enable Public IP to the NSX Edge for Azure VMware Solution


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/disable-internet-access.md

Enable public internet for Azure VMware Solution

workloads

8/19/2022 « 4 minutes to read » Edit Online

Public IP is a feature in Azure VMware Solution connectivity. It makes resources, such as web servers, virtual
machines (VMs), and hosts accessible through a public network.

You enable public internet access in two ways.
e Host and publish applications under the Application Gateway load balancer for HTTP/HTTPS traffic.

e Publish through public IP features in Azure Virtual WAN.

As a part of Azure VMware Solution private cloud deployment, upon enabling public IP functionality, the
required components with automation get created and enabled:

e Virtual WAN
e Virtual WAN hub with ExpressRoute connectivity

e Azure Firewall services with public IP

This article details how you can use the public IP functionality in Virtual WAN.

Prerequisites

e Azure VMware Solution environment
e A webserver running in Azure VMware Solution environment.

e A new non-overlapping IP range for the Virtual WAN hub deployment, typically a /24 .

Reference architecture
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The architecture diagram shows a web server hosted in the Azure VMware Solution environment and
configured with RFC1918 private IP addresses. The web service is made available to the internet through Virtual
WAN public IP functionality. Public IP is typically a destination NAT translated in Azure Firewall. With DNAT rules,
firewall policy translates public IP address requests to a private address (webserver) with a port.

User requests hit the firewall on a public IP that, in turn, is translated to private IP using DNAT rules in the Azure
Firewall. The firewall checks the NAT table, and if the request matches an entry, it forwards the traffic to the
translated address and port in the Azure VMware Solution environment.

The web server receives the request and replies with the requested information or page to the firewall, and then
the firewall forwards the information to the user on the public IP address.

Test case

In this scenario, you'll publish the IIS webserver to the internet. Use the public IP feature in Azure VMware
Solution to publish the website on a public IP address. You'll also configure NAT rules on the firewall and access
Azure VMware Solution resource (VMs with a web server) with public IP.

TIP

To enable egress traffic, you must set Security configuration > Internet traffic to Azure Firewall.

Deploy Virtual WAN

1. Sign in to the Azure portal and then search for and select Azure VMware Solution.
2. Select the Azure VMware Solution private cloud.

3. Under Manage, select Connectivity.

Home > Azure VMware Solution
Azure VMware Sol...  «
Microsoft
+ Add € Manage view ‘ Eearch ictri+) | « il Delete
Contoso-AVS | I e
3 2 Resource group (change) ESXi hosts
Name T B Actiity log Contoso-AVS-Testing Cluster-1: 3
¢ Contoso-private-cloud-WestUS vee B0 Access control (1AM) Status
¢ Succeeded
ags
Location Secondary peering subnet
ﬂ Diagnose and solve problems West US 10.123.2.0/13
) subscription (change) Private Cloud Management network
Settings Azure Viware Solution 10.123.3.0/14
B Locks Subscription 1D vMotion networ
1234abc-5678def-9123ghi-4567jk| 10.123.4.

B3 Export template
= P VM Workload network

10.123,5.0/16

Manage

| Connectivity

B8 Identity

B Clusters
Page [ 1~ |of1

Monitoring

4. Select the Public IP tab and then select Configure.
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Home > Azure VMware Solution > Contoso-private-cloud-WestUS
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5. Accept the default values or change them, and then select Create.
e Virtual WAN resource group
e Virtual WAN name
e Virtual hub address block (using new non-overlapping IP range)

e Number of public IPs (1-100)

It takes about one hour to complete the deployment of all components. This deployment only has to occur once
to support all future public IPs for this Azure VMware Solution environment.

TIP

You can monitor the status from the Notification area.

View and add pubilic IP addresses

We can check and add more public IP addresses by following the below steps.
1. In the Azure portal, search for and select Firewall.

2. Select a deployed firewall and then select Visit Azure Firewall Manager to configure and manage
this firewall.

Home > Firewalls

.Contoso—private-cloud~AUEAST-vwan-fw =

Firewall

j Delete

& Overview

@ Visit Azure Firewall Manager to configure and manage this firewall. =

E Activity log pr—
/ Essentials JSON View

B Access control (IAM)

Resource group (change) wan-rg Firewall public 1P

¢ Tags

Location 10.123.1.2
Settings Subscription (change) ! Azur e Solution 2
Subscription ID : 1234abc-d567-8910-abod-2e2bb12345e6
B Public IP configuration
: RDP IP RMP DC 1920

™% Firewall Manager
Secured virtual hub name : Contoso-private-cloud-AUEAST-vwan-hub
e
Propertie
' pan Provisioning state Succeeded
Locks
= Tags (change) Click here to add tags

¥ Export template

Monitoring
fa Metrics

@ Diagnostic settings

3. Select Secured virtual hubs and, from the list, select a virtual hub.
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Home > Firewalls > Contoso-private-cloud-AUEAST-vwan-fw > Firewall Manager

¢ Firewall Manager | Secured virtual hubs =

P Search (Ctrl+/) « =+ Create new secured virtual hub  “» Convert existing hubs () Refresh
"™ Getting Started

5 Fearch for hubs by name Clear all filters subscription : multiple selected: 4 >
¥ Secured virtual hubs
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‘ >
™ security Partner Providers

4. On the virtual hub page, select Public IP configuration, and to add more public IP address, then select
Add.

Home > Firewalls Contoso-private-cloud-AUEAST-vwan-fw > Firewall Manager > Contoso-private-cloud-AUEAST-vwan-hub

2 Contoso-private-cloud-AUEAST-vwan-hub | Public IP configuration =

Azure Firewali Manager

| £ search (Ctei+/) « £ Refresh

W Overview

D Name Ty 1P Address Ty
Settings -
D Contoso-private-cloud-AUEAST-vwan-fw-PubliciP-007 10.12.15.110 o]
% Security providers

@ Security configuration

Azure Firewall

£ Public 1P configuration

& Diagnostic settings

# Logs

5. Provide the number of IPs required and select Add.

Add public IP configurations X

Specify how many public IP configurations you want to add. Public IP configurations will be
named automatically. Static Standard Public IP addresses are billed separately. Learn more. 7

Specify number of Public IP addresses ()

O 1

1 20 4c 60 80 89

Create firewall policies
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Once all components are deployed, you can see them in the added Resource group. The next step is to add a
firewall policy.

1. In the Azure portal, search for and select Firewall.

2. Select a deployed firewall and then select Visit Azure Firewall Manager to configure and manage
this firewall.

Home alls

@ Contoso-private-cloud-AUEAST-vwan-fw =

Firewall

j Delete |

& Overview

@ Visit Azure Firewall Manager to configure and manage this firewall. =

@ Activitylo
2 / Essentials SON View

. Access control (I1AM)

Resource grou 1-AUEAS g
9 oy Location 10.123.1.2
Settings Subscription (change! Azure VMware Solution_2
B Public P configuration ption ID 12343bc-d567-5910-abed-2e2bb1234506

P RMP DC 1920

Firewall policy : RDP

™% Firewall Manager
Secured virtual hub name : Contoso-private-cloud-AUEAST-vwan-hub

il Properties
X P Provisioning state Succeeded

B Locks

Tags (change) : Click here to add tags

3 Export template

Monitoring

i Metrics

& Diagnostic settings

3. Select Azure Firewall Policies and then select Create Azure Firewall Policy.

Home > Firewalls » Contoso-private-cloud-AUEAST-vwan-fw> Firewall Manager

g= Firewall Manager | Azure Firewall Policies =

£ search (Ctri+/] | «

™ Getting Started

Subscription(s)
% Secured virtual hubs Aeieded =)
& Hubv works s + i
Hub-\istual networks Firewall Policy %y Inherits From %3  Hub Associations*y  Hub Location VNet Associatio...Ty  VNet Location Ssubscription g Resourc
Security [J == ror > 1 hubs > Ovnets Azure VMw

i »
B Azure Firewall P

™ Security Partner Providers

4. Under the Basics tab, provide the required details and select Next: DNS Settings.
5. Under the DNS tab, select Disable, and then select Next: Rules.

6. Select Add a rule collection, provide the below details and select Add. Then select Next: Threat
intelligence.

e Name

e Rules collection Type - DNAT

e Priority

e Rule collection Action — Allow

e Name of rule

e Source Type- IPaddress

e Source-*

e Protocol - TCP

e Destination port—80

e Destination Type — IP Address

e Destination — Public IP Address

e Translated address — Azure VMware Solution Web Server private IP Address
e Translated port - Azure VMware Solution Web Server port

7. Leave the default value, and then select Next: Hubs.
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8. Select Associate virtual hub.
9. Select a hub from the list and select Add.

Secure hubs with Azure Firewall Policy -

The selected hubs will be converted to Secured Virtual Hubs, Grayed out hubs might be in a failed state and needs to be recovered first using Azure Virtual WAN Ui

Subscription(s) * | -
[ Hus name Tv  FirewallPolicy Ty FirewallStatus Ty subscription %y ResourceGroup Ty HUBLOCATION Ty VIRTUALWAN 7y
D » Contosc-private.. @ ng Paolicy Deployed Contoso-private-Cloud-H... westus Contoso-private-cloud-Hde.
| ¢ Calltosc Frtvate dioua,. AMP Deploved Contoso-private-cloud-A... australiaeast Contoso-private-cloud-Aus..

@ This operation will deploy Azure Firewali in the sefected hub if it
doesn't have one deployed and will have an immediate silling
mpact

10. Select Next: Tags.
11. (Optional) Create name and value pairs to categorize your resources.

12. Select Next: Review + create and then select Create.

Limitations

You can have 100 public IPs per private cloud.

Next steps

Now that you've covered how to use the public IP functionality in Azure VMware Solution, you may want to
learn about:

e Using public IP addresses with Azure Virtual WAN.

e Creating an IPSec tunnel into Azure VMware Solution.
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Configure DHCP for Azure VMware Solution

8/19/2022 + 5 minutes to read « Edit Online

Applications and workloads running in a private cloud environment require name resolution and DHCP services
for lookup and IP address assignments. A proper DHCP and DNS infrastructure are required to provide these

services. You can configure a virtual machine to provide these services in your private cloud environment.

Use the DHCP service built-in to NSX or use a local DHCP server in the private cloud instead of routing
broadcast DHCP traffic over the WAN back to on-premises.

In this how-to article, you'll use NSX-T Manager to configure DHCP for Azure VMware Solution in one of the
following ways:

e Use the Azure portal to create a DHCP server or relay
e Use NSX-T Data Center to host your DHCP server

e Use a third-party external DHCP server

TIP

If you want to configure DHCP using a simplified view of NSX-T Data Center operations, see Configure DHCP for Azure
VMware Solution.

IMPORTANT

For clouds created on or after July 1, 2021, the simplified view of NSX-T Data Center operations must be used to

configure DHCP on the default Tier-1 Gateway in your environment.

DHCP does not work for virtual machines (VMs) on the VMware HCX L2 stretch network when the DHCP server is in the
on-premises datacenter. NSX-T Data Center, by default, blocks all DHCP requests from traversing the L2 stretch. For the
solution, see the Configure DHCP on L2 stretched VMware HCX networks procedure.

Use the Azure portal to create a DHCP server or relay

You can create a DHCP server or relay directly from Azure VMware Solution in the Azure portal. The DHCP
server or relay connects to the Tier-1 gateway created when you deployed Azure VMware Solution. All the
segments where you gave DHCP ranges will be part of this DHCP. After you've created a DHCP server or DHCP
relay, you must define a subnet or range on segment level to consume it.

1. In your Azure VMware Solution private cloud, under Workload Networking, select DHCP > Add.

2. Select either DHCP Server or DHCP Relay and then provide a name for the server or relay and three IP
addresses.

NOTE

For DHCP relay, you only require one IP address for a successful configuration.
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Home > Azure VMware Solution > Contoso-westus-sddc Add DHCP
Azure VMware Sol...  « == Contoso-westus-sddc | DHCP

Azure Private Cloud

Microseft (microsoftonmic o
- Add €5 Manageview ~ o « t Add ) Refresh
Server Type
Settings N i
[ Filter for any field.. | (®) DHCP Relay
£ Locks co
Name - @ Once 2 DHCP server or DHCP relay is created, a user mt (O DHCP Server
configuration
@ Contoso-eastus-sddc Manage Server name *
& Contoso-westus-sddc - Connectivity [Entera name ‘
[ @ No DHCP server or relay to display
entity erver <ces (up to three) *
@ Contoso-private-cloud Y Server P addresses (up to three)
R Clusters Enter an address
@ Contoso_private_cloud B Clusters ‘ ‘
@ acure_private_cloud F Add-ans [Enter an adress |
Workload Networking
5 Segments @ Once 3 DHCP server or DHCP relay is created, a user must define 2 subnet or range on

- segment level to consume it. Go to Segments to complete this configuration.
DHCP

B Port mirroring

3. Complete the DHCP configuration by providing DHCP ranges on the logical segments and then select
OK.

Use NSX-T Data Center to host your DHCP server

If you want to use NSX-T Data Center to host your DHCP server, you'll create a DHCP server and a relay service.
Then you'll add a network segment and specify the DHCP IP address range.

Create a DHCP server

1. In NSX-T Manager, select Networking > DHCP, and then select Add Server.

2. Select DHCP for the Server Type, provide the server name and IP address, and select Save.

[F < B vsphere - Cluster-1-Summ | (5 NsX X l + v = o X

< > O @ https://10.210.0.3/nsx/#/app/networks/dhcp/home/dhcp Y v 7 &

Home Networking Security Inventory Plan & Troubleshoot System Advanced Networking & Security

DHCP ®
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 Network Overview

x\l

ADD SERVER

Connectivity

& Tier-0 Gateways Server Type  Server Name Server IP Lease Time Edge Where Used  Tags
Lo Address (seconds) Cluster
[# Tier-1 Gateways

| DHCP PServer & ).1.1.1/24 = 86400 Tag (R

o< Segments Format is

Network Services
® VPN
J NAT

% Load Balancing

< Forwarding Policies

IP Management
B DNs
£ bHcP

@ IP Address Pools C REFRESH No DHCPs

Settings

3. Select Tier 1 Gateways, select the vertical ellipsis on the Tier-1 gateway, and then select Edit.



Home

Connectivity
Tier-O Gateways
Tier-1 Gateways

<8 Segments

Network Services

Networking

Security

«

Inventory

Tier-1 Gateway

ADD TIER-1 GATEWAY

Delete

Plan & Troubleshoot

Copy path to clipboard

® VPN

P NAT

IP Management
E DNs

& pHcP

Settings

<% Load Balancing

& Forwarding Policies

& IP Address Pools

C REFRESH

4. Select No IP Allocation Set to add a subnet.

Tier-1 Gateway

ADD TIER-1 GATEWAY

(C REFRESH

5

>

Tier-1 Gateway Name

System

Advanced Networking & Security

EXPAND ALL

Linked Tier-O Gateway #Linked Segments

TNT72-TO (o]

Filter by Name, Path or more

Status

®u CO

COLLAPSE ALL

Linked Tier-O Gateway

|P Address Management

NT72-T1 X ® TNT72-TO ® v
Fail Over Non Preemptive

Edge Cluster

Tags

> Route Advertisement

> Additional Settings

SERVICE INTERFACES

STATIC ROUTES

Select Edge Clus
Select Edge Cluster if you

plan to configure stateful
services such as NAT

Tag (Requir

Max 30 allowed. Click (+)
to save.

5. For Type, select DHCP Local Server.

6. For the DHCP Server, select Default DHCP, and then select Save.

7. Select Save again and then select Close Editing.

Add a network segment

Scope (Opt

Edges

#Linked Segments

Enable Standby

Relocation

1-10f 1 Tier-1 Gateways

Status

No |

If no edges has been
selected the system will
auto-allocate.

@

1-10f1Tier-1 Gateways

1. In NSX-T Manager, select Networking > Segments, and then select Add Segment.
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Settings
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2. Enter a name for the segment.
3. Select the Tier-1 Gateway (TNTxx-T1) as the Connected Gateway and leave the Type as Flexible.

4. Select the pre-configured overlay Transport Zone (TNTxx-OVERLAY-TZ) and then select Set Subnets.

Home Security Inventory Plan & Troubleshoot System A ced Networking & Security
«

s CEMENT DDA EC

=9 SEGMENTS SEGMENT PROFILES (’%
7 Network Over

| EXPAND ALL
Connectivity
Tier-0 Gateways Segment Name Connected Gateway & Type Subnets Status

Tier-1 Gateways : I 1sO1 ) | | TNTI2-T1 (& ) Flex !

Transport Zone

VPN Tunnel ID VLAN

NOTE - Before further configurations can be done, fill out mandatory fields above ( * ), click 'Save’ below.

DNS SAVE CANCEL

5 ot  TNTIZTOMSFTAS None - Fiexible euwcC
s
> x TNT12-TO-PRIVATE-LS None - Flexible ® Up
Settings INT ; Py
3 . 12-TO-PUBLIC-LS None - Flexibk "
PV6 Profiles
(™ REFRESH

5. Enter the gateway IP address and then select Add.



IMPORTANT
The IP address needs to be on a non-overlapping RFC1918 address block, which ensures connection to the VMs

on the new segment.

Set Subnets

Segment #5ubnets @
Gateway IP/Prefix Length DHCP Ranges
] I 10.10.230.1/24 : Enter DHCP Ranges
Format CIDR e.g. 10.12.21/24
F ats, 2.2 64/2 }
ADD CANCEL

CANCEL

6. Select Apply and then Save.
7. Select No to decline the option to continue configuring the segment.

Specify the DHCP IP address range
When you create a relay to a DHCP server, you'll also specify the DHCP IP address range.

NOTE
The IP address range shouldn't overlap with the IP range used in other virtual networks in your subscription and on-

premises networks.

1. In NSX-T Manager, select Networking > Segments.
2. Select the vertical ellipsis on the segment name and select Edit.

3. Select Set Subnets to specify the DHCP IP address for the subnet.
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T
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Segment needs to have either Subnets or VPN defined, or both.

L2 VPN You have no L2 VPN sessions Transport Zone TNT72-OVERLAY-TZ | Ov
for this Gateway. For that, go
to VPN Services . Note that for

VPN Tunnel ID L2 sessions to work, you also VLAN Enter List of VLANs
need IP Sec session defined.

NOTE - Before further configurations can be done, fill out mandatory fields above ( * ), click 'Save' below.
PORTS

SEGMENT PROFILES

> &  TNT72-TO-MSFT-LS None - Flexible ® up C

~

C REFRESH 1- 3 of 3 Segments

4. Modify the gateway IP address if needed, and enter the DHCP range IP

Set Subnets
segment

ADD SUBNET O\

Gateway DHCP Ranges
] 10.12.2.1/24 * 10.12.2.64/26 X
Format CIDR e.g. 10.12.2.1/24 Enter DHCP Ranges

Formats, e.g. 10.12.2.64/26, 10.12.2.2-10.12.2.50

5. Select Apply, and then Save. The segment is assigned a DHCP server pool.
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If you want to use a third-party external DHCP server, you'll create a DHCP relay service in NSX-T Manager. You'll

also specify the DHCP IP address range.

IMPORTANT

configure DHCP on the default Tier-1

Gateway in your environment.

For clouds created on or after July 1, 2021, the simplified view of NSX-T Data Center operations must be used to

Create DHCP relay service

Use a DHCP relay for any non-NSX-based DHCP service. For example, a VM running DHCP in Azure VMware

Solution, Azure laa$, or on-premises.

1. In NSX-T Manager, select Networking > DHCP, and then select Add Server.

2. Select DHCP Relay for the Server Type, provide the server name and IP address, and select Save.

Advanced Networking & Security

® VPN
F NAT
<% Load Balancing

< Forwarding Policies

IP Management
= DNS

£ pHcP

Home Networking Security Inventory Plan & Troubleshoot System
= DHCP
= =

Connectivity
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Network Services €.9.10.10.10.10

CANCEL

Lease Time (seconds) Edge Cluster Where Used Tags

Tag  Scof

Max 30
allowed. Click
(+) to save

3. Select Tier 1 Gateways, select the vertical ellipsis on the Tier-1 gateway, and then select Edit.
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Advanced Networking & Security

Linked Tier-f

TNT72-TO

EXPAND ALL Filter by Name, Path or more
0 Gateway #Linked Segments Status
o

4. Select No IP Allocation Set to define the IP address allocation.
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5. For Type, select DHCP Server.
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plan to configure stateful
services such as NAT

Tag (Requir

Max 30 allowed. Click (+)
to save.

Scope (Opt

|P Address Management

Edges

Enable Standby
Relocation

6. For the DHCP Server, select DHCP Relay, and then select Save.

7. Select Save again and then select Close Editing.

Specify the DHCP IP address range

®u CO

1-10f 1 Tier-1 Gateways

Status

No IP Allocation Set

If no edges has been

selected the system will
auto-allocate.

@

1-10f1Tier-1 Gateways

When you create a relay to a DHCP server, you'll also specify the DHCP IP address range.

NOTE

premises networks.

The IP address range shouldn't overlap with the IP range used in other virtual networks in your subscription and on-

1. In NSX-T Manager, select Networking > Segments.

2. Select the vertical ellipsis on the segment name and select Edit.




3. Select Set Subnets to specify the DHCP IP address for the subnet.

o
0£g SEGMENTS  SEGMENT PROFILES ®
Segment Name Connected Gateway & Type Subnets Status

Default VM Segment i TNT72-T] X ®v * Flexitv* Set SubnetS*l

Segment needs to have either Subnets or VPN defined, or both.

L2 VPN You have no L2 VPN sessions Transport Zone TNT72-OVERLAY-TZ | Ov
for this Gateway. For that, go
to VPN Services . Note that for

VPN Tunnel ID L2 sessions to work, you also VLAN Enter List of VLANs
need IP Sec session defined.

NOTE - Before further configurations can be done, fill out mandatory fields above ( * ), click 'Save' below.

PORTS
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4. Modify the gateway IP address if needed, and enter the DHCP range IP

Set Subnets
segment
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CANCEL

5. Select Apply, and then Save. The segment is assigned a DHCP server pool.
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Next steps

If you want to send DHCP requests from your Azure VMware Solution VMs to a non-NSX-T DHCP server, see the
Configure DHCP on L2 stretched VMware HCX networks procedure.



Configure DHCP on L2 stretched VMware HCX

networks

8/19/2022 - 2 minutes to read  Edit Online

DHCP does not work for virtual machines (VMs) on the VMware HCX L2 stretch network when the DHCP server
is in the on-premises data center. This is because NSX-T Data Center, by default, blocks all DHCP requests from
traversing the L2 stretch. Therefore, to send DHCP requests from your Azure VMware Solution VMs to a non-
NSX-T Data Center DHCP server, you'll need to configure DHCP on L2 stretched VMware HCX networks.

1. (Optional) If you need to locate the segment name of the L2 extension:
a. Sign in to your on-premises vCenter Server, and under Home, select HCX.
b. Select Network Extension under Services.

c. Select the network extension you want to support DHCP requests from Azure VMware Solution to
on-premises.

d. Take note of the destination network name.

vm vSphere Client

HCX .
Network Extension
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Switch: VM-RegionB01- 1 L2 HOL1-NE-1 vc: vesa-01a.corp local egionB01-vDS- Extension complete
d ¥DS.COMP COM-1-10b33282
“D Disaster Recovery
- System
& Administration

© Support

2. In NSX-T Manager, select Networking > Segments > Segment Profiles.

3. Select Add Segment Profile and then Segment Security.
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4. Provide a name and a tag, and then set the BPDU Filter toggle to ON and all the DHCP toggles to OFF.
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Configure a DNS forwarder in the Azure portal

8/19/2022 « 4 minutes to read » Edit Online

IMPORTANT
For Azure VMware Solution private clouds created on or after July 1, 2021, you now have the ability to configure private
DNS resolution. For private clouds created before July 1, 2021, that need private DNS resolution, open a support request

and request Private DNS configuration.

By default, Azure VMware Solution management components such as vCenter Server can only resolve name
records available through Public DNS. However, certain hybrid use cases require Azure VMware Solution
management components to resolve name records from privately hosted DNS to properly function, including
customer-managed systems such as vCenter Server and Active Directory.

Private DNS for Azure VMware Solution management components lets you define conditional forwarding rules
for the desired domain name to a selected set of private DNS servers through the NSX-T Data Center DNS
Service.

This capability uses the DNS Forwarder Service in NSX-T Data Center. A DNS service and default DNS zone are
provided as part of your private cloud. To enable Azure VMware Solution management components to resolve
records from your private DNS systems, you must define an FQDN zone and apply it to the NSX-T Data Center
DNS Service. The DNS Service conditionally forwards DNS queries for each zone based on the external DNS
servers defined in that zone.

NOTE

The DNS Service is associated with up to five FQDN zones. Each FQDN zone is associated with up to three DNS servers.

TIP

If desired, you can also use the conditional forwarding rules for workload segments by configuring virtual machines on
those segments to use the NSX-T Data Center DNS Service IP address as their DNS server.

Architecture

The diagram shows that the NSX-T Data Center DNS Service can forward DNS queries to DNS systems hosted
in Azure and on-premises environments.
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Configure DNS forwarder

1. In your Azure VMware Solution private cloud, under Workload Networking, select DNS > DNS zones.
Then select Add.

NOTE

For private clouds created on or after July 1, 2021, the default DNS zone is created for you during the private
cloud creation.




Home > azcat-avs-cac-js-pc02
o azcat-avs-cac-js-pc02 | DNS = - X

AVS Private cloud ® Directory: Microsoft

lP Search (Ctrl+/) J « |+ Add | & Edit [ Delete ) Refresh
W Orviei DNS service

@ Activitylog
f, Access control (1AM) Name : All

@ Tags [] Name © Domain Ty DNS servers Ty Source IP Ty, DNS service Ty

2 Diagnose and solve problems [0 @ 1NT74-DNS-FORWARDER-ZONE any 11111001 T 1

Settings

B Locks

Manage

®  Connectivity

B Identity

B clusters

+ Add-ons
Workload Networking
< Segments

Tl DHep

N Port mirroring

© ons

Operations

Run command

Monitoring
B Alerts
fid Metrics
& Advisor recommendations

Automation

2. Select FQDN zone, provide a name and up to three DNS server IP addresses in the format of 10.0.0.53.
Then select OK.

Add DNS zone X

Type
(O Default DNS zone

@ FQDN zone

DINS zone name *

| contase \/|
Domain *
| contoso.corp \/|

DINS server IP {up to 3) *

| 172218820 -]
[ 172218834 ]
Enter an address v
Source IP
Enter an address e




IMPORTANT
While NSX-T Data Center allows spaces and other non-alphanumeric characters in a DNS zone name, certain NSX-
T Data Center resources such as a DNS Zone are mapped to an Azure resource whose names don't permit certain

characters.

As a result, DNS zone names that would otherwise be valid in NSX-T Data Center may need adjustment to adhere

to the Azure resource naming conventions.

It takes several minutes to complete, and you can follow the progress from Notifications. You'll see a
message in the Notifications when the DNS zone has been created.

3. Ignore the message about a default DNS zone because one gets created for you as part of your private
cloud.

4. Select the DNS service tab and then select Edit.

TIP

For private clouds created on or after July 1, 2021, you can ignore the message about a default DNS zone as one

is created for you during private cloud creation.

IMPORTANT

While certain operations in your private cloud may be performed from NSX-T Manager, for private clouds created
on or after July 1, 2021, you must edit the DNS service from the Simplified Networking experience in the Azure
portal for any configuration changes made to the default Tier-1 Gateway.

Home > azcat-avs-cac-js-pc02

(o) azcat-avs-cac-js-pc02 | DNS =

AVS Private cloud @ Directory: Microsoft

|P Search (Ctrl+/) | « Add Delete () Refresh

a

& Overview

Activity log

Name | TNT74-DNS-FORWARDER s} |
Ao Access control (IAM)
¢ Tags Tier-1 Gateway [ NT7aTT |
£ Diagnose and solve problems DNS service IP | 10.114.240,192 iy |
Settings Default DNS zone | TNT74-DNS-FORWARDER-ZONE i} |
B Locks FQDN zones | - s |
Manage Log level | INFO D |
. Connectivity

Status | success m|

B identity

5. From the FQDN zones drop-down, select the newly created FQDN, and then select OK.


https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/resource-name-rules

Edit DNS service %
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TNT74-T1
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Default DNS zone *

Fi W
FQDM zones (up to 5)
contoso ~
H contaso
Info e

“ c ance’

It takes several minutes to complete, and once finished, you'll see the Completed message from
Notifications. At this point, management components in your private cloud should be able to resolve
DNS entries from the FQDN zone provided to the NSX-T Data Center DNS Service.

6. Repeat the above steps for other FQDN zones, including any applicable reverse lookup zones.

Verify name resolution operations

After you've configured the DNS forwarder, you'll have a few options available to verify name resolution
operations.

NSX-T Manager

NSX-T Manager provides the DNS Forwarder Service statistics at the global service level and on a per-zone

basis.

1. In NSX-T Manager, select Networking > DNS, and then expand your DNS Forwarder Service.

admin

Home Networking ~ Security  Inventory  Plan & Troubleshoot  System Advanced Networking & Security
«

=] DNSSERVICES ~ DNS ZONES @)
@ Network Overview

" ADD DNS SERVICE COLLAPSE ALL O\ earc
Connectivity
3 Tier-0 Gateways Name Tier0/Tier1 Gateway DNS Service IP Default DNS Zone Status
& Tier-1 Gateways i v [E TNT86-DNS-FORWARDER TNT86-TI 10.103.64.192 TNT86-DNS-FORWARDER-ZONE @ @ Up C
o<§ Segments

Description Not Set Admin Status @ Enabled VIEW STATISTICS

I . FQGDN Zones contoso-onprem (@ Tags o

a Log Level Info
® VPN
F NAT

% Load Balancing

& Forwarding Policies

IP Management
& DNs

& bHcP

2. Select View Statistics, and then from the Zone Statistics drop-down, select your FQDN Zone.

The top half shows the statistics for the entire service, and the bottom half shows the statistics for your



specified zone. In this example, you can see the forwarded queries to the DNS services specified during

the configuration of the FQDN zone.

Statistics - TNT86-DNS-FORWARDER X
DS Status: ® Up
d On: Thursday, July 1, 2021 at 4:45:08 PM GMT-07.00 REFRESH

Service Statistics:

Cache Utilization - Cache Size: 1.00 KB Cached Queries
Entries

Used 2.00 Bytes + Forwarded 803.76K

1.00 KB Unused 1022.00 803.92K Answered 164
Bytes Locally
Zone Statistics: contoso-onprem

Damains: coantoso.corp

Upstream Server Queries Succeeded Queries Failed

172.21.88.34 2 o}

172.21.88.20 2 0
PowerCLI

The NSX-T Policy API lets you run nslookup commands from the NSX-T Data Center DNS Forwarder Service.
The required cmdlets are part of the vMware.vimAutomation.Nsxt module in PowerCLI. The following example

demonstrates output from version 12.3.0 of that module.

1. Connect to your NSX-T Manager cluster.

TIP
You can obtain the IP address of your NSX-T Manager cluster from the Azure portal under Manage > ldentity.

Connect-NsxtServer -Server 10.103.64.3
2. Obtain a proxy to the DNS Forwarder's nslookup service.

$nslookup = Get-NsxtPolicyService -Name com.vmware.nsx_policy.infra.tier_1s.dns_forwarder.nslookup
3. Perform lookups from the DNS Forwarder Service.

$response = $nslookup.get('TNT86-T1', 'vcOl.contoso.corp')

The first parameter in the command is the ID for your private cloud's T1 gateway, which you can obtain from the

DNS service tab in the Azure portal.

1. Obtain a raw answer from the lookup using the following properties of the response.



$response.dns_answer_per_enforcement_point.raw_answer; (()) DiG 9.10.3-P4-Ubuntu (()) @10.103.64.192
-b 10.103.64.192 vcO@l.contoso.corp +timeout=5 +tries=3 +nosearch ; (1 server found) ;; global
options: +cmd ;; Got answer: ;; -))HEADER((- opcode: QUERY, status: NOERROR, id: 10684 ;; flags: gr
rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: ©, ADDITIONAL: 1 ;; OPT PSEUDOSECTION: ; EDNS: version: 0,
flags:; udp: 4096 ;; QUESTION SECTION: ;vc@l.contoso.corp. IN A ;; ANSWER SECTION:
vcol.contoso.corp. 3046 IN A 172.21.90.2 ;; Query time: © msec ;; SERVER:
10.103.64.192:53(10.103.64.192) ;; WHEN: Thu Jul @1 23:44:36 UTC 2021 ;; MSG SIZE rcvd: 62

In this example, you can see an answer for the query of vc01.contoso.corp showing an A record with the
address 172.21.90.2. Also, this example shows a cached response from the DNS Forwarder Service, so
your output may vary slightly.



Create a HCX network extension

8/19/2022 « 2 minutes to read = Edit Online

This is an optional step to extend any networks from your on-premises environment to Azure VMware Solution.

1. Under Services, select Network Extension > Create a Network Extension.

vm  vSphere Client

HeX
@ pashboara Network Extension

~ Infrastructure

< V1 > HCX services are using trial period limits. Activate HCX to remove the limits. ]
Pairing

& Interconnect

overy
~ System
& Administration

@ support You have not created a Network Extension

CREATE A NETWORK EXTENSION

What is a Net:

2. Select each of the networks you want to extend to Azure VMware Solution, and then select Next.

Extend Networks select source networks for extension to remote site

Select Service Mesh: ServiceMesh: hcxmanager-enterprise - TNT51-HCX-MGR-cloud

 Tide Withort vi= €9 B — .
| Hide Wit out 5 @ |\ Hide Ineligible m/|

% source Network VLAN ID/VNI

Workloads-PG

3. Enter the on-premises gateway IP for each of the networks you're extending, and then select Submit.

Extend Networks select source networks for extension to remote site

Service Mesh: ServiceMesh : [ hcxmanager-enterprise g TNTS1-HCX-MGR-cloud

Destination First Hop Router TNT51-T1

1. Source Network to Extend: Workloads-PG

Gateway IP Address Extension Appliance

10.254.200.1/24|

ServiceMesh-NE-I1 (O of 8 extensions)

> Settings - optional

It takes a few minutes for the network extension to finish. When it does, you see the status change to
Extension complete.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-hcx-network-extension.md
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Extensions: ()

+EXTEND NETWORKS

1

Transport Zones / DVS

Extension Appliance Status

ServiceMesh-MNE-I ﬂ Extension complete

1 extension

Next steps

Now that you've configured the HCX Network Extension, you can also learn about:

e VMware HCX Mobility Optimized Networking (MON) guidance



Configure NSX-T Data Center network components

using Azure VMware Solution

8/19/2022 - 2 minutes to read  Edit Online

An Azure VMware Solution private cloud comes with NSX-T Data Center by default. The private cloud comes
pre-provisioned with an NSX-T Data Center Tier-0 gateway in Active/Active mode and a default NSX-T Data
Center Tier-1 gateway in Active/Standby mode. These gateways let you connect the segments (logical switches)
and provide East-West and North-South connectivity.

After deploying Azure VMware Solution, you can configure the necessary NSX-T Data Center objects from the
Azure portal. It presents a simplified view of NSX-T Data Center operations a VMware administrator needs daily
and is targeted at users not familiar with NSX-T Manager.

You'll have four options to configure NSX-T Data Center components in the Azure VMware Solution console:

e Segments - Create segments that display in NSX-T Manager and vCenter Server. For more information,
see Add an NSX-T Data Center segment using the Azure portal.

e DHCP - Create a DHCP server or DHCP relay if you plan to use DHCP. For more information, see Use the
Azure portal to create a DHCP server or relay.

e Port mirroring — Create port mirroring to help troubleshoot network issues. For more information, see
Configure port mirroring in the Azure portal.

e DNS - Create a DNS forwarder to send DNS requests to a designated DNS server for resolution. For
more information, see Configure a DNS forwarder in the Azure portal.

IMPORTANT

You'll still have access to the NSX-T Manager console, where you can use the advanced settings mentioned and other
NSX-T Data Center features.



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-nsx-network-components-azure-portal.md

Configure port mirroring in the Azure portal

8/19/2022 « 2 minutes to read = Edit Online

After deploying Azure VMware Solution, you can configure port mirroring from the Azure portal. Port mirroring
places a protocol analyzer on the port that receives the mirrored data. It analyzes traffic from a source, a virtual
machine (VM), or a group of VMs, and then sent to a defined destination.

In this how-to, you'll configure port mirroring to monitor network traffic, which involves forwarding a copy of
each packet from one network switch port to another.

Prerequisites

An Azure VMware Solution private cloud with access to the vCenter Server and NSX-T Manager interfaces. For
more information, see the Configure networking tutorial.

Create the VMs or VM groups

You'll create the source and destination VMs or VM groups. The source group has a single VM or multiple VMs
where the traffic is mirrored.

1. In your Azure VMware Solution private cloud, under Workload Networking, select Port mirroring >
VM groups > Add.

gx Contoso-eastus-sddc | Port mirroring

Azure Private Cloud

|,-' Search (Ctrl+/) | « + Add te () Refresh
Manage -

& Connectivity _VMgmupsl Port mirroring
B Identity | Filter by name Name : All
B Clusters [ Name *

+ Add-ons [[] Destination-Group-Test
Workload Networking [] pst-group

% Segments [ source-Group-Test

T DHCP [J Src-web

B Port mirroring I

© DNS

2. Provide a name for the new VM group, select VMs from the list, and then OK.

3. Repeat these steps to create the destination VM group.

NOTE

Before creating a port mirroring profile, make sure that you've created both the source and destination VM
groups.

Create a port mirroring profile

You'll create a port mirroring profile that defines the traffic direction for the source and destination VM groups.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-port-mirroring-azure-vmware-solution.md

1. Select Port mirroring > Port mirroring > Add and then provide:

gy Contoso-eastus-sddc | Port mirroring Add port mirroring

Azure Private Cloud

[0 Search (Ctries) | « te () Refresh

Port mirraring name

Manage o
Wi groups Port mirrori Enfter a name

‘ ccr‘-"ec.- ..":ll g p

Direction *
& Identity O Filter by name | Mame : All

Select a direction

B Clusters Mame T Direction Ty,

Source =
+ Add-ons Mo part mirrering profiles to display Select
Worklead Networking Destination *
< Segments Select & destination
i DHCP Description

I BB Port mirroring I Enter a description

@ DNS
Maonitoring
ER Alerts

| o
fial Metrics

e Port mirroring name - Descriptive name for the profile.

e Direction - Select from Ingress, Egress, or Bi-directional.

e Source - Select the source VM group.

e Destination - Select the destination VM group.

e Description - Enter a description for the port mirroring.
2. Select OK to complete the profile.

The profile and VM groups are visible in the Azure VMware Solution console.



Configure a site-to-site VPN in vVWAN for Azure

VMware Solution

8/19/2022 « 9 minutes to read » Edit Online

In this article, you'll establish a VPN (IPsec IKEv1 and IKEv2) site-to-site tunnel terminating in the Microsoft
Azure Virtual WAN hub. The hub contains the Azure VMware Solution ExpressRoute gateway and the site-to-site
VPN gateway. It connects an on-premises VPN device with an Azure VMware Solution endpoint.

1 . /A Azure .

. VMware - .

. Solution

vmware |

VPN .
VM VM vMm

|
|
|
gateway |
|
|
|
|

ExpressRoute | |, . . @ .-EE
gateway ._.v"' N

Prerequisites

You must have a public-facing IP address terminating on an on-premises VPN device.

Create an Azure Virtual WAN

1. In the portal, in the Search resources bar, type Virtual WAN in the search box and select Enter.

2. Select Virtual WANs from the results. On the Virtual WANs page, select + Create to open the Create
WAN page.

3. On the Create WAN page, on the Basics tab, fill in the fields. Modify the example values to apply to your
environment.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-site-to-site-vpn-gateway.md

Create WAN

Basics Review + create

The virtual WAN resource represents a virtual overlay of your Azure network and is a collection of multiple resources. Learn
more

Project details

Subscription * | Content Development v |
Resource group * I TestRG N I
Create new

Virtual WAN details

Resource group location * I East US ~ I
Name * | TestvwANT ]
Type @ | Standard v |

e Subscription: Select the subscription that you want to use.
e Resource group: Create new or use existing.

e Resource group location: Choose a resource location from the dropdown. A WAN is a global
resource and doesn't live in a particular region. However, you must select a region in order to manage
and locate the WAN resource that you create.

e Name: Type the Name that you want to call your virtual WAN.

e Type: Basic or Standard. Select Standard. If you select Basic, understand that Basic virtual WANs can
only contain Basic hubs. Basic hubs can only be used for site-to-site connections.

4. After you finish filling out the fields, at the bottom of the page, select Review +Create.

5. Once validation passes, click Create to create the virtual WAN.

Create a virtual hub

Avirtual hub is a virtual network that is created and used by Virtual WAN. It's the core of your Virtual WAN
network in a region. It can contain gateways for site-to-site and ExpressRoute.

TIP

You can also create a gateway in an existing hub.

1. Go to the virtual WAN that you created. On the virtual WAN page left pane, under the Connectivity,
select Hubs.

2. On the Hubs page, select + New Hub to open the Create virtual hub page.


https://docs.microsoft.com/en-us/azure/virtual-wan/virtual-wan-expressroute-portal

Create virtual hub

Basics  Site to site Point to site ExpressRoute Tags  Review + create

A virtual hub is a Microsoft-managed virtual network. The hub contains various service endpoints to enable connectivity from
your on-premises network (vpnsite). Learn more

Project details

The hub will be created under the same subscription and resource group as the VWAN.

Subscription \ Content Development v ‘

~ Resource group ‘ TestRG vV ‘

Virtual Hub Details

Region * I East US v I
Name * { Hub1 \/l
Hub private address space * © ‘ 10.1.0.0/16 v |
Virtual hub capacity * © I 2 Routing Infrastructure Units, 3 Gbps Router, Supports 2000 VMs v I
Hub routing preference * © \ ExpressRoute v ’

3. On the Create virtual hub page Basics tab, complete the following fields:

e Region: Select the region in which you want to deploy the virtual hub.
e Name: The name by which you want the virtual hub to be known.

e Hub private address space: The hub's address range in CIDR notation. The minimum address space
is /24 to create a hub.

e Virtual hub capacity: Select from the dropdown. For more information, see Virtual hub settings.

e Hub routing preference: This field is only available as part of the virtual hub routing preference
preview and can only be viewed in the preview portal. See Virtual hub routing preference for more
information.

Create a VPN gateway

1. Onthe Create virtual hub page, click Site to site to open the Site to site tab.


file:///C:/localrun/t/1pp1/gn1d/azure/includes/media/virtual-wan-hub-basics/create-hub.png#lightbox
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Home > Virtual WANs > TestVWAN1 >

Create virtual hub

Basics  Sitetosite  Point to site ExpressRoute Tags  Review + create

You will need to enable Site to site (VPN gateway) before connecting to VPN sites. You can do this after hub creation, but
doing it now will save time and reduce the risk of service interruptions later. Learn more

Do you want to create a Site to site (VPN ‘: No

gateway)?

AS Number @ 65515 D |
*Gateway scale units @© ’ 2 scale units - 1 Gbps x 2 v ]
Routing preference © 'é‘ Microsoft network O Internet

2. On the Site to site tab, complete the following fields:
e Select Yes to create a Site-to-site VPN.
e AS Number: The AS Number field can't be edited.

e Gateway scale units: Select the Gateway scale units value from the dropdown. The scale unit
lets you pick the aggregate throughput of the VPN gateway being created in the virtual hub to
connect sites to.

If you pick 1 scale unit = 500 Mbps, it implies that two instances for redundancy will be created,
each having a maximum throughput of 500 Mbps. For example, if you had five branches, each
doing 10 Mbps at the branch, you'll need an aggregate of 50 Mbps at the head end. Planning for
aggregate capacity of the Azure VPN gateway should be done after assessing the capacity needed
to support the number of branches to the hub.

e Routing preference: Azure routing preference lets you choose how your traffic routes between
Azure and the internet. You can choose to route traffic either via the Microsoft network, or via the
ISP network (public internet). These options are also referred to as cold potato routing and hot

potato routing, respectively.

The public IP address in Virtual WAN is assigned by the service, based on the routing option
selected. For more information about routing preference via Microsoft network or ISP, see the

Routing preference article.
3. Select Review + Create to validate.

4. Select Create to create the hub and gateway. This can take up to 30 minutes. After 30 minutes, Refresh
to view the hub on the Hubs page. Select Go to resource to navigate to the resource.

Create a site-to-site VPN

1. In the Azure portal, select the virtual WAN you created earlier.

2. Inthe Overview of the virtual hub, select Connectivity > VPN (Site-to-site) > Create new VPN
site.


https://docs.microsoft.com/en-us/azure/virtual-network/ip-services/routing-preference-overview
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3. On the Basics tab, enter the required fields.

Home > Virtual[HubDeployment > TestRG > TestVWAN1 >

Create VPN site

Basics

Project details

Subscription Content Development

Resource group TestRG 9

Instance details

Region * [ Eastus v |
Name * [ Testsite1 v]
Device vendor * l Cisco v l

Private address space

[ 10200724 e

{ \

e Region - Previously referred to as location. It's the location you want to create this site resource in.
e Name - The name by which you want to refer to your on-premises site.

e Device vendor - The name of the VPN device vendor, for example, Citrix, Cisco, or Barracuda. It
helps the Azure Team better understand your environment to add more optimization possibilities
in the future or help you troubleshoot.

e Private address space - The CIDR IP address space located on your on-premises site. Traffic
destined for this address space is routed to your local site. The CIDR block is only required if you
BGP isn't enabled for the site.

NOTE

If you edit the address space after creating the site (for example, add an additional address space) it can take 8-10

minutes to update the effective routes while the components are recreated.

4. Select Links to add information about the physical links at the branch. If you have a Virtual WAN partner
CPE device, check with them to see if this information gets exchanged with Azure as a part of the branch
information upload set up from their systems.

Specifying link and provider names allow you to distinguish between any number of gateways that may
eventually be created as part of the hub. BGP and autonomous system number (ASN) must be unique


file:///C:/localrun/t/1pp1/gn1d/azure/includes/media/virtual-wan-tutorial-site-include/site-basics.png#lightbox
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inside your organization. BGP ensures that both Azure VMware Solution and the on-premises servers
advertise their routes across the tunnel. If disabled, the subnets that need to be advertised must be
manually maintained. If subnets are missed, HCX fails to form the service mesh.

IMPORTANT

By default, Azure assigns a private IP address from the GatewaySubnet prefix range automatically as the Azure
BGP IP address on the Azure VPN gateway. The custom Azure APIPA BGP address is needed when your on
premises VPN devices use an APIPA address (169.254.0.1 to 169.254.255.254) as the BGP IP. Azure VPN Gateway
will choose the custom APIPA address if the corresponding local network gateway resource (on-premises network)
has an APIPA address as the BGP peer IP. If the local network gateway uses a regular IP address (not APIPA), Azure
VPN Gateway will revert to the private IP address from the GatewaySubnet range.

= Microsoft Azure P Search resources, services, and docs (G+/)

Create VPN site

Basics  Links

At least one link is r

Link name Link speed Link provider name Link IP address / FQDN Link BGP address Link ASN

@ You can also work with a Virtual WAN partner to create multiple sites simultaneously. Learn more.

[ Previous | [ Next:Review + create >

5. SelectReview + create.

6. Navigate to the virtual hub you want, and deselect Hub association to connect your VPN site to the
hub.

Home > TestVWAN1T > Hub1

B Hub1| VPN (Site to site) »

Virtual HUB

[ search (ctri+) | « L Download VPN Config [il] Delete gateway () Reset gateway
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&¢ User VPN (Point to site)

O Search this page Clear all filters

@ Routing

Hub association : Connected to this hub X
Security

VPN Sites ©
& Convert to secure hub
Third party providers (i)

Check active filters when searching for a VPN site
T Network Virtual Appliance

+ Create new VPN'site @ Connect VPN sites ¢ Disconnect VPN sites () Refresh

Page: | 1 v
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(Optional) Create policy-based VPN site-to-site tunnels

IMPORTANT
This is an optional step and applies only to policy-based VPNs.

Policy-based VPN setups require on-premises and Azure VMware Solution networks to be specified, including
the hub ranges. These ranges specify the encryption domain of the policy-based VPN tunnel on-premises

endpoint. The Azure VMware Solution side only requires the policy-based traffic selector indicator to be enabled.
1. In the Azure portal, go to your Virtual WAN hub site and, under Connectivity, select VPN (Site to site).

2. Select the VPN Site for which you want to set up a custom IPsec policy.

Home > Resource groups » SEA-Cust13 > wwan-SEA-Cust13 > westushub-SEA-Cust13 - VPN (Site to site)

ﬁ.i westushub-SEA-Cust13 - VPN (Site to site)

Virtual HUB

|).J Search (Ctri+/) ‘ « \l, Download VPN Config T Delete gateway U Reset gateway

‘& Overview ASN : 65515

Gateway scale units : 1 scale unit - 500 Mbps x 2
Connectivity

i VPN (Site to site) 2 Search by site name Clear all filters

& ExpressRoute
Hub association : Connected to this hub @

%t User VPN (Point to site)

7 VPN Sites O
B, Routing . ) o i
—+ Create new VPN site & Connect VPN sites  ¢¥ Disconnect VPN sites () Refresh
D Site name Location
& nfgwonprem westus
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3. Select your VPN site name, select More (..) at the far right, and then select Edit VPN Connection.

|2 Search by site name | Clearall filters
Hub association : Connected to this hub @

VPN Sites (O
~+ Create new VPN site & Connect VPN sites ¥ Disconnect VPN sites () Refresh

D Site name Location Hub connection status Site Connection Provisioning Status Context mer
B nfgwonprem1 westus © Succeeded @ Connected I:l
B nfgwonprem2 westus © Succeeded @ Connected

e Internet Protocol Security (IPSec), select Custom.
e Use policy-based traffic selector, select Enable
e Specify the details for IKE Phase 1 and IKE Phase 2(ipsec).

4. Change the IPsec setting from default to custom and customize the IPsec policy. Then select Save.


https://docs.microsoft.com/en-us/azure/virtual-wan/virtual-wan-custom-ipsec-portal
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Edit VPN connection

Virtual HUB

You are editing the connection between the [nfgwonprem1] VPN site and the [westushub-SEA-Cust13] hub.

Connection name

| Connection-nfgwonprem1

Border gateway protocol (0

@ To edit the site BGP settings, navigate to the site nfgwonprem1.

Links
Link name (@ Link1

Use Azure Private IP Address & [:

Security settings

s . )
(_pisable (QEERTED)
e 44

Pre-shared key (PSK) @

-
Protoco \
.

.

KEv2 KEw1

vy

To change the protocol, please delete the connection first and then create a new connection.

IPSec () [:. Default (elEo] -:]
IKE Phase 1 (@ Encryption * Integrity/PRF * DH Group *
| agsizs v | [ sHazss v | | pHGroupis v |
IKE Phase 2(ipsec) 1 IPSec Encryption * IPSec Integrity * PFS Group *
|aes2ss v | [ shazse v | [ersia v

Propagate Default Route (@

Use policy based traffic selector (O

Cerae CEEDD)
(b I

Your traffic selectors or subnets that are part of the policy-based encryption domain should be:

e Virtual WAN hub /24
e Azure VMware Solution private cloud /22

e Connected Azure virtual network (if present)

Connect your VPN site to the hub

1. Select your VPN site name and then select Connect VPN sites.

2. Inthe Pre-shared key field, enter the key previously defined for the on-premises endpoint.

TIP

If you don't have a previously defined key, you can leave this field blank. A key is generated for you automatically.
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Connect sites X
Virtual HUB

Security settings

Pre-shared key (PSK) © ‘
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IPsec (D ‘:. Default Custom.iI
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Configure traffic selector? I: Yes m'
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These sites will be connected to the [Hub1] hub.

Site name T  Region ™

ﬁ' TestSite1 eastus

3. If you're deploying a firewall in the hub and it's the next hop, set the Propagate Default Route option to
Enable.

When enabled, the Virtual WAN hub propagates to a connection only if the hub already learned the
default route when deploying a firewall in the hub or if another connected site has forced tunneling
enabled. The default route does not originate in the Virtual WAN hub.

4. Select Connect. After a few minutes, the site shows the connection and connectivity status.
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@+
«

(0 Sy ] L Download VPN Config [ Delete gateway  {) Reset gateway

tcentralushub - VPN (Site to site) 2 X
o

- ASN : 65515 Bytesin/out : 3.15MB /001 GB
# Overview
Gateway scale units © 1 scale unit - 500 Mbpsx 2 VPN Gateway

Connectivity

B VPN (Site 1o site)

. ExpressRoute
Hub

Connected to thishub  ©
&t User VPN (Point 1o site)
VPN Sites &

#. Routing
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| Site name Location Connection Status Comnectivity Status

RE westcentralusBRANCH westcentralus © Succeeded @ Connected

Connection Status: Status of the Azure resource for the connection that connects the VPN site to the
Azure hub's VPN gateway. Once this control plane operation is successful, the Azure VPN gateway and
the on-premises VPN device establish connectivity.

Connectivity Status: Actual connectivity (data path) status between Azure’s VPN gateway in the hub
and VPN site. It can show any of the following states:

e Unknown: Typically seen if the backend systems are working to transition to another status.

e Connecting: Azure VPN gateway is trying to reach out to the actual on-premises VPN site.

e Connected: Connectivity established between Azure VPN gateway and on-premises VPN site.
e Disconnected: Typically seen if disconnected for any reason (on-premises or in Azure)

5. Download the VPN configuration file and apply it to the on-premises endpoint.

a. On the VPN (Site to site) page, near the top, select Download VPN Config. Azure creates a
storage account in the resource group 'microsoft-network-[location]', where location is the
location of the WAN. After you have applied the configuration to your VPN devices, you can delete
this storage account.


file:///C:/localrun/t/1pp1/gn1d/azure/includes/media/virtual-wan-tutorial-connect-vpn-site-include/status.png#lightbox

b. Once created, select the link to download it.
c. Apply the configuration to your on-premises VPN device.
For more information about the configuration file, see About the VPN device configuration file.

6. Patch the Azure VMware Solution ExpressRoute in the Virtual WAN hub.

IMPORTANT

You must first have a private cloud created before you can patch the platform.

a. In the Azure portal, navigate to the Azure VMware Solution private cloud. Select Manage >
Connectivity > ExpressRoute and then select + Request an authorization key.

L et p e b U
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b. Provide a name for it and select Create.

It may take about 30 seconds to create the key. Once created, the new key appears in the list of
authorization keys for the private cloud.
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AVS Private cloud
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c. Copy the authorization key and ExpressRoute ID. You'll need them to complete the peering. The
authorization key disappears after some time, so copy it as soon as it appears.

7. Link Azure VMware Solution and the VPN gateway together in the Virtual WAN hub. You'll use the
authorization key and ExpressRoute ID (peer circuit URI) from the previous step.

a. Select your ExpressRoute gateway and then select Redeem authorization key.
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b. Paste the authorization key in the Authorization Key field.

c. Paste the ExpressRoute ID into the Peer circuit URI field.

d. Select Automatically associate this ExpressRoute circuit with the hub check box.
e. Select Add to establish the link.

8. Test your connection by creating an NSX-T Data Center segment and provisioning a VM on the network.
Ping both the on-premises and Azure VMware Solution endpoints.

NOTE

Wiait approximately 5 minutes before you test connectivity from a client behind your ExpressRoute circuit, for
example, a VM in the VNet that you created earlier.
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NOTE

HCX Mobility Optimized Networking is officially supported by VMware and Azure VMware Solutions from HCX version
4.1.0.

IMPORTANT

Before you enable HCX MON, please read the below limitations and unsupported configurations:
Unsupported source configurations for HCX NE

Limitations for any HCX deployment including MON

HCX Mobility Optimized Networking (MON) is an optional feature to enable when using HCX Network
Extensions (NE). MON provides optimal traffic routing under certain scenarios to prevent network tromboning
between the on-premises and cloud-based resources on extended networks.

As MON is an enterprise capability of the NE feature, make sure you've enabled the VMware HCX Enterprise
add-on through a support request. VMware HCX Enterprise Edition will be available for customers to add and
run with their Azure VMware Solution environment free of charge until 10/1/2022.

Throughout the migration cycle, MON optimizes application mobility for:
e Optimizing for virtual machine (VM) to VM L2 communication when using stretched networks

e Optimizing and avoiding asymmetric traffic flows between on-premises, Azure VMware Solution, and
Azure

In this article, you'll learn about the Azure VMware Solution-specific use cases for MON.

Optimize traffic flows across standard and stretched segments on the
private cloud side

In this scenario, VM1 is migrated to the cloud using the NE, which provides optimal VM to VM latency. As a
result, VM1 needs low latency to VM3 on the local Azure VMware Solution segment. We migrate the VM1
gateway from on-premises to Azure VMware Solution (cloud) to ensure an optimal path for traffic (blue line). If
the gateway remains on-premises (red line), a tromboning effect and higher latency are observed.

NOTE

When you enable MON without migrating the VM gateway to the cloud side, it doesn't ensure an optimal path for traffic
flow. It also doesn't allow the evaluation of policy routes.



https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/vmware-hcx-mon-guidance.md
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https://docs.vmware.com/en/VMware-HCX/4.2/hcx-user-guide/GUID-0E254D74-60A9-479C-825D-F373C41F40BC.html
https://cloud.vmware.com/community/2019/08/08/introducing-hcx-enterprise/
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Optimize and avoid asymmetric traffic flows

In this scenario, we assume a VM from on-premises has been migrated to Azure VMware Solution and

participates in L2, and L3 traffic flows back to on-premises to access services. We also assume some VM

communication from Azure (in the Azure VMware Solution connected vNET) could reach down into the Azure

VMware Solution private cloud.

IMPORTANT

The main point here is to plan and avoid asymmetric traffic flows carefully.

By default and without using MON, a VM in Azure VMware Solution on a stretched network without MON can

communicate back to on-premises using the ExpressRoute preferred path. Ideally, and based on customers use

case one should evaluate how a VM on an Azure VMware Solution stretched segment enabled with MON

should be traversing back to on-premises either over the NE or the TO gateway via the ExpressRoute, but

keeping traffic flows symmetric.

If choosing the NE path for example, the MON policy routes have to specifically address the subnet on the on-

premises side; otherwise, the 0.0.0.0/0 default route is used. Policy routes can be found under the NE segment,

selecting advanced. By default, all RFC1918 IP addresses are included in the MON policy routes definition.




Policy Routes %

Configure IP subnets assigned to the source environment. @
Mobility Optimized Networking Site: TNT37-HCX-MGR-cloud

ADD (> REFRESH

Metwork Send to Source with HCX
10.0.0.0/8 (]
172.16.0.0/12 (]

192.168.0.0/16

SUBMIT CANCEL

Policy routes are evaluated only if the VM gateway is migrated to the cloud. The effect of this configuration is
that any matching subnets for the destination get tunneled over the NE appliance. If not matched, they get
routed through the TO gateway.

NOTE

Special consideration for using MON in Azure VMware Solution is to give the /32 routes advertised over BGP to its peers;
this includes on-premises and Azure over the ExpressRoute connection. For example, a VM in Azure learns the path to an
Azure VMware Solution VM on an Azure VMware Solution MON enabled segment. Once the return traffic is sent back to
the TO as expected, if the return subnet is an RFC1918 match, traffic is forced over the NE instead of the T0. Then
egresses over the ExpressRoute back to Azure on the on-premises side. This can cause confusion for stateful firewalls in
the middle and asymmetric routing behavior. It's also a good idea to determine how VMs on NE MON segments will need

to access the internet, either via the TO in Azure VMware Solution or only through the NE back to on-premises.




ExpressRoute Expr essRoute

No Policy < : /32 h_ost routes 0..0.0.0;'0 T /32 h_os;(r;‘utes
Route via BGP Policy Route E via
To NSX-TTO
- egress
T ceress < NSX-TT1
B Hoxne | —=— B HXNE
Fig 2- With Palicy Route defined to direct

Fig 1- No Policy Based Route defined

A

ExpressRoute " /32 host routes

all traffic to NE

Default =T via BGP
Policy % @

Routes
NSX-TTO
(=&

RFC1918 egress traffic . Public/Internet
NSKTT1 egress traffic

) n HCX NE

Fig 3- With Policy Route defined
using defaults (RFC1918)

As outlined in the above diagram, the importance is to match a policy route to each required subnet. Otherwise,
the traffic gets routed over the TO and not the NE.

To learn more about policy routes, see Mobility Optimized Networking Policy Routes.


https://docs.vmware.com/en/VMware-HCX/4.1/hcx-user-guide/GUID-F45B1DB5-C640-4A75-AEC5-45C58B1C9D63.html

Configure storage policy

8/19/2022 « 4 minutes to read » Edit Online

VMware vSAN storage policies define storage requirements for your virtual machines (VMs). These policies
guarantee the required level of service for your VMs because they determine how storage is allocated to the
VM. Each VM deployed to a vSAN datastore is assigned at least one VM storage policy.

You can assign a VM storage policy in an initial deployment of a VM or when you do other VM operations, such
as cloning or migrating. Post-deployment cloudadmin users or equivalent roles can't change the default storage
policy for a VM. However, VM storage policy per disk changes is permitted.

The Run command lets authorized users change the default or existing VM storage policy to an available policy
for a VM post-deployment. There are no changes made on the disk-level VM storage policy. You can always
change the disk level VM storage policy as per your requirements.

NOTE

Run commands are executed one at a time in the order submitted.

In this how-to, you learn how to:

e List all storage policies
e Set the storage policy for a VM

e Specify default storage policy for a cluster
Prerequisites
Make sure that the minimum level of hosts are met.
RAID CONFIGURATION FAILURES TO TOLERATE (FTT) MINIMUM HOSTS REQUIRED

RAID-1 (Mirroring) 1 3
Default setting.

RAID-5 (Erasure Coding) 1 4
RAID-1 (Mirroring) 2 5
RAID-6 (Erasure Coding) 2 6
RAID-1 (Mirroring) 3 7

List storage policies

You'll run the Get-StoragePolicy cmdlet to list the vSAN based storage policies available to set on a VM.
1. Sign in to the Azure portal.

2. Select Run command > Packages > Get-StoragePolicies.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-storage-policy.md
https://docs.vmware.com/en/VMware-Cloud-on-AWS/services/com.vmware.vsphere.vmc-aws-manage-data-center-vms.doc/GUID-EDBB551B-51B0-421B-9C44-6ECB66ED660B.html
https://portal.azure.com
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Home > Contoso-westus-sddc

Contoso-westus-sddc | Run command - x
AVS Private cloud

P Search (Ctrl+)) « O Refresh

@ Overview
Run execution status

Activity log

Ao, Access control (IAM) v~ Name Description
€ Togs “  JSDRConfiguration (1020 @
£ Diagnose and solve problems Install-JetDR This top level Cmdlet Downloads JetDr bundle from MMS, creates a new user, assigns elevated privilleges to the user,

deploys JetDr Management Server Appliance(MSA), registers vCenter to the JetDr MSA, configures cluster.
Settings

Invoke-PreflightetDRInstall This Cmdlet checks and displays current state of the system It checks whether the minimal requirements for the script to
8 Locks run are met. It also checks if the cluster has minimum of 4 hosts, if the cluster details are correct, if there is already a VM
with the same name pravided for installing MSA, if there is any jetdr plugin present in the vCenter.
Manage Invoke-Preflight/etDRSystemCheck  This Cmdlet checks and displays current state of the system It checks whether the minimal requirements for the script to
run are met.
Connectivity ) N ~
Invoke-Preflight/etDRUninstall This Cmdlet checks and displays current state of the system It checks whether the minimal requirements for the script to
B |dentity run are met. It also checks if the cluster has minimum of 4 hosts, if the cluster details are correct and if any VCenter is

registered to the MSA
B Clusters . . X
Uninstall-JetDR The top level Cmdlet creates a new user, assigns elevated privilleges to the user, unconfigures cluster, unregisters vCenter
X from the JetDr MSA, removes the user.
Waorkload Networking -

v MicrosoftAvS.Management (1030 @
% segments

Add-GroupTeCloudAdmins Add group to Cloud Admin
Get-ExternalidentitySources Get 3ll current external sources connected to vCenter SSO

B Port mirraring B 3
Get-StoragePalicies Get available storage policies to set an a VM

© ons 3 5 - B
New-AvsLDAPIdentitySource Allow customers to add an LDAP Secure external identity source (Active Directory aver LDAF) for use with single sign an to

vCenter.

Operatians.
New-AvsLDAPS|dentitySource Allow customers to add an LDAPS Secure external identity source (Active Directory over LDAP) for use with single sign on

™ Run command | tovCenter.

P Removi ernalldentitySources Remave all external identity sources
Monitoring
B e Remove-GroupFromCloudaAdmins Remove previously added AD group from CloudAdmins
erts

Set-AvsVMStoragePolicy Set the storage policy on a VM

Metrics

& Advisor recommendations

3. Provide the required values or change the default values, and then select Run.
Run command - Get-StoragePolicies X

Get available storage policies to set on a VM

Details
Retain up to

&0
day haur

Specify name for execution *

Timeout *
3

L frafiung

FIELD VALUE

Retain up to Retention period of the cmdlet output. The default value
is 60.

Specify name for execution Alphanumeric name, for example, Get-StoragePolicies-
Execl.

Timeout The period after which a cmdlet exits if taking too long to

finish.

4. Check Notifications to see the progress.

Set storage policy on VM


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/run-command/run-command-overview-storage-policy.png#lightbox

You'll run the set-vMstoragePolicy cmdlet to modify vSAN-based storage policies on a default cluster, individual
VM, or group of VMs sharing a similar VM name. For example, if you have three VMs named "MyVM1",
"MyVM2", and "MyVM3", supplying "MyVM*" to the VMName parameter would change the StoragePolicy on all
three VMs.

NOTE

You cannot use the vSphere Client to change the default storage policy or any existing storage policies for a VM.

1. Select Run command > Packages > Set-VMStoragePolicy.

2. Provide the required values or change the default values, and then select Run.

FIELD VALUE

VMName Name of the target VM.

StoragePolicyName Name of the storage policy to set. For example, RAID-
FTT-1.

Retain up to Retention period of the cmdlet output. The default value
is 60.

Specify name for execution Alphanumeric name, for example,

changeVMStoragePolicy.

Timeout The period after which a cmdlet exits if taking too long to
finish.

3. Check Notifications to see the progress.

Set storage policy on all VMs in a location

You'll run the Set-LocationStoragePolicy cmdlet to Modify vVSAN based storage policies on all VMs in a location
where a location is the name of a cluster, resource pool, or folder. For example, if you have 3 VMs in Cluster-3,

supplying "Cluster-3" would change the storage policy on all 3 VMs.

NOTE

You cannot use the vSphere Client to change the default storage policy or any existing storage policies for a VM.

1. SelectRun command > Packages > Set-LocationStoragePolicy.

2. Provide the required values or change the default values, and then select Run.

FIELD VALUE

Location Name of the target VM.

StoragePolicyName Name of the storage policy to set. For example, RAID-
FTT-1.

Retain up to Retention period of the cmdlet output. The default value

is 60.



FIELD VALUE

Specify name for execution Alphanumeric name, for example,
changeVMStoragePolicy.

Timeout The period after which a cmdlet exits if taking too long to
finish.

3. Check Notifications to see the progress.

Specify storage policy for a cluster

You'll run the set-ClusterDefaultStoragePolicy cmdlet to specify default storage policy for a cluster,
1. Select Run command > Packages > Set-ClusterDefaultStoragePolicy.

2. Provide the required values or change the default values, and then select Run.

FIELD VALUE

ClusterName Name of the cluster.

StoragePolicyName Name of the storage policy to set. For example, RAID-
FTT-1.

Retain up to Retention period of the cmdlet output. The default value
is 60.

Specify name for execution Alphanumeric name, for example, Set-

ClusterDefaultStoragePolicy-Exec1.

Timeout The period after which a cmdlet exits if taking too long to
finish.

3. Check Notifications to see the progress.

Next steps

Now that you've learned how to configure VMware vSAN storage policies, you can learn more about:

e How to attach disk pools to Azure VMware Solution hosts (Preview) - You can use disks as the persistent
storage for Azure VMware Solution for optimal cost and performance.

e How to configure external identity for vCenter - vCenter Server has a built-in local user called cloudadmin
and assigned to the CloudAdmin role. The local cloudadmin user is used to set up users in Active
Directory (AD). With the Run command feature, you can configure Active Directory over LDAP or LDAPS
for vCenter as an external identity source.
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Diagnostic settings are used to configure streaming export of platform logs and metrics for a resource to the
destination of your choice. You can create up to five different diagnostic settings to send different logs and
metrics to independent destinations.

In this article, you'll configure a diagnostic setting to collect VMware syslogs for your Azure VMware Solution
private cloud. You'll store the syslog to a storage account to view the vCenter Server logs and analyze for
diagnostic purposes.

IMPORTANT

The VMware syslogs contains the following logs:

® Distributed Firewall Logs
® NSX-T Manager Logs

® Gateway Firewall Logs

® ESXi Logs

® vCenter Logs

® NSX Edge Logs

Prerequisites

Make sure you have an Azure VMware Solution private cloud with access to the vCenter Server and NSX-T
Manager interfaces.

Configure diagnostic settings

1. From your Azure VMware Solution private cloud, select Diagnostic settings, then Add diagnostic
settings.

P Sareh esotem et o e

»

Home > Contoso-westus-sddc

R o Contoso-westus-sddc | Diagnostic settings = X
=« AVS Private cloud
En © Search (Ctrl+/) « (D Refresh <P Feedback

B Run command (preview) Diagnostic settings are used to configure streaming export of platform logs and metrics for a resource to the destination of your choice. You may create up

* to five different diagnostic settings to send different logs and metrics to independent destinations. Learn more about diagnostic settings
Monitoring
HH Diagnostic settings
i) N Alerts . . " .
(%) Name Storage account Event hub Log Analytics worksp...  Partner solution Edit setting
fil Metrics
@ testwestus05 = - Edit setting
I & Diagnostic settings | :
4 service testwestus03 - - Edit setting
& Advisor recommendations - .
&8 testamanejawestus - - veenterlogs-hel - Edit setting
o 4 Autamaticn + Add diagnostic setting
o Zu Tasks (preview) i ) . . X X
Click 'Add Diagnostic setting’ above to configure the collection of the following data:
=
& G Export template « ymwaresyslog
* AllMetrics
— Support + troubleshooting
&> @ Resource health
> 8 New Support Request

2. Select the vmwaresyslog, All metrics, and select one of the following options presented.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-vmware-syslogs.md
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/diagnostic-settings/diagnostic-settings-log-analytics-workspace-1.png#lightbox

IMPORTANT

The Send to log analytics workspace option is currently unavailable.

Archive to storage account

a. In Diagnostic setting, select the storage account where you want to store the logs and select

Save.

”  Home > Contoso-westus-sddc >

+ Diagnostic setting
®
En X Discard  Feedback

* destinatid. . ...
categories and contents of those logs

Diagnostic setting name * Vmwaresddlogs

Adiagno[ g, 9 specifies a lst of categories of platform logs and/or metrics that you want to collect from a resource, and one or more
,0u would stream them to. Normal usage charges for the destination will oceur. Leam more about the different log

v

Category details

&

& log
Retention (days)
vmwaresyslox
-] ] syslog =)
% .
‘metric.
L Retention (da
B AiMetrics L)
& 2 v |

@ Retention oniy applies to storage account. Retention policy ranges from 1 to 365
days. If you do not want to apply any retention policy and retain data forever,
set retention (days) to O.

~

QpPad@e

Destination details

[[] send to Log Analytics workspace

Archive to a storage account

@ You'll be charged normal data rates fer storage and transactiens when you
send diagnostics 10 8 storage account.

@ showing all storage accounts including classic storage accounts

Location
West US

Subscription

Storage account *

Contoso v

testwestusos v

b. Go to your Storage accounts, verify Insight logs vmwarelog has been created, select it.

> Home > Storage accounts > testwestus0S

+ Storage accounts == testwestus05 | Containers =
A Microson (mierosoftonmierosofteom) W Siorage sceoum
En + Create €5} Manageview ~ -+ P Search (Ctrl+/) r + Container £ Chang . ntainers « () Refresh
= == M Overvien, [Besrch containers by prefix ) Show deleted containers
* TR B Activity log
- Name Last modified Public access level Lease state
B e . ® T
® = testwestus03 O skgs 812/2021, 115733 PM Private. Available
i 2 Diagnose and solve problems
= e insights-logs-vmmwaresysk /13/2021, 122716 AM Private Available
@ A Access Control (AM) IG Lt iz
& O insights-metrics-ptim 8/13/2021, 122113 AM  Private Available
& Data migration
a Events
% =, Storage Explorer (preview)
o
b Data storage
& File shares
s
O Queues
>
& Tables
®
@ Security + networking
o & Neworking
,'\ § @ Azure CON
o Page [ 1~ |of1 .
Access keys
© ot -

c. Browse Insight logs vmwarelog to locate and download the json file to view the logs.
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> Home > Storage accounts > testwestus05 >
7 insights-logs-vmwaresyslog - X
& 2 Search (Cirl+)) P’ T upload [ Change accesslevel () Refresh 2 " J '- -
B3 Overview Authentication methe

Location: insights-I
* P Diagnose and solve problems syl

B Access Control 14M) Search blobs by prefix (case-sensitive) () show deleted blobs
J)
Settings Fg Add fier
@ Shared access tokens
- Access policy Name Modified Access tier Blob type Size Lease state
y
s -
Properties
i @ Mmetadata 8/18/2021, 6:31:14 AM Append blob 13.04 Mig Available
a
>
®
Q
#
a
©

Stream to Microsoft Azure Event Hubs

a. In Diagnostic setting, under Destination details, select Stream to an Event Hub.

b. From the Event Hub namespace drop-down menu, choose where you want to send the logs,
select, and Save.

« C @ &  hitpsy//ms.portal.azure.com/# /1178122f-6ced-45e3-bd92- Migration-RG/p

A Search resources, services, and docs (G+/)

Home > SDDC-WestUs

Diagnostic setting

X Discard & Feedback

A diagnostic setting specifies a list of categories of platform logs and/or metrics that you want ta collect from a resaurce, and one or more
destinations that you would stream them to. Normal usage charges for the destination will oceur. Learn mare about the dif
categories and contents of those logs

Diagnostic setting name * EventHubSysLogs v

Category detalls
log
B vmwaresysiog
metric

] AlMetrics

Destination details

] Send to Log Analytics workspace

Archive 1o a Storage account

B stream 1o an event hub

For patential partner integrations, see documentation here

Subscription
AVS Doglood

Event hub namespace *
amaneja-eventhub-ns

Event hub name foptional)

amaneja-westus-eventhub

Event hub policy name

RootManagesharedAccessKey

[7] send to partner solution
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Configure Windows Server Failover Cluster on

Azure VMware Solution vSAN

8/19/2022 « 7 minutes to read  Edit Online

In this article, you'll learn how to configure Failover Clustering in Windows Server on Azure VMware Solution
vSAN with native shared disks.

IMPORTANT

The implementation in this article is for proof of concept and pilot purposes. We recommend using a Cluster-in-a-Box

(CIB) configuration until placement policies become available.

Windows Server Failover Cluster, previously known as Microsoft Service Cluster Service (MSCS), is a Windows
Server Operating System (OS) feature. WSFC is a business-critical feature, and for many applications is required.
For example, WSFC is required for the following configurations:

e SQL server configured as:
o Always On Failover Cluster Instance (FCI), for instance-level high availability.
o Always On Availability Group (AG), for database-level high availability.
e Windows File Services:
o Generic File share running on active cluster node.
o Scale-Out File Server (SOFS), which stores files in cluster shared volumes (CSV).

o Storage Spaces Direct (S2D); local disks used to create storage pools across different cluster nodes.

You can host the WSFC cluster on different Azure VMware Solution instances, known as Cluster-Across-Box
(CAB). You can also place the WSFC cluster on a single Azure VMware Solution node. This configuration is
known as Cluster-in-a-Box (CIB). We don't recommend using a CIB solution for a production implementation.
Were the single Azure VMware Solution node to fail, all WSFC cluster nodes would be powered off, and the
application would experience downtime. Azure VMware Solution requires a minimum of three nodes in a
private cloud cluster.

It's important to deploy a supported WSFC configuration. You'll want your solution to be supported on vSphere
and with Azure VMware Solution. VMware provides a detailed document about WSFC on vSphere 6.7, Setup for

Failover Clustering and Microsoft Cluster Service.

This article focuses on WSFC on Windows Server 2016 and Windows Server 2019. Unfortunately, older
Windows Server versions are out of mainstream support, so we don't consider them here.

You'll need first to create a WSFC. Then, use the information we provide in this article to specify a WSFC
deployment on Azure VMware Solution.

Prerequisites

o Azure VMware Solution environment

o Microsoft Windows Server OS installation media

Reference architecture

Azure VMware Solution provides native support for virtualized WSFC. It supports SCSI-3 Persistent


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-windows-server-failover-cluster.md
https://docs.microsoft.com/en-us/windows-server/failover-clustering/failover-clustering-overview
https://docs.vmware.com/en/VMware-vSphere/6.7/vsphere-esxi-vcenter-server-67-setup-mscs.pdf
https://support.microsoft.com/lifecycle/search?alpha=windows%20server
https://docs.microsoft.com/en-us/windows-server/failover-clustering/create-failover-cluster

Reservations (SCSI3PR) on a virtual disk level. WSFC requires this support to arbitrate access to a shared disk
between nodes. Support of SCSI3PRs enables configuration of WSFC with a disk resource shared between VMs
natively on vSAN datastores.

The following diagram illustrates the architecture of WSFC virtual nodes on an Azure VMware Solution private
cloud. It shows where Azure VMware Solution resides, including the WSFC virtual servers (blue box), in relation
to the broader Azure platform. This diagram illustrates a typical hub-spoke architecture, but a similar setup is
possible using Azure Virtual WAN. Both offer all the value other Azure services can bring you.

© \

Azure VMware Solution Private Cloud

vSphereand vCenter

ESXi vSAN

HCX NSX
A

Supported configurations

Currently, the configurations supported are:

e Microsoft Windows Server 2012 or later

e Up to five failover clustering nodes per cluster
e Up to four PVSCSI adapters per VM

e Up to 64 disks per PVSCSI adapter

Virtual machine configuration requirements

WSFC node configuration parameters
e |nstall the latest VMware Tools on each WSFC node.

e Mixing non-shared and shared disks on a single virtual SCSI adapter isn't supported. For example, if the
system disk (drive C:) is attached to SCSI0:0, the first shared disk would be attached to SCSI1:0. A VM node of
a WSFC has the same virtual SCSI controller maximum as an ordinary VM - up to four (4) virtual SCSI
Controllers.

e Virtual discs SCSI IDs should be consistent between all VMs hosting nodes of the same WSFC.
COMPONENT REQUIREMENTS

VM hardware version 11 or above to support Live vMotion.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/windows-server-failover-cluster/windows-server-failover-architecture.svg#lightbox

COMPONENT

Virtual NIC

Memory

Increase the 1/0 timeout of each WSFC node.

Windows cluster health monitoring

WSFC node - Boot disks configuration parameters

COMPONENT

SCSI Controller Type

Disk mode

SCSI bus sharing

Modify advanced settings for a virtual SCSI controller
hosting the boot device.

WSFC node - Shared disks configuration parameters

COMPONENT

SCSI Controller Type

Disk mode

SCSI bus sharing

Multi-writer flag

Disk format

REQUIREMENTS

VMXNET3 paravirtualized network interface card (NIC);
enable the in-guest Windows Receive Side Scaling (RSS) on
the virtual NIC.

Use full VM reservation memory for nodes in the WSFC
cluster.

Modify
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services
\Disk\TimeOutValueSet to 60 seconds or more. (If you
recreate the cluster, this value might be reset to its default,
so you must change it again.)

The value of the SameSubnetThreshold Parameter of
Windows cluster health monitoring must be modified to
allow 10 missed heartbeats at minimum. It's the default in
Windows Server 2016. This recommendation applies to all
applications using WSFC, including shared and non-shared
disks.

REQUIREMENTS

LSI Logic SAS

Virtual

None

Add the following advanced settings to each WSFC node:
scsiX.returnNoConnectDuringAPD = "TRUE"
scsiX.returnBusyOnNoConnectStatus = "FALSE"

Where X is the boot device SCSI bus controller ID number.
By default, X is set to 0.

REQUIREMENTS

VMware Paravirtualize (PVSCSI)

Independent - Persistent (step 2 in illustration below). By
using this setting, you ensure that all disks are excluded
from snapshots. Snapshots aren't supported for WSFC-
based VMs.

Physical (step 1 in illustration below)

Not used

Thick provisioned. (Eager Zeroed Thick (EZT) isn't required
with vSAN.)


https://techcommunity.microsoft.com/t5/failover-clustering/tuning-failover-cluster-network-thresholds/ba-p/371834

Edit Settings =~ waoie-wsFc-Non w

Wirtual Hardware

New Hard disk * 750 -
Maximum Size 1397 TB
WM storage policy wSAN Default Storage Palicy

Location Store with the virtual machine

Disk Provisioning As defined in the VM storage policy

Sharing Unspecified

Shares Narma

Limit - 10Ps Unlimited

Virtual flash read cache o MB

Disk Mode 2 I naependsnt - Persistent I

WVirtual Device Node SCEl coniroller O SCSI0) Mew Hard disk
SCSI controlier O LSI Logic SAS

MNew SCSI controlier * Whkdware Paravirtual

Change Type VMware Paravirtiual

SCSI Bus Sharing
Network adapter 1 workload-segment-01 Connected

CO/DVD drive 1 Datastorg ISO Filg Connected

Non-supported scenarios

The following functionalities aren't supported for WSFC on Azure VMware Solution:

NFS data stores

Storage Spaces

vSAN using iSCSI Service

vSAN Stretched Cluster

Enhanced vMotion Compatibility (EVC)
vSphere Fault Tolerance (FT)
Snapshots

Live (online) storage vMotion

N-Port ID Virtualization (NPIV)

Hot changes to virtual machine hardware might disrupt the heartbeat between the WSFC nodes.

The following activities aren't supported and might cause WSFC node failover:

Hot adding memory

Hot adding CPU

Using snapshots

Increasing the size of a shared disk

Pausing and resuming the virtual machine state

Memory over-commitment leading to ESXi swapping or VM memory ballooning

Hot Extend Local VMDK file, even if it isn't associated with SCSI bus sharing controller

Configure WSFC with shared disks on Azure VMware Solution vSAN



10.

11.

12.

13.

14,

15.

16.

. Ensure that an Active Directory environment is available.
. Create virtual machines (VMs) on the vSAN datastore.

. Power on all VMs, configure the hostname and IP addresses, join all VMs to an Active Directory domain,

and install the latest available OS updates.

Install the latest VMware Tools.

. Enable and configure the Windows Server Failover Cluster feature on each VM.

Configure a Cluster Witness for quorum (this can be a file share witness).
Power off all nodes of the WSFC cluster.

Add one or more Paravirtual SCSI controllers (up to four) to each VM part of the WSFC. Use the settings
per the previous paragraphs.

On the first cluster node, add all needed shared disks using Add New Device > Hard Disk. Leave Disk
sharing as Unspecified (default) and Disk mode as Independent - Persistent. Then attach it to the
controller(s) created in the previous steps.

Continue with the remaining WSFC nodes. Add the disks created in the previous step by selecting Add
New Device > Existing Hard Disk. Be sure to maintain the same disk SCSI IDs on all WSFC nodes.

Power on the first WSFC node; sign in and open the disk management console (mmc). Make sure the
added shared disks can be managed by the OS and are initialized. Format the disks and assign a drive
letter.

Power on the other WSFC nodes.
Add the disk to the WSFC cluster using the Add Disk wizard and add them to a Cluster Shared Volume.

Test a failover using the Move disk wizard and make sure the WSFC cluster with shared disks works
properly.

Run the Validation Cluster wizard to confirm whether the cluster and its nodes are working properly.
It's important to keep the following specific items from the Cluster Validation test in mind:

e Validate Storage Spaces Persistent Reservation. If you aren't using Storage Spaces with your
cluster (such as on Azure VMware Solution vSAN), this test isn't applicable. You can ignore any
results of the Validate Storage Spaces Persistent Reservation test including this warning. To avoid

warnings, you can exclude this test.

e Validate Network Communication. The Cluster Validation test displays a warning indicating
that only one network interface per cluster node is available. You can ignore this warning. Azure
VMware Solution provides the required availability and performance needed, since the nodes are
connected to one of the NSX-T Data Center segments. However, keep this item as part of the
Cluster Validation test, as it validates other aspects of network communication.

Create a Placement Policy to situate the WSFC VMs on the same Azure VMware Solution nodes. To do so,
you need a host-to-VM affinity rule. This way, cluster nodes will run on the same Azure VMware Solution
host.

NOTE

For this you need to create a Support Request ticket. Our Azure support organization will be able to help you with
this.




Related information

Failover Clustering in Windows Server

e Guidelines for Microsoft Clustering on vSphere (1037959) (vmware.com)

About Setup for Failover Clustering and Microsoft Cluster Service (vmware.com)

VvSAN 6.7 U3 - WSFC with Shared Disks & SCSI-3 Persistent Reservations (vmware.com)

Azure VMware Solution limits

Next steps

Now that you've covered setting up a WSFC in Azure VMware Solution, you may want to learn about:

e Setting up your new WSFC by adding more applications that require the WSFC capability. For instance, SQL
Server and SAP ASCS.

e Setting up a backup solution.
o Setting up Azure Backup Server for Azure VMware Solution

o Backup solutions for Azure VMware Solution virtual machines


https://docs.microsoft.com/en-us/windows-server/failover-clustering/failover-clustering-overview
https://kb.vmware.com/s/article/1037959
https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.mscs.doc/GUID-1A2476C0-CA66-4B80-B6F9-8421B6983808.html
https://blogs.vmware.com/virtualblocks/2019/08/23/vsan67-u3-wsfc-shared-disksupport/
https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/azure-subscription-service-limits

Connect multiple Azure VMware Solution private

clouds in the same region

8/19/2022 - 2 minutes to read  Edit Online

The AVS Interconnect feature lets you create a network connection between two or more Azure VMware
Solution private clouds located in the same region. It creates a routing link between the management and
workload networks of the private clouds to enable network communication between the clouds.

You can connect a private cloud to multiple private clouds, and the connections are non-transitive. For example,
if private cloud T is connected to private cloud 2, and private cloud 2 is connected to private cloud 3, private
clouds 1 and 3 would not communicate until they were directly connected.

You can only connect private clouds in the same region. To connect private clouds that are in different regions,
use ExpressRoute Global Reach to connect your private clouds in the same way you connect your private cloud
to your on-premises circuit.

Supported regions

The Azure VMware Solution Interconnect feature is available in all regions.

Prerequisites

e \Write access to each private cloud you're connecting

e Routed IP address space in each cloud is unique and doesn't overlap

NOTE

The AVS interconnect feature doesn't check for overlapping IP space the way native Azure vNet peering does before
creating the peering. Therefore, it's your responsibility to ensure that there isn't overlap between the private clouds.

In Azure VMware Solution environments, it's possible to configure non-routed, overlapping IP deployments on NSX
segments that aren't routed to Azure. These don't cause issues with the AVS Interconnect feature, as it only routes
between the NSX TO on each private cloud.

Add connection between private clouds

1. In your Azure VMware Solution private cloud, under Manage, select Connectivity.

2. Select the AVS Interconnect tab and then Add.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/connect-multiple-private-clouds-same-region.md

Home > Contoso-westus-pcdl

[ Contoso-westus-pc01 | Connectivity = - X

" AVS Private cloud

£ search (Ctrl+/) « &l save (O Refresh

& Overview . :
Azure vNet connect  Settings  ExpressRoute  PubliclP  ExpressRoute Global Reach A t

B Activity log

. Access control (1AM} @ The AVS Interconnect (Preview] feature is currently in public preview.

¢ This preview version is provided without a service level ag! t, and it's not for pi workloads. Certain features might not be supported or might have:
Tags i ities. For more ion, see Suppl | Terms of Use for Microsoft Azure Previews.

& Diagnose and solve problems

Allows you to enable network connectivity between two Azure VMware Solution private clouds in the same region. Learn more.

Settings
Before you begin
8 Locks
o Ensure that the IP address space used in each cloud is unique and doesn't overlap.
Manage « Ensure that you have write access to both clouds.
| ® Connectivi | Connections between private clouds are non-transitive. If private cloud 1 is connected to private cloud 2, and private cloud 2 connected to private cloud 3, private clouds 1.and 3
pERCOECIY, would not be able to communicate until they were directly connected to each other.

Clusters

: .3
B Identity i
. + add | O refresh

+ Add AVS Private cloud Is source? @
-ons

No results.
Workload Networking

=% Segments

3. Select the information and Azure VMware Solution private cloud for the new connection.

NOTE

You can only connect to private clouds in the same region. To connect to private clouds that are in different
regions, use ExpressRoute Global Reach to connect your private clouds in the same way you connect your private
cloud to your on-premises circuit.

Add connection to other private cloud X

Subscription
| Contoso s |
Location (&)
| (US) West Us v

You can only connect to other private clouds in the same region.

Resource group

| contoso-westus-rg ~ |

AVS Private cloud* (@O

| Contoso-westus-pc02 ~ |

ﬂ | confirm that the two private clouds to be connected don't contain overlapping network
address space.

4. Select the | confirm checkbox acknowledging that there are no overlapping routed IP spaces in the two
private clouds.

5. Select Create. You can check the status of the connection creation.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/networking/private-cloud-to-private-cloud-no-connections.png#lightbox

Notifications X

More events in the activity log —» Dismiss all

==* Save cloud connection Running

Building connection between Contoso-westus-pc01 and Contoso-westus-pcd3,

21 minutes ago

Q Save cloud connection

Successfully created a connection between Contoso-westus-pc01 and Contoso-
westus-02,

2 minutes ago

You'll see all of your connections under AVS Private Cloud.

Home > Contoso-westus-pcdi

& Contoso-westus-pc01 | Connectivity =
% Avs private cloud

2 Search (Cirl+/) « [& save (O Refresh

@ Overview = )
Azure vNet connect Settings ExpressRoute Public IP ExpressRoute Global Reach AVS Interconnect

Activity log

B, Access control (1AM) @ The AVS Interconnect (Preview) feature is currently in public preview.

P This preview version is provided without a service level agreement, and it's not recommended for production workloads. Certain features might not be supperted or might have
Tags For more information, ses Supplemental Terms of Use for Microsoft Azure Previews,

£® Diagnose and solve problems

Allows you to enable network connectivity between two Azure ViMware Solution private clouds in the same region. Learn more,

Settings
Before you begin
B Locks
= Ensure that the IP address space used in each cloud is unique and doesn't averlap.
Manage = Ensure that you have write access to both clouds.

e
# Connectivity would not be able to communicate until they were directly connected to each other.

Connections between private clouds are non-transitive. If private cloud 1is connected to private cloud 2, and private cloud 2 connected to private cloud 3, private clouds 1 and 3

B (dentity

b add () Refresh
B clusters

AVS Private cloud Is source? (@
+ add-ons

Contoso-westus-pc02 No m
Waorkload Networking

Contoso-westus-pc03 No 0]
= Segments .

Remove connection between private clouds

1. In your Azure VMware Solution private cloud, under Manage, select Connectivity.

2. For the connection you want to remove, on the right, select Delete (trash can) and then Yes.

Next steps

Now that you've connected multiple private clouds in the same region, you may want to learn about:

o Move Azure VMware Solution resources to another region

o Move Azure VMware Solution subscription to another subscription



file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/networking/private-cloud-to-private-cloud-two-connections.png#lightbox

Deploy Arc for Azure VMware Solution (Preview)

8/19/2022 + 18 minutes to read « Edit Online

In this article, you'll learn how to deploy Arc for Azure VMware Solution. Once you've set up the components
needed for this public preview, you'll be ready to execute operations in Azure VMware Solution vCenter Server
from the Azure portal. Operations are related to Create, Read, Update, and Delete (CRUD) virtual machines
(VMs) in an Arc-enabled Azure VMware Solution private cloud. Users can also enable guest management and

install Azure extensions once the private cloud is Arc-enabled.
Before you begin checking off the prerequisites, verify the following actions have been done:

e You deployed an Azure VMware Solution private cluster.

e You have a connection to the Azure VMware Solution private cloud through your on-prem environment or
your native Azure Virtual Network.

e There should be an isolated NSX-T Data Center segment for deploying the Arc for Azure VMware Solution
Open Virtualization Appliance (OVA). If an isolated NSX-T Data Center segment doesn't exist, one will be
created.

Prerequisites

The following items are needed to ensure you're set up to begin the onboarding process to deploy Arc for Azure
VMware Solution (Preview).

e Ajump box virtual machine (VM) with network access to the Azure VMware Solution vCenter.
o From the jump-box VM, verify you have access to vCenter Server and NSX-T Manager portals.

e Verify that your Azure subscription has been enabled or you have connectivity to Azure end points,
mentioned in the Appendices.

e Resource group in the subscription where you have owner or contributor role.

e A minimum of three free non-overlapping IPs addresses.

o Verify that your vCenter Server version is 6.7 or higher.

e Aresource pool with minimum-free capacity of 16 GB of RAM, 4 vCPUs.

e A datastore with minimum 100 GB of free disk space that is available through the resource pool.

e On the vCenter Server, allow inbound connections on TCP port 443, so that the Arc resource bridge and

VMware cluster extension can communicate with the vCenter server.

NOTE
Only the default port of 443 is supported. If you use a different port, Appliance VM creation will fail.

At this point, you should have already deployed an Azure VMware Solution private cloud. You need to have a
connection from your on-prem environment or your native Azure Virtual Network to the Azure VMware
Solution private cloud.

For Network planning and setup, use the Network planning checklist - Azure VMware Solution | Microsoft Docs

Registration to Arc for Azure VMware Solution feature set

The following Register features are for provider registration using Azure CLI.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/deploy-arc-for-azure-vmware-solution.md

az provider register --namespace Microsoft.ConnectedVMwarevSphere
az provider register --namespace Microsoft.ExtendedLocation

az provider register --namespace Microsoft.KubernetesConfiguration
az provider register --namespace Microsoft.ResourceConnector

az provider register --namespace Microsoft.AVS

Alternately, users can sign into their Subscription, navigate to the Resource providers tab, and register
themselves on the resource providers mentioned previously.

For feature registration, users will need to sign into their Subscription, navigate to the Preview features tab,
and search for 'Azure Arc for Azure VMware Solution'. Once registered, no other permissions are required for
users to access Arc.

Users need to ensure they've registered themselves to Microsoft.AVS/earlyAccess. After registering, use the
following feature to verify registration.

az feature show --name AzureArcForAVS --namespace Microsoft.AVS

Onboard process to deploy Azure Arc

Use the following steps to guide you through the process to onboard in Arc for Azure VMware Solution
(Preview).

1. Sign into the jJumpbox VM and extract the contents from the compressed file from the following location.
The extracted file contains the scripts to install the preview software.

2. Open the 'config_avs.json' file and populate all the variables.

Config JSON

"subscriptionId":

nn
1)

"resourceGroup":

"applianceControlPlaneIpAddress":
"privateCloud": ""
"isStatic": true,
"staticIpNetworkDetails": {

nn
1)

"networkForAppliancevM":

"networkCIDRForAppliancevM": "",
"k8sNodeIPPoolStart": "",
"k8sNodeIPPoolEnd": "",
"gatewayIPAddress": ""
}
}
e Populate the subscriptionId , resourceGroup ,and privateCloud names respectively.
® isstatic isalways true.
® networkForAppliancevM is the name for the segment for Arc appliance VM. One will be created if it
doesn't already exist.
® networkCIDRForAppliancevM is the IP CIDR of the segment for Arc appliance VM. It should be unique
and not affect other networks of Azure VMware Solution management IP CIDR.
® GatewayIPAddress is the gateway for the segment for Arc appliance VM.

® applianceControlPlaneIpAddress is the IP address for the Kubernetes APl server that should be part of
the segment IP CIDR provided. It shouldn't be part of the k8s node pool IP range.

k8sNodeIPPoolStart , k8sNodeIPPoolEnd are the starting and ending IP of the pool of IPs to assign to


https://github.com/Azure/ArcOnAVS/releases/latest

3

4.

the appliance VM. Both need to be within the networkCIDRForAppliancevm .

Json example

"subscriptionId"”: "XXXXXXXX-XXXX=XXXX=XXXX-XXXXXXXXXXXX" ,
"resourceGroup": "test-rg",
"applianceControlPlaneIpAddress”: "10.14.10.10",
"privateCloud": "test-pc",

"isStatic": true,

"staticIpNetworkDetails": {
"networkForApplianceVM": "arc-segment",
"networkCIDRForApplianceVM": "10.14.10.1/24",
"k8sNodeIPPoolStart": "10.14.10.20",
"k8sNodeIPPoolEnd": "10.14.10.30",
"gatewayIPAddress": "10.14.10.1"

}

. Run the installation scripts. We've provided you with the option to set up this preview from a Windows or

Linux-based jump box/VM.
Run the following commands to execute the installation script.

e Windows based jump box/VM
e Linux based jump box/VM

Scriptisn't signed so we need to bypass Execution Policy in PowerShell. Run the following commands.

Set-ExecutionPolicy -Scope Process -ExecutionPolicy ByPass; .\run.psl -Operation onboard -FilePath
{config-json-path}

You'll notice more Azure Resources have been created in your resource group.
e Resource bridge
e Custom location

e VMware vCenter

IMPORTANT

You can't create the resources in a separate resource group. Make sure you use the same resource group from where the

Azure VMware Solution private cloud was created to create the resources.

Discover and project your VMware infrastructure resources to Azure

When Arc appliance is successfully deployed on your private cloud, you can do the following actions.

View the status from within the private cloud under Operations > Azure Arc, located in the left navigation.

View the VMware vSphere infrastructure resources from the private cloud left navigation under Private
cloud then select Azure Arc vCenter resources.

Discover your VMware vSphere infrastructure resources and project them to Azure using the same browser
experience, Private cloud > Arc vCenter resources > Virtual Machines.

Similar to VMs, customers can enable networks, templates, resource pools, and data-stores in Azure.

After you've enabled VMs to be managed from Azure, you can install guest management and do the following

actions.




e Enable customers to install and use extensions.
o To enable guest management, customers will be required to use admin credentials

o VMtools should already be running on the VM

NOTE

Azure VMware Solution vCenter Server will be available in global search but will NOT be available in the list of vCenter
Servers for Arc for VMware.

e Customers can view the list of VM extensions available in public preview.
o Change tracking
o Log analytics
o Update management

o Azure policy guest configuration
Azure VMware Solution private cloud with Azure Arc

When the script has run successfully, you can check the status to see if Azure Arc has been configured. To verify
if your private cloud is Arc-enabled, do the following action:

e In the left navigation, locate Operations.
e Choose Azure Arc (preview). Azure Arc state will show as Configured.

¢ Private_cloud_pp2 | Azure Arc (preview)

AVS Private cloud

I}D Search (Ctrl+/) } &

-

vCenter inventory (preview) Enable Azure Arc to manage VMware infrastructure and workloads from on-premise, provision virtual machines and use

' various platform native Azure services to manage. Configure Azure Arc using scripts

B3 virtual machines Learn more about step by step guidance Of

B Resource pools/clusters/hosts

ﬂ Templates | Azure Arc state Configured

[1]
o Nebworks Azure Arc connection state Connected

B Datastores
View and manage appliance Go to Arc Center
Workload Networking

% Segments
T DHCP -

BE Port mirroring

@ Dns

EN Public IP (Preview)

Operations

82 Azure Arc (preview)

™ Run command

Arc enabled VMware vSphere resources
After the private cloud is Arc-enabled, vCenter resources should appear under Virtual machines.

e From the left navigation, under Azure Arc VMware resources (preview), locate Virtual machines.

o Choose Virtual machines to view the vCenter Server resources.

Manage access to VMware resources through Azure Role-Based Access Control

After your Azure VMware Solution vCenter resources have been enabled for access through Azure, there's one
final step in setting up a self-service experience for your teams. You'll need to provide your teams with access to:
compute, storage, networking, and other vCenter Server resources used to configure VMs.

This section will demonstrate how to use custom roles to manage granular access to VMware vSphere resources
through Azure.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/deploy-arc-for-azure-vmware-solution/arc-private-cloud-configured.png#lightbox

Arc-enabled VMware vSphere custom roles

Three custom roles are provided to meet your Role-based access control (RBAC) requirements. These roles can
be applied to a whole subscription, resource group, or a single resource.

e Azure Arc VMware vSphere Administrator role
e Azure Arc VMware vSphere Private Cloud User role

e Azure Arc VMware vSphere VM Contributor role
The first role is for an Administrator. The other two roles apply to anyone who needs to deploy or manage a VM.
Azure Arc Azure VMware Solution Administrator role

This custom role gives the user permission to conduct all possible operations for the
Microsoft.ConnectedvMwarevSphere resource provider. This role should be assigned to users or groups who are

administrators that manage Azure Arc-enabled Azure VMware Solution deployment.
Azure Arc Azure VMware Solution Private Cloud User role

This custom role gives the user permission to use the Arc-enabled Azure VMware Solutions vSphere resources
that have been made accessible through Azure. This role should be assigned to any users or groups that need to
deploy, update, or delete VMs.

We recommend assigning this role at the individual resource pool (host or cluster), virtual network, or template
that you want the user to deploy VMs with.

Azure Arc Azure VMware Solution VM Contributor role

This custom role gives the user permission to perform all VMware VM operations. This role should be assigned
to any users or groups that need to deploy, update, or delete VMs.

We recommend assigning this role at the subscription level or resource group you want the user to deploy VMs
with.

Assign custom roles to users or groups

1. Navigate to the Azure portal.

2. Locate the subscription, resource group, or the resource at the scope you want to provide for the custom
role.

3. Find the Arc-enabled Azure VMware Solution vCenter Server resources.
a. Navigate to the resource group and select the Show hidden types checkbox.
b. Search for "Azure VMware Solution".

4. Select Access control (IAM) in the table of contents located on the left navigation.

5. Select Add role assignment from the Grant access to this resource.
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6. Select the custom role you want to assign, Azure Arc VMware Solution: Administrator, Private Cloud
User, or VM Contributor.

7. Search for AAD user or group name that you want to assign this role to.

8. Select the AAD user or group name. Repeat this step for each user or group you want to give permission
to.

9. Repeat the above steps for each scope and role.

Create Arc-enabled Azure VMware Solution virtual machine

This section shows users how to create a virtual machine (VM) on VMware vCenter Server using Azure Arc.
Before you begin, check the following prerequisite list to ensure you're set up and ready to create an Arc-
enabled Azure VMware Solution VM.

Prerequisites

e An Azure subscription and resource group where you have an Arc VMware VM Contributor role.
e A resource pool resource that you have an Arc VMware private cloud resource User role.

e Avirtual machine template resource that you have an Arc private cloud resource User role.

e (Optional) a virtual network resource on which you have Arc private cloud resource User role.

Create VM flow
e Open the Azure portal

e On the Home page, search for virtual machines. Once you've navigated to Virtual machines, select the +
Create drop down and select Azure VMware Solution virtual machine.
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Near the top of the Virtual machines page, you'll find five tabs labeled: Basics, Disks, Networking, Tags, and

Review + create. Follow the steps or options provided in each tab to create your Azure VMware Solution

virtual machine.

= Microsoft Azure (Preview) P Search resources, services, and docs (G+/)

Home > Virtual machines >

Create an AVS virtual machine

Basics Disks  Networking Tags  Review + create

Use one of your resource providers to create a new virtual machine in one of your custom locations.
Project details

Select the subscription to deploy your virtual machine. Use resource groups like folders to organize and manage all your resources.

Subscription* ‘ AnyBuild-InternalProdClusters v |
— Resource group * (® Select a resource group A% |
Create new

Instance details

Select the custom location for your new virtual machine. Some custom locations may support more than one kind of virtual machine.

Virtual machine name *

Basics

—_

v M oW N

. InProject details, select the Subscription and Resource group where you want to deploy your VM.

. InInstance details, provide the virtual machine name.

. Select a Custom location that your administrator has shared with you.

. Select the Resource pool/cluster/host where the VM should be deployed.

. For Template details, pick a Template based on the VM you plan to create.

e Alternately, you can check the Override template defaults box that allows you to override the CPU
and memory specifications set in the template.

e |f you chose a Windows template, you can provide a Username and Password for the
Administrator account.

For Extension setup, the box is checked by default to Enable guest management. If you don’'t want guest

management enabled, uncheck the box.

. The connectivity method defaults to Public endpoint. Create a Username, Password, and Confirm

password.

Disks


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/deploy-arc-for-azure-vmware-solution/deploy-vm-arc-1.2.png#lightbox
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/deploy-arc-for-azure-vmware-solution/deploy-vm-arc-tabs.png#lightbox

e You can opt to change the disks configured in the template, add more disks, or update existing disks. These
disks will be created on the default datastore per the VMware vCenter Server storage policies.

e You can change the network interfaces configured in the template, add Network interface cards (NICs), or
update existing NICs. You can also change the network that the NIC will be attached to provided you have
permissions to the network resource.

Networking

e A network configuration is automatically created for you. You can choose to keep it or override it and add a
new network interface instead.

e To override the network configuration, find and select + Add network interface and add a new network
interface.

Tags
e [n this section, you can add tags to the VM resource.
Review + create

e Review the data and properties you've set up for your VM. When everything is set up how you want it, select
Create. The VM should be created in a few minutes.

Enable guest management and extension installation

The guest management must be enabled on the VMware vSphere virtual machine (VM) before you can install
an extension. Use the following prerequisite steps to enable guest management.

Prerequisite

1. Navigate to Azure portal.

2. Locate the VMware vSphere VM you want to check for guest management and install extensions on, select
the name of the VM.

3. Select Configuration from the left navigation for a VMware VM.

4. Verify Enable guest management has been checked.

NOTE

The following conditions are necessary to enable guest management on a VM.

e The machine must be running a Supported operating system.

e The machine needs to connect through the firewall to communicate over the internet. Make sure the
URLs listed aren't blocked.

e The machine can't be behind a proxy, it's not supported yet.
e [f you're using Linux VM, the account must not prompt to sign in on pseudo commands.
Avoid pseudo commands by following these steps:

1. Sign into Linux VM.
2. Open terminal and run the following command: sudo visudo .
3. Add theline username ALL=(ALL) NOPASSWD:ALL atthe end of the file.

4. Replace username with the appropriate user-name.

If your VM template already has these changes incorporated, you won't need to do the steps for the VM created
from that template.


https://portal.azure.com/
https://docs.microsoft.com/en-us/azure/azure-arc/servers/agent-overview
https://docs.microsoft.com/en-us/azure/azure-arc/servers/agent-overview

Extension installation steps

1. Go to Azure portal.

2. Find the Arc-enabled Azure VMware Solution VM that you want to install an extension on and select the VM

name.
3. Navigate to Extensions in the left navigation, select Add.
4. Select the extension you want to install.

a. Based on the extension, you'll need to provide details. For example, workspace 1d and key for
LogAnalytics extension.

5. When you're done, select Review + create.

When the extension installation steps are completed, they trigger deployment and install the selected extension
on the VM.

Change Arc appliance credential

Use the following guide to change your Arc appliance credential once you've changed your SDDC credentials.

Use the set credential command to update the provider credentials for appliance resource. When

cloudadmin credentials are updated, use the following steps to update the credentials in the appliance store.

1. Log into the jumpbox VM from where onboarding was performed. Change the directory to onboarding
directory.

2. Run the following command for Windows-based jumpbox VM.
./.temp/.env/Scripts/activate

3. Run the following command.
az arcappliance setcredential vmware --kubeconfig kubeconfig

4. Run the onboard command again. See step 3 in the Process to onboard in Arc for Azure VMware Preview.

NOTE

Customers need to ensure kubeconfig and SSH keys remain available as they will be required for log collection, appliance
Upgrade, and credential rotation. These parameters will be required at the time of upgrade, log collection, and credential

update scenarios.

Parameters
Required parameters
-kubeconfig # kubeconfig of Appliance resource
Examples
The following command invokes the set credential for the specified appliance resource.

az arcappliance setcredential <provider> --kubeconfig <kubeconfig>

Manual appliance upgrade

Use the following steps to perform a manual upgrade for Arc appliance virtual machine (VM).

1. Log into vCenter Server.

2. Locate the Arc appliance VM, which should be in the resource pool that was configured during onboarding.



a. Power off the VM.
b. Delete the VM.
3. Delete the download template corresponding to the VM.
4. Delete the resource bridge ARM resource.
5. Get the previous script config_avs file and add the following configuration item:
a. "register":false
6. Download the latest version of the Azure VMware Solution onboarding script.
7. Run the new onboarding script with the previous config_avs.json from the jump box VM, without changing

other config items.

Off board from Azure Arc-enabled Azure VMware Solution

This section demonstrates how to remove your VMware vSphere virtual machines (VMs) from Azure

management services.

If you've enabled guest management on your Arc-enabled Azure VMware Solution VMs and onboarded them to
Azure management services by installing VM extensions on them, you'll need to uninstall the extensions to
prevent continued billing. For example, if you installed an MMA extension to collect and send logs to an Azure
Log Analytics workspace, you'll need to uninstall that extension. You'll also need to uninstall the Azure
Connected Machine agent to avoid any problems installing the agent in future.

Use the following steps to uninstall extensions from the portal.

NOTE
Steps 2-5 must be performed for all the VMs that have VM extensions installed.

1. Log into your Azure VMware Solution private cloud.

2. Select Virtual machines in Private cloud, found in the left navigation under "Arc-enabled VMware
resources”.

3. Search and select the virtual machine where you have Guest management enabled.

4. Select Extensions.

5. Select the extensions and select Uninstall.

To avoid problems onboarding the same VM to Guest management, we recommend you do the following
steps to cleanly disable guest management capabilities.

NOTE

Steps 2-3 must be performed for all VMs that have Guest management enabled.

1. Sign into the virtual machine using administrator or root credentials and run the following command in the
shell.

a. azcmagent disconnect --force-local-only .
2. Uninstall the connectedMachine agent from the machine.

3. Set the identity on the VM resource to none.

Remove Arc-enabled Azure VMware Solution vSphere resources from
Azure

When you activate Arc-enabled Azure VMware Solution resources in Azure, a representation is created for them



in Azure. Before you can delete the vCenter Server resource in Azure, you'll need to delete all of the Azure
resource representations you created for your vSphere resources. To delete the Azure resource representations
you created, do the following steps:

1. Go to the Azure portal.

2. Choose Virtual machines from Arc-enabled VMware vSphere resources in the private cloud.
3. Select all the VMs that have an Azure Enabled value as Yes.
4

. Select Remove from Azure. This step will start deployment and remove these resources from Azure. The

resources will remain in your vCenter Server.

a. Repeat steps 2, 3 and 4 for Resourcespools/clusters/hosts, Templates, Networks, and
Datastores.

5. When the deletion completes, select Overview.
a. Note the Custom location and the Azure Arc Resource bridge resources in the Essentials section.
6. Select Remove from Azure to remove the vCenter resource from Azure.
7. Go to vCenter Server resource in Azure and delete it.
8. Go to the Custom location resource and select Delete.
9

. Go to the Azure Arc Resource bridge resources and select Delete.

At this point, all of your Arc-enabled VMware vSphere resources have been removed from Azure.

Delete Arc resources from vCenter Server

For the final step, you'll need to delete the resource bridge VM and the VM template that were created during
the onboarding process. Once that step is done, Arc won't work on the Azure VMware Solution SDDC. When you
delete Arc resources from vCenter, it won't affect the Azure VMware Solution private cloud for the customer.

Preview FAQ

Is Arc supported in all the Azure VMware Solution regions?

Arc is supported in EastUS and WestEU regions however we are working to extend the regional support.
How does support work?

Standard support process for Azure VMware Solution has been enabled to support customers.

Does Arc for Azure VMware Solution support private end point?

Yes. Arc for Azure VMware Solution will support private end point for general audience. However, it's not

currently supported.

Is enabling internet the only option to enable Arc for Azure VMware Solution?
Yes

Is DHCP support available?

DHCP support is not available to customers at this time, we only support static IP.

NOTE

This is Azure VMware Solution 2.0 only. It's not available for Azure VMware Solution by Cloudsimple.

Debugging tips for known issues

Use the following tips as a self-help guide.



What happens if | face an error related to Azure CLI?

For windows jumpboyx, if you have 32-bit Azure CLI installed, verify that your current version of Azure CLI has

been uninstalled. Verification can be done from the Control Panel.
To ensure it's uninstalled, try the az version to check if it's still installed.
If you already installed Azure CLI using MSI, az installed by MSI and pip will conflict on PATH. In this case,

it's recommended that you uninstall the current Azure CLI version.

My script stopped because it timed-out, what should | do?

Retry the script for create . A prompt will ask you to selectY and rerun it.
It could be a cluster extension issue that would result in adding the extension in the pending state.
Verify you have the correct script version.

Verify the VMware pod is running correctly on the system in running state.

Basic trouble-shooting steps if the script run was unsuccessful.

Follow the directions provided in the Prerequisites section of this article to verify that the feature and
resource providers are registered.

What happens if the Arc for VMware section shows no data?

If the Azure Arc VMware resources in the Azure Ul show no data, verify your subscription was added in the
global default subscription filter.

| see the error: " ApplianceClusterNotRunning Appliance Cluster: <resource-bridge-id> expected states to be

Succeeded found: Succeeded and expected status to be Running and found: Connected".

e Run the script again.

I'm unable to install extensions on my virtual machine.

e Check that guest management has been successfully installed.
e VMtools should be installed on the VM.

I'm facing Network related issues during on-boarding.

e Look for an IP conflict. You need IPs with no conflict or from free pool.

e Verify the internet is enabled for the network segment.

Where can | find more information related to Azure Arc resource bridge?

e For more information, go to Azure Arc resource bridge (preview) overview

Appendices

Appendix 1 shows proxy URLs required by the Azure Arc-enabled private cloud. The URLs will get pre-fixed

when the script runs and can be run from the jumpbox VM to ping them.

AZURE ARC SERVICE URL
Microsoft container registry https://mcr.microsoft.com
Azure Arc Identity service https://*.his.arc.azure.com

Azure Arc configuration service https://*.dp.kubernetesconfiguration.azure.com


https://docs.microsoft.com/en-us/azure/azure-arc/resource-bridge/overview

AZURE ARC SERVICE URL

Cluster connect https://*.servicebus.windows.net

Guest Notification service https://guestnotificationservice.azure.com
Resource bridge (appliance) Dataplate service https://*.dp.prod.appliances.azure.com
Resource bridge (appliance) container image download https://ecpacr.azurecr.io

Resource bridge (appliance) image download https://.blob.core.windows.net

https://*.dl.delivery.mp.microsoft.com
https://*.do.dsp.mp.microsoft.com

Azure Resource Manager https://management.azure.com

Azure Active Directory https://login.mirosoftonline.com

Additional URL resources

e Google Container Registry
e Red Hat Quay.io


http://gcr.io/
http://quay.io/

Deploy disaster recovery using JetStream DR

software
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JetStream DR is a cloud-native disaster recovery solution designed to minimize downtime of virtual machines

(VM) if there was a disaster. Instances of JetStream DR are deployed at both the protected and recovery sites.

JetStream is built on the foundation of Continuous Data Protection (CDP), using VMware vSphere API for 1/0
filtering (VAIO) framework, which enables minimal or close to no data loss. JetStream DR provides the level of
protection wanted for business and mission-critical applications. It also enables cost-effective DR by using
minimal resources at the DR site and using cost-effective cloud storage, such as Azure Blob Storage.

In this article, you'll implement JetStream DR for your Azure VMware Solution private cloud and on-premises
VMware workloads.

To learn more about JetStream DR, see:
e JetStream Solution brief
e JetStream DR on Azure Marketplace

e JetStream knowledge base articles

Core components of the JetStream DR solution

ITEMS DESCRIPTION
JetStream Management Server Virtual Appliance MSA enables both Day 0 and Day 2 configuration, such as
(MSA) primary sites, protection domains, and recovering VMs. MSA

is installed on a vSphere node by the cloud admin. The MSA
implements a vCenter Server plugin that allows you to
manage JetStream DR natively from vCenter Server. The
MSA doesn't handle replication data of protected VMs.

JetStream DR Virtual Appliance (DRVA) Linux-based Virtual Machine appliance receives protected
VMs replication data from the source ESXi host. It's
responsible for storing the replication data at the DR site,
typically in an object store such as Azure Blob Storage.
Depending on the number of protected VMs and the
amount of storage to replicate, the private cloudadmin can
create one or more DRVA instances.

JetStream ESXi host components (IO Filter packages) JetStream software installed on each ESXi host configured for
JetStream DR. The host driver intercepts the vSphere VMs 10
and sends the replication data to the DRVA.

JetStream protection domain Logical group of VMs that will be protected together using
the same policies and run book. The data for all VMs in a
protection domain is stored in the same Azure Blob
container instance. The same DRVA instance handles
replication to remote DR storage for all VMs in a protection
domain.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/deploy-disaster-recovery-using-jetstream.md
https://www.jetstreamsoft.com/product-portfolio/jetstream-dr/
https://core.vmware.com/resource/vmware-vsphere-apis-io-filtering-vaio
https://azure.microsoft.com/services/storage/blobs/
https://www.jetstreamsoft.com/2020/09/28/solution-brief-disaster-recovery-for-avs/
https://portal.azure.com/#blade/Microsoft_Azure_Marketplace/GalleryItemDetailsBladeNopdl/id/jetstreamsoftware1596597632545.jsdravs-111721
https://www.jetstreamsoft.com/resources/knowledge-base/

ITEMS

Azure Blob Storage containers

DESCRIPTION

The protected VMs replicated data is stored in Azure Blobs.

JetStream software creates one Azure Blob container
instance for each JetStream protection domain.

JetStream scenarios on Azure VMware Solution

YoucanuseletStream DRwithAzureVMwareSolutionforthefollowingtwoscenarios:

e On-premises VMware vSphere to Azure VMware Solution DR

e Azure VMware Solution to Azure VMware Solution DR

Scenario 1: On-premises VMware vSphere to Azure VMware Solution DR

In this scenario, the primary site is your on-premises VMware vSphere environment and the DR site is an Azure

VMware Solution private cloud.
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Scenario 2: Azure VMware Solution to Azure VMware Solution DR

In this scenario, the primary site is an Azure VMware Solution private cloud in one Azure region. The disaster

recovery site is an Azure VMware Solution private cloud in a different Azure region.
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Disaster Recovery with Azure NetApp Files, JetStream DR and Azure

VMware Solution
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Disaster Recovery to cloud is a resilient and cost-effective way of protecting the workloads against site outages
and data corruption events like ransomware. Leveraging the VMware VAIO framework, on-premises VMware
workloads can be replicated to Azure Blob storage and recovered with minimal or close to no data loss and
near-zero Recovery Time Objective (RTO). JetStream DR can seamlessly recover workloads replicated from on-

premises to Azure VMware Solution and specifically to Azure NetApp Files.

JetStream DR enables cost-effective disaster recovery by consuming minimal resources at the DR site and using
cost-effective cloud storage. JetStream DR automates recovery to Azure NetApp Files (ANF) datastores using
Azure Blob Storage. It can recover independent VMs or groups of related VMs into the recovery site
infrastructure according to runbook settings. It also provides point-in-time recovery for ransomware protection.

Install JetStream DR

To install JetStream DR in the on-premises data center and in the Azure VMware Solution private cloud:
e [nstall JetStream DR in the on-premises data center:

o Download the JetStream DR bundle from Azure Marketplace (ZIP) and deploy the JetStream DR MSA
(OVA) in the designated cluster.

o Configure the cluster with the 10 filter package (install JetStream VIB).

o Provision Azure Blob (Azure Storage Account) in the same region as the DR Azure VMware Solution
cluster.

o Deploy the disaster recovery virtual appliance (DRVA) and assign a replication log volume (VMDK
from existing datastore or shared iSCSI storage).

o Create protected domains (groups of related VMs) and assign DRVAs and the Azure Blob Storage/ANF.

o Start protection.

e Install JetStream DR in the Azure VMware Solution private cloud:

o Use the Run command to install and configure JetStream DR.

o Add the same Azure Blob container and discover domains using the Scan Domain option.

o Deploy the DRVA appliance.

o Create a replication log volume using an available vSAN or ANF datastore.

o Import protected domains and configure RocVA (recovery VA) to use ANF datastore for VM
placements.

o Select the appropriate failover option and start continuous rehydration for near-zero RTO
domains/VMs.

e During a disaster event, trigger failover to Azure NetApp Files datastores in the designated Azure
VMware Solution DR site.

e Invoke failback to the protected site after the protected site has been recovered.

Ransomware recovery
Recovering from ransomware can be a daunting task. Specifically, it can be hard for IT organizations to pinpoint
what the “safe point of return is,". After that safe point is determined, how to ensure that recovered workloads

are safeguarded from the attacks re-occurring by sleeping malware or through vulnerable applications.

JetStream DR for Azure VMware Solution together with Azure NetApp Files datastores can address these
concerns by allowing organizations to recover from an available point-in-time. It ensures that workloads are
recovered to a functional and isolated network if required, allows the applications to function and communicate
with each other without exposing them to any North-South traffic. It also gives security teams a safe place to
perform forensics, and conduct other recovery measures.

For full details, refer to the article: Disaster Recovery with Azure NetApp Files, JetStream DR and Azure VMware

Solution.
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Prerequisites

Scenario 1: On-premises VMware vSphere to Azure VMware Solution DR

Azure VMware Solution private cloud deployed with a minimum of three nodes in the target DR region.

Azure VMware Solution = -

Microsoft

—+ Create 5?}3 Manage view v O Refresh i_' Export to CSV S Open query Assign tags Q Feedback

Filter for any field. Subscription == all Resource group == all X Location == all X +V Add filter

Showing 1 to 2 of 2 records.

D Name T Type To Resource group T Location Ty
[ & avs_euw o001 AVS Private cloud AVS_EUW_001 West Europe
(] € avs_uks_oo1 AVS Private cloud AVS_UKS_001 UK South

Network connectivity configured between the primary site JetStream appliances and the Azure Storage
blob instance.

Setup and Subscribe to JetStream DR from the Azure Marketplace to download the JetStream DR
software.

Azure Blob Storage account created using either Standard or Premium Performance tier. For access tier,
select Hot.

NOTE

The Enable hierarchical namespace option on the blob isn't supported.

An NSX-T network segment configured on Azure VMware Solution private cloud with DHCP enabled on
the segment for the transient JetStream Virtual appliances employed during recovery or failover.

A DNS server configured to resolve the IP addresses of Azure VMware Solution vCenter Server, Azure
VMware Solution ESXi hosts, Azure Storage account, and the JetStream Marketplace service for the

JetStream virtual appliances.

(Optional) Azure NetApp Files volume(s) are created and attached to the Azure VMware Solution private

cloud for recovery or failover of protected VMs to Azure NetApp Files backed datastores.

o Attach Azure NetApp Files datastores to Azure VMware Solution hosts (Preview)

o Disaster Recovery with Azure NetApp Files, JetStream DR and AVS (Azure VMware Solution)

Scenario 2: Azure VMware Solution to Azure VMware Solution DR

Azure VMware Solution private cloud deployed with a minimum of three nodes in both the primary and

secondary regions.

Network connectivity configured between the primary site JetStream appliances and the Azure Storage
blob instance.

Setup and Subscribe to JetStream DR from the Azure Marketplace to download the JetStream DR
software.

Azure Blob Storage account created using either Standard or Premium Performance tier. For access tier,
select Hot.
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NOTE

The Enable hierarchical namespace option on the blob isn't supported.

An NSX-T network segment configured on Azure VMware Solution private cloud with DHCP enabled on

the segment for the transient JetStream Virtual appliances employed during recovery or failover.

A DNS server configured on both the primary and DR sites to resolve the IP addresses of Azure VMware
Solution vCenter Server, Azure VMware Solution ESXi hosts, Azure Storage account, and the JetStream

Marketplace service for the JetStream virtual appliances.

(Optional) Azure NetApp Files volume(s) are created and attached to the Azure VMware Solution private

cloud for recovery or failover of protected VMs to Azure NetApp Files backed datastores.

o Attach Azure NetApp Files datastores to Azure VMware Solution hosts (Preview)

o Disaster Recovery with Azure NetApp Files, JetStream DR and AVS (Azure VMware Solution)

For more on-premises JetStream DR prerequisites, see the JetStream Pre-Installation Guide.

Install JetStream DR on Azure VMware Solution

You can follow these steps for both supported scenarios.
1. In your on-premises data center, install JetStream DR following the JetStream documentation.

2. In your Azure VMware Solution private cloud, install JetStream DR using a Run command. From the

Azure portal, select Run command > Packages > JSDR.Configuration.

| Run command

AVS Private cloud

O Refresh &7 Feedback

Run execution status

Settings Y e

[P search (ctri+n | «
@ Tags ~

f Diagnose and solve problems
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8 Locks v JSDRConfiguration (401

Manage Disable-JetDRForCluster

® Connectivity ” .
Enable-JetDRForCluster
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Install-JetDRWithDHCP
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= Storage (preview) Install-JetDRWithStaticlP

W Piacement policies Invoke-Preflight/etDRInstall

+ Add-ons
Invoke-Preflight/etDRUninstall
Workload Networking

« Segments Register-JetDRPlugin

DHCP Resolve-Hostlssue

B Port mirroring Uninstall-JetDR

@ DNs Unregister-JetDRPlugin

El Internet connectivity Update-JetDRCluster

Module for confguration of JetStream Software on AVS. See JetStream Software. Inc. for support

Unconfigures a cluster, uninstalls vibs from all hosts in the cluster and removes storage policies. It will not uninstall
JetDR completely

Configures an additional cluster for protection. installs vib to all hosts in the cluster and creates storage policies.

Deploys JetDr Management Server Appliance(MSA) with Dynamic network IP configurations and configures one
cluster

Deploys JetDr Management Server Appliance(MSA) with Static network IP configuration and configures one cluster

Checks to display current state of the system and minimum requirement are met before deploying JeDR. It also
checks for minimum of 3 hosts in a cluster, jetdr plugin if already present in vcenter and if a vm exists with same
name as MSA

Checks to display current state of the system and minimum reg are met before
checks for minimum of 4 hosts in a cluster

JeDR. It also

Registers JetDR plugin to vCenter

Resolves last failed vCenter task on the host.

Unconfigures cluster, unregisters vCenter from the JetDr MSA
Unregisters JetDR plugin from vCenter

Upgrades JetDR iofilter to latest available update.

Operations >

™ Run command

Monitoring
B Alerts
4l Metrics

E Diagnostic settings v

Microsoft.AVS.Management (5.0.75

level tasks in managing Azure VMware Solutions

NOTE

The default CloudAdmin user in Azure VMware Solution doesn't have sufficient privileges to install JetStream DR.
Azure VMware Solution enables simplified and automated installation of JetStream DR by invoking the Azure
VMware Solution Run command for JetStream DR.
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3. Runthe Invoke-PreflightJetDRInstall cmdlet, which checks if the prerequisites for installing JetStream

DR have been met. For example, it validates the required number of hosts, cluster names, and unique VM

names.

FIELD

Network

Datastore

ProtectedCluster

Cluster

VMName

Specify name for execution

Timeout

5. View the status of the execution.

Install the JetStream DR MSA

. Provide the required values or change the default values, and then select Run.

VALUE

Name of the NSX-T Data Center network segment where
you must deploy the JetStream MSA.

Name of the datastore where you'll deploy the MSA.

Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name.

Name of the Azure VMware Solution private cluster
where the JetStream MSA is deployed, for example,
Cluster-1.

Name of JetStream MSA VM, for example,
jetstreamServer.

Alphanumeric name of the execution, for example,
Invoke-PreflightJetDRInstall-Exec1. It's used to
verify if the cmdlet ran successfully.

The period after which a cmdlet exits if taking too long to
finish.

Azure VMware Solution supports the installation of JetStream using either static IP addresses or using DHCP-

based IP addresses.

Static IP address

1. SelectRun command > Packages > Install-JetDRWithStaticIP.

2. Provide the required values or change the default values, and then select Run.

FIELD

ProtectedCluster

Datastore

VMName

VALUE

Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name during the install.

Name of the datastore where you'll deploy the JetStream
MSA.

Name of JetStream MSA VM, for example,
jetstreamServer.



FIELD

Cluster

Netmask

MSIp

Dns

Gateway

Credential

HostName

Network

Specify name for execution

3. View the status of the execution.

DHCP-based IP address

VALUE

Name of the Azure VMware Solution private cluster
where the JetStream MSA is deployed, for example,
Cluster-1.

Netmask of the MSA to be deployed, for example, 22 or
24.

IP address of the JetStream MSA VM.

DNS IP that the JetStream MSA VM should use.

IP address of the network gateway for the JetStream
MSA VM.

Credentials of the root user of the JetStream MSA VM.

Hostname (FQDN) of the JetStream MSA VM.

Name of the NSX-T Data Center network segment where
you must deploy the JetStream MSA.

Alphanumeric name of the execution, for example,
Install-JetDRWithStaticlP-Exec1. It's used to verify if
the cmdlet ran successfully and should be unique for
each run.

This step also installs JetStream vSphere Installation Bundle (VIB) on the clusters that need DR protection.

1. Select Run command > Packages > Install-JetDRWithDHCP.

2. Provide the required values or change the default values, and then select Run.

FIELD

ProtectedCluster

Datastore

VMName

Cluster

Credential

HostName

VALUE

Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name during the install.

Name of the datastore where you'll deploy the JetStream
MSA.

Name of JetStream MSA VM, for example,
jetstreamServer.

Name of the Azure VMware Solution private cluster
where the JetStream MSA is deployed, for example,
Cluster-1.

Credentials of the root user of the JetStream MSA VM.

Hostname (FQDN) of the JetStream MSA VM.



FIELD

Network

Specify name for execution

3. View the status of the execution.

VALUE

Name of the NSX-T Data Center network segment where
you must deploy the JetStream MSA.

Alphanumeric name of the execution, for example,
Install-JetDRWithDHCP-Exec1. It's used to verify if
the cmdlet ran successfully and should be unique for
each run.

Add JetStream DR to new Azure VMware Solution clusters

1. Select Run command > Packages > Enable-JetDRForCluster.

2. Provide the required values or change the default values, and then select Run.

FIELD

ProtectedCluster

Credential

MSlp

Specify name for execution

3. View the status of the execution.

Configure JetStream DR

VALUE

Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name during the install.

Credentials of the root user of the JetStream MSA VM.

IP address of the JetStream MSA VM.

Alphanumeric name of the execution, for example,
Enable-JetDRForCluster-Exec1. It's used to verify if
the cmdlet ran successfully and should be unique for
each run.

This section only covers an overview of the steps required for configuring JetStream DR. For detailed

descriptions and steps, see the Configuring JetStream DR documentation.

Once JetStream DR MSA and JetStream VIB are installed on the Azure VMware Solution clusters, use the

JetStream portal to complete the remaining configuration steps.

1. Access the JetStream portal from the vCenter appliance.

2. Add an external storage site.

3. Deploy a JetStream DRVA appliance.

4. Create a JetStream replication log store volume using one of the datastores available to the Azure

VMware Solution cluster.

TIP

Fast local storage, such as vSAN datastore, is preferred for the replication log.

5. Create a JetStream protected domain. You'll provide the Azure Blob Storage site, JetStream DRVA



https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/configuring-jetstream-dr/
https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/add-a-storage-site/
https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/deploy-a-dr-virtual-appliance/
https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/create-a-replication-log-store-volume/
https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/create-a-protected-domain/

instance, and replication log created in previous steps.
6. Select the VMs you want to protect and then start VM protection.

For remaining configuration steps for JetStream DR, such as creating a failover runbook, invoking failover to the

DR site, and invoking failback to the primary site, see the JetStream Admin Guide documentation).

Disable JetStream DR on an Azure VMware Solution cluster

This cmdlet disables JetStream DR only on one of the clusters and doesn't completely uninstall JetStream DR.
1. Select Run command > Packages > Disable-JetDRForCluster.

2. Provide the required values or change the default values, and then select Run.
FIELD VALUE

ProtectedCluster Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name during the install.

Credential Credentials of the root user of the JetStream MSA VM.
MSlp IP address of the JetStream MSA VM.
Specify name for execution Alphanumeric name of the execution, for example,

Disable-JetDRForCluster-Exec1. It's used to verify if
the cmdlet ran successfully and should be unique for
each run.

3. View the status of the execution.

Uninstall JetStream DR

1. Select Run command > Packages > Invoke-PreflightJetDRUninstall. This cmdlet checks if the

cluster has at least four hosts (minimum required).

2. Provide the required values or change the default values, and then select Run.
FIELD VALUE

ProtectedCluster Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name during the install.

Credential Credentials of the root user of the JetStream MSA VM.
MSlp IP address of the JetStream MSA VM.
Specify name for execution Alphanumeric name of the execution, for example,

Invoke-PreflightJetDRUninstall-Exec1. It's used to
verify if the cmdlet ran successfully and should be unique
for each run.

3. View the status of the execution.

4. After the preflight cndlet completes successfully, select Uninstall-JetDR, provide the required values or
change the default values, and select Run.


https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/select-vms-for-protection/
https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/start-vm-protection/
https://www.jetstreamsoft.com/portal/jetstream-knowledge-base/disaster-recovery-with-azure-netapp-files-jetstream-dr-and-avs-azure-vmware-solution/

FIELD VALUE

ProtectedCluster Name of the Azure VMware Solution private cloud
cluster to be protected, for example, Cluster-1. You can
only provide one cluster name during the install.

Credential Credentials of the root user of the JetStream MSA VM.
MSIp IP address of the JetStream MSA VM.
Specify name for execution Alphanumeric name of the execution, for example,

Uninstall-JetDR-Exec1. It's used to verify if the cmdlet
ran successfully and should be unique for each run.

5. View the status of the execution.

Support

JetStream DR is a solution that JetStream Software supports. For any product or support issues with JetStream,
contact support-avs@jetstreamsoft.com.

Azure VMware Solution uses the Run command (Preview) to automate both the install and uninstall of
JetStream DR. Contact Microsoft support for any issue with the run commands. For issues with JetStream install
and uninstall cmdlets, contact JetStream for support.

Next steps

e Infrastructure Setup: JetStream DR for Azure VMware Solution
e JetStream DR for Azure VMware Solution (Full demo)

o Get started with JetStream DR for Azure VMware Solution

o

Configure and protect VMs

o

Failover to Azure VMware Solution

o

Failback to on-premises
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Deploy disaster recovery using VMware HCX

8/19/2022 + 5 minutes to read « Edit Online

In this article, you'll deploy disaster recovery of your virtual machines (VMs) with VMware HCX solution and
using an Azure VMware Solution private cloud as the recovery or target site.

IMPORTANT

Although part of HCX, VMware HCX Disaster Recovery (DR) is not recommended for large deployments. The disaster
recovery orchestration is 100% manual, and Azure VMware Solution currently doesn't have runbooks or features to
support manual HCX DR failover. For enterprise-class disaster recovery, refer to VMware Site Recovery Manager (SRM) or

VMware business continuity and disaster recovery (BCDR) solutions.

VMware HCX provides various operations that provide fine control and granularity in replication policies.
Available Operations include:

e Reverse — After a disaster has occurred. Reverse helps make Site B the source site and Site A, where the
protected VM now lives.

e Pause - Pause the current replication policy associated with the VM selected.

e Resume - Resume the current replication policy associated with the VM selected.
e Remove - Remove the current replication policy associated with the VM selected.
e Sync Now - Out of bound sync source VM to the protected VM.

This guide covers the following replication scenarios:

e Protecta VM or a group of VMs.

e Complete a Test Recover of a VM or a group of VMs.

e Recover a VM or a group of VMs.

e Reverse Protection of a VM or a group of VMs.

Protect VMs

1. Log into vSphere Client on the source site and access HCX plugin.
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2. Enter the Disaster Recovery area and select PROTECT VMS.
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3. Select the Source and the Remote sites. The Remote site in this case should be the Azure VMware

Solution private cloud.

@ HCX: Protect Virtual Machines

Replication Destination Site:

] protect WMs to Primary Site

v [ Local hex-enterprise / V1080200 2[5 Remote: TNT20-HOCMGRcloud /W 10.22.0.2

https:10.22.0.7

3 Local: hex-enterprise / V(C:10.8.0.201 = Remote: (select)
@TNT20—HCX—MGR—CIOud £ WC10.22.0.2

https:#10.22.0.7

4. If needed, select the Default replication options:

e Enable Compression: Recommended for low throughput scenarios.

e Enable Quiescence: Pauses the VM to ensure a consistent copy is synced to the remote site.

e Destination Storage: Remote datastore for the protected VMs, and in an Azure VMware Solution
private cloud, which should be the vSAN datastore.

e Compute Container: Remote vSphere Cluster or Resource Pool.
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e Destination Folder: Remote destination folder, which is optional, and if no folder is selected, the
VMs are placed directly under the selected cluster.

e RPO: Synchronization interval between the source VM and the protected VM. It can be anywhere
from 5 minutes to 24 hours.

e Snapshot interval: Interval between snapshots.

e Number of Snapshots: Total number of snapshots within the configured snapshot interval.
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5. Select one or more VMs from the list and configure the replication options as needed.

By default, the VMs inherit the Global Settings Policy configured in the Default replication options. For
each network interface in the selected VM, configure the remote Network Port Group and select Finish
to start the protection process.

@ HCX: Protect Virtual Machines
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6. Monitor the process for each of the selected VMs in the same disaster recovery area.
v A ® ] S vei10320 vncin 1 -

Status Parameters

7. After the VM has been protected, you can view the different snapshots in the Snapshots tab.
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The yellow triangle means the snapshots and the virtual machines haven't been tested in a Test Recovery

operation.

There are key differences between a VM that is powered off and one powered on. The image shows the
syncing process for a powered-on VM. It starts the syncing process until it finishes the first snapshot,
which is a full copy of the VM, and then completes the next ones in the configured interval. It syncs a copy
for a powered off VM, and then the VM appears as inactive, and protection operation shows as
completed. When the VM is powered on, it starts the syncing process to the remote site.

Complete a test recover of VMs

1.

2.

Log into vSphere Client on the remote site, which is the Azure VMware Solution private cloud.

Within the HCX plugin, in the Disaster Recovery area, select the vertical ellipses on any VM to display
the operations menu and then select Test Recover VM.
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. Select the options for the test and the snapshot you want to use to test different states of the VM.
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After selecting Test, the recovery operation begins.

. When finished, you can check the new VM in the Azure VMware Solution private cloud vCenter.
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6. After testing has been done on the VM or any application running on it, do a cleanup to delete the test

instance.
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1. Log into vSphere Client on the remote site, which is the Azure VMware Solution private cloud, and

access the HCX plugin.

For the recovery scenario, a group of VMs used for this example.

2. Select the VM to be recovered from the list, open the ACTIONS menu, and select Recover VMs.
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3. Configure the recovery options for each instance and select Recover to start the recovery operation.
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4. After the recovery operation is completed, the new VMs appear in the remote vCenter Server inventory.

Complete a reverse replication on VMs

1. Log into vSphere Client on your Azure VMware Solution private cloud, and access HCX plugin.

NOTE

Ensure the original VMs on the source site are powered off before you start the reverse replication. The operation
fails if the VMs aren't powered off.

2. From the list, select the VMs to be replicated back to the source site, open the ACTIONS menu, and select
Reverse.



3. Select Reverse to start the replication.
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Disaster recovery plan automation

VMware HCX currently doesn't have a built-in mechanism to create and automate a disaster recovery plan.
However, VMware HCX provides a set of REST APIs, including APIs for the Disaster Recovery operation. The API
specification can be accessed within VMware HCX Manager in the URL.

These APIs cover the following operations in Disaster Recovery.
e Protect

® Recover

e Test Recover

e Planned Recover

® Reverse

e Query

e Test Cleanup

e Pause

e Resume

e Remove Protection
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e Reconfigure

An example of a recover operation payload in JSON is shown below.

"replicationId": "string",
"needPowerOn": true,
"instanceId": "string",
"source": {

"endpointType": "string",

"endpointId": "string",

"endpointName": "string",
"resourceType": "string",
"resourceId”: "string",

"resourceName": "string"

1

"destination": {

"endpointType": "string",

"endpointId": "string",

"endpointName": "string",
"resourceType": "string",
"resourceId": "string",

"resourceName": "string"

3

"placement": [

{
"containerType": "string",
"containerId": "string"
}
1,
"resourceld": "string",

"forcePowerOff": true,

"isTest": true,

"forcePowerOffAfterTimeout": true,

"isPlanned": true



With these APIs, you can build a custom mechanism to automate a disaster recovery plan's creation and

execution.



Deploy disaster recovery with VMware Site

Recovery Manager

8/19/2022 « 10 minutes to read « Edit Online

This article explains how to implement disaster recovery for on-premises VMware virtual machines (VMs) or
Azure VMware Solution-based VMs. The solution in this article uses VMware Site Recovery Manager (SRM) and

vSphere Replication with Azure VMware Solution. Instances of SRM and replication servers are deployed at both
the protected and the recovery sites.

SRM is a disaster recovery solution designed to minimize downtime of the virtual machines in an Azure
VMware Solution environment if there was a disaster. SRM automates and orchestrates failover and failback,
ensuring minimal downtime in a disaster. Also, built-in non-disruptive testing ensures your recovery time
objectives are met. Overall, SRM simplifies management through automation and ensures fast and highly
predictable recovery times.

vSphere Replication is VMware's hypervisor-based replication technology for vSphere VMs. It protects VMs from
partial or complete site failures. In addition, it simplifies DR protection through storage-independent, VM-centric
replication. vSphere Replication is configured on a per-VM basis, allowing more control over which VMs are
replicated.

In this article, you'll implement disaster recovery for on-premises VMware virtual machines (VMs) or Azure
VMware Solution-based VMs.

Supported scenarios

SRM helps you plan, test, and run the recovery of VMs between a protected vCenter Server site and a recovery
vCenter Server site. You can use SRM with Azure VMware Solution with the following two DR scenarios:

e On-premises VMware to Azure VMware Solution private cloud disaster recovery

e Primary Azure VMware Solution to Secondary Azure VMware Solution private cloud disaster recovery

The diagram shows the deployment of the primary Azure VMware Solution to secondary Azure VMware
Solution scenario.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/disaster-recovery-using-vmware-site-recovery-manager.md
https://docs.vmware.com/en/Site-Recovery-Manager/index.html
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You can use SRM to implement different types of recovery, such as:

MISEE

e Planned migration commences when both primary and secondary Azure VMware Solution sites are
running and fully functional. It's an orderly migration of virtual machines from the protected site to the
recovery site where no data loss is expected when migrating workloads in an orderly fashion.

Disaster recovery using SRM can be invoked when the protected Azure VMware Solution site goes
offline unexpectedly. Site Recovery Manager orchestrates the recovery process with the replication
mechanisms to minimize data loss and system downtime.

In Azure VMware Solution, only individual VMs can be protected on a host by using SRM in combination
with vSphere Replication.

Bidirectional Protection uses a single set of paired SRM sites to protect VMs in both directions. Each
site can simultaneously be a protected site and a recovery site, but for a different set of VMs.

IMPORTANT

Azure VMware Solution doesn't support:

® Array-based replication and storage policy protection groups

VVOLs Protection Groups

SRM IP customization using SRM command-line tools

One-to-Many and Many-to-One topology

Custom SRM plug-in identifier or extension 1D

Deployment workflow

The workflow diagram shows the Primary Azure VMware Solution to secondary workflow. In addition, it shows
steps to take within the Azure portal and the VMware vSphere environments of Azure VMware Solution to
achieve the end-to-end protection of VMs.
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Prerequisites

Make sure you've explicitly provided the remote user the VRM administrator and SRM administrator roles in the

remote vCenter Server.

Scenario: On-premises to Azure VMware Solution

e Azure VMware Solution private cloud deployed as a secondary region.

e DNS resolution to on-premises SRM and virtual cloud appliances.

NOTE

configuration.

For private clouds created on or after July 1, 2021, you can configure private DNS resolution. For private clouds

created before July 1, 2021, that need a private DNS resolution, open a support request to request Private DNS

e ExpressRoute connectivity between on-premises and Azure VMware Solution - 2 Gbps.

Scenario: Primary Azure VMware Solution to secondary

e Azure VMware Solution private cloud must be deployed in the primary and secondary region.
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e Connectivity, like ExpressRoute Global Reach, between the source and target Azure VMware Solution
private cloud.
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Install SRM in Azure VMware Solution

1. In your on-premises datacenter, install VMware SRM and vSphere Replication.

NOTE

Use the Two-site Topology with one vCenter Server instance per PSC deployment model. Also, make sure that the
required vSphere Replication Network ports are opened.

2. In your Azure VMware Solution private cloud, under Manage, select Add-ons > Disaster recovery.

The default CloudAdmin user in the Azure VMware Solution private cloud doesn't have sufficient
privileges to install VMware SRM or vSphere Replication. The installation process involves multiple steps
outlined in the Prerequisites section. Instead, you can install VMware SRM with vSphere Replication as an
add-on service from your Azure VMware Solution private cloud.


https://docs.vmware.com/en/Site-Recovery-Manager/8.4/com.vmware.srm.install_config.doc/GUID-F474543A-88C5-4030-BB86-F7CC51DADE22.html
https://kb.vmware.com/s/article/2087769
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3. From the Disaster Recovery Solution drop-down, select VMware Site Recovery Manager (SRM) —
vSphere Replication.

Home > Microsoft AVS-20200914145430 > Azure private cloud

-+ Azure private cloud | Add-ons #

AVS Private cloud

P Search (Ctrl+/) “ . R

. - Overview Disaster recovery

@ Overview

W Activity log Disaster recovery solution *

A Access control (IAM) | VMware Site Recovery Manager (SRM) - vSphere replication ~
L Tags License key

| Enter your license key.
¢ Diagnose and solve problems L Lt Y

Settings D | agree with terms and conditions.
By checking this, you allow Microsoft Azure to install this software on your behalf. Microsoft does not manage your
B Locks license. You are responsible for maintaining your license with ViMware.

-
2 Export template Installation would take approximately 30 minutes to complete. You can track progress using Azure notifications.

Once complete, go to vCenter and complete configuration and site pairing.
Manage
® Connectivity Install
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E Clusters
+ Add-ons
Monitoring
HR Alerts
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@ Resource health

B Mew support request

4. Provide the License key, select agree with terms and conditions, and then select Install.
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NOTE
If you don't provide the license key, SRM is installed in an Evaluation mode. The license is used only to enable
VMware SRM.
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Once complete, go to vCenter and complete configuration and site pairing.
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BB |dentity
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Install the vSphere Replication appliance

After the SRM appliance installs successfully, you'll need to install the vSphere Replication appliances. Each
replication server accommodates up to 200 protected VMs. Scale in or scale out as per your needs.

1. From the Replication using drop-down, on the Disaster recovery tab, select vSphere Replication.

Setup replication

Replication using *

vSphere Replication Y4

Each vSphere replication server accomodates up to 200 protected VMs. Scale in or scale out as per your needs.

vSphere servers * ©

O
=T

2. Move the vSphere server slider to indicate the number of replication servers you want based on the
number of VMs to be protected. Then select Install.
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Setup replication

Replication using *

vSphere Replication v

Each vSphere replication server accomodates up to 200 protected VMs. Scale in or scale out as per your needs.

vSphere servers * (©

O

3. Once installed, verify that both SRM and the vSphere Replication appliances are installed.

TIP
The Uninstall button indicates that both SRM and the vSphere Replication appliances are currently installed.

Overview Disaster recovery

Disaster recovery solution

VMware Site Recovery Manager (SRM) N

o Disaster recovery with Site Recovery Manager is a preview feature.

License key @

| Enter your license key.

Save
or
Completely remove and uninstall SRM cloud appliance.
This will remove the software. All site pairs should be deleted before uninstalling.

Uninstall VMware Site Recovery Manager (SRM)

Replication using

vSphere Replication N
Each vSphere replication server accomodates up to 200 protected VMs. Scale in or scale out as per your needs.

vSphere servers * (O

O

Save

Uninstall vSphere Replication

Configure site pairing in vCenter Server

After installing VMware SRM and vSphere Replication, you need to complete the configuration and site pairing

in vCenter Server.



1. Sign in to vCenter Server as cloudadmin@vsphere.local.

2. Navigate to Site Recovery, check the status of both vSphere Replication and VMware SRM, and then
select OPEN Site Recovery to launch the client.

Site Recovery

& Shortcuts

Local wCenter Server instances with installed vSphere Replication or Site Recovery Ma
.I_[ Hosts and Clestors E g
= button. The Site Recovery application opens in a new browser tab.
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Storage ic _. ve dble2ab63aibd 514322793 sasius avs AZUre COM
5 Networkir
[E content Linranes viphere Replication COMFIGURE [
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[ Global inventory Lists P 101,010
Warsion B3I 0624276

% Policies and Frofiles

8} Aute Deploy
Currently serving Site Recovery client
<}> Developer Center

® vRealize Operations . e @ ok T
W Hox
Wersion B3 015628803

B Administration

v Update Manager [1+] comvmware volr

[ Tasks I OPEN Site Recovery [7 I
amk

0@ Events

& Tags & Custom Attributes

3. Select NEW SITE PAIR in the Site Recovery (SR) client in the new tab that opens.

NEW SITE PAIR

Replications within the same vCenter Server

Iy within vc 4bfe2aBE9alk 2e793 eastus.avs.azure.com O

4. Enter the remote site details, and then select NEXT.

NOTE

An Azure VMware Solution private cloud operates with an embedded Platform Services Controller (PSC), so only
one local vCenter can be selected. If the remote vCenter Server is using an embedded Platform Service Controller
(PSC), use the vCenter Server's FQDN (or its IP address) and port to specify the PSC.

The remote user must have sufficient permissions to perform the pairings. An easy way to ensure this is to give
that user the VRM administrator and SRM administrator roles in the remote vCenter Server. For a remote Azure

VMware Solution private cloud, cloudadmin is configured with those roles.




New Site Pair

1 Site details

Site details

First site

Select a local wCenter Servers you want to pair.

wCenter Server

[-] v Abfe2ab69albd 514926793 eastus avs azure com
Second site
Enter the Flatform Services Controller details for the vCenter Server
PSC host name 10002
PSC port 4432
User name cloudadmingdvsphere local
Password sRsssssssnsens

5. Select CONNECT to accept the certificate for the remote vCenter Server.

At this point, the client should discover the VRM and SRM appliances on both sides as services to pair.

6. Select the appliances to pair and then select NEXT.

New Site Pair

1 Site details

2 vCenter Server and services

vCenter Server and services

Select the vCenter Server you want to pair.

vCenter Server

© [10002

The following services have been identified on the vCenter Servers.
Select the ones you want to pair:

Service ~or ve.4bfe2a669a1b451492e793 eastus.avs.azure.com
@ Site Recovery Manager ... tnt22-p03-eastus
|§l vSphere Replication tnt22-p03-eastus

T 10.0.0.2 T
tnt51-pC1-stnc02

tnt51-p01-sntc02

CANCEL BACK NEXT

7. Select CONNECT to accept the certificates for the remote VMware SRM and the remote vCenter Server

(again).

8. Select CONNECT to accept the certificates for the local VMware SRM and the local vCenter Server.

9. Review the settings and then select FINISH.

If successful, the client displays another panel for the pairing. However, if unsuccessful, an alarm will be

reported.
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10. At the bottom, in the right corner, select the double-up arrow to expand the panel to show Recent Tasks
and Alarms.

NOTE

The SR client sometimes takes a long time to refresh. If an operation seems to take too long or appears "stuck”,

select the refresh icon on the menu bar.

11. Select VIEW DETAILS to open the panel for remote site pairing, which opens a dialog to sign in to the

remote vCenter Server.

NEW SITE PAIR

ve4bfe2aé69alba5i492e79.. « (@ 10.0.0.2 Replications within the same vCenter Server
Site Recovery Manager 1 within wc 4bfe2a669a1b45f492e 793 eastus avs.azure com O
7 Protection Groups O ] Recovery Plans O

vSphere Replication

B Outaoing b ciin: i
) Outgoing O ncoming

viEw DETALS  [ETRITEICES VIEW DETAILS

12. Enter the username with sufficient permissions to do replication and site recovery and then select LOG
IN.

For pairing, the login, which is often a different user, is a one-time action to establish pairing. The SR
client requires this login every time the client is launched to work with the pairing.

NOTE

The user with sufficient permissions should have VRM administrator and SRM administrator roles given to
them in the remote vCenter Server. The user should also have access to the remote vCenter Server inventory, like
folders and datastores. For a remote Azure VMware Solution private cloud, the cloudadmin user has the

appropriate permissions and access.

Log In Site X

Enter vCenter Server credentials

vCenter Server 10.0.02
User name cloudadmin@vsphere_local
Password .c-un.n--n.n--l o @

CANCEL LOG IN

You'll see a warning message indicating that the embedded VRS in the local VRM isn't running. This is
because Azure VMware Solution doesn't use the embedded VRS in an Azure VMware Solution private
cloud. Instead, it uses VRS appliances.
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Site Recovery Manager -

@ Protection Groups0 [ Recovery Plans:0

> N

Remote SRM connection

vSphere Replication

03-eastusi0 [Py Replicated VMs from tntS1-p0l-sntc0Z0

Recent Tasks

SRM protection, reprotection, and failback

After you've created the site pairing, follow the VMware documentation mentioned below for end-to-end
protection of VMs from the Azure portal.

e Using vSphere Replication with Site Recovery Manager (vmware.com)

e Inventory Mappings for Array-Based Replication Protection Groups and vSphere Replication Protection
Groups (vmware.com)

o About Placeholder Virtual Machines (vmware.com)

e vSphere Replication Protection Groups (vmware.com)

e (Creating, Testing, and Running Recovery Plans (vmware.com)

e Configuring a Recovery Plan (vmware.com)

e Customizing IP Properties for Virtual Machines (vmware.com)

e How Site Recovery Manager Reprotects Virtual Machines with vSphere Replication (vmware.com)

e Perform a Failback (vmware.com)

NOTE

If IP Customization Rules have been defined for network mappings between the AVS environment and the on-
premises environment, these rules will not be applied on failback from the AVS environment to the on-premises
environment due to a known issue with SRM 8.3.0. You can work around this limitation by removing protection

from all VMs in the Protection Group and then reconfiguring protection on them prior to initiating the failback.

Ongoing management of your SRM solution

While Microsoft aims to simplify VMware SRM and vSphere Replication installation on an Azure VMware
Solution private cloud, you are responsible for managing your license and the day-to-day operation of the
disaster recovery solution.

Scale limitations

To learn about the limits for the VMware Site Recovery Manager Add-On with the Azure VMware Soltuion, check
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the Azure subscription and service limits, quotas, and constraints.

SRM licenses

You can install VMware SRM using an evaluation license or a production license. The evaluation license is valid
for 60 days. After the evaluation period, you'll be required to obtain a production license of VMware SRM.

You can't use pre-existing on-premises VMware SRM licenses for your Azure VMware Solution private cloud.
Work with your sales teams and VMware to acquire a new term-based production license of VMware SRM.

Once a production license of SRM is acquired, you'll be able to use the Azure VMware Solution portal to update
SRM with the new production license.

Uninstall SRM

If you no longer require SRM, you must uninstall it in a clean manner. Before you uninstall SRM, you must
remove all SRM configurations from both sites in the correct order. If you do not remove all configurations
before uninstalling SRM, some SRM components, such as placeholder VMs, might remain in the Azure VMware
Solution infrastructure.

1. In the vSphere Client or the vSphere Web Client, select Site Recovery > Open Site Recovery.
2. On the Site Recovery home tab, select a site pair and select View Details.

3. Select the Recovery Plans tab, right-click on a recovery plan and select Delete.

NOTE

You cannot delete recovery plans that are running.

4. Select the Protection Groups tab, select a protection group, and select the Virtual Machines tab.
5. Highlight all virtual machines, right-click, and select Remove Protection.

Removing protection from a VM deletes the placeholder VM from the recovery site. Repeat this operation
for all protection groups.

6. In the Protection Groups tab, right-click a protection group and select Delete.

NOTE

You cannot delete a protection group that is included in a recovery plan. You cannot delete vSphere Replication

protection groups that contain virtual machines on which protection is still configured.

7. Select Site Pair > Configure and remove all inventory mappings.
a. Select each of the Network Mappings, Folder Mappings, and Resource Mappings tabs.
b. In each tab, select a site, right-click a mapping, and select Delete.
8. For both sites, select Placeholder Datastores, right-click the placeholder datastore, and select Remove.

9. Select Site Pair > Summary, and select Break Site Pair.


https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/azure-subscription-service-limits

NOTE

Breaking the site pairing removes all information related to registering Site Recovery Manager with Site Recovery
Manager, vCenter Server, and the Platform Services Controller on the remote site.

10. Inyour private cloud, under Manage, select Add-ons > Disaster recovery, and then select Uninstall
the replication appliances.

11. Once replication appliances are uninstalled, from the Disaster recovery tab, select Uninstall for the
Site Recovery Manager.

12. Repeat these steps on the secondary Azure VMware Solution site.

Support

VMware Site Recovery Manager (SRM) is a Disaster Recovery solution from VMware.

Microsoft only supports install/uninstall of SRM and vSphere Replication Manager and scale up/down of
vSphere Replication appliances within Azure VMware Solution.

For all other issues, such as configuration and replication, contact VMware for support.

VMware and Microsoft support teams will engage each other as needed to troubleshoot SRM issues on Azure
VMware Solution.
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In this article, you'll learn how to implement disaster recovery for on-premises VMware or Azure VMware
Solution-based virtual machines (VMs). The solution in this article uses Zerto disaster recovery. Instances of
Zerto are deployed at both the protected and the recovery sites.

Zerto is a disaster recovery solution designed to minimize downtime of VMs should a disaster occur. Zerto's
platform is built on the foundation of Continuous Data Protection (CDP) that enables minimal or close to no
data loss. The platform provides the level of protection wanted for many business-critical and mission-critical
enterprise applications. Zerto also automates and orchestrates failover and failback to ensure minimal
downtime in a disaster. Overall, Zerto simplifies management through automation and ensures fast and highly
predictable recovery times.

Core components of the Zerto platform

COMPONENT DESCRIPTION

Zerto Virtual Manager (ZVM) Management application for Zerto implemented as a
Windows service installed on a Windows VM. The private
cloud administrator installs and manages the Windows VM.
The ZVM enables Day 0 and Day 2 disaster recovery
configuration. For example, configuring primary and disaster
recovery sites, protecting VMs, recovering VMs, and so on.
However, it doesn't handle the replication data of the
protected customer VMs.

Virtual Replication appliance (VRA) Linux VM to handle data replication from the source to the
replication target. One instance of VRA is installed per ESXi
host, delivering a true scale architecture that grows and
shrinks along with the private cloud's hosts. The VRA
manages data replication to and from protected VMs to its
local or remote target, storing the data in the journal.

Zerto ESXi host driver Installed on each VMware ESXi host configured for Zerto
disaster recovery. The host driver intercepts a vSphere VM's
10 and sends the replication data to the chosen VRA for that
host. The VRA is then responsible for replicating the VM's
data to one or more disaster recovery targets.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/deploy-zerto-disaster-recovery.md
https://www.zerto.com/solutions/use-cases/disaster-recovery/

COMPONENT

Zerto Cloud Appliance (ZCA)

Virtual Protection Group (VPG)

DESCRIPTION

Windows VM only used when Zerto is used to recover

vSphere VMs as Azure Native laaS VMs. The ZCA is

composed of:

® ZVM: A Windows service that hosts the Ul and
integrates with the native APIs of Azure for
management and orchestration.

® VRA: A Windows service that replicates the data
from or to Azure.

The ZCA integrates natively with the platform it's deployed
on, allowing you to use Azure Blob storage within a storage
account on Microsoft Azure. As a result, it ensures the most
cost-efficient deployment on each of these platforms.

Logical group of VMs created on the ZVM. Zerto allows
configuring disaster recovery, Backup, and Mobility policies
on a VPG. This mechanism enables a consistent set of
policies to be applied to a group of VMs.

To learn more about Zerto platform architecture, see the Zerto Platform Architecture Guide.

Supported Zerto scenarios

You can use Zerto with Azure VMware Solution for the following three scenarios.

Scenario 1: On-premises VMware to Azure VMware Solution disaster recovery

In this scenario, the primary site is an on-premises vSphere-based environment. The disaster recovery site is an

Azure VMware Solution private cloud.
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Scenario 2: Azure VMware Solution to Azure VMware Solution cloud disaster recovery

In this scenario, the primary site is an Azure VMware Solution private cloud in one Azure Region. The disaster

recovery site is an Azure VMware Solution private cloud in a different Azure Region.


https://www.zerto.com/wp-content/uploads/2021/07/Zerto-Platform-Architecture-Guide.pdf
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Scenario 3: Azure VMware Solution to l1aaS VMs cloud disaster recovery

In this scenario, the primary site is an Azure VMware Solution private cloud in one Azure Region. Azure Blobs

and Azure laaS (Hyper-V based) VMs are used in times of Disaster.
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Prerequisites
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On-premises VMware to Azure VMware Solution disaster recovery

e Azure VMware Solution private cloud deployed as a secondary region.

e VPN or ExpressRoute connectivity between on-premises and Azure VMware Solution.

Azure VMware Solution to Azure VMware Solution cloud disaster recovery

e Azure VMware Solution private cloud must be deployed in the primary and secondary regions.

Azure VMware Solution »

Microsoft

—+ Create @3 Manage view v/ O Refresh l_, Export to CSV 3 Open query € Assign tags

Filter for any field... Subscription == all Resource group == all X
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e Connectivity, like ExpressRoute Global Reach, between the source and target Azure VMware Solution

private cloud.




Azure VMware Solution laaS VMs cloud disaster recovery

e Network connectivity, ExpressRoute based, from Azure VMware Solution to the vNET used for disaster

recovery.

e Follow the Zerto Virtual Replication Azure Enterprise Guidelines for the rest of the prerequisites.

Install Zerto on Azure VMware Solution

Currently, Zerto disaster recovery on Azure VMware Solution is in an Initial Availability (IA) phase. In the IA

phase, you must contact Microsoft to request and qualify for IA support.

To request IA support for Zerto on Azure VMware Solution, send an email request to
zertoonavs@microsoft.com. In the IA phase, Azure VMware Solution only supports manual installation and
onboarding of Zerto. However, Microsoft will work with you to ensure that you can manually install Zerto on

your private cloud.

NOTE

As part of the manual installation, Microsoft creates a new vCenter user account for Zerto. This user account is only for
Zerto Virtual Manager (ZVM) to perform operations on the Azure VMware Solution vCenter. When installing ZVM on
Azure VMware Solution, don't select the “Select to enforce roles and permissions using Zerto vCenter privileges” option.

After the ZVM installation, select the options below from the Zerto Virtual Manager Site Settings.

Site Settings @ X

@ site Information HOST MAINTENANCE MODE
. Enable VRA auto population after exiting host maintenance mode
(%) Throttling
Enable VRA auto evacuation once entering maintenance mode
Policies
VRA DEPLOYMENT
Workload e .
; nable VRA auto installation once host i o clus
& Automation Ea ™ g : »
Enable VRA auto population after installation
Email Settings
Enable VRA removal once host removed from inventory
(5 Reports
VMS PROTECTION
5. Compatibility Enable VMs auto protection using VMware vSphere tags

5 Cloud Settings

Long-term
Settings

NOTE

General Availability of Azure VMware Solution will enable self-service installation and Day 2 operations of Zerto on Azure
VMware Solution.

Configure Zerto for disaster recovery

To configure Zerto for the on-premises VMware to Azure VMware Solution disaster recovery and Azure VMware


https://www.zerto.com/wp-content/uploads/2016/11/Zerto-Virtual-Replication-5.0-for-Azure.pdf

Solution to Azure VMware Solution Cloud disaster recovery scenarios, see the Zerto Virtual Manager

Administration Guide vSphere Environment.

For more information, see the Zerto technical documentation. Alternatively, you can download all the Zerto
guides part of the v8.5 Search Tool for Zerto Software PDFs documentation bundle.

Ongoing management of Zerto

e As you scale your Azure VMware Solution private cloud operations, you might need to add new Azure
VMware Solution hosts for Zerto protection or configure Zerto disaster recovery to new Azure VMware
Solution vSphere Clusters. In both these scenarios, you'll be required to open a Support Request with the
Azure VMware Solution team in the Initial Availability phase. You can open the support ticket from the
Azure portal for these Day 2 configurations.
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e In the GA phase, all the above operations will be enabled in an automated self-service fashion.

FAQs

Can | use a pre-existing Zerto product license on Azure VMware Solution?

You can reuse pre-existing Zerto product licenses for Azure VMware Solution environments. If you need new

Zerto licenses, email Zerto atinfo@zerto.com to acquire new licenses.

How is Zerto supported?

Zerto disaster recovery is a solution that is sold and supported by Zerto. For any support issue with Zerto

disaster recovery, always contact Zerto support.

Zerto and Microsoft support teams will engage each other as needed to troubleshoot Zerto disaster recovery

issues on Azure VMware Solution.


https://s3.amazonaws.com/zertodownload_docs/8.5_Latest/Zerto%20Virtual%20Manager%20vSphere%20Administration%20Guide.pdf?cb=1629311409
https://www.zerto.com/myzerto/technical-documentation/
https://s3.amazonaws.com/zertodownload_docs/8.5_Latest/SEARCH_TOOL.zip?cb=1629311409
https://rc.portal.azure.com/#create/Microsoft.Support
https://www.zerto.com/support-and-services/
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NOTE

This document focuses on the VMware Horizon product, formerly known as Horizon 7. Horizon is a different solution than
Horizon Cloud on Azure, although there are some shared components. Key advantages of the Azure VMware Solution
include both a more straightforward sizing method and the integration of VMware Cloud Foundation management into
the Azure portal.

VMware Horizon(®), a virtual desktop and applications platform, runs in the data center and provides simple
and centralized management. It delivers virtual desktops and applications on any device, anywhere. Horizon lets
you create, and broker connections to Windows and Linux virtual desktops, Remote Desktop Server (RDS)
hosted applications, desktops, and physical machines.

Here, we focus specifically on deploying Horizon on Azure VMware Solution. For general information on
VMware Horizon, refer to the Horizon production documentation:

e What is VMware Horizon?
e [earn more about VMware Horizon

o Horizon Reference Architecture

With Horizon's introduction on Azure VMware Solution, there are now two Virtual Desktop Infrastructure (VDI)
solutions on the Azure platform. The following diagram summarizes the key differences at a high level.

Differences between VMware Horizon on Azure VMware
Solution and VMware Horizon Cloud on Azure

Horizon on AVS (laaS Model) Horizon Cloud Azure (DaaS Model)

RDSH Farms Desktop Pools

RDSH Desktop

RDSH Farms Desktop Pools

Tenant RDSH Desktop
Self-managed Se‘gr;e:‘;‘f;tged RDSH

Horizon

Horizon Cloud

vSphere)
Azure
Managed Service ManagEd SEWice

* Customer managed ¢ DaaS, supports Azure Windows Virtual Desktop
e VMware SDDC (enables Instant Clone, vMotion, Content * Uses native Azure instances - no vSphere
Library, etc.) ¢ Different architecture as on-premises Horizon

Azure AVS (with VMware

» Same Horizon architecture and features as on-premises

Horizon 2006 and later versions on the Horizon 8 release line supports both on-premises and Azure VMware
Solution deployment. There are a few Horizon features that are supported on-premises but not on Azure
VMware Solution. Other products in the Horizon ecosystem are also supported. For more information, see
feature parity and interoperability.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/azure-vmware-solution-horizon.md
https://www.vmware.com/products/horizon.html
https://www.vmware.com/products/horizon.html
https://docs.vmware.com/en/VMware-Horizon/index.html
https://techzone.vmware.com/resource/workspace-one-and-horizon-reference-architecture
https://kb.vmware.com/s/article/80850

Deploy Horizon in a hybrid cloud

You can deploy Horizon in a hybrid cloud environment by using Horizon Cloud Pod Architecture (CPA) to
interconnect on-premises and Azure data centers. CPA scales up your deployment, builds a hybrid cloud, and
provides redundancy for Business Continuity and Disaster Recovery. For more information, see Expanding
Existing Horizon 7 Environments.

IMPORTANT

CPA is not a stretched deployment; each Horizon pod is distinct, and all Connection Servers that belong to each of the
individual pods are required to be located in a single location and run on the same broadcast domain from a network

perspective.

Like on-premises or private data centers, you can deploy Horizon in an Azure VMware Solution private cloud.
We'll discuss key differences in deploying Horizon on-premises and Azure VMware Solution in the following
sections.

The Azure private cloudis conceptually the same as the VMware SDDC, a term typically used in Horizon
documentation. The rest of this document uses both terms interchangeably.

The Horizon Cloud Connector is required for Horizon on Azure VMware Solution to manage subscription
licenses. You can deploy Cloud Connector in Azure Virtual Network alongside Horizon Connection Servers.

IMPORTANT

Horizon Control Plane support for Horizon on Azure VMware Solution is not yet available. Be sure to download the VHD
version of Horizon Cloud Connector.

vCenter Server Cloud Admin role

Since Azure VMware Solution is an SDDC service and Azure manages the lifecycle of the SDDC on Azure

VMware Solution, the vCenter Server permission model on Azure VMware Solution is limited by design.

Customers are required to use the Cloud Admin role, which has a limited set of vCenter Server permissions. The
Horizon product was modified to work with the Cloud Admin role on Azure VMware Solution, specifically:

e |nstant clone provisioning was modified to run on Azure VMware Solution.

e A specific vSAN policy (VMware_Horizon) was created on Azure VMware Solution to work with Horizon,
which must be available and used in the SDDCs deployed for Horizon.

e vSphere Content-Based Read Cache (CBRC), also known as View Storage Accelerator, is disabled when

running on the Azure VMware Solution.

IMPORTANT
CBRC must not be turned back on.

NOTE

Azure VMware Solution automatically configures specific Horizon settings as long as you deploy Horizon 2006 (aka
Horizon 8) and above on the Horizon 8 branch and select the Azure option in the Horizon Connection Server installer.



https://techzone.vmware.com/resource/business-continuity-vmware-horizon#_Toc41650874

Horizon on Azure VMware Solution deployment architecture

A typical Horizon architecture design uses a pod and block strategy. A block is a single vCenter Server, while
multiple blocks combined make a pod. A Horizon pod is a unit of organization determined by Horizon scalability

limits. Each Horizon pod has a separate management portal, and so a standard design practice is to minimize
the number of pods.

Every cloud has its own network connectivity scheme. Combined with VMware SDDC networking / NSX-T Data
Center, the Azure VMware Solution network connectivity presents unique requirements for deploying Horizon
that is different from on-premises.

Each Azure private cloud and SDDC can handle 4,000 desktop or application sessions, assuming:
e The workload traffic aligns with the LoginVSI task worker profile.
e Only protocol traffic is considered, no user data.

e NSXEdge is configured to be large.

NOTE

Your workload profile and needs may be different, and therefore results may vary based on your use case. User Data
volumes may lower scale limits in the context of your workload. Size and plan your deployment accordingly. For more

information, see the sizing guidelines in the Size Azure VMware Solution hosts for Horizon deployments section.

Given the Azure private cloud and SDDC max limit, we recommend a deployment architecture where the
Horizon Connection Servers and VMware Unified Access Gateways (UAGs) are running inside the Azure Virtual
Network. It effectively turns each Azure private cloud and SDDC into a block. In turn, maximizing the scalability
of Horizon running on Azure VMware Solution.

The connection from Azure Virtual Network to the Azure private clouds / SDDCs should be configured with
ExpressRoute FastPath. The following diagram shows a basic Horizon pod deployment.
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Network connectivity to scale Horizon on Azure VMware Solution

This section lays out the network architecture at a high level with some common deployment examples to help
you scale Horizon on Azure VMware Solution. The focus is specifically on critical networking elements.

Single Horizon pod on Azure VMware Solution
Region 1- US East
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A single Horizon pod is the most straight forward deployment scenario because you deploy just one Horizon
pod in the US East region. Since each private cloud and SDDC is estimated to handle 4,000 desktop sessions,
you deploy the maximum Horizon pod size. You can plan the deployment of up to three private clouds/SDDCs.

With the Horizon infrastructure virtual machines (VMs) deployed in Azure Virtual Network, you can reach the
12,000 sessions per Horizon pod. The connection between each private cloud and SDDC to the Azure Virtual
Network is ExpressRoute Fast Path. No east-west traffic between private clouds is needed.

Key assumptions for this basic deployment example include that:

e You don't have an on-premises Horizon pod that you want to connect to this new pod using Cloud Pod
Architecture (CPA).

e End users connect to their virtual desktops through the internet (vs. connecting via an on-premises
datacenter).

You connect your AD domain controller in Azure Virtual Network with your on-premises AD through VPN or
ExpressRoute circuit.

A variation on the basic example might be to support connectivity for on-premises resources. For example,
users access desktops and generate virtual desktop application traffic or connect to an on-premises Horizon pod
using CPA.

The diagram shows how to support connectivity for on-premises resources. To connect to your corporate
network to the Azure Virtual Network, you'll need an ExpressRoute circuit. You'll also need to connect your
corporate network with each of the private cloud and SDDCs using ExpressRoute Global Reach. It allows the
connectivity from the SDDC to the ExpressRoute circuit and on-premises resources.



Region 1- US East
Horizon POD 1

subnet] suknet2
AN Managers, Dynamic
- Environment Manager, Cloud
Cannectars, AD Domain
Controllers, Events DB
WINETI
Tl S Glolkal Reach = =——
| . \\\ — —
AVS PC1 to AVERG2to Tl
VNETIER F VNET1EREP AVEPSIfo—
h VNET1ER FP
Desktops Desktops Desktops
/ Apps / Apps / Apps Corporate
Network
S o ) on-
AVS PC1/ AVS PC2 AVS PC3 Premises
SDDCT spDDC2 SpDC32 T

Multiple Horizon pods on Azure VMware Solution across multiple regions

Another scenario is scaling Horizon across multiple pods. In this scenario, you deploy two Horizon pods in two
different regions and federate them using CPA. It's similar to the network configuration in the previous example,
but with some additional cross-regional links.

You'll connect the Azure Virtual Network in each region to the private clouds/SDDCs in the other region. It
allows Horizon connection servers part of the CPA federation to connect to all desktops under management.
Adding extra private clouds/SDDCs to this configuration would allow you to scale to 24,000 sessions overall.

The same principles apply if you deploy two Horizon pods in the same region. Make sure to deploy the second
Horizon pod in a separate Azure Virtual Network. Just like the single pod example, you can connect your
corporate network and on-premises pod to this multi-pod/region example using ExpressRoute and Global
Reach.
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Size Azure VMware Solution hosts for Horizon deployments

Horizon's sizing methodology on a host running in Azure VMware Solution is simpler than Horizon on-
premises. That's because the Azure VMware Solution host is standardized. Exact host sizing helps determine the

number of hosts needed to support your VDI requirements. It's central to determining the cost-per-desktop.

Sizing tables

Specific vCPU/VRAM requirements for Horizon virtual desktops depend on the customer’s specific workload
profile. Work with your MSFT and VMware sales team to help determine your vCPU/VRAM requirements for

your virtual desktops.
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orizon sizing inputs

Here's what you'll need to gather for your planned workload:

Number of concurrent desktops
Required vCPU per desktop
Required VRAM per desktop

Required storage per desktop

In general, VDI deployments are either CPU or RAM constrained, which determines the host size. Let's take the

following example for a LoginVSI Knowledge Worker type of workload, validated with performance testing:

2,000 concurrent desktop deployment
2vCPU per desktop.
4-GB vRAM per desktop.

50 GB of storage per desktop

For this example, the total number of hosts factors out to 18, yielding a VM-per-host density of 111.

64
00

(%]

IMPORTANT
Customer workloads will vary from this example of a LoginVSI Knowledge Worker. As a part of planning your deployment,
work with your VMware EUC SEs for your specific sizing and performance needs. Be sure to run your own performance

testing using the actual, planned workload before finalizing host sizing and adjust accordingly.

Horizon on Azure VMware Solution licensing

There are four components to the overall costs of running Horizon on Azure VMware Solution.

Azure VMware Solution Capacity Cost

For information on the pricing, see the Azure VMware Solution pricing page



https://azure.microsoft.com/pricing/details/azure-vmware/

Horizon Licensing Cost

There are two available licenses for use with the Azure VMware Solution, which can be either Concurrent User
(CCU) or Named User (NU):

e Horizon Subscription License
e Horizon Universal Subscription License

If only deploying Horizon on Azure VMware Solution for the foreseeable future, then use the Horizon

Subscription License as it is a lower cost.

If deployed on Azure VMware Solution and on-premises, choose the Horizon Universal Subscription License as a
disaster recovery use case. However, it includes a vSphere license for on-premises deployment, so it has a

higher cost.
Work with your VMware EUC sales team to determine the Horizon licensing cost based on your needs.

Azure Instance Types

To understand the Azure virtual machine sizes that are required for the Horizon Infrastructure, see Horizon

Installation on Azure VMware Solution.

References

System Requirements For Horizon Agent for Linux

Next steps

To learn more about VMware Horizon on Azure VMware Solution, read the VMware Horizon FAQ.


https://techzone.vmware.com/resource/horizon-on-azure-vmware-solution-configuration#horizon-installation-on-azure-vmware-solution
https://docs.vmware.com/en/VMware-Horizon/2012/linux-desktops-setup/GUID-E268BDBF-1D89-492B-8563-88936FD6607A.html
https://www.vmware.com/content/dam/digitalmarketing/vmware/en/pdf/products/horizon/vmw-horizon-on-microsoft-azure-vmware-solution-faq.pdf

Deploy Citrix on Azure VMware Solution

8/19/2022 « 2 minutes to read = Edit Online

Citrix Virtual Apps and Desktop service supports Azure VMware Solution. Azure VMware Solution provides
cloud infrastructure containing vSphere clusters created by Azure infrastructure. You can leverage the Citrix
Virtual Apps and Desktop Service to use Azure VMware Solution for provisioning your Virtual Delivery Agent
(VDA) workload in the same way you would using vSphere in on-premises environments.

Learn more about Citrix virtual apps and desktops
Deployment guide

Solution brief

FAQ (review Q&As)

e Q. Can | migrate my existing Citrix desktops and apps to Azure VMware Solution, or operate a hybrid
environment that consists of on-premises and Azure VMware Solution-based Citrix workloads?

A. Yes. You can use the same machine images, application packages, and processes you currently use.
You're able to seamlessly link on-premises and Azure VMware Solution-based environments together for
a migration.

e Q. Can Citrix be deployed as a standalone environment within Azure VMware Solution?

A. Yes. You're free to migrate, operate a hybrid environment, or deploy a standalone directly into Azure
VMware Solution

e Q. Does Azure VMware Solution support both PVS and MCS?
A. Yes
e Q. Are GPU-based workloads supported in Citrix on Azure VMware Solution?

A. Not at this time. However, Citrix workloads on Microsoft Azure support GPU if that use case is
important to you.

e Q. Is Azure VMware Solution supported with on-prem Citrix deployments or LTSR?

A.No. Azure VMware Solution is only supported with the Citrix Virtual Apps and Desktops service
offerings.

e Q Who do | call for support?
A. Customers should contact Citrix support www.citrix.com/support for assistance.
e Q Can | use my Azure Virtual Desktop benefit from Microsoft with Citrix on Azure VMware Solution?

A. No. Azure Virtual Desktop benefits are applicable to native Microsoft Azure workloads only. Citrix
Virtual Apps and Desktops service, as a native Azure offering, can apply your Azure Virtual Desktop
benefit alongside your Azure VMware Solution deployment.

e Q How do | purchase Citrix Virtual Apps and Desktops service to use Azure VMware Solution?

A. You can purchase Citrix offerings via your Citrix partner or directly from the Azure Marketplace.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/azure-vmware-solution-citrix.md
https://www.citrix.com/downloads/xendesktop/components/xendesktop-and-xenapp-76-VDA.html
https://www.citrix.com/products/citrix-virtual-apps-and-desktops/
https://docs.citrix.com/en-us/citrix-virtual-apps-desktops-service/install-configure/resource-location/azure-resource-manager.html#azure-vmware-solution-avs-integration
https://www.citrix.com/content/dam/citrix/en_us/documents/solution-brief/citrix-virtual-apps-and-desktop-service-on-azure-vmware-solution.pdf
https://www.citrix.com/support

Move Azure VMware Solution subscription to

another subscription

8/19/2022 - 2 minutes to read  Edit Online

This article describes how to move an Azure VMware Solution subscription to another subscription. You might
move your subscription for various reasons, like billing.

Prerequisites

You should have at least contributor rights on both source and target subscriptions.

IMPORTANT

VNet and VNet gateway cannot be moved from one subscription to another. Additionally, moving your subscriptions has
no impact on the management and workloads, like the vCenter, NSX, and workload virtual machines.

Prepare and move

1. In the Azure portal, select the private cloud you want to move.

Home »
& ContosoSEA0312
AVS Private cloud
0 Search (Ctrl+/) « [i] Delete
& Overview “ A Essentials View Cost  JSON View
E Activity log Resource group (change) : Contosorg3 ESXi hosts 3
Rq, Access control (IAM) Status : Succeeded Primary peering subnet 1 10.201,12.232/30
P Location : Southeast Asia Secondary peering subnet : 10.201.12.236/30
ags
Subscription (change)  : Azure VMware solution Group Private Cloud Manageme... : 10.201.12.0/26
& Diagnose and solve problems
Subscription ID : 81004dbe-f479-5415-bdecg-4ed4bb9118%4  vMotion network : 10.201,13.128/25
Settings Tags (change) : Click here to add tags
B Locks

2. From a command prompt, ping the components and workloads to verify that they are pinging from the
same subscription.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/move-ea-csp-subscriptions.md

3. Select the Subscription (change) link.

Microsoft Azure 2 Search resources, services, and docs (G+/)

&) ContosoSEA0312

i| Delete

# Essentials

: Contosorg3
: Succeeded

: Southeast Asia

: Azure VMware solution Group

: 81004dbe-f479-5415-bdcg-4edbb91105f4

4. Provide the subscription details for Target and select Next.

= Micrasoft Azure

Home > ContosoSEAD312
Move resources

AD312

o Source + target

Source

Subscription Azure VMware solution Group

Resource group Contosorg3

Target

Subscription * AzureVsolstion

Resource group




5. Confirm the validation of the resources you selected to move. During the validation, you'll see Pending
validation for the status.

T

Home = ContosoSEAD312 =

Move resources
ContosaSEADI12

Source + tanget ° Resources to move 3 Review

Add resources

Marmie Type Validation status

& ContosoSEAD212 Azure Private Ooud @ Pending validation

vevos | [

6. Once the validation is successful, select Next to start the migration of your private cloud.

T

Home = ContosoSEAD312 =

Move resources
ConlosaSEAD3N2

Source + target °‘ Resources 1o move ¥ Review

Add resources

Mame Type Validation status

@ ContosoSEAN31Z Azure Private Cloud @ Succeeded

PIWious “

7. Select the check box indicating you understand that the tools and scripts associated won't work until you
update them to use the new resource IDs. Then select Move.

e DT

Home » ContosoSEADZIZ =

Move resources
ContosaSEADI12

Source + target : Resources 1o move ° Review

Selection summary

Souree subseription Azure VMware solution Group

Source resource group Contesangd

Target subscription AzureVaohition

Target resource group Migration-RiG

Mumber of resowrces 1o move 1

understand that tools and soripts assodated with moved resources will not work until 1| update them to use new resource |Ds

PIWious m

Verify the move

A notification appears once the resource move is complete.



Home *

&» ContosoSEAQ312

AVS Private cloud

Notifications

Disrniss all

3 Search (Cirl+/) « i Delete

¢

o Maving resources complete
Cverview “ A~ Essentials
Successfully moved TonlosoSEADI 12" from resource group Conlosorg” in

Activity log Re e group (change) : Comtozongd subscription “Azure Viware solution Groug’ 1o resource group ‘Migration-RG
in subscription "Azure Vsolution”
Access contral (LAM) Status : Succeeded R Lalsd] gl
Location : Southeast Asia

e >y o 9

Tags a few seconds ago

Subscription {change)

Private Cloud Manag

Subscription ID : 21004 dbe-f4T79-5415-bdog-4edbb 3112564 vMotion network

& Diagnose and solve problems

Settings

Tags (change) : Click here to add tags

G Locks

The new subscription appears in the private cloud Overview.

Home >

& ContosoSEA0312

AVS Private cloud

O Search (Ctrl+/) | « li] Delete
@ Overview “ s Essentials View Cost | JSON View
B Activity log Resource group (change) : Migration-RG ESXi hosts 13
A, Access control (IAM) Status : Succeeded Primary peering subnet : 10.201.12.232/30
Location : Southeast Asia Secondary peering subnet : 10.201.12.236/30
& Tags
Subscription (change)  : AzureVsolution Private Cloud Manageme... - 10.201.12.0/26
f Diagnose and solve problems
Subscription ID | 22899339-7af5-56¢4-ce13-cbg1141cbet | wiotion network : 10.201.13.128/25
Settings Tags (change) : Click here to add tags
B Locks

Next steps

Learn more about:

e Move Azure VMware Solution across regions

e Move guidance for networking resources

Move guidance for virtual machines

Move guidance for App Service resources


https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/move-limitations/networking-move-limitations
https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/move-limitations/virtual-machines-move-limitations
https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/move-limitations/app-service-move-limitations

Move Azure VMware Solution resources to another

region

8/19/2022 « 10 minutes to read « Edit Online

IMPORTANT

The steps in this article are strictly for moving Azure VMware Solution (source) in one region to Azure VMware Solution
(target) in another region.

You can move Azure VMware Solution resources to a different region for several reasons. For example, deploy
features or services available in specific regions only, meet policy and governance requirements, or respond to
capacity planning requirements.

This article helps you plan and migrate Azure VMware Solution from one Azure region to another, such as Azure
region A to Azure region B.

The diagram shows the recommended ExpressRoute connectivity between the two Azure VMware Solution
environments. An HCX site pairing and service mesh are created between the two environments. The HCX
migration traffic and Layer-2 extension moves (depicted by the red line) between the two environments. For
VMware recommended HCX planning, see Planning an HCX Migration.
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NOTE
You don't need to migrate any workflow back to on-premises because the traffic will flow between the private clouds

(source and target):

Azure VMware Solution private cloud (source) > ExpressRoute gateway (source) > ExpressRoute gateway
(target) > Azure VMware Solution private cloud (target)

The diagram shows the connectivity between both Azure VMware Solution environments.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/move-azure-vmware-solution-across-regions.md
https://vmc.techzone.vmware.com/vmc-solutions/docs/deploy/planning-an-hcx-migration#section1
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In this article, we'll walk you through the steps to:

e Prepare and plan the move to another Azure region

e Establish network connectivity between the two Azure VMware Solution private clouds

e Export the configuration from the Azure VMware Solution source environment

e Reapply the supported configuration elements to the Azure VMware Solution target environment

e Migrate workloads using VMware HCX

Prerequisites

e VMware HCX appliance is upgraded to the latest patch to avoid migration issues if any.

e Source's local content library is a published content library.

Prepare

The following steps show how to prepare your Azure VMware Solution private cloud to move to another Azure

VMware Solution private cloud.

Export the source configuration

1. From the source, export the extended segments, firewall rules, port details, and route tables.
2. Export the contents of an inventory list view to a CSV file.
3. Sortworkloads into migration groups (migration wave).

Deploy the target environment

Before you can move the source configuration, you'll need to deploy the target environment.

Back up the source configuration

Back up the Azure VMware Solution (source) configuration that includes vCenter Server, NSX-T Data Center, and
firewall policies and rules.

e Compute: Export existing inventory configuration. For Inventory backup, you can use RVtools (an open-
source app).

e Network and firewall policies and rules: On the Azure VMware Solution target, create the same
network segments as the source environment.


https://docs.vmware.com/en/VMware-HCX/services/user-guide/GUID-02DB88E1-EC81-434B-9AE9-D100E427B31C.html
https://docs.vmware.com/en/VMware-Validated-Design/services/deployment-of-vrealize-suite-2019-on-vmware-cloud-foundation-310/GUID-59E0CBA1-2CF6-488D-AA58-C97C76FD8159.html?hWord=N4IghgNiBcIA4FcBGECWBnAFgAgMYHsA7AFwFMTs0kAnMagTxAF8g
https://docs.vmware.com/en/VMware-NSX-T-Data-Center/3.1/administration/GUID-FCE6567E-1174-49CC-90F1-BA7B695B28F0.html
https://docs.vmware.com/en/VMware-vSphere/7.0/com.vmware.vsphere.vcenterhost.doc/GUID-C0E8DD52-677E-464F-A3EA-044EE20B7B92.html
https://vmc.techzone.vmware.com/vmc-solutions/docs/deploy/planning-an-hcx-migration#sec4-sub1

Azure VMware Solution supports all backup solutions. You'll need CloudAdmin privileges to install, backup data,
and restore backups. For more information, see Backup solutions for Azure VMware Solution VMs.

e VM workload backup using the Commvault solution:
o Create a VMware client from the Command center for Azure VMware Solution vCenter.
o Create a VM group with the required VMs for backups.
o Run backups on VM groups.
o Restore VMs.

e VM workload backup using Veritas NetBackup solution.

TIP

You can use Azure Resource Mover to verify and migrate the list of supported resources to move across regions, which

are dependent on Azure VMware Solution.

Locate the source ExpressRoute circuit 1D

1. From the source, sign in to the Azure portal.
2. Select Manage > Connectivity > ExpressRoute.
3. Copy the source’s ExpressRoute ID. You'll need it to peer between the private clouds.

Create the target’s authorization key

1. From the target, sign in to the Azure portal.

2. Select Manage > Connectivity > ExpressRoute and then select + Request an authorization key.

'D Soah resourees S o g0

Home > Contoso-westus-sddc

@ Contoso-westus-sddc | Connectivity # - X
=4 AVS Private cloud
« E = () Refresh
@ Overview - :
Azure vNet connect Settings HCX Public IP ExpressRoute Global Reach AVS Interconnect
B Activity log
ExpressRoute 1D
f Access control (IAM) |,t;uhsmplioms;‘l2345h:-d§67-391n-abdc-zezbbI2idseéfresnurceﬁmups,’lmlso-:usl-pﬂI-\\.‘E;h. provid rosoft.Network/exp ircuits/tnt50-cust-p01-westus... El
¢ Tags N
Private peering ID
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Settings P
} Request an authorization key | () Refresh
8 Locks
Name Key
Manage Contoso-westus-sddc | 2e2bb12345e6-1234abc-d567-8910-abdc [is]
& Connectivity I
B identity
B Clusters

3. Provide a name for it and select Create.

It may take about 30 seconds to create the key. Once created, the new key appears in the list of
authorization keys for the private cloud.


https://documentation.commvault.com/commvault/v11_sp20/article?p=119380.htm
https://documentation.commvault.com/commvault/v11_sp20/article?p=121182.htm
https://documentation.commvault.com/commvault/v11_sp20/article?p=121657.htm
https://documentation.commvault.com/commvault/v11_sp20/article?p=87275.htm
https://vrt.as/nb4avs
https://docs.microsoft.com/en-us/azure/resource-mover/move-region-within-resource-group
https://portal.azure.com/
https://portal.azure.com/
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/expressroute-global-reach/start-request-authorization-key.png#lightbox

Home > Contoso-westus-sddc

@ Contoso-westus-sddc | Connectivity = - x

~* AVS Private cloud

P search (Ctrl+/) « () Refresh

@ Overview
Azure vNet connect Settings | ExpressRoute | HCX  Public IP ExpressRoute Global Reach AVS Interconnect

@ Activity log
ExpressRoute ID
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@ Tags
Private peering ID
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4. Copy the authorization key and ExpressRoute ID. You'll need them to complete the peering. The
authorization key disappears after some time, so copy it as soon as it appears.

Peer between private clouds

Now that you have the ExpressRoute circuit IDs and authorization keys for both environments, you can peer the
source to the target. You'll use the resource ID and authorization key of your private cloud ExpressRoute circuit
to finish the peering.

1. From the target, sign in to the Azure portal using the same subscription as the source’s ExpressRoute

circuit.

2. Under Manage, select Connectivity > ExpressRoute Global Reach > Add.

p o e e

Home > contoso-westus-sddc

@ Contoso-westus-sddc | Connectivity = - P

T4 AVS Private cloud

£ Search (Ctrl+/) « & save () Refresh

@ Overview .
Azure vNet connect  Settings  ExpressRoute  HCX  PublicIP | ExpressRoute Global Reach | AVS Interconnect

@ Activity log
Identify the ExpressRoute circuits that you want to use. You can enable ExpressRoute Global Reach between the private peering of any two ExpressRoute circuits, as long as they're

. Access control (IAM) located in the supported countries/regions and were created at different peering locations. Learn more.
¢ Tags Before you begin
& Diagnose and solve problems ® You understand ExpressRoute circuit provisioning workflows.

* Your ExpressRoute circuits are in a provisioning state.
Settings ® Azure private peering is configured on your ExpressRoute circuits.

« Do not initiate a Global Reach connection from this page if a connection has already been initiated from the on-premises side.
B Locks

On-prem cloud connections (O

M

# Connectivity I . — i

Subscription Resource group ExpressRoute circuit Authorization key State
N ey No results
B Clusters

Workload Networking
% Segments

T DHcP

B Port mirroring

@ Dns

3. Paste the ExpressRoute circuit ID and target's authorization key you created in the previous step. Then
select Create:


https://portal.azure.com

On-prem cloud connections X

Subscnption

Contoso “

Resource group

contoso-westus-rg i

ExpressRoute circuit * (&

{E'DL. have a aircuit ID, copy/paste below

Enter an ExpressRoute circut 1D

authorization key

Create a site pairing between private clouds

After you establish connectivity, you'll create a VMware HCX site pairing between the private clouds to facilitate
the migration of your VMs. You can connect or pair the VMware HCX Cloud Manager in Azure VMware Solution
with the VMware HCX Connector in your data center.

1. Sign in to your source's vCenter Server, and under Home, select HCX.

2. Under Infrastructure, select Site Pairing and select the Connect To Remote Site option (in the
middle of the screen).

3. Enter the Azure VMware Solution HCX Cloud Manager URL or IP address you noted earlier
https://x.x.x.9 , the Azure VMware Solution cloudadmin@vsphere.local username, and the password.
Then select Connect.

NOTE

To successfully establish a site pair:
® Your VMware HCX Connector must be able to route to your HCX Cloud Manager IP over port 443.

® Use the same password that you used to sign in to vCenter Server. You defined this password on the initial
deployment screen.

You'll see a screen showing that your VMware HCX Cloud Manager in Azure VMware Solution and your
on-premises VMware HCX Connector are connected (paired).

wvm  vSphere Client

HCX
&) Dashivoard Site Pairing
« Infrastructure

nterconnect

« Services

o

& hittps 10 254.11.9:443 & hitpst

& Igjhcxmnnager-enterprlse - @TNTSI HCX-MGR-cloud
1 Disaster Recovery oSS S
 System

2o Administration

& support




Create a service mesh between private clouds

NOTE

To successfully establish a service mesh with Azure VMware Solution:

® Ports UDP 500/4500 are open between your on-premises VMware HCX Connector 'uplink' network profile
addresses and the Azure VMware Solution HCX Cloud 'uplink’ network profile addresses.

® Be sure to review the VMware HCX required ports.

1. Under Infrastructure, select Interconnect > Service Mesh > Create Service Mesh.

vm vSphere Client

HCX
@ Dashboard Interconnect
~ Infrastructure

i Multi-Site Service Mesh
& Site Pairing —_

[ compute Profies | SewviceMesh | Network Profiles [ Sentinel Management |
~ Services

@ Network Extension

@ migration

“D Disaster Recovery
~ System
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@ support
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CRefresh

The HCX Service Mesh is the effectiv

dded to a connected Site Pair that has a

valid Compute Profile created an s Adding a Service Mesh it

il appliances on both of the sites

2. Review the pre-populated sites, and then select Continue.

NOTE

If this is your first service mesh configuration, you won't need to modify this screen.

3. Select the source and remote compute profiles from the drop-down lists, and then select Continue.

The selections define the resources where VMs can consume VMware HCX services.

Create Service Mesh

X
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Create Service Mesh

Select Compute Profiles

Select one compute profile each in t

Select Source Compute Profile

ource and remote sites

for enabling hybridity services. Th

© Computeprofiie

Datacenter

GlEITIISle)

(£ New Cluster

¢

© TNT41HCX-ComputeProfiie

cLOSE

CISISISISle)

) Cluster-1

4. Review services that you want to be enabled, and then select Continue.
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5. In Advanced Configuration - Override Uplink Network profiles, select Continue.

Uplink network profiles connect to the network through which the remote site's interconnect appliances

can be reached.

6. In Advanced Configuration - Network Extension Appliance Scale Out, review and select

Continue.

You can have up to eight VLANSs per appliance, but you can deploy another appliance to add another

eight VLANSs. You must also have IP space to account for the more appliances, and it's one IP per

appliance. For more information, see VMware HCX Configuration Limits.
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Advanced Configuration - Network Extension Appliance Scale Out
HCX will deploy the specified appliance count for each selected network container. HCX-NE appliances are deployed in both sites.

Local Network Container

@ dvsot

Remote Network Container

4 TNT57-OVERLAY-TZ

Appliance Count

1

[ ] ] CONTINUE

@ s e e e
el
3 a =
i :
= ’ — HOY
: Q

7. In Advanced Configuration - Traffic Engineering, review and make any modifications that you feel

are necessary, and then select Continue.

8. Review the topology preview and select Continue.

9. Enter a user-friendly name for this service mesh and select Finish to complete.

10. Select View Tasks to monitor the deployment.
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When the service mesh deployment finishes successfully, you'll see the services as green.
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11. Verify the service mesh's health by checking the appliance status.

12. Select Interconnect > Appliances.
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Move

The following steps show how to move your Azure VMware Solution private cloud resources to another Azure
VMware Solution private cloud in a different region.

In this section, you'll migrate the:

e Resource pool configuration and folder creation

e VM templates and the associated tags

e | ogical segments deployment based on the source's port groups and associated VLANs

e Network security services and groups
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e Gateway firewall policy and rules based on the source's firewall policies

Migrate the source vSphere configuration

In this step, you'll copy the source's vSphere configuration and move it to the target environment.

1.

From the source's vCenter Server, use the same resource pool configuration and create the same
resource pool configuration on the target's vCenter Server.

From the source's vCenter Server, use the same VM folder name and create the same VM folder on the

target's vCenter Server under Folders.
Use VMware HCX to migrate all VM templates from the source's vCenter Server to the target's vCenter.
a. From the source, convert the existing templates to VMs and then migrate them to the target.

b. From the target, convert the VMs to VM templates.

. From the source environment, use the same VM Tags name and create them on the target's vCenter.

. From the source's vCenter Server Content Library, use the subscribed library option to copy the ISO, OVF,

OVA, and VM Templates to the target content library:

a. If the content library isn't already published, select the Enable publishing option.

b. From the source's Content Library, copy the URL of the published library.

c. From the target, create a subscribed content library with the URL from the source's library.

d. SelectSync Now.

Configure the target NSX-T Data Center environment

In this step, you'll use the source NSX-T Data Center configuration to configure the target NSX-T environment.

NOTE

You'll have multiple features configured on the source NSX-T Data Center, so you must copy or read from the source NSX-
T Data Center and recreate it in the target private cloud. Use L2 Extension to keep same IP address and Mac Address of
the VM while migrating Source to target AVS Private Cloud to avoid downtime due to IP change and related
configuration.

. Configure NSX-T Data Center network components required in the target environment under default

Tier-1 gateway.

Create the security group configuration.
Create the distributed firewall policy and rules.
Create the gateway firewall policy and rules.
Create the DHCP server or DHCP relay service.
Configure port mirroring.

Configure DNS forwarder.

Configure a new Tier-1 gateway (other than default). This configuration is based on the NSX-T Data
Center configured on the source.

Migrate the VMs from the source

In this step, you'll use VMware HCX to migrate the VMs from the source to the target. You'll have the option to

do a Layer-2 extension from the source and use HCX to vMotion the VMs from the source to the target with
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minimal interruption.

Besides vMotion, other methods, like Bulk and Cold vMotion, are also recommended. Learn more about:
e Plan an HCX Migration

e Migrate Virtual Machines with HCX

Cutover extended networks

In this step, you'll do a final gateway cutover to terminate the extended networks. You'll also move (migrate) the
gateways from the source Azure VMware Solution environment to the target environment.

IMPORTANT

You must do the gateway cutover post VLAN workload migration to the target Azure VMware Solution environment.

Also, there shouldn't be any VM dependency on the source and target environments.

Before the gateway cutover, verify all migrated workload services and performance. Once application and web
service owners accept the performance (except for any latency issues), you can continue with the gateway
cutover. Once you've completed the cutover, you'll need to modify the public DNS A and PTR records.

For VMware recommendations, see Cutover of extended networks.

Public IP DNAT for migrated DMZ VMs

To this point, you've migrated the workloads to the target environment. These application workloads must be
reachable from the public internet. The target environment provides two ways of hosting any application.
Applications can be:

e Hosted and published under the application gateway load balancer.

e Published through the public IP feature in vWAN.

Public IP is typically the destination NAT translated into the Azure firewall. With DNAT rules, firewall policy
would translate the public IP address request to a private address (webserver) with a port. For more

information, see How to use the public IP functionality in Azure Virtual WAN.

NOTE

SNAT is by default configured in Azure VMware Solution, so you must enable SNAT from Azure VMware Solution private

cloud connectivity settings under the Manage tab.

Decommission

For this last step, you'll verify that all the VM workloads were migrated successfully, including the network
configuration. If there's no dependency, you can disconnect the HCX service mesh, site pairing, and network
connectivity from the source environment.

NOTE

Once you decommission the private cloud, you cannot undo it as the configuration and data will be lost.

Next steps

Learn more about:


https://vmc.techzone.vmware.com/vmc-solutions/docs/deploy/planning-an-hcx-migration#sec4-sub1
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https://vmc.techzone.vmware.com/vmc-solutions/docs/deploy/planning-an-hcx-migration#section9

Move operation support for Microsoft. AVS
Move guidance for networking resources
Move guidance for virtual machines

Move guidance for App Service resources
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https://docs.microsoft.com/en-us/azure/azure-resource-manager/management/move-limitations/app-service-move-limitations

Request host quota for Azure VMware Solution
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In this how-to, you'll request host quota/capacity for Azure VMware Solution. You'll submit a support ticket to
have your hosts allocated whether it's for a new deployment or an existing one.

If you have an existing Azure VMware Solution private cloud and want more hosts allocated, you'll follow the
same process.

IMPORTANT

It can take up to five business days to allocate the hosts, depending on the number requested. So request what is needed

for provisioning, so you don't need to request a quota increase as often.

Eligibility criteria
You'll need an Azure account in an Azure subscription that adheres to one of the following criteria:

e A subscription under an Azure Enterprise Agreement (EA) with Microsoft.

e A Cloud Solution Provider (CSP) managed subscription under an existing CSP Azure offers contract or an
Azure plan.

e A Microsoft Customer Agreement with Microsoft.

Request host quota for EA customers

1. In your Azure portal, under Help + Support, create a New support request and provide the following
information:

e |ssue type: Technical

e Subscription: Select your subscription

e Service: All services > Azure VMware Solution

e Resource: General question

e Summary: Need capacity

e Problem type: Capacity Management Issues

e Problem subtype: Customer Request for Additional Host Quota/Capacity

2. In the Description of the support ticket, on the Details tab, provide information for:

® Region Name
e Number of hosts

e Any other details

NOTE

Azure VMware Solution requires a minimum of three hosts and recommends redundancy of N+1 hosts.

3. Select Review + Create to submit the request.

Request host quota for CSP customers


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/request-host-quota-azure-vmware-solution.md
https://docs.microsoft.com/en-us/azure/cost-management-billing/manage/ea-portal-agreements
https://docs.microsoft.com/en-us/azure/cost-management-billing/understand/mca-overview
https://rc.portal.azure.com/#create/Microsoft.Support

CSPs must use Microsoft Partner Center to enable Azure VMware Solution for their customers. This article uses
CSP Azure plan as an example to illustrate the purchase procedure for partners.

Access the Azure portal using the Admin On Behalf Of (AOBO) procedure from Partner Center.

IMPORTANT

Azure VMware Solution service does not provide a multi-tenancy required. Hosting partners requiring it are not
supported.

1. Configure the CSP Azure plan:

a. In Partner Center, select CSP to access the Customers area.

Customers

contoso services = Add products

Add products Amre O

| selea

Review Specty  quant

Confirm

Order history

c. Select Azure plan and then select Add to cart.

d. Review and finish the general setup of the Azure plan subscription for your customer. For more
information, see Microsoft Partner Center documentation.

2. After you configure the Azure plan and you have the needed Azure RBAC permissions in place for the

subscription, you'll request the quota for your Azure plan subscription.

a. Access Azure portal from Microsoft Partner Center using the Admin On Behalf Of (AOBO)
procedure.

b. Select CSP to access the Customers area.
¢. Expand customer details and select Microsoft Azure Management Portal.

d. In the Azure portal, under Help + Support, create a New support request and provide the
following information:


https://partner.microsoft.com
https://docs.microsoft.com/en-us/partner-center/azure-plan-lp
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e |ssue type: Technical

e Subscription: Select your subscription

e Service: All services > Azure VMware Solution

e Resource: General question

e Summary: Need capacity

e Problem type: Capacity Management Issues

e Problem subtype: Customer Request for Additional Host Quota/Capacity

e. Inthe Description of the support ticket, on the Details tab, provide information for:

e Region Name
e Number of hosts
e Any other details

e [s intended to host multiple customers?

NOTE

Azure VMware Solution requires a minimum of three hosts and recommends redundancy of N+1 hosts.

f. Select Review + Create to submit the request.

Next steps

Before deploying Azure VMware Solution, you must first register the resource provider with your subscription
to enable the service.



Rotate the cloudadmin credentials for Azure

VMware Solution
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IMPORTANT

Currently, rotating your NSX-T Manager admin credentials isn't supported. To rotate your NSX-T Manager password,
submit a support request. This process might impact running HCX services.

In this article, you'll rotate the cloudadmin credentials (vCenter Server CloudAdmin credentials) for your Azure
VMware Solution private cloud. Although the password for this account doesn't expire, you can generate a new
one at any time.

Caution
If you use your cloudadmin credentials to connect services to vCenter Server in your private cloud, those

connections will stop working once you rotate your password. Those connections will also lock out the
cloudadmin account unless you stop those services before rotating the password.

Prerequisites

Consider and determine which services connect to vCenter Server as cloudadmin@vsphere.local before you
rotate the password. These services may include VMware services such as HCX, vRealize Orchestrator, vRealize
Operations Manager, VMware Horizon, or other third-party tools used for monitoring or provisioning.

One way to determine which services authenticate to vCenter Server with the cloudadmin user is to inspect
vSphere events using the vSphere Client for your private cloud. After you identify such services, and before
rotating the password, you must stop these services. Otherwise, the services won't work after you rotate the
password. You'll also experience temporary locks on your vCenter Server CloudAdmin account, as these services
continuously attempt to authenticate using a cached version of the old credentials.

Instead of using the cloudadmin user to connect services to vCenter, we recommend individual accounts for
each service. For more information about setting up separate accounts for connected services, see Access and
Identity Concepts.

Reset your vCenter Server credentials

e Portal

e Azure CLI

1. In your Azure VMware Solution private cloud, select Identity.

2. Select Generate new password.
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3. Select the confirmation checkbox and then select Generate password.

Update HCX Connector

1. Go to the on-premises HCX Connector at https://{ip of the HCX connector appliance}:443 and sign in
using the new credentials.

Be sure to use port443.

2. On the VMware HCX Dashboard, select Site Pairing.
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3. Select the correct connection to Azure VMware Solution and select Edit Connection.

4. Provide the new vCenter Server user credentials and select Edit, which saves the credentials. Save should
show successful.

Next steps

Now that you've covered resetting your vCenter Server credentials for Azure VMware Solution, you may want to
learn about:

e Integrating Azure native services in Azure VMware Solution

e Deploying disaster recovery for Azure VMware Solution workloads using VMware HCX
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Save costs with Azure VMware Solution
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When you commit to a reserved instance of Azure VMware Solution, you save money. The reservation discount
automatically applies to the running Azure VMware Solution hosts that match the reservation scope and
attributes. In addition, a reserved instance purchase covers only the compute part of your usage and includes
software licensing costs.

Purchase restriction considerations

Reserved instances are available with some exceptions.
e Clouds - Reservations are available only in the regions listed on the Products available by region page.

e Insufficient quota - A reservation scoped to a single/shared subscription must have hosts quota
available in the subscription for the new reserved instance. You can create quota increase request to
resolve this issue.

e Offer eligibility- You'll need an Azure Enterprise Agreement (EA) with Microsoft.

e Capacity restrictions - In rare circumstances, Azure limits the purchase of new reservations for Azure
VMware Solution host SKUs because of low capacity in a region.

Buy a reservation

You can buy a reserved instance of an Azure VMware Solution host instance in the Azure portal.
You can pay for the reservation up front or with monthly payments.
These requirements apply to buying a reserved dedicated host instance:

e You must be in an Owner role for at least one EA subscription or a subscription with a pay-as-you-go
rate.

e For EA subscriptions, you must enable the Add Reserved Instances option in the EA portal. If disabled,
you must be an EA Admin for the subscription to enable it.

e For subscription under a Cloud Solution Provider (CSP) Azure Plan, the partner must purchase the
customer's reserved instances in the Azure portal.

Buy reserved instances for an EA subscription

1. Sign in to the Azure portal.
2. Select All services > Reservations.
3. Select Purchase Now and then select Azure VMware Solution.

4. Enter the required fields. The selected attributes that match running Azure VMware Solution hosts qualify
for the reservation discount. Attributes include the SKU, regions (where applicable), and scope.
Reservation scope selects where the reservation savings apply.

If you have an EA agreement, you can use the Add more option to add instances quickly. The option
isn't available for other subscription types.
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https://portal.azure.com/

FIELD DESCRIPTION

Subscription The subscription used to pay for the reservation. The
payment method on the subscription is charged the
costs for the reservation. The subscription type must be
an enterprise agreement (offer numbers: MS-AZR-0017P
or MS-AZR-0148P), Microsoft Customer Agreement, or
an individual subscription with pay-as-you-go rates
(offer numbers: MS-AZR-0003P or MS-AZR-0023P). The
charges are deducted from the Azure Prepayment
(previously called monetary commitment) balance, if
available, or charged as overage. For a subscription with
pay-as-you-go rates, the charges are billed to the
subscription’s credit card or an invoice payment method.

Scope The reservation's scope can cover one subscription or

multiple subscriptions (shared scope). If you select:

® Single resource group scope - Applies the
reservation discount to the matching resources in
the selected resource group only.

® Single subscription scope - Applies the
reservation discount to the matching resources in
the selected subscription.

® Shared scope - Applies the reservation discount
to matching resources in eligible subscriptions
that are in the billing context. For EA customers,
the billing context is the enrollment. Therefore,
the billing scope is all eligible subscriptions
created by the account administrator for
individual subscriptions with pay-as-you-go
rates.

® Management group - Applies the reservation
discount to the matching resource in the list of
subscriptions that are a part of both the
management group and billing scope.

Region The Azure region that's covered by the reservation. Host Size AV36 Term One year or three years.
Quantity The number of instances to purchase within the reservation. The quantity is the number of running
Azure VMware Solution hosts that can get the billing discount.

Buy reserved instances for a CSP subscription

CSPs that want to purchase reserved instances for their customers must use the Admin On Behalf Of (AOBO)
procedure from the Partner Center documentation. For more information, view the Admin on behalf of (AOBO)
video.

1. Sign in to Partner Center.
2. Select CSP to access the Customers area.

3. Expand customer details and select Microsoft Azure Management Portal.
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4. In the Azure portal, select All services > Reservations.

5. Select Purchase Now and then select Azure VMware Solution.
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Next: Review + buy

6. Enter the required fields. The selected attributes that match running Azure VMware Solution hosts qualify
for the reservation discount. Attributes include the SKU, regions (where applicable), and scope.
Reservation scope selects where the reservation savings apply.

FIELD DESCRIPTION

Subscription The subscription that funds the reservation. The
payment method on the subscription is charged the
costs for the reservation. The subscription type must be
an eligible one, which in this case is a CSP subscription
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FIELD DESCRIPTION

Scope The reservation's scope can cover one subscription or

multiple subscriptions (shared scope). If you select:

® Single resource group scope - Applies the
reservation discount to the matching resources in
the selected resource group only.

® Single subscription scope - Applies the
reservation discount to the matching resources in
the selected subscription.

® Shared scope - Applies the reservation discount
to matching resources in eligible subscriptions
that are in the billing context. For EA customers,
the billing context is the enrollment. Therefore,
the billing scope is all eligible subscriptions
created by the account administrator for
individual subscriptions with pay-as-you-go
rates.

® Management group - Applies the reservation
discount to the matching resource in the list of
subscriptions that are a part of both the
management group and billing scope.

Region The Azure region that's covered by the reservation. Host Size AV36 Term One year or three years.
Quantity The number of instances to purchase within the reservation. The quantity is the number of running
Azure VMware Solution hosts that can get the billing discount.

To learn more about viewing the purchased reservations for your customer, see View Azure reservations as a
Cloud Solution Provider (CSP) article.

Usage data and reservation usage

Your usage that gets a reservation discount has an effective price of zero. You can see which Azure VMware
Solution instance received the reservation discount for each reservation.

For more information about how reservation discounts appear in usage data:

e For EA customers, see Understand Azure reservation usage for your Enterprise enrollment

e For individual subscriptions, see Understand Azure reservation usage for your Pay-As-You-Go subscription

Change a reservation after purchase

You can make these changes to a reservation after purchase:
e Update reservation scope
e [nstance size flexibility (if applicable)

e Ownership

You can also split a reservation into smaller chunks or merge reservations. None of the changes cause a new
commercial transaction or change the end date of the reservation.

For details about CSP-managed reservations, see Sell Microsoft Azure reservations to customers using Partner
Center, the Azure portal, or APIs.
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NOTE

Once you've purchased your reservation, you won't be able to make these types of changes directly:

® An existing reservation’s region
e SKU
® Quantity

® Duration

However, you can exchange a reservation if you want to make changes.

Cancel, exchange, or refund reservations

You can cancel, exchange, or refund reservations with certain limitations. For more information, see Self-service
exchanges and refunds for Azure Reservations.

CSPs can cancel, exchange, or refund reservations, with certain limitations, purchased for their customer. For
more information, see Manage, cancel, exchange, or refund Microsoft Azure reservations for customers.

Next steps
Now that you've covered reserved instance of Azure VMware Solution, you may want to learn about:

e Creating an Azure VMware Solution assessment.
e Configure DHCP for Azure VMware Solution.

e Integrating Azure native services in Azure VMware Solution.


https://docs.microsoft.com/en-us/azure/cost-management-billing/reservations/exchange-and-refund-azure-reservations
https://docs.microsoft.com/en-us/partner-center/azure-reservations-manage

Operating system support for Azure VMware

Solution virtual machines

8/19/2022 - 2 minutes to read  Edit Online

Azure VMware Solution supports a wide range of operating systems to be used in the guest virtual machines.
Being based on VMware vSphere, currently 6.7 version, all operating systems currently supported by vSphere
can be used by any Azure VMware Solution customer for their workloads.

Check the list of operating systems and configurations supported in the VMware Compatibility Guide, create a
query for ESXi 6.7 Update 3 and select all operating systems and vendors.

Additionally to the supported operating systems by VMware for vSphere, we have worked with Red Hat, SUSE
and Canonical to extend the support model currently in place for Azure Virtual Machines to the workloads
running on Azure VMware Solution, given that it is a first-party Azure service. You can check the following sites
of vendors for more information about the benefits of running their operating system on Azure.

e Red Hat Enterprise Linux

e Ubuntu Server

e SUSE Enterprise Linux Server


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/ecosystem-os-vms.md
https://www.vmware.com/resources/compatibility/search.php?deviceCategory=software
https://access.redhat.com/ecosystem/microsoft-azure
https://ubuntu.com/azure
https://www.suse.com/partners/alliance/microsoft/

Backup solutions for Azure VMware Solution virtual

machines (VMs)
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A key principle of Azure VMware Solution is to enable you to continue to use your investments and your
favorite VMware solutions running on Azure. Independent software vendor (ISV) technology support, validated
with Azure VMware Solution, is an important part of this strategy.

Our backup partners have industry-leading backup and restore solutions in VMware-based environments.
Customers have widely adopted these solutions for their on-premises deployments. Now these partners have
extended their solutions to Azure VMware Solution, using Azure to provide a backup repository and a storage
target for long-term retention and archival.

Back up network traffic between Azure VMware Solution VMs and the backup repository in Azure travels over a
high-bandwidth, low-latency link. Replication traffic across regions travels over the internal Azure backplane
network, which lowers bandwidth costs for users.

NOTE

For common questions, see our third-party backup solution FAQ.

You can find more information on these backup solutions here:

e (Cohesity

e Commvault

e Dell Technologies
e Rubrik

® \eeam

e \leritas


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/ecosystem-back-up-vms.md
https://www.cohesity.com/blogs/expanding-cohesitys-support-for-microsofts-ecosystem-azure-stack-and-azure-vmware-solution/
https://documentation.commvault.com/11.21/essential/128997_support_for_azure_vmware_solution.html
https://www.delltechnologies.com/resources/en-us/asset/briefs-handouts/solutions/dell-emc-data-protection-for-avs.pdf
https://www.rubrik.com/en/products/cloud-data-management
https://www.veeam.com/kb4012
https://vrt.as/nb4avs

Disaster recovery solutions for Azure VMware

Solution virtual machines (VMs)
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One of the most important aspects of any Azure VMware Solution deployment is disaster recovery, which can
be achieved by creating disaster recovery plans between different Azure VMware Solution regions or between
Azure and an on-premises vSphere environment.

We currently offer customers the possibility to implement their disaster recovery plans using state-of-the-art
VMware solution like SRM or HCX.

Following our principle of giving customers the choice to apply their investments in skills and technology we've
collaborated with some of the leading partners in the industry.

You can find more information about their solutions in the links below:

e Jetstream
e Zerto

o RiverMeadow


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/ecosystem-disaster-recovery-vms.md
https://www.jetstreamsoft.com/2020/09/28/solution-brief-disaster-recovery-for-avs/
https://www.zerto.com/solutions/use-cases/disaster-recovery/
https://www.rivermeadow.com/disaster-recovery-azure-blob

Migration solutions for Azure VMware Solution

virtual machines (VMs)
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One of the most common use cases for using Azure VMware Solution is data center evacuation. It allows you to
continue to maximize your VMware investments, because Azure VMware Solution will always be up to date.
Additionally, you can enhance your workloads with the full range of native Azure services. An initial key step in
this process is the migration of your legacy VMware-based environment onto Azure VMware Solution.

Our migration partners have industry-leading migration solutions in VMware-based environments. Customers
around the world have used these solutions for their migrations to both Azure and Azure VMware Solution.

You aren't required to use VMware HCX as a migration tool, which means you can also migrate physical
workloads into Azure VMware Solution. Additionally, migrations to your Azure VMware Solution environment
don't need an ExpressRoute connection if it's not available within your source environment. Migrations can be
done to multiple locations if you decide to host those workloads in multiple Azure regions.

You can find more information on these migration solutions here:

e RiverMeadow.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/ecosystem-migration-vms.md
https://www.rivermeadow.com/migrating-to-vmware-on-azure

Security solutions for Azure VMware Solution
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A fundamental part of Azure VMware Solution is security. It allows customers to run their VMware-based
workloads in a safe and trustable environment.

Our security partners have industry-leading solutions in VMware-based environments that cover many aspects
of the security ecosystem like threat protection and security scanning. Our customers have adopted many of
these solutions integrated with VMware NSX-T Data Center for their on-premises deployments. As one of our
key principles, we want to enable them to continue to use their investments and VMware solutions running on

Azure. Many of these Independent Software Vendors (ISV) have validated their solutions with Azure VMware
Solution.

You can find more information about these solutions here:

e Bitdefender
e Trend Micro Deep Security
e Check Point


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/ecosystem-security-solutions.md
https://businessinsights.bitdefender.com/expanding-security-support-for-azure-vmware-solution
https://www.trendmicro.com/en_us/business/products/hybrid-cloud/deep-security.html
https://www.checkpoint.com/cloudguard/cloud-network-security/iaas-public-cloud-security/

Application performance monitoring and
troubleshooting solutions for Azure VMware

Solution
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A key objective of Azure VMware Solution is to maintain the performance and security of applications and
services across VMware on Azure and on-premises. Getting there requires visibility into complex infrastructures
and quickly pinpointing the root cause of service disruptions across the hybrid cloud.

Microsoft solutions

Microsoft recommends Application Insights, a feature of Azure Monitor, to maximize the availability and
performance of your applications and services.

Learn how modern monitoring with Azure Monitor can transform your business by reviewing the product
overview, features, getting started guide and more.

Third-party solutions

Our application performance monitoring and troubleshooting partners have industry-leading solutions in
VMware-based environments that assure the availability, reliability, and responsiveness of applications and
services. Our customers have adopted many of these solutions integrated with VMware NSX-T Data Center for
their on-premises deployments. As one of our key principles, we want to enable them to continue to use their
investments and VMware solutions running on Azure. Many of these Independent Software Vendors (ISV) have
validated their solutions with Azure VMware Solution.

You can find more information about these solutions here:

e NETSCOUT

e Turbonomic


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/ecosystem-app-monitoring-solutions.md
https://docs.microsoft.com/en-us/azure/azure-monitor/app/app-insights-overview
https://docs.microsoft.com/en-us/azure/azure-monitor/overview
https://azure.microsoft.com/services/monitor
https://www.netscout.com/technology-partners/microsoft-azure
https://blog.turbonomic.com/turbonomic-announces-partnership-and-support-for-azure-vmware-service

Bitnami appliance deployment
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Bitnami by VMware provides a rich catalog of turnkey virtual appliances. You can deploy any vSphere
compatible appliance by Bitnami available in the VMware Marketplace, including many of the most common
open-source software projects.

In this article, you'll learn how to install and configure the following virtual appliances packaged by Bitnami on
your Azure VMware Solution private cloud:

e LAMP
e Jenkins
e PostgreSQL
e NGINX

e RabbitMQ

Prerequisites
e Azure VMware Solution private cloud deployed with a minimum of three nodes.

e Networking configured as described in Network planning checklist.

Step 1. Download the Bitnami virtual appliance OVA/OVF file

1. Go to the VMware Marketplace and download the virtual appliance you want to install on your Azure
VMware Solution private cloud:

e LAMP virtual appliance packaged by Bitnami
e Jenkins

e PostgreSQL

e NGINX

e RabbitMQ

2. Select the version, select Download, and then accept the EULA license.

NOTE

Make sure the file is accessible from the virtual machine.

Step 2. Access the local vCenter Server of your private cloud

1. Sign in to the Azure portal, select your private cloud, and then Manage > Identity.

2. Copy the vCenter Server URL, username, and password. You'll use them to access your virtual machine
(VM).

3. Select Overview, select the VM, and then connect to it through RDP. If you need help with connecting,


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/bitnami-appliances-deployment.md
https://marketplace.cloud.vmware.com/
https://marketplace.cloud.vmware.com/
https://marketplace.cloud.vmware.com/services/details/lampstack?slug=true
https://marketplace.cloud.vmware.com/services/details/jenkins?slug=true
https://marketplace.cloud.vmware.com/services/details/postgresql?slug=true
https://marketplace.cloud.vmware.com/services/details/nginxstack?slug=true
https://marketplace.cloud.vmware.com/services/details/rabbitmq?slug=true
https://portal.azure.com

4.

5.

see connect to a virtual machine for details.
In the VM, open a browser and navigate to the vCenter URL.

Sign in with the cloudadmin@vsphere.local user credentials you copied earlier.

B &8 3 Lgin x| VMware NSX | Login + v = o

&« QO @ https://10.210.0.2/websso/SAML2/SSO/vmcp local ?'SAMLRequest=2VRPbSswFL%2FvUyDfweDQplGaVFmzapHaNSvZNOOyOealsQQ28zC =4 = 4L =

VMware® vSphere

cloudadmin@vsphere local

Step 3. Install the Bitnami OVA/OVF file in vCenter Server

1.

10.

11.

12.

13.

Right-click the cluster that you want to install the LAMP virtual appliance and select Deploy OVF
Template.

. Select Local file and navigate to the OVF file you downloaded earlier. Then select Next.

. Select your data center and provide a name for your virtual appliance VM, for example, bitnami-

lampstack. Then select Next.

. Select the ESXi host as the compute resource to run your VM and then select Next.
. Review the details and select Next.

. Accept the license agreement and select Next.

. Select the storage for your VM and select Next.

. Select the destination network for your VM and select Next.

. Provide the required information to customize the template, such as the VM and networking properties.

Then select Next.
Review the configuration settings and then select Finish.

From the Task Console, verify that the status of the OVF template deployment has completed
successfully.

After the installation finishes, under Actions, select Power on to turn on the appliance.

From the vCenter Server console, select Launch Web Console and sign in to the Bitnami virtual
appliance. Check the Bitnami virtual appliance support documentation for the default username and

password.



file:///C:/localrun/t/1pp1/gn1d/azure/virtual-machines/windows/connect-logon.html#connect-to-the-virtual-machine
https://docs.bitnami.com/vmware-marketplace/faq/get-started/find-credentials/

NOTE

You can change the default password to a more secure one. For more information, see ...

Step 4. Assign a static IP to the virtual appliance

In this step, you'll modify the bootproto and onboot parameters and assign a static IP address to the Bitnami

virtual appliance.

1. Search for the network configuration file.
sudo find /etc -name \*ens160\*

2. Edit the /fetc/sysconfig/network-scripts/ifcfg-ens 160 file and modify the boot parameters. Then add the
static IP netmask, and gateway addresses.

e bootproto=static
e onboot=yes

3. View and confirm the changes to the ifcfg-ens160 file.
cat ifcfg-ensl60

4. Restart the networking service. This stops the networking services first and then applies the IP
configuration.

sudo systemctl restart network

5. Ping the gateway IP address to verify the configuration and VM connectivity to the network.

6. Confirm that the default route 0.0.0.0 is listed.

sudo route -n

Step 5. Enable SSH access to the virtual appliance

In this step, you'll enable SSH on your virtual appliance for remote access control. The SSH service is disabled by
default. You'll also use PuTTy to connect to the host console.

1. Enable and start the SSH service.

sudo rm /etc/ssh/sshd_not_to_be_run
sudo systemctl enable sshd
sudo systemctl start sshd

2. Edit the /fetc/ssh/sshd_configfile to change the password authentication.
PasswordAuthentication yes

3. View and confirm the changes to the sshd_config file.



sudo cat sshd_config
4. Reload the changes made to the file.
sudo /etc/init.d/ssh force-reload

5. Open PuUTTY, select the SSH option and provide the host name and *22 for the port. Then select Open.

6. At the virtual appliance console prompt, enter the Bitnami username and password to connect to the
host.



Create a HCX network extension
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This is an optional step to extend any networks from your on-premises environment to Azure VMware Solution.

1. Under Services, select Network Extension > Create a Network Extension.

vm  vSphere Client

HeX
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~ Infrastructure

< V1 > HCX services are using trial period limits. Activate HCX to remove the limits. ]
Pairing

& Interconnect

overy
~ System
& Administration

@ support You have not created a Network Extension

CREATE A NETWORK EXTENSION

What is a Net:

2. Select each of the networks you want to extend to Azure VMware Solution, and then select Next.

Extend Networks select source networks for extension to remote site

Select Service Mesh: ServiceMesh: hcxmanager-enterprise - TNT51-HCX-MGR-cloud

 Tide Withort vi= €9 B — .
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3. Enter the on-premises gateway IP for each of the networks you're extending, and then select Submit.

Extend Networks select source networks for extension to remote site

Service Mesh: ServiceMesh : [ hcxmanager-enterprise g TNTS1-HCX-MGR-cloud

Destination First Hop Router TNT51-T1

1. Source Network to Extend: Workloads-PG

Gateway IP Address Extension Appliance

10.254.200.1/24|

ServiceMesh-NE-I1 (O of 8 extensions)

> Settings - optional

It takes a few minutes for the network extension to finish. When it does, you see the status change to
Extension complete.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-hcx-network-extension.md
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/tutorial-vmware-hcx/create-network-extension.png#lightbox
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Next steps

Now that you've configured the HCX Network Extension, you can also learn about:

e VMware HCX Mobility Optimized Networking (MON) guidance



HCX Network extension high availability (HA)
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VMware HCX is an application mobility platform that's designed to simplify application migration, workload
rebalancing, and business continuity across data centers and clouds.

The HCX Network Extension service provides layer 2 connectivity between sites. Network Extension HA protects
extended networks from a Network Extension appliance failure at either the source or remote site.

HCX 4.3.0 or later allows network extension high availability. Network Extension HA operates in Active/Standby
mode. In this article, you'll learn how to configure HCX network extension High Availability on Azure private
cloud.

Prerequisites

The Network Extension High Availability (HA) setup requires four Network Extension appliances, with two
appliances at the source site and two appliances at the remote site. Together, these two pairs form the HA Group,
which is the mechanism for managing Network Extension High Availability. Appliances on the same site require
a similar configuration and must have access to the same set of resources.

e Network Extension HA requires an HCX Enterprise license.

e In the HCX Compute Profile, the Network Extension Appliance Limit is set to allow for the number of Network
Extension appliances. The Azure VMware Solutions Limit is automatically set to unlimited.

e |n the HCX Service Mesh, the Network Extension Appliance Scale Out Appliance Count is set to provide
enough appliances to support network extension objectives, including any Network Extension HA groups.

When you create a service mesh, set the appliance count to a minimum of two. For an existing service mesh,
you can edit and adjust the appliance count to provide the required appliance count.

e The Network Extension appliances selected for HA activation must have no networks extended over them.
e Only Network Extension appliances upgraded to HCX 4.3.0 or later can be added to HA Groups.

e Learn more about the Network Extension High Availability feature, prerequisites, considerations and
limitations.

Activate high availability (HA)
Use the following steps to activate HA, create HA groups, and view the HA roles and options available.
1. Sign in to HCX Manager Ul in one of two ways:

a. cloudadmin@vsphere.local.
b. HCX Ul through vCenter HCX Plugin.

2. Navigate to Infrastructure, then Interconnect.
3. SelectService Mesh, then select View Appliances.
4. Select Appliances from the Interconnect tab options.

a. Check the network appliance that you want to make highly available and select Activate High
Availability.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/configure-hcx-network-extension-high-availability.md
https://docs.vmware.com/en/VMware-HCX/4.3/hcx-user-guide/GUID-E1353511-697A-44B0-82A0-852DB55F97D7.html?msclkid=1fcacda4c4dd11ecae41f8715a8d8ded
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. Select HA Management from the Interconnect tab options to view the HA group details and the

available options: Manual failover, Deactivate, Redeploy, and Force Sync.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hcx/appliances-activate-high-availability.png#lightbox
file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hcx/high-availability-group-active-standby-roles.png#lightbox
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Extend network using network HA group

1. Locate Services in the left navigation and select Network Extension.
2. Select Create a Network Extension.
3. Choose the Network you want and select Next.

4. In mandatory fields, provide the gateway IP address in CIDR format, select the HA group under
Extension Appliances (this was created in the previous step), and select Submit to extend the Network.

5. After the network is extended, under Extension Appliance, you can see the extension details and HA

group.
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6. To migrate virtual machines (VMs), navigate to Services and select Migration.

a. Select Migrate from the Migration window to start the workload mobility wizard.

7. InWorkload Mobility, add and replace details as needed, then select Validate.

8. After validation completes, select Go to start the migration using Extended Network.


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hcx/high-availability-management-group-details-available-options.png#lightbox
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Next steps

Now that you've learned how to configure and extend HCX network extension high availability (HA), use the

following resource to learn more about how to manage HCX network extension HA.

Managing Network Extension High Availability


file:///C:/localrun/t/1pp1/gn1d/azure/azure-vmware/media/hcx/extend-network-migrate-process.png#lightbox
https://docs.vmware.com/en/VMware-HCX/4.3/hcx-user-guide/GUID-4A745694-5E32-4E87-92D2-AC1191170412.html

Configure vRealize Operations for Azure VMware

Solution

8/19/2022 - 3 minutes to read  Edit Online

vRealize Operations is an operations management platform that allows VMware infrastructure administrators to
monitor system resources. These system resources could be application-level or infrastructure level (both
physical and virtual) objects. Most VMware administrators have used vRealize Operations to monitor and
manage the VMware private cloud components — vCenter Server, ESXi, NSX-T Data Center, vSAN, and VMware
HCX. Each provisioned Azure VMware Solution private cloud includes a dedicated vCenter Server, NSX-T Data
Center, vSAN, and HCX deployment.

Thoroughly review Before you begin and Prerequisites first. Then, we'll walk you through the two typical
deployment topologies:

e On-premises vRealize Operations managing Azure VMware Solution deployment

e vRealize Operations running on Azure VMware Solution deployment

Before you begin

e Review the vRealize Operations Manager product documentation to learn more about deploying vRealize
Operations.

® Review the basic Azure VMware Solution Software-Defined Datacenter (SDDC) tutorial series.

e Optionally, review the vRealize Operations Remote Controller product documentation for the on-premises
vRealize Operations managing Azure VMware Solution deployment option.

Prerequisites

e vRealize Operations Manager installed.
e A VPN or an Azure ExpressRoute configured between on-premises and Azure VMware Solution SDDC.

e An Azure VMware Solution private cloud has been deployed in Azure.

On-premises vRealize Operations managing Azure VMware Solution
deployment
Most customers have an existing on-premises deployment of vRealize Operations to manage one or more on-

premises vCenter Server domains. When they provision an Azure VMware Solution private cloud, they connect
their on-premises environment with their private cloud using an Azure ExpressRoute or a Layer 3 VPN solution.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/vrealize-operations-for-azure-vmware-solution.md
https://docs.vmware.com/en/vRealize-Operations-Manager/8.1/com.vmware.vcom.vapp.doc/GUID-7FFC61A0-7562-465C-A0DC-46D092533984.html
https://docs.vmware.com/en/vRealize-Operations-Manager/8.1/com.vmware.vcom.vapp.doc/GUID-263F9219-E801-4383-8A59-E84F3D01ED6B.html
https://docs.vmware.com/en/vRealize-Operations-Manager/8.1/com.vmware.vcom.vapp.doc/GUID-7FFC61A0-7562-465C-A0DC-46D092533984.html
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To extend the vRealize Operations capabilities to the Azure VMware Solution private cloud, you create an
adapter instance for the private cloud resources. It collects data from the Azure VMware Solution private cloud
and brings it into on-premises vRealize Operations. The on-premises vRealize Operations Manager instance can
directly connect to the vCenter Server and NSX-T Manager on Azure VMware Solution. Optionally, you can
deploy a vRealize Operations Remote Collector on the Azure VMware Solution private cloud. The collector
compresses and encrypts the data collected from the private cloud before it's sent over the ExpressRoute or VPN
network to the vRealize Operations Manager running on-premise.

TIP

Refer to the VMware documentation for step-by-step guide for installing vRealize Operations Manager.

vRealize Operations running on Azure VMware Solution deployment

Another option is to deploy an instance of vRealize Operations Manager on a vSphere cluster in the private
cloud.

IMPORTANT

This option isn't currently supported by VMware.
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https://docs.vmware.com/en/vRealize-Operations-Manager/8.1/com.vmware.vcom.config.doc/GUID-640AD750-301E-4D36-8293-1BFEB67E2600.html
https://docs.vmware.com/en/vRealize-Operations-Manager/8.1/com.vmware.vcom.vapp.doc/GUID-7FFC61A0-7562-465C-A0DC-46D092533984.html

Once the instance has been deployed, you can configure vRealize Operations to collect data from vCenter
Server, ESXi, NSX-T Data Center, vSAN, and HCX.

Known limitations

e The cloudadmin@vsphere.local user in Azure VMware Solution has limited privileges. Virtual machines
(VMs) on Azure VMware Solution doesn't support in-guest memory collection using VMware tools. Active
and consumed memory utilization continues to work in this case.

e Workload optimization for host-based business intent doesn't work because Azure VMware Solutions
manage cluster configurations, including DRS settings.

e Workload optimization for the cross-cluster placement within the SDDC using the cluster-based business
intent is fully supported with vRealize Operations Manager 8.0 and onwards. However, workload
optimization isn't aware of resource pools and places the VMs at the cluster level. A user can manually
correct it in the Azure VMware Solution vCenter Server interface.

e You can't sign in to vRealize Operations Manager using your Azure VMware Solution vCenter Server
credentials.

e Azure VMware Solution doesn't support the vRealize Operations Manager plugin.

When you connect the Azure VMware Solution vCenter to vRealize Operations Manager using a vCenter Server
Cloud Account, you'll see a warning:

Warning

ation succeeded, but vCenter Server

The warning occurs because the cloudadmin@vsphere.local user in Azure VMware Solution doesn't have
sufficient privileges to do all vCenter Server actions required for registration. However, the privileges are
sufficient for the adapter instance to do data collection, as seen below:

Mame Adapter Type Object Type Collection State Collection Status

VC-avs vCenter Adapter viCenter Server o &

For more information, see Privileges Required for Configuring a vCenter Server Adapter Instance.


https://docs.vmware.com/en/vRealize-Operations-Manager/8.1/com.vmware.vcom.core.doc/GUID-3BFFC92A-9902-4CF2-945E-EA453733B426.html

Deploy Horizon on Azure VMware Solution

8/19/2022 + 11 minutes to read « Edit Online

NOTE

This document focuses on the VMware Horizon product, formerly known as Horizon 7. Horizon is a different solution than
Horizon Cloud on Azure, although there are some shared components. Key advantages of the Azure VMware Solution
include both a more straightforward sizing method and the integration of VMware Cloud Foundation management into
the Azure portal.

VMware Horizon(®), a virtual desktop and applications platform, runs in the data center and provides simple
and centralized management. It delivers virtual desktops and applications on any device, anywhere. Horizon lets
you create, and broker connections to Windows and Linux virtual desktops, Remote Desktop Server (RDS)
hosted applications, desktops, and physical machines.

Here, we focus specifically on deploying Horizon on Azure VMware Solution. For general information on
VMware Horizon, refer to the Horizon production documentation:

e What is VMware Horizon?
e [earn more about VMware Horizon

o Horizon Reference Architecture

With Horizon's introduction on Azure VMware Solution, there are now two Virtual Desktop Infrastructure (VDI)
solutions on the Azure platform. The following diagram summarizes the key differences at a high level.

Differences between VMware Horizon on Azure VMware
Solution and VMware Horizon Cloud on Azure

Horizon on AVS (laaS Model) Horizon Cloud Azure (DaaS Model)

RDSH Farms Desktop Pools

RDSH Desktop

RDSH Farms Desktop Pools

Tenant RDSH Desktop
Self-managed Se‘gr;e:‘;‘f;tged RDSH

Horizon

Horizon Cloud

vSphere)
Azure
Managed Service ManagEd SEWice

* Customer managed ¢ DaaS, supports Azure Windows Virtual Desktop
e VMware SDDC (enables Instant Clone, vMotion, Content * Uses native Azure instances - no vSphere
Library, etc.) ¢ Different architecture as on-premises Horizon

Azure AVS (with VMware

» Same Horizon architecture and features as on-premises

Horizon 2006 and later versions on the Horizon 8 release line supports both on-premises and Azure VMware
Solution deployment. There are a few Horizon features that are supported on-premises but not on Azure
VMware Solution. Other products in the Horizon ecosystem are also supported. For more information, see
feature parity and interoperability.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/azure-vmware-solution-horizon.md
https://www.vmware.com/products/horizon.html
https://www.vmware.com/products/horizon.html
https://docs.vmware.com/en/VMware-Horizon/index.html
https://techzone.vmware.com/resource/workspace-one-and-horizon-reference-architecture
https://kb.vmware.com/s/article/80850

Deploy Horizon in a hybrid cloud

You can deploy Horizon in a hybrid cloud environment by using Horizon Cloud Pod Architecture (CPA) to
interconnect on-premises and Azure data centers. CPA scales up your deployment, builds a hybrid cloud, and
provides redundancy for Business Continuity and Disaster Recovery. For more information, see Expanding
Existing Horizon 7 Environments.

IMPORTANT

CPA is not a stretched deployment; each Horizon pod is distinct, and all Connection Servers that belong to each of the
individual pods are required to be located in a single location and run on the same broadcast domain from a network

perspective.

Like on-premises or private data centers, you can deploy Horizon in an Azure VMware Solution private cloud.
We'll discuss key differences in deploying Horizon on-premises and Azure VMware Solution in the following
sections.

The Azure private cloudis conceptually the same as the VMware SDDC, a term typically used in Horizon
documentation. The rest of this document uses both terms interchangeably.

The Horizon Cloud Connector is required for Horizon on Azure VMware Solution to manage subscription
licenses. You can deploy Cloud Connector in Azure Virtual Network alongside Horizon Connection Servers.

IMPORTANT

Horizon Control Plane support for Horizon on Azure VMware Solution is not yet available. Be sure to download the VHD
version of Horizon Cloud Connector.

vCenter Server Cloud Admin role

Since Azure VMware Solution is an SDDC service and Azure manages the lifecycle of the SDDC on Azure

VMware Solution, the vCenter Server permission model on Azure VMware Solution is limited by design.

Customers are required to use the Cloud Admin role, which has a limited set of vCenter Server permissions. The
Horizon product was modified to work with the Cloud Admin role on Azure VMware Solution, specifically:

e |nstant clone provisioning was modified to run on Azure VMware Solution.

e A specific vSAN policy (VMware_Horizon) was created on Azure VMware Solution to work with Horizon,
which must be available and used in the SDDCs deployed for Horizon.

e vSphere Content-Based Read Cache (CBRC), also known as View Storage Accelerator, is disabled when

running on the Azure VMware Solution.

IMPORTANT
CBRC must not be turned back on.

NOTE

Azure VMware Solution automatically configures specific Horizon settings as long as you deploy Horizon 2006 (aka
Horizon 8) and above on the Horizon 8 branch and select the Azure option in the Horizon Connection Server installer.



https://techzone.vmware.com/resource/business-continuity-vmware-horizon#_Toc41650874

Horizon on Azure VMware Solution deployment architecture

A typical Horizon architecture design uses a pod and block strategy. A block is a single vCenter Server, while
multiple blocks combined make a pod. A Horizon pod is a unit of organization determined by Horizon scalability

limits. Each Horizon pod has a separate management portal, and so a standard design practice is to minimize
the number of pods.

Every cloud has its own network connectivity scheme. Combined with VMware SDDC networking / NSX-T Data
Center, the Azure VMware Solution network connectivity presents unique requirements for deploying Horizon
that is different from on-premises.

Each Azure private cloud and SDDC can handle 4,000 desktop or application sessions, assuming:
e The workload traffic aligns with the LoginVSI task worker profile.
e Only protocol traffic is considered, no user data.

e NSXEdge is configured to be large.

NOTE

Your workload profile and needs may be different, and therefore results may vary based on your use case. User Data
volumes may lower scale limits in the context of your workload. Size and plan your deployment accordingly. For more

information, see the sizing guidelines in the Size Azure VMware Solution hosts for Horizon deployments section.

Given the Azure private cloud and SDDC max limit, we recommend a deployment architecture where the
Horizon Connection Servers and VMware Unified Access Gateways (UAGs) are running inside the Azure Virtual
Network. It effectively turns each Azure private cloud and SDDC into a block. In turn, maximizing the scalability
of Horizon running on Azure VMware Solution.

The connection from Azure Virtual Network to the Azure private clouds / SDDCs should be configured with
ExpressRoute FastPath. The following diagram shows a basic Horizon pod deployment.
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Network connectivity to scale Horizon on Azure VMware Solution

This section lays out the network architecture at a high level with some common deployment examples to help
you scale Horizon on Azure VMware Solution. The focus is specifically on critical networking elements.

Single Horizon pod on Azure VMware Solution
Region 1- US East

Horizon POD 1

sUbnetl Dnets

UAG

Desktop = SKTOf Deasktop
Apps s/ Apps s/ Apps
AWS PCT AVS PC2 ANS PC3
/ 5DDCI / SDDC2 / SDDC3

A single Horizon pod is the most straight forward deployment scenario because you deploy just one Horizon
pod in the US East region. Since each private cloud and SDDC is estimated to handle 4,000 desktop sessions,
you deploy the maximum Horizon pod size. You can plan the deployment of up to three private clouds/SDDCs.

With the Horizon infrastructure virtual machines (VMs) deployed in Azure Virtual Network, you can reach the
12,000 sessions per Horizon pod. The connection between each private cloud and SDDC to the Azure Virtual
Network is ExpressRoute Fast Path. No east-west traffic between private clouds is needed.

Key assumptions for this basic deployment example include that:

e You don't have an on-premises Horizon pod that you want to connect to this new pod using Cloud Pod
Architecture (CPA).

e End users connect to their virtual desktops through the internet (vs. connecting via an on-premises
datacenter).

You connect your AD domain controller in Azure Virtual Network with your on-premises AD through VPN or
ExpressRoute circuit.

A variation on the basic example might be to support connectivity for on-premises resources. For example,
users access desktops and generate virtual desktop application traffic or connect to an on-premises Horizon pod
using CPA.

The diagram shows how to support connectivity for on-premises resources. To connect to your corporate
network to the Azure Virtual Network, you'll need an ExpressRoute circuit. You'll also need to connect your
corporate network with each of the private cloud and SDDCs using ExpressRoute Global Reach. It allows the
connectivity from the SDDC to the ExpressRoute circuit and on-premises resources.
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Multiple Horizon pods on Azure VMware Solution across multiple regions

Another scenario is scaling Horizon across multiple pods. In this scenario, you deploy two Horizon pods in two
different regions and federate them using CPA. It's similar to the network configuration in the previous example,
but with some additional cross-regional links.

You'll connect the Azure Virtual Network in each region to the private clouds/SDDCs in the other region. It
allows Horizon connection servers part of the CPA federation to connect to all desktops under management.
Adding extra private clouds/SDDCs to this configuration would allow you to scale to 24,000 sessions overall.

The same principles apply if you deploy two Horizon pods in the same region. Make sure to deploy the second
Horizon pod in a separate Azure Virtual Network. Just like the single pod example, you can connect your
corporate network and on-premises pod to this multi-pod/region example using ExpressRoute and Global
Reach.
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Size Azure VMware Solution hosts for Horizon deployments

Horizon's sizing methodology on a host running in Azure VMware Solution is simpler than Horizon on-
premises. That's because the Azure VMware Solution host is standardized. Exact host sizing helps determine the

number of hosts needed to support your VDI requirements. It's central to determining the cost-per-desktop.

Sizing tables

Specific vCPU/VRAM requirements for Horizon virtual desktops depend on the customer’s specific workload
profile. Work with your MSFT and VMware sales team to help determine your vCPU/VRAM requirements for

your virtual desktops.
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orizon sizing inputs

Here's what you'll need to gather for your planned workload:

Number of concurrent desktops
Required vCPU per desktop
Required VRAM per desktop

Required storage per desktop

In general, VDI deployments are either CPU or RAM constrained, which determines the host size. Let's take the

following example for a LoginVSI Knowledge Worker type of workload, validated with performance testing:

2,000 concurrent desktop deployment
2vCPU per desktop.
4-GB vRAM per desktop.

50 GB of storage per desktop

For this example, the total number of hosts factors out to 18, yielding a VM-per-host density of 111.

64
00

(%]

IMPORTANT
Customer workloads will vary from this example of a LoginVSI Knowledge Worker. As a part of planning your deployment,
work with your VMware EUC SEs for your specific sizing and performance needs. Be sure to run your own performance

testing using the actual, planned workload before finalizing host sizing and adjust accordingly.

Horizon on Azure VMware Solution licensing

There are four components to the overall costs of running Horizon on Azure VMware Solution.

Azure VMware Solution Capacity Cost

For information on the pricing, see the Azure VMware Solution pricing page



https://azure.microsoft.com/pricing/details/azure-vmware/

Horizon Licensing Cost

There are two available licenses for use with the Azure VMware Solution, which can be either Concurrent User
(CCU) or Named User (NU):

e Horizon Subscription License
e Horizon Universal Subscription License

If only deploying Horizon on Azure VMware Solution for the foreseeable future, then use the Horizon

Subscription License as it is a lower cost.

If deployed on Azure VMware Solution and on-premises, choose the Horizon Universal Subscription License as a
disaster recovery use case. However, it includes a vSphere license for on-premises deployment, so it has a

higher cost.
Work with your VMware EUC sales team to determine the Horizon licensing cost based on your needs.

Azure Instance Types

To understand the Azure virtual machine sizes that are required for the Horizon Infrastructure, see Horizon

Installation on Azure VMware Solution.

References

System Requirements For Horizon Agent for Linux

Next steps

To learn more about VMware Horizon on Azure VMware Solution, read the VMware Horizon FAQ.


https://techzone.vmware.com/resource/horizon-on-azure-vmware-solution-configuration#horizon-installation-on-azure-vmware-solution
https://docs.vmware.com/en/VMware-Horizon/2012/linux-desktops-setup/GUID-E268BDBF-1D89-492B-8563-88936FD6607A.html
https://www.vmware.com/content/dam/digitalmarketing/vmware/en/pdf/products/horizon/vmw-horizon-on-microsoft-azure-vmware-solution-faq.pdf
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A content library stores and manages content in the form of library items. A single library item consists of files
you use to deploy virtual machines (VMs).

In this article, you'll create a content library in the vSphere Client and then deploy a VM using an ISO image

from the content library.

Prerequisites

An NSX-T Data Center segment and a managed DHCP service are required to complete this tutorial. For more
information, see Configure DHCP for Azure VMware Solution.

Create a content library

1. From the on-premises vSphere Client, select Menu > Content Libraries.

vm  vSphere Client
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2. Select Add to create a new content library.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/deploy-vm-content-library.md

vm vSphere Client
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3. Provide a name and confirm the IP address of the vCenter Server and select Next.

New Content Library

1 Name and location Name and location

2 Configure content library Specify content library name and location.

32 Add storage

4 Ready to complete
Name: AVSV-Library] x|
MNotes:
vCenter Server: 10.61.0.2

CANCEL NEXT

4. Select the Local content library and select Next.



New Content Library

+ 1Name and location Configure content library

2 Configure content library Local libraries can be published externally and optimized for syncing over HTTP. Subscribed

3 Add storage libraries originate from other published libraries.

4 Ready to complete
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|

O subscribed content library

CANCEL BACK NEXT

5. Select the datastore for storing your content library, and then select Next.

New Content Library

+ 1 Name and location Add storage

+ 2 Configure content library Select a storage location for the library contents. Use a file system backing for published

i¥4 3 Add storage content libraries to store the uploaded OVF packages. Use a datastore backing for local and

4 Ready to complete subscribed content libraries to store content optimized for cloning.
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1items

CAMNCEL BACK

6. Review the content library settings and select Finish.



New Content Library
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+ 3 Add storage
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MName: AVSV-Library

Notes:

vCenter Server: 10.61.02

Type: Local Content Library
Published: No

Storage: vsanDatastore

CANCEL BACK FINISH

Upload an ISO image to the content library
Now that you've created the content library, you can add an ISO image to deploy a VM to a private cloud cluster.
1. From the vSphere Client, select Menu > Content Libraries.
2. Right-click the content library you want to use for the new ISO and select Import Item.
3. Import a library item for the Source by doing one of the following, and then select Import:
a. Select URL and provide a URL to download an ISO.

b. Select Local File to upload from your local system.

TIP

Optional, you can define a custom item name and notes for the Destination.

4. Open the library and select the Other Types tab to verify that your ISO was uploaded successfully.

Deploy a VM to a private cloud cluster

1. From the vSphere Client, select Menu > Hosts and Clusters.

2. In the left panel, expand the tree and select a cluster.

3. Select Actions > New Virtual Machine.

4. Go through the wizard and modify the settings you want.

5. Select New CD/DVD Drive > Client Device > Content Library ISO File.
6. Select the ISO uploaded in the previous section and then select OK.

7. Select the Connect check box so the ISO is mounted at power-on time.

8. Select New Network > Select dropdown > Browse.

9. Select the logical switch (segment) and select OK.



10. Modify any other hardware settings and select Next.

11. Verify the settings and select Finish.

Next steps

Now that you've created a content library to deploy VMs in Azure VMware Solution, you may want to learn
about:

e Migrating VM workloads to your private cloud

o Integrating Azure native services in Azure VMware Solution
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In this article, you'll learn how to perform HCX migration over a Public IP address using Azure VMware Solution.

IMPORTANT

Before configuring a Public IP on your Azure VMware Solution private cloud, please consult your Network Administrator

to understand the implications and the impact to your environment.

You'll also learn how to pair HCX sites and create service mesh from on-premises to an Azure VMware Solution
private cloud using a Public IP. The service mesh allows you to migrate a workload from an on-premises
datacenter to an Azure VMware Solution private cloud over the public internet. This solution is useful when the
customer is not using ExpressRoute or VPN connectivity with the Azure cloud.

IMPORTANT

The on-premises HCX appliance should be reachable from the internet to establish HCX communication from on-premises

to the Azure VMware Solution private cloud.

Configure Public IP block

To perform HCX Migration over the public internet, you'll need a minimum of six Public IP addresses. Five of
these Public IP addresses will be used for the Public IP segment, and one will be used for configuring Network
Address Translation (NAT). You can obtain the Public IP block by reserving a /29 from the Azure VMware
Solution portal. Configure a Public IP block through portal by using the Public IP feature of the Azure VMware
Solution private cloud.

1. Sign in to Azure VMware Solution portal.

2. Under Workload Networking, select Public IP (preview).
3. Select +Public IP.
4

. Enter the Public IP name and select the address space from the Address space drop-down list according
to the number of IPs required, then select Configure.

NOTE

It will take 15-20 minutes to configure the Public IP block on private cloud.

After the Public IP is configured successfully, you should see it appear under the Public IP section. The
provisioning state shows Succeeded. This Public IP block is configured as NSX-T segment on the Tier-1 router.

For more information about how to enable a public IP to the NSX Edge for Azure VMware Solution, see Enable
Public IP to the NSX Edge for Azure VMware Solution.

Create Public IP segment on NSX-T

Before you create a Public IP segment, get your credentials for NSX-T Manager from Azure VMware Solution
portal.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/enable-hcx-access-over-internet.md

1. Sign in to NSX-T Manager using credentials provided by the Azure VMware Solution portal.

2. Under the Manage section, select Identity.

3. Copy the NSX-T Manager admin user password.

4. Browse the NSX-T Manger and paste the admin password in the password field, and select Login.
5. Under the Networking section select Connectivity and Segments, then select ADD SEGMENT.

6. Provide Segment name, select Tier-1 router as connected gateway, and provide the reserved Public IP
under subnets. The Public IP block for this Public IP segment shouldn't include the first and last Public IPs
from the overall Public IP block. For example, if you reserved 20.95.1.16/29, you would input
20.95.1.16/30.

7. Select Save.

Assign public IP to HCX manager

HCX manager of destination Azure VMware Solution SDDC should be reachable from the internet to do site
pairing with source site. HCX Manager can be exposed by way of DNAT rule and a static null route. Because HCX
Manager is in the provider space, not within the NSX-T environment, the null route is necessary to allow HCX
Manager to route back to the client by way of the DNAT rule.

Add static null route to the T1router

The static null route is used to allow HCX private IP to route through the NSX T1 for public endpoints.

1. Sign in to NSX-T manager, and select Networking.

Under the Connectivity section, select Tier-1 Gateways.
Edit the existing T1 gateway.

Expand STATIC ROUTES.

Select the number next to Static Routes.

Select ADD STATIC ROUTE.
A pop-up window is displayed.
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Under Name, enter the name of the route.

8. Under network, enter a non-overlapping /32 IP address under Network.

NOTE

This address should not overlap with any other IP addresses on the network.

9. Under Next hops, select Set.

10. Select NULL as IP Address.
Leave defaults for Admin distance and scope.

11. Select ADD, then select APPLY.
12. Select SAVE, then select CLOSE.
13. Select CLOSE EDITING.

Add NAT rule to T1gateway

NOTE
The NAT rules should use a different Public IP address than your Public IP segment.

1. Sign in to NSX-T Manager, and select Networking.



Select NAT.

Select the T1 Gateway.

Select ADD NAT RULE.

Add one SNAT rule for HCX Manager.

a. The DNAT Rule Destination is the Public IP for HCX Manager. The Translated IP is the HCX Manager IP
in the cloud.

vk W

b. The SNAT Rule Source is the HCX Manager IP in the cloud. The Translated IP is the non-overlapping
/32 IP from the Static Route.

6. Make sure to set the Firewall option on DNAT rule to Match External Address.
7. Create T1 Gateway Firewall rules to allow only expected traffic to the Public IP for HCX Manager and drop
everything else.
a. Create a Gateway Firewall rule on the T1 that allows your On-Premise as the Source IP and the Azure
VMware Solution reserved Public as the Destination IP. This rule should be the highest priority.

b. Create a Gateway Firewall rule on the T1 that denies all other traffic where the Source IP is and “Any”
and Destination IP is the Azure VMware Solution reserved Public IP.

NOTE

HCX manager can now be accessed over the internet using public IP

Create network profile for HCX at destination site

1. Sign in to Destination HCX Manager.

Select Interconnect and then select the Network Profiles tab.
Select Create Network Profile.

Select NSX Networks as network type under Network.

Select the Public-IP-Segment created on NSX-T.

Enter Name.

Under IP pools, enter the IP Ranges for HCX uplink, Prefix Length, and Gateway of public IP segment.

© N o v kWD

Scroll down and select the HCX Uplink checkbox under HCX Traffic Type as this profile will be used for
HCX uplink.

9. To create the Network Profile, select Create.

Pair site

Site pairing is required to create service mesh between source and destination sites.

1. Sign in to the Source site HCX Manager.
2. Select Site Pairing and select ADD SITE PAIRING.

3. Enter the remote HCX URL and sign in credentials, then select Connect.
After pairing is done, it will appear under site pairing.

Create service mesh

Service Mesh will deploy HCX WAN Optimizer, HCX Network Extension and HCX-IX appliances.

1. Sign in to Source site HCX Manager.

Select Interconnect and then select the Service Mesh tab.

Select CREATE SERVICE MESH.

Select the destination site to create service mesh with and select Continue.

Select the compute profiles for both sites and select Continue.

A T

Select the HCX services to be activated and select Continue.



11.
12.

NOTE

Premium services require an additional HCX Enterprise license.

Select the Network Profile of source site.
Select the Network Profile of Destination that you created in the Network Profile section.

Select Continue.

. Review the Transport Zone information, and then select Continue.

Review the Topological view, and select Continue.

Enter the Service Mesh name and select FINISH.

Extend network

The HCX Network Extension service provides layer 2 connectivity between sites. The extension service also

allows you to keep the same IP and MAC addresses during virtual machine migrations.

1.
2.

o v ok~ w

Sign in to source HCX Manager.

Under the Network Extension section, select the site for which you want to extend the network, and then
select EXTEND NETWORKS.

Select the network that you want to extend to destination site, and select Next.
Enter the subnet details of network that you're extending.
Select the destination first hop route (T1), and select Submit.

Sign in to the destination NSX, you'll see Network 10.14.27.1/24 has been extended.

After the network is extended to destination site, VMs can be migrated over Layer 2 Extension.

Next steps

Enable Public IP to the NSX Edge for Azure VMware Solution

For detailed information on HCX network underlay minimum requirements, see Network Underlay Minimum

Requirements.



https://docs.vmware.com/en/VMware-HCX/4.3/hcx-user-guide/GUID-8128EB85-4E3F-4E0C-A32C-4F9B15DACC6D.html

Enable SQL Azure hybrid benefit for Azure VMware

Solution (Preview)

8/19/2022 - 2 minutes to read  Edit Online

In this article, you'll learn how to apply SQL Azure hybrid benefits to an Azure VMware Solution private cloud by
configuring a placement policy. The placement policy defines the number of hosts that are running SQL.

IMPORTANT

It is important to note that SQL benefits are applied at the host level.

For example, if each host in Azure VMware Solution has 36 cores and you signal that two hosts run SQL, then
SQL Azure hybrid benefit will apply to 72 cores.

Configure host-VM placement policy

1. From your Azure VMware Solution private cloud, select Azure hybrid benefit, then Create host-VM

placement policy.

— Microsoft Azure (Preview) R Search resources, services, and docs (G+/)

Home > NormalSDDC2

ga NormalSDDC2 | Azure hybrid benefit (preview)

F Search (Ctrl+/) Save money using Azure hybrid benefit
Identity
entity Save money and benefit from licenses you already paid for. By craeting a host-VM affinity policy and controlling hosts running SQL

= Storage (preview) instances, you can avail discount

B Placement policies 1 placement policies with Azure hybrid benefit

-+ Add-ons Create host-VM placement policy I

vCenter inventory (preview)
KX Virtual machines

i Resource poolsfelusters/hosts

Learn more

B Templates
B Networks

ﬁ Azure hybrid benefit & Learn how much you saved
@ Datastores

Step-by-step guidance to help you plan, set up, and avail Step-by-step guidance to help admins plan, set up, and
Workload Networking this benefit. secure Azure for your organization.
% Segments Learn mare & Show cost saving &

DHCP
B Port mirroring
@ Oons

KR Public P (Preview)

Operations
88 Azure Arc (preview)

@ Run command

I B Azure hybrid benefit (preview) ]

Monitoring

2. Fill'in the required fields for creating the placement policy.

a. Name — Select the name that identifies this policy.

b. Type — Select the type of policy. This type must be VM-Host affinity only.

c. Azure hybrid benefit — Select the checkbox to apply the SQL Azure hybrid benefit.
d. Cluster — Select the necessary cluster. The policy is applicable per cluster only.

e. Enabled - Select enabled to apply the policy immediately once created.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/enable-sql-azure-hybrid-benefit.md

= Microsoft Azure (Preview) £ Search resources, services, and docs (G+/) I

Home > MormalSDDC2

Create placement policy

Basics Review and Create

Placement policies are a way of specifying constraints for running virtual machines in an Azure VMware Solution private cloud. Learn more
Details
Name: * 5QL-AHUB
Type: * VM -Host affinity
Thi: icy decides which VMs should (but are not

req

run on any of the selected hosts

Azure hybrid benefit Use this paolicy to ensure host to VM affinity. | confirm | have eligible SQL Server licenses with software assurance or SQL server subscription
to apply this Azure hybrid benefit. Learn more

Cluster: * Cluster-1

Enabled: * @) Enabled Disabled

3. Select the hosts and VMs that will be applied to the VM-Host affinity policy.

a. Add Hosts — Select the hosts that will be running SQL.
b. Add VMs - Select the VMs that should run on the selected hosts.

c. Review and Create the policy.

Select hosts

-+ Edithosts [i] Unassign

Name T Associated policies Virtual machines

B esx13-r16,p01.eastus.avslab.azure.com 0 0

Select virtual machines

—+ Editvirtual machines [i] Unassign

Display name 1

Il vsan-healthcheck-disposable-04-15-1502-44-esx22-r07.p01.7c8287cb0d474c449d58d e

Next: Review and Create

Manage placement policies

After creating the placement policy, you can review, manage, or edit the policy by way of the Placement policies
menu in the Azure VMware Solution private cloud.

By checking the Azure hybrid benefit checkbox in the configuration setting, you can enable existing host-VM
affinity policies with the SQL Azure hybrid benefit.

- Microsaft Azure (Preview) P Search resources, services, and docs (G+/)

Home NormalS|

B NormalSDDC2 | Placement policies =

aholdlas + create policy () Refresh (5 Restrict VM movement 27 Feedback

Settings Total policies ~ VMs with restricted movement
8 Locks
Manage Search policies Cluster: Cluster-3  Enable: Al Policytype: All  Azure hybrid benefit : All
& Connectivi . . i
Lonnactiy Name 7 Type Azure hybrid benefit Hosts VMs Provisioning state State

W Clusters
3l test WM-Host affinity 1 2 Succeeded © Enabled
W Encryption

i Y VM-Host affinity  Yes 1 1 Succeeded © Enabled
£ VMware credentials

Identity

= Storage (preview

B Placement policies

+ Add-cns



Next steps

Azure Hybrid Benefit

Attach Azure NetApp Files datastores to Azure VMware Solution hosts (Preview)


https://azure.microsoft.com/pricing/hybrid-benefit/

Open a support request for an Azure VMware

Solution deployment or provisioning failure

8/19/2022 - 3 minutes to read  Edit Online

This article shows you how to open a support request and provide key information for an Azure VMware
Solution deployment or provisioning failure.

When you have a failure on your private cloud, you need to open a support request in the Azure portal. To open
a support request, first get some key information in the Azure portal:

e Correlation ID
e Azure ExpressRoute circuit ID

e Error messages

Get the correlation ID

When you create a private cloud or any resource in Azure, a correlation ID for the resource is automatically
generated for the resource. Include the private cloud correlation ID in your support request to more quickly
open and resolve the request.

In the Azure portal, you can get the correlation ID for a resource in two ways:

e QOverview pane

e Deployment logs

Get the correlation ID from the resource overview

Here's an example of the operation details of a failed private cloud deployment, with the correlation ID selected:

i Delete \ Cancel : Redeploy O Refresh

o The resource operation completed with terminal provisiening state 'Failed’. Click here for details =

Your deployment failed

Deployment name: VMCP-20200528091210 Start time: 5/28/2020, 9:12:16 AM
Subseription: |Correlation ID: cc2ffcdd-cad8-2020-91dc-1e3¢20362020 |
Resource group: contose-a0l

- Deployment details (Download)

Resource Type Status Operation details

O pa3 Microsoft AVS/privateClouds Conflict Operation details

To access deployment results in a private cloud Overview pane:

1. In the Azure portal, select your private cloud.

2. In the left menu, select Overview.

After a deployment is initiated, the results of the deployment are shown in the private cloud Overview pane.

Copy and save the private cloud deployment correlation ID to include in the service request.


https://github.com/MicrosoftDocs/azure-docs/blob/main/articles/azure-vmware/fix-deployment-failures.md
https://rc.portal.azure.com/#create/Microsoft.Support

Get the correlation ID from the deployment log

You can get the correlation ID for a failed deployment by searching the deployment activity log in the Azure

portal.

To access the deployment log:

1. In the Azure portal, select your private cloud, and then select the notifications icon.

< c 0

@ portal.azure.com/#home

= Microsoft Azure P Search resources, services, and docs (G+/)

Azure services

mmm .
'l i &
E () 0O @ L ain -
Create a Subscriptions All resources App Resource Application Meonitor Enterprise Groups More services
resource Configuration groups groups applications
Recent resources
Name Type Last Viewed

(%) contoso-a01

Resource group 10 hours ago

2. In the Notifications pane, select More events in the activity log:

Notifications X

More events in the activity log — Dismiss all

3. To find the failed deployment and its correlation ID, search for the name of the resource or other
information that you used to create the resource.

The following example shows search results for a private cloud resource named pc03.

Home >

Activity log =

Create or update a PrivateCloud. X
Thu May 28 2020 09:44:25 GMT-0700 (Pacific Daylight Time)

T New alert rule -t~ New support request

Edit columns 'T,) Refresh 53} Diagnostics settings  + Downloi
. Summary Change history (Preview)
[~ peo3 | | ¥ Quick In
L .
i — 23 "name": 'Rene Pavlic", I
|_Management Group : Nene | | Subscription : 3 selected | [ Ev 24 “http://schemas.microsoft.com/identity/claims/objectidentifier”:
. m \ "6Badc783-2398-4bae-blbc-7a9b@230851",
25 "onprem_sid": "S-1-5-21-0000000000-0000E060A-0A00OBO00 - DAVERVA"
. 26 "puid": "6@adc7@3n2469757",
G items. 27 "http://schemas.microsoft.com/identity/claims/scope™: “user_impersonation”,
Operation name 28 "http://schemas.xmlsoap.org/ws/2005/85/identity/claims/nameidentifier":
"6@adc7031zMVCND5c7821 LhDEEYTKSDAS_bw246975Z",
@ Create or update a PrivateCloud ' 29 "http://schemas.microsoft.com/identity/claims/tenantid":
"6Padc703-83a2-4e80-978C-246975Z",
@ Create or update a PrivateCloud. { 30 "http://schemas.xmlsoap.ery/ws/2005/85/identity/claims/name”: “rpavlik@contoso.com,
31 "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/upn": “prpavlik@contoso.com,
@ Create or update a PrivateCloud. ' 32 "uti": "fcd@eeafs@UEVGPEOAQBAA",
@ Create or update a PrivateCloud. | ;j 3, verts 1.0
I @ Create or update a PrivateCloud. I | 35 I “correlatiol : "67@b326d-853d-4cb4-9daa-Bedee2469757", ]
36 "descriptios N
> @ Create or update a PrivateCloud ' 37 eventDatal fcdBeeaf-edc1-4add-992 f-8b35fcdeeat",
38 "eventName":
39 "value": "EndRequest",
40 “localizedValue": “End request"
41 e
42 "category": {
43 “value": "Administrative”,
44 "localizedValue": "Administrative"
45 }.
a6 “eventTimestamp": "'2020-05-28T16:44:25.246975Z",

4. In the search results in the Activity log pane, select the operation name of the failed deployment.

5. Inthe Create or update a PrivateCloud pane, select the JSON tab, and then look for correlationId in

the log that is shown. Copy the correlationid value to include itin your support request.

Copy error messages

To help resolve your deployment issue, include any error messages that are shown in the Azure portal. Select a
warning message to see a summary of errors:



Errors X

Summary | Raw Error

ERROR DETAILS E

. The resource operation completed with terminal provisioning state 'Failed’. (Code:
ResourceDeploymentFailure)

- The -mgmt-d deployment in the 02amst01 resource group has failed.
The status is: Failed at 05/28/2020 16:17:45.
Details: Code: 'AnotherOperationinProgress' Message:
‘Anocther operation on this or dependent resource is in progress. To retrieve
status of the operation use uri: https;//management.azure.com/subscriptions/
providers/Microsoft. Network/locations/westeurope/operations/providers/
/Microsoft.Network/ 7api-version=2019-02-01." Code:

‘AnotherOperationinProgress’  Message: 'The access token for this request

was issued by the tenant .

WAS THIS HELPFUL? L i}

Troubleshooting Options

Common Azure deployment errors [
Check Usage + Quota @
New Support Request 4

To copy the error message, select the copy icon. Save the copied message to include in your support request.

Get the ExpressRoute ID (URI)

Perhaps you're trying to scale or peer an existing private cloud with the private cloud ExpressRoute circuit, and it
fails. In that scenario, you need the ExpressRoute ID to include in your support request.

To copy the ExpressRoute ID:

1. In the Azure portal, select your private cloud.

2. In the left menu, under Manage, select Connectivity.
3. In the right pane, select the ExpressRoute tab.
4

. Select the copy icon for ExpressRoute ID and save the value to use in your support request.

'D S senn.ces' il )

Home > Contoso-westus-sddc
¢ Contoso-westus-sddc | Connectivity = - X
1T AVS Private cloud
P Search (Ctrl+/) « O Refresh
@ Overview = .
Azure vNet connect Settings HCX Public IP ExpressRoute Global Reach AVS Interconnect
B Activitylog —

ExpressRoute 1D
| /subscriptions/1234abc-d567-8910-abdc-2e2bb12345e6/resourceGroups/tnt50-cust-p01-westus/providers/Microsoft. Network/expressRouteCircuits/tnt50-cust-p01-westus.. D |

Ba Access control (1AM)

¢ Tags
Private peering ID
& Diagnose and solve problems | fsubscriptions/1234abc-d567-8910-abdc-2e2bb12345e6/resourceGroups/tnt50-cust-p01-westus/providers/Microsoft. Network/expressRouteCircuits/tnt50-cust-p01-westus.. D |
Settings
s - Request an autherization key () Refresh
B Locks
Name Key
Manage Contoso-westus-sddc 2e2bb12345e6-1234abc-d567-8910-abde D|

& Connectivity

B identity

B Clusters

Pre-validation failures

If your private cloud pre-validation check failed (before deployment), a correlation ID won't have been



generated. In this scenario, you can provide the following information in your support request:

e Error and failure messages. These messages can be helpful in many failures, for example, for quota-related
issues. It's important to copy these messages and include them in the support request, as described in this
article.

e Information you used to create the Azure VMware Solution private cloud, including:
o Location
o Resource group

o Resource name

Create your support request
For general information about creating a support request, see How to create an Azure support request.
To create a support request for an Azure VMware Solution deployment or provisioning failure:

1. In the Azure portal, select the Help icon, and then select New support request.

= Microsoft Azure (Preview) {t | © Search resources, services, and docs (G+/)

Home >

+ Help + support | New support request

|’O Search (Ctrl+/) ‘ « Basics Solutions Details Review + create

3‘ Overview
Create a new support request to get assistance with billing, subscription, technical (including advisory) or quota
Support management issues.

Complete the Basics tab by selecting the options that best describe your problem. Providing detailed, accurate

New support request information can help to solve your issues faster.

All support requests

2 * Issue type ‘ Technical ~ ‘
@ Support Plans . -
Subscription ‘ 9e93-d505¢-4234-d505c-4e34-4260-9293-7e528ff744... v ‘
% Service Health
hd Can't find your subscription? Show more @
& Advisor ) . .
* Service @ My services O All services
‘ Azure VMware Seclution ~ ‘
* Summary ‘ My AVS private cloud failed to deploy b ‘
* Problem type ‘ Configuration and Setup Issues e ‘
* Problem subtype ‘ Pravision a Private Cloud ' ‘

Next: Selutions > >

2. Enter or select the required information:
a. On the Basics tab:
a. For Problem type, select Configuration and Setup Issues.
b. For Problem subtype, select Provision a private cloud.
b. On the Details tab:
a. Enter or select the required information.

b. Paste your Correlation ID or ExpressRoute ID where this information is requested. If you
don't see a specific text box for these values, paste them in the Provide details about the
issue text box.

c. Paste any error details, including the error or failure messages you copied, in the Provide details
about the issue text box.


https://docs.microsoft.com/en-us/azure/azure-portal/supportability/how-to-create-azure-support-request

3. Review your entries, and then select Create to create your support request.
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